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1  Welcome to the GNSS options
The R&S SMBV100B-K44/-K66/-K94/-K97/-K98/-K106/-K107/-K108/-K109/-K122/-
K132/-K133/-K134/-K135/-K136/-K137 are firmware applications that add functionality
to generate signals in accordance with GPS, Galileo, GLONASS, NavIC, QZSS and
COMPASS/BeiDou navigation systems and SBAS augmentation systems.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMBV100B user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMBV100B

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMBV100B service manual.

● Key features............................................................................................................ 11
● Accessing the GNSS dialog....................................................................................13
● What's new..............................................................................................................13
● Documentation overview.........................................................................................13
● Scope......................................................................................................................16
● Notes on screenshots............................................................................................. 16

1.1  Key features

The global navigation satellite system (GNSS) solution for the R&S SMBV100B is suit-
able for R&D lab tests or production tests. Supported are all possible scenarios, from
simple setups with individual satellites all the way to flexible scenarios generated in
real time.

Real-time scenarios offer simulation of up to several hundred satellites for navigation
systems GPS, Galileo, GLONASS, BeiDou, NavIC and QZSS depending on the instal-
led options.

Key features

The GNSS options key features are:
● Support of multiple GNSS and regional navigation satellite systems (RNSS) and

signals including mixed constellations (Table 1-1)
● Support of satellite-based augmentation systems (SBAS) and signals including

mixed constellations (Table 1-2)
● Configuring the state of a particular signal component individually
● Real-time simulation of mixed constellations and unlimited simulation time
● Flexible scenario generation including moving scenarios, dynamic power control

and atmospheric modeling

Key features

https://www.rohde-schwarz.com/manual/smbv100b


Welcome to the GNSS optionsSatellite Navigation

12User Manual 1178.9403.02 ─ 10

● Simulation of real-time kinematics (RTK) virtual reference stations
● Configuration of realistic user environments, including obscuration and multipath,

antenna characteristics and vehicle attitude
● Navigation test mode for satellite constellation simulation, position fixing and time

to first fix (TTFF) testing
● Tracking test mode for signal acquisition and tracking tests
● Single satellite per system test mode for production tests
● Simulation of orbit perturbations and pseudorange errors
● Support of ranging, correction and integrity services for SBAS
● Configuration suitable for basic receiver testing using signals with zero, constant or

varying Doppler profiles
● Common configuration of advanced GNSS scenarios
● Support of assisted GNSS test scenarios, including generation of assistance data

for GPS, Galileo, GLONASS and BeiDou
● Logging of user motion and satellite-related parameters
● Real-time external trajectory feed for hardware in the loop (HIL) applications
● High signal dynamics, simulation of spinning vehicles to support aerospace and

defense applications
Table 1-1: Supported GNSS/RNSS, frequency bands and signals

GNSS/RNSS L1 band L2 band L5 band

GPS C/A, P, L1C C/A, P, L2C L5

Galileo E1 OS E6 E5a, E5b

GLONASS C/A, CDMA L1 C/A, CDMA L2 CDMA L3

BeiDou B1I, B1C B3I B2I, B2a, B2b

QZSS C/A, L1C L2C L5

NavIC - - SPS

For detailed information, see Chapter 2.2, "GNSS overview", on page 19.
Table 1-2: Supported SBAS, frequency bands and signals

SBAS L1 band L2 band L5 band

EGNOS C/A - Exp L5

WAAS C/A - Exp L5

MSAS C/A - -

GAGAN C/A - -

For detailed information, see Table 2-11.

Key features
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1.2  Accessing the GNSS dialog

To open the dialog with GNSS settings

► In the block diagram of the R&S SMBV100B, select "Baseband" > "GNSS".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State" > "On".

1.3  What's new

This manual describes the feature pack of firmware version FW 5.30.047.xx and later
of the R&S®SMBV100B.

Compared to the previous version it provides the new features listed below:
● Generating real-time Galileo open service navigation message authentication

(OSNMA) signals, see Chapter 12.1.1, "About Galileo OSNMA real-time signals",
on page 175 and Chapter 12.2, "Generating Galileo OSNMA real-time signals",
on page 176.

● Galileo OSNMA test vector scenarios configuration 1 and configuration 2 added,
see Table 12-1.

● Editorial changes

1.4  Documentation overview

This section provides an overview of the R&S SMBV100B user documentation. Unless
specified otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smbv100b

1.4.1  Getting started manual

Introduces the R&S SMBV100B and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Documentation overview

https://www.rohde-schwarz.com/manual/smbv100b
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Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMBV100B is not included.

The contents of the user manuals are available as help in the R&S SMBV100B. The
help offers quick, context-sensitive access to the complete information for the base unit
and the software options.

All user manuals are also available for download or for immediate display on the inter-
net.

1.4.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.4.4  Instrument security procedures

Deals with security issues when working with the R&S SMBV100B in secure areas. It
is available for download on the internet.

1.4.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.4.6  Specifications and product brochures

The specifications document, also known as the data sheet, contains the technical
specifications of the R&S SMBV100B. It also lists the firmware applications and their
order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smbv100b

Documentation overview

https://gloris.rohde-schwarz.com
https://www.rohde-schwarz.com/brochure-datasheet/smbv100b
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1.4.7  Calibration certificate

The document is available on https://gloris.rohde-schwarz.com/calcert. You need the
device ID of your instrument, which you can find on a label on the rear panel.

1.4.8  Release notes and open source acknowledgment

The release notes list new features, improvements and known issues of the current
software version, and describe the software installation.

The software uses several valuable open source software packages. An open source
acknowledgment document provides verbatim license texts of the used open source
software.

www.rohde-schwarz.com/firmware/smbv100b

1.4.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

For some application sheets, see also:

www.rohde-schwarz.com/application/smbv100b

1.4.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-1: Product search on YouTube

Documentation overview

https://gloris.rohde-schwarz.com/calcert
https://www.rohde-schwarz.com/firmware/smbv100b
https://www.rohde-schwarz.com/application/smbv100b
https://www.youtube.com/@RohdeundSchwarz
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1.5  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMBV100B user manual.

1.6  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  About the GNSS options
Global navigation satellite system (GNSS) employs the radio signals of several naviga-
tion standards, like GPS, Galileo, GLONASS and BeiDou and NavIC. For several
years, GPS used to be the only standard available for civilian navigation through its
C/A civilian code.

Nowadays, the GNSS signals and systems are undergoing fast development, some
systems are getting modernized and some are new. In the foreseeable future, several
more GNSS satellites utilizing more signals and new frequencies are available.

The GNSS implementation in the R&S SMBV100B enables you to generate composite
signals of GNSS satellites, depending on the installed options. Signal generation is
performed in real time and thus not limited to a certain time period.

The following chapters provide background information on required options, basic
terms and principles in the context of GNSS signal generation. For detailed information
on the GNSS standards, see the corresponding specifications.

2.1  Required options

The basic equipment layout for generating GNSS signals includes:
● Base unit
● Baseband real-time extension (R&S SMBVB-K520)
● At least one basic or modernized GNSS option, see Table 2-1. The modernized

GNSS options do not require a basic GNSS option.
For production testing, use the option Single-Satellite GNSS instead of a GNSS
option, see Table 2-3.

● Optional enhanced simulation capability options, see Table 2-2.
● Optional enhanced simulation capacity options, see Table 2-3.
Table 2-1: GNSS system options

Option Designation Remark

R&S SMBVB-K44 GPS C/A and P signals in L1 and L2 bands

R&S SMBVB-K66 Galileo E1 OS, E6, E5a and E5b signals in L1, L2 and L5 bands

R&S SMBVB-K94 GLONASS C/A signal in L1 and L2 bands

R&S SMBVB-K97 NavIC/IRNSS SPS signal in L5 band

R&S SMBVB-K98 Modernized GPS L1C, L2C and L5 signals in L1, L2 and L5 bands

R&S SMBVB-K107 BeiDou/COMPASS B1I and B2I signals in L1 and L5 bands

Q-component AS signals are not supported, see also
Table 2-8.

Required options
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Option Designation Remark

R&S SMBVB-K123 Modernized GLONASS CDMA L1, L2 and L3 signals in L1, L2 and L5 bands

R&S SMBVB-K132 Modernized BeiDou B1C, B3I, B2a, and B2b_I signals in L1, L2 and L5 bands

Q-component AS signals including B2b_Q are not suppor-
ted, see also Table 2-8.

Table 2-2: GNSS simulation capability options

Option Designation Remark

R&S SMBVB-K106 SBAS/QZSS Requires R&S SMBVB-K44.

Augmentation system option using satellite-based and
regional navigation signals.

R&S SMBVB-K108 Real world simulation Simulates real-world environments: Signal obscurations,
echoed and multipath effects, receiver antenna patterns
and body masks.

R&S SMBVB-K109 Real-time interfaces Emulates a realistic environment of the DUT in real time
via the Hardware in the Loop test mode.

R&S SMBVB-K122 Real-time kinematics
(RTK)

Requires R&S SMBVB-K520.

Simulates real-time kinematics for one RTK base station
and one GNSS receiver.

Table 2-3: GNSS simulation capacity options

Option Designation Remark

R&S SMBVB-K133 Single-Satellite GNSS Requires no GNSS system option.

Single satellite signal of a GNSS system suitable for pro-
duction testing.

R&S SMBVB-K134 Dual-frequency GNSS Simulation of 2 RF band signals

R&S SMBVB-K135 Triple-frequency GNSS Requires R&S SMBVB-K134.

Simulation of 3 RF band signals

R&S SMBVB-K136 Add 6 GNSS channels Installable up to 8 times

R&S SMBVB-K137 Add 12 GNSS channels Installable up to 8 times

There is a limitation on the maximum number of satellite signals that can be simulated
simultaneously. For more information, see Chapter G, "Channel budget", on page 642.

To find out installed GNSS options

► Select "System Config" > "Setup" > "Instrument Assembly" > "Versions / Options" >
"Software Options".

The column "Licenses" lists the number of installed options.

To play back GNSS waveforms

You can generate signals via play-back of waveform files at the signal generator. To
create the waveform file using R&S WinIQSIM2, you do not need a specific option.

Required options
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To play back the waveform file at the signal generator, you have two options:
● Install the R&S WinIQSIM2 option of the digital standard, e.g. R&S SMBVB-K255

for playing LTE waveforms
● If supported, install the real-time option of the digital standard, e.g. R&S SMBVB-

K55 for playing LTE waveforms

For more information, see data sheet.

2.2  GNSS overview

This section provides an overview on the GNSS including the following:

● Power spectral density, frequency bands and center frequencies fcenter

● Characteristics of the satellite constellation
● Signal plan for each GNSS

The number of deployed satellites increases constantly. For the current deployment
status, see the official information of the GNSS providers.

The GNSS simulation capacity depends on installed options and the visibility state of
the individual satellite. For the number of satellites that can be present in the satellite
constellation, see Table 6-1.

f

Q

I

Figure 2-1: Power spectral density and center frequencies of most important GNSS signals

Red = GPS L1, L2 and L5 signals, details in GPS signal plan
Blue = Galileo E1, E5 and E6 signals, details in Galileo signal plan
Green = GLONASS G1(L1), G2(L2) and G3(L5) signals, details in GLONASS FDMA signal plan
Yellow = BeiDou B1, B2 and B3 signals, details in BeiDou signal plan

GPS

The Global Positioning System (GPS) consists of several satellites circling the earth in
low orbits. The satellites transmit permanently information that can be used by the
receivers to calculate their current position (ephemeris) and about the orbits of all sat-
ellites (almanac). The 3D position of a receiver on the earth can be determined by car-
rying out delay measurements of at least four signals emitted by different satellites.

Being transmitted on a single carrier frequency, the signals of the individual satellites
can be distinguished by correlation (gold) codes. These ranging codes are used as
spreading codes for the navigation message which is transmitted at a rate of 50 bauds.

GNSS overview
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The C/A codes provide standard positioning service (SPS). The P codes provide pre-
cise positioning service (PPS).

For interface control documents (ICD), see GPS ICD.
Table 2-4: GPS signal plan

Signal C/A P L1C L2C L5

Freq. band L1

L2

L1

L2

L1 L2 L5

fcenter, MHz 1575.42

1227.6

1575.42

1227.6

1575.42 1227.6 1176.45

Modulation BPSK(1) - TMBOC

(6,1,1/11)

BPSK(1) QPSK(10)

Galileo

Galileo is the European global navigation satellite system that provides global position-
ing service under civilian control. It is planed to be inter-operable with GPS and GLO-
NASS and other global satellite navigation systems.

The fully deployed Galileo system consists of operational and spare satellites. Three
independent CDMA signals, named E5, E6 and E1, are permanently transmitted by all
Galileo satellites. The E5 signal is further subdivided into two signals denoted E5a and
E5b (see Figure 2-1). The Galileo system provides open service (OS), public regulated
service (PRS) to authorized, commercial service (CS) and search and rescue (SAR)
service.

For interface control documents (ICD), see Galileo ICD.
Table 2-5: Galileo signal plan

Signal E1 OS E5a E5b E6

Freq. band E1

L1 (GPS)

E5

L5 (GPS)

E5

L5 (GPS)

E6

L2 (GPS)

fcenter, MHz 1575.42 1176.45 1207.14 1278.75

Modulation CBOC

(6,1,1/11)

AltBOC

(15,10)

AltBOC

(15,10)

BPSK(5)

1) The Galileo signals E1 PRS-Noise and E6 PRS-Noise are for experimental use only.
These signals contain arbitrary noise. Use them for spectral interferer testing. For
example, to generate a E1 OS signal and an interfering E1 PRS-Noise signal on the
same center frequency. Theses noise signals are not useful position fix calculation and
do not comply with any ICD specification.

GLONASS

GLONASS is the Russian global navigation satellite system that uses 24 modernized
GLONASS satellites touring the globe.

Together with GPS, more GNSS satellites are provided, which improves the availability
and therefore the navigation performance in high-urban areas.

GNSS overview
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For interface control documents (ICD), see GLONASS ICD.
Table 2-6: GLONASS FDMA signal plan

Signal C/A C/A P1) P1)

Freq. band L1 (G1) L2 (G2) L1 (G1) L2 (G2)

fcenter, MHz 1602 ± k*0.56252) 1246 ± k*0.56252) 1602 ± k*0.56252) 1246 ± k*0.56252)

Modulation BPSK(0.5) BPSK(0.5) BPSK(5) BPSK(5)

1) L1 and L2 P code signals are not supported in the GNSS firmware.
2) k is the frequency number (FDMA) with -7 ≤ k ≤ 13.

Table 2-7: GLONASS CDMA signal plan

Signal CDMA L11) CDMA L21) CDMA L3

Freq. band L1 L2 L5

fcenter, MHz 1600.995 1248.06 1202.025

Modulation TDM TDM QPSK

1) The modernized GLONASS signals CDMA L1 and CDMA L2 are for experimental
use only. Any compliance with GLONASS ICD CDMA open service navigation signal in
L1 frequency band or GLONASS ICD CDMA open service navigation signal in L2 fre-
quency band is not guaranteed.

BeiDou

The fully deployed BeiDou navigation satellite system (BDS) is a Chinese satellite navi-
gation system. This navigation system is also referred as BeiDou-2.

The BDS is a global satellite navigation system with a constellation of satellites (COM-
PASS satellites) to cover the globe. The constellation includes geostationary orbit sat-
ellites (GEO) and non-geostationary satellites. The non-geostationary satellites com-
prise medium earth orbit satellites (MEO) and inclined geosynchronous orbit (IGSO).

The BDS uses frequencies allocated in the B1, B2 and B3 bands. The in phase com-
ponents (I-components) of the signals provide open service (OS), the quadrature
phase components (Q-components) of the signals provide authorized service (AS). For
an overview of supported OS signals, see Table 2-8. Q-component AS signals B1Q,
B2Q, including B2b_Q, and B3Q are not supported in the GNSS firmware.

For interface control documents (ICD), see BeiDou ICD.
Table 2-8: BeiDou signal plan

Signal B1C B1I B2a B2b1) B2I B3I

Freq. band B1

L1 (GPS)

B1

L1 (GPS)

B2

L5 (GPS)

B2

L5 (GPS)

B2

L5 (GPS)

B3

L2 (GPS)

fcenter, MHz 1575.42 1561.098 1176.45 1207.14 1207.14 1268.52

Modulation BOC(1,1)

QMBOC(6, 1, 4/33)

BPSK(2) BPSK(10)

BPSK(10)

BPSK(10) BPSK(2) BPSK(10)

GNSS overview
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1) BeiDou B2b_I I-component of the B2b open service signal for space vehicles PRN 6
to PRN 58.

QZSS

The Quasi-Zenith satellite system (QZSS) is a regional space-based positioning sys-
tem deployed in 2013.

In its final deployment stage, the QZSS uses a total number of three regional non-geo-
stationary and highly inclined satellites and one geostationary orbit (GEO) satellite. The
QZSS does not aim to cover the globe but to increase the availability of GPS in Japan,
especially in the larger towns.

The QZSS uses signals that are similar to the GPS public signals. For interface control
documents (ICD), see QZSS ICD.
Table 2-9: QZSS signal plan

Service name C/A L1C SAIF1) L2CM, L2CL L5I, L5Q LEX1)

Signal C/A L1C - L2C L5 -

Freq. band L1 L1 L1 L2 L5 E6

fcenter, MHz 1575.42 1575.42 1575.42 1227.6 1176.45 1278.75

Modulation BPSK(1) TMBOC

(6,1,1/11)

BPSK(1) BPSK(1) BPSK(10) BPSK(5)

1) QZSS SAIF and E6 LEX signals are not supported in the GNSS firmware.

NavIC

NavIC (Navigation Indian Constellation) is the Indian navigation satellite system, for-
merly denoted IRNSS (Indian Regional Navigational Satellite System).

NavIC is a regional satellite navigation system with a constellation of satellites to cover
an area of 1500 km surrounding India (2016). The constellation includes geostationary
orbit (GEO) satellites and inclined geosynchronous orbit (IGSO) satellites.

The NavIC system uses frequencies allocated in the L5 and S bands providing special
positioning service (SPS) and precision service (PS).

For interface control documents (ICD), see NavIC ICD.
Table 2-10: NavIC signal plan

Signal SPS PS1)

Freq. band L5 S

fcenter, MHz 1176.45 2491.75

Modulation BPSK(1) N/A

1) NavIC PS signal is not supported in the GNSS firmware.

GNSS overview
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Assisted GNSS (A-GNSS)

Assisted GNSS (A-GNSS) was introduced to different mobile communication stand-
ards to reduce the time to first fix (TTFF) of a user equipment (UE) containing a GNSS
receiver. The reduction is achieved by transmitting information (assistance data) mainly
about the satellites directly from a base station to the UE.

For example, a standalone GPS receiver needs about 30 to 60 seconds for a first fix
and up to 12.5 minutes to get all information (almanac).

In A-GNSS "UE-based mode", the base station assists the UE by providing the com-
plete navigation message along with a list of visible satellites and ephemeris data. In
addition to this information, the UE gets the location and the current time at the base
station. That speeds up both acquisition and navigation processes of the GPS receiver
and reduces TTFF to a few seconds.

In A-GNSS "UE assisted mode", the base station is even responsible for the calcula-
tion of the UE's exact location. The base station takes over the navigation based on the
raw measurements provided by the UE. Since the acquisition assistance data provided
by the base station already serves speeding up the acquisition process, the UE only
has to track the code and carrier phase.

2.3  SBAS overview

Satellite-based augmentation systems (SBAS) use geostationary satellites (GEO) to
broadcast GNSS coarse integrity and wide area correction data (error estimations),
and ranging signal to augment the GNSS.

SBAS broadcast augmentation data in the GPS frequency band L1 using the C/A code
of GPS. For experimental use, the R&S SMBV100B provides modulation of SBAS L1
navigation message data in the GPS L5 band for SBAS systems EGNOS and WAAS.
The signal "Exp L5" is a pure copy of L1 data and does not comply with SBAS inter-
face control document (ICD) specifications.
Table 2-11: SBAS signal plan

Signal C/A Exp L5

Freq. band L1 L5

fcenter, MHz 1575.42 1176.45

Modulation BPSK(1) N/A

The SBAS provides data for a maximum of 51 satellites. In the SBAS, the term
"pseudo random number" (PRN) is used instead of the term space vehicle (SV). There
are 90 PRN numbers reserved for SBAS, where the numbering starts at 120.

Several SBAS systems are still in their development phase, like, for example, the
SDCM in Russia Federation, and GAGAN in India.

SBAS overview
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SBAS systems that are currently in operation argument the US GPS satellite naviga-
tion system, so that they are suitable, for example, for civil aviation navigation safety
needs. The following SBAS systems are supported by R&S SMBV100B:
● EGNOS

EGNOS (European geostationary navigation overlay service) EGNOS is the Euro-
pean SBAS system.

● WAAS
WAAS (wide area augmentation system) is the SBAS system in United States.

● MSAS
MSAS (multi-functional satellite augmentation system) is the SBAS system working
in Japan. It uses the multi-functional transport satellites (MTSAT) and supports dif-
ferential GPS.

● GAGAN
GAGAN (GPS aided geo augmented navigation system) is the SBAS implementa-
tion by the Indian government.

2.4  GNSS components overview

The GNSS system consists of three main components: the space segment, the ground
segment and the user segment.

Figure 2-2: GNSS system components (simplified)

1 = Space segment or satellites
2 = Ground segment or ground stations
3 = User segment or receivers
4 = Ephemeris (broadcasted satellites orbit and clock)
5 = Broadcasted navigation message

GNSS components overview
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Space segment

The space segment consists of the satellites that orbit the earth on their individual
orbits. Satellites broadcast signals at specific frequency in the L band and spread by
predefined codes. For the GPS satellites using L1 frequency band, for instance, the
predefined codes are the coarse/acquisition (C/A) or the precision (P) codes.

The transmitted signal carries the navigation message, on which each satellite broad-
casts its major characteristics, its clock offsets and precise orbit description, where the
latter is called ephemeris. The navigation message contains also satellites status
information, ionospheric and time-related parameters, UTC information and orbit data
with reduced accuracy for all other satellites, commonly referred as almanac.

Ground segment

The ground segment is a network of ground stations whose primary goal is to mea-
sure constantly the satellites’ location, altitude and velocity, and the satellites signals.
The ground stations also estimate the influence of the ionosphere. They calculate the
precise orbit (and orbit perturbation) parameters and clock drifts parameters of
each satellite. This corrected highly accurate information is regularly broadcasted back
to the satellites so that their navigation messages can be updated.

User segment

Finally, the receiver decodes the navigation message (ephemeris and almanac)
broadcasted by the GNSS satellites, obtains information regarding the satellites orbit,
clock, health etc. and calculates the satellites coordinates. The receiver also measures
the signal propagation time (i.e. the pseudorange) of at least four satellites and esti-
mates its own position.

2.5  How are the GNSS components simulated?

In real life, the true satellite orbit can differ from the orbit information that the satellite
broadcasts.

In this implementation, the simulated orbit is the true orbit. Thus, the satellites motion
along their orbits, the clock they use and the current distance to each of them are refer-
red to as simulated orbit, clock and pseudorange. They are set as retrieved from
the constellation data source and can be configured on a per satellite basis.

The navigation message of each of the satellites is per default identical to the simula-
ted one. It is referred to as broadcasted navigation message, since it represents the
broadcasted satellite’s signal, see Figure 2-2. Per default, the broadcasted and the
simulated orbit and clock parameters match. Obviously, if the parameters in any of
those two groups are changed, a deviation between the sets is simulated.

The receiver is the device under test (DUT). In the simulation, the receiver is represen-
ted by its position, antenna configuration, environment, etc. The receiver is tested with
the GNSS that it would receive in a real-world situation if placed in the specified condi-
tions.

How are the GNSS components simulated?
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Simulation date, time and location

The R&S SMBV100B generates the signal for any simulation date and time, in the past
or in the future. The generated signal represents any location, on the earth or in the
space, for a static or moving receiver.

You have full control over the satellites’ constellation, the satellites signals and the nav-
igation message of each satellite. Repeat measurement scenarios with same precondi-
tions and vary the complexity or replay simulation events from the past.

For details, see:
● Chapter 4, "Simulation time", on page 46
● Chapter 5, "Receiver type and position", on page 52
● Chapter 6, "Satellite constellation", on page 67
● Chapter 7, "Space vehicle configuration", on page 82

Real-world scenarios through environmental effects

You can also simulate various different environmental conditions, like the effect of the
receiver’s antenna characteristic, vehicle movement, vehicle body mask, multipath
propagation, obstacles or the atmosphere.

For details, see Chapter 10, "Real-world environment", on page 116.

Ionospheric effects

You can also simulate the effect of the atmospheric (ionospheric and tropospheric)
errors on the positioning accuracy.

For details, see "Tropospheric and ionospheric models" on page 197.

GNSS errors sources

Additional to the real-world and the ionosphere effects, you can simulate signal errors
by manipulating the navigation messages of the satellites. Signal errors have a direct
impact on the receiver’s positioning accuracy.

You can observe the effect of the following common error sources:
● Ephemeris errors: Orbit and orbit perturbation errors
● Satellite clock and time conversion errors
● Pseudorange errors

For details, see Chapter 13, "Perturbations and errors simulation", on page 191.

Historical constellations and navigation data

You can also replay historical satellite constellations, by loading constellation files and
navigation data files for all GNSS systems supported in the GNSS firmware.

For details, see:
● "File formats" on page 282
● Chapter 17.1, "Import constellation settings", on page 284

How are the GNSS components simulated?
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Correction data

You can also correct navigation data by loading SBAS corrections.

For details, see:
● Chapter 14, "SBAS corrections", on page 236
● Chapter 17.2, "Import SBAS settings", on page 286

How are the GNSS components simulated?
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3  Getting started
In its default configuration, the software generates GNSS signal that is sufficient for a
receiver to get a position fix. The simulated GNSS depends on the installed options.
For example, if R&S SMBV100B-K44 is installed, it is GPS C/A signal in the L1 band.

For all GNSS, the simulation starts on 2014-02-19 at 6 am UTC time and the satellite
constellation corresponds to a constellation that is visible for a static receiver located in
Munich.

To simulate a defined configuration, you can load predefined assistance GNSS scenar-
ios or load a user-defined scenario. The software applies the configuration automati-
cally, you can change related settings afterwards. For example, try out the receiver
templates and configure a receiver, moving in a circle in New York.

● Trying out the GNSS simulator............................................................................... 28
● General settings......................................................................................................32
● Simulation monitor.................................................................................................. 36

3.1  Trying out the GNSS simulator

The following simple examples can help you get familiar with the basic functions of the
software:
● "To generate a GNSS signal" on page 28
● "To use predefined scenarios" on page 29
● "To generate a multi-constellation GNSS signal" on page 31

To generate a GNSS signal

This step-by-step instruction shows how to generate a GNSS signal with the default
configuration of a GPS signal for simple receiver tests.

1. Select "Baseband" > "Satellite Navigation" > "GNSS".

2. Select "General" > "State" > "On".

Configured is a GPS signal with C/A signal in the L1 frequency band.

Trying out the GNSS simulator
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3. To observe current satellite constellation, select "GNSS" > "Simulation Monitor".

4. In the block diagram, select "RF" > "On".

The signal generation starts. The frequency and level of the generated RF signal
are configured automatically. Further settings are not required.
For a description of related settings, see:
● Chapter 3.2, "General settings", on page 32
● Chapter 3.3, "Simulation monitor", on page 36

To use predefined scenarios

1. Select "Baseband" > "Satellite Navigation" > "GNSS".

2. Select "General" > "Predefined Scenarios".

The "Predefined Scenario" dialog opens displaying predefined scenarios in a list.
See also Chapter E, "Predefined GNSS scenarios", on page 630.

3. Select, for example, "Assisted GNSS" > "3GPP2" > "3GPP2 C.S0036 2.1.2 Mov-
ing".

4. Select "General" > "State" > "On".

Trying out the GNSS simulator



Getting startedSatellite Navigation

30User Manual 1178.9403.02 ─ 10

The scenario provides a GPS signal with C/A signal in the L1 frequency band for a
moving GNSS receiver.

5. To observe simulation characteristics, open the "Simulation Monitor" dialog:

a) For the receiver trajectory, select "Display" > "Map View".
b) For the satellite constellation, select "Display" > "Sky View".

6. To check related settings of the GNSS receiver, select "Simulation Monitor" >
"GNSS Config".

a) To check general receiver characteristics, select "Receiver".

Trying out the GNSS simulator
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b) To check the receiver position, select "Receiver" > "Position Configuration".

7. In the block diagram, select "RF" > "On".

The signal generation starts. The frequency and level of the generated RF signal
are configured automatically. Further settings are not required.
For description of the related settings, see:
● Chapter 3.2, "General settings", on page 32
● Chapter 3.3, "Simulation monitor", on page 36
● Chapter 5, "Receiver type and position", on page 52

To generate a multi-constellation GNSS signal

1. Select "Baseband" > "Satellite Navigation" > "GNSS".

2. Select "GNSS Configuration" > "Systems & Signals".

Trying out the GNSS simulator



Getting startedSatellite Navigation

32User Manual 1178.9403.02 ─ 10

3. Select the frequency band, for example, set "L1" > "On".

4. Enable the global, regional and augmentation GNSS systems to be simulated, for
example, "GPS" > "On", "Galileo" > "On", "GLONASS" > "On".

5. Define the signals per GNSS system, for example, for GPS:

a) Enable the C/A signal: Select "GPS" > "C/A" > "On".
b) Disable the P signal: Select "GPS" > "P" > "Off".

6. To observe current satellite constellation, select "GNSS" > "Simulation Monitor".

7. To reconfigure constellation settings, select "Simulation Monitor" > "GNSS Config".

8. In the block diagram, select "RF" > "On".

The signal generation starts. The frequency and level of the generated RF signal
are configured automatically. Further settings are not required.
For related settings, see:
● Chapter 3.2, "General settings", on page 32
● Chapter 3.3, "Simulation monitor", on page 36
● Chapter 6, "Satellite constellation", on page 67

3.2  General settings

Access:

► Select "Baseband" > "Satellite Navigation" > "GNSS".

The dialog provides general settings to call the default settings, save and recall
settings and access to further settings of the GNSS simulation.
The remote commands required to define these settings are described in Chap-
ter 21.1, "General commands", on page 328.

General settings
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Settings:

State..............................................................................................................................33
Set to Default................................................................................................................ 33
Recall Scenario/Save Scenario.....................................................................................33
Predefined Scenario......................................................................................................34
Scenario........................................................................................................................ 34
Test Mode......................................................................................................................34
GNSS Configuration......................................................................................................35
Simulation Monitor........................................................................................................ 35
Data Generation............................................................................................................36
RTK Configuration.........................................................................................................36

State
Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.
Remote command: 
[:SOURce<hw>]:BB:GNSS:STATe on page 329

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

"State" Not affected by "Set to default"

"Scenario" "None"

"Test Mode" "Navigation"

"Logging" "Off"

"RTK" "Off"

Remote command: 
[:SOURce<hw>]:BB:GNSS:PRESet on page 329

Recall Scenario/Save Scenario
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMBV100B user manual.
To ensure repeatable test situation, the save file or recall file contains all settings. The
scenario includes all files used in the simulation, for example, waypoints files or vehicle
description files.
When recalling a scenario, the instrument checks the installed options and the used
system configuration. If there is a mismatch, the file is loaded, settings adapted as far
as possible and the simulation displays a warning message to indicate this situation.

General settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog? on page 331
[:SOURce<hw>]:BB:GNSS:SETTing:STORe on page 331
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD on page 331
[:SOURce<hw>]:BB:GNSS:SETTing:DELete on page 332

Predefined Scenario
Accesses the standard "File Select" dialog and allows you to select a predefined sce-
nario.
The available test scenarios depend on the installed software options. For an overview,
see Chapter E, "Predefined GNSS scenarios", on page 630.
Once a scenario is selected, all parameters (simulated position, satellite configuration,
navigation data, etc.) are configured automatically. The scenario name is indicated,
see "Scenario" on page 34.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog:PREDefined? on page 332
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD:PREDefined on page 332

Scenario
Displays a loaded scenario, if selected.
"None" No scenario selected (default setting), see "Set to Default"

on page 33.
Predefined scenario

Name of the predefined scenario as selected via "Predefined Sce-
nario" on page 34.

Predefined scenario *
Name of the predefined scenario with changed settings.

Directory and filename
Directory and filename, when you load a scenario, see "Recall Sce-
nario/Save Scenario" on page 33.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SCENario? on page 329

Test Mode
Set the test mode to match the operation mode in that the DUT works.
Irrespectively of the selected mode, initial satellites constellations are defined by the
predefined or imported constellation data. Also, the number of active satellites with
their initial position and messages are retrieved from constellation data. You can edit
the satellite constellation and signals in both modes.
Switching from one test mode to the other presets all satellites parameters to their
default values. The modes differ in terms of signal content and scenario complexity:

General settings
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"Navigation" The generated signal contains satellite signals to simulate a particular
location of a GNSS receiver.
This signal implies a realistic navigation scenario. The DUT can ach-
ieve position fix, since the satellite constellation comprises of at least
three satellites. The signal is suitable for signal acquisition and TTFF
tests.
For more information, see Chapter 5, "Receiver type and position",
on page 52.

"Tracking" The generated signal contains no positioning data. You do not need
to configure the GNSS receiver.
Navigation and acquiring of position fix is not possible. The signal is,
however, sufficient to test the ability of the DUT to find the channel
and to decode the signal. It is also sufficient for sensitivity testing.
Use this mode to simulate high signal dynamics. For example, simu-
late spinning vehicles and precision code (P code) such as in some
aerospace and defense applications.
For more information, see Chapter 8, "Tracking mode", on page 106.

"Single Satellite per System"
Requires R&S SMBVB-K133.
The generated GNSS signal contains one satellite signal for each
GNSS system GPS, Galileo, GLONASS, COMPASS/BeiDou and
NavIC. Use this mode for production tests.
Navigation and acquiring of position fix is not possible. The signal is,
however, sufficient to test the ability of the DUT to find the channel
and to decode the signal. It is also sufficient for sensitivity testing.
For more information, see Chapter 9, "Production tester",
on page 112.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TMODe on page 330

GNSS Configuration
Accesses the "GNSS Configuration" dialog for defining active navigation system, used
RF bands and signals. Also, the dialog provides further settings to configure satellites.
See:
● Chapter 6.1, "Systems and signals settings", on page 68
● Chapter 4.1, "Time settings", on page 46
● Chapter 5.1, "General receiver settings", on page 52
● Chapter 6.2, "Satellites settings", on page 73
● Chapter 13.4, "Atmospheric effects and ionospheric errors settings", on page 200

Simulation Monitor
Accesses the "Simulation Monitor" dialog for real-time display of the most important
parameters.
These parameters are, for example, the current satellite constellation with SV states
and position, receiver position or movement trajectory and received satellite power.
See Chapter 3.3, "Simulation monitor", on page 36.

General settings
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Data Generation
Accesses the "Data Generation" dialog for enabling and configuring data logging,
assistance data generation and generating files by converting. Also, the button dis-
plays logging state ("Logging On"/"Logging Off").
See:
● Chapter 15, "Data logging", on page 265
● Chapter 16, "Assistance data generation", on page 275

RTK Configuration
Requires R&S SMBVB-K122.
Accesses the "RTK Configuration" dialog for enabling and configuring real-time kine-
matics (RTK) simulation. Also, the button displays the RTK state ("RTK On"/"RTK Off").
See Chapter 11, "Real-time kinematics", on page 162.

3.3  Simulation monitor

About the simulation monitor

The simulation monitor visualizes the real-world situation of disappearance and reap-
pearance of satellites in real time. It is a dynamic display that provides real-time infor-
mation on the following:
● Satellite location, satellite states and satellite tracks
● Receiver position and receiver velocity including the current simulation time
● Trajectory of a moving receiver
● Signal power levels of the active satellites and echo signals
● Horizontal dilution of precision (HDOP) and position dilution of precision (PDOP)

To access the functionality

1. Select "GNSS" > "General" > "Simulation Monitor".

Simulation monitor
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The dialog displays the view that fits best to the settings in the origin dialog.

2. To access related settings, select "GNSS Configuration".

The simulation monitor offers different views to monitor characteristics of the GNSS
signal. The views cover the following topics.

Settings:

Display.......................................................................................................................... 37
P/V/T............................................................................................................................. 42
GNSS Configuration......................................................................................................42
Expand left/right............................................................................................................ 42
SV/HDOP/PDOP...........................................................................................................42
View Settings.................................................................................................................43
Show Echoes................................................................................................................ 43
Show Tracks..................................................................................................................43
Axis............................................................................................................................... 43
Yaw / Heading/Pitch / Elev./Roll / Bank.........................................................................44
System.......................................................................................................................... 44
SV-ID.............................................................................................................................44
Channels....................................................................................................................... 44
HW Channels table....................................................................................................... 45

Display
Switches between the available views.

Simulation monitor
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"Sky View" Displays the current position and state (active or inactive) of the satel-
lites in the current satellites constellation. In this display, you can, for
example, observe the situation of disappearance and reappearance
of satellites.

Figure 3-1: Hybrid satellite constellation with obscured satellites in a moving
scenario

For instruments equipped with option R&S SMBV100B-K108, the
"Sky View" indicates also the obscured satellites, the satellites with
echoes, etc. For example, the satellites which signal is not visible
from the current receivers position because there is an obstacle
between the receiver and the satellite, are displayed in gray color.

"Power View" Displays the current power levels of the signals of the active satellites
and their echoes.

Figure 3-2: Hybrid satellite constellation with obscured satellites and echoes
with power signal levels per satellite

Simulation monitor
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"Ground Track"
Displays an aggregated plot of the trajectories of all satellites projec-
ted on the world map.
To observe satellite ground tracks, you can show tracks for all and for
single satellites:
● For all satellite ground tracks, select "Show Tracks". See "Show

Tracks" on page 43.
● For a single satellite ground track, access the "Simulated Orbit"

settings of this satellite. See "Ground Track" on page 94.

Simulation monitor
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"Map View" Displays the trajectory of a moving receiver or the position of a static
one. The blue trajectory displays the last 50 receiver positions, the
orange trajectory displays the receiver positions from the last three
hours or the expected movement from a waypoint file. If the receiver
position reaches the limits of the axes, the scaling is adapted auto-
matically.

1

2

3

1 = Receiver position
2 = Blue trajectory: 50 last receiver positions
3 = Orange trajectory: receiver positions of the last three hours or the expected move-

ment from a waypoint file

If you analyze the generated GNSS signal with a GNSS receiver soft-
ware, you can notice a slight difference in the receiver position. The
receiver position displayed on the "Map View" and the position dis-
played on the receiver software can deviate at the beginning of a sim-
ulation. The accuracy of the "Map View" display is progressively
increasing with the time elapsed and after the first satellite handover
the deviation completely disappears.

Simulation monitor
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"Attitude View" Displays a compass showing the geographic direction of a moving
receiver, typically an airplane. It also displays an attitude indicator
showing the orientation of this airplane relative to earth's horizon.

The displayed attitude indicator is known from the flight simulators.
The yellow sign in the middle represents the airplane with its nose
and wings. The brown part of the display is the earth, whereas the
sky is displayed in blue; the line between the two parts is the horizon.
The "Attitude View" changes in real time:
● If the yellow circle, i.e. the nose of the airplane, is on the blue

background, then the airplane is nose up.
● If a spinning and roll is enabled, the attitude indicator also visual-

izes pitch and roll (i.e. bank or side-to-side tilt).
"Elev./Azimuth"

Displays the time variation of the azimuth and the satellite's elevation
over 24 hours UTC time. The start time is hour 00:00:00 of the simu-
lated day. The vertical dotted green line indicates the current simula-
tion time and updates in real time. Crossing midnight ("24") triggers a
refresh of the two plots.

Simulation monitor
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"HW Channels"
Lists the channel information, number of active channels and alloca-
ted channels of the composite GNSS signal.

See also:
● "Channels" on page 44
● "HW Channels table" on page 45

Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay on page 577

P/V/T
Real-time information for receiver position, receiver velocity and simulation time.
"P" Receiver position with latitude and longitude in degrees and altitude

in meters. See also "Location Coordinates, Position Format"
on page 57.

"V" Receiver velocity in meter per second
"T" Date and time in UTC format: YYYY-MM-DD HH:MM:SS. See also

"Simulation Start" on page 48.

GNSS Configuration
Accesses the "GNSS Configuration" dialog to configure the following GNSS settings:
● Chapter 6.1, "Systems and signals settings", on page 68
● Chapter 4.1, "Time settings", on page 46
● Chapter 5, "Receiver type and position", on page 52
● Chapter 6.2, "Satellites settings", on page 73
● Chapter 13.4, "Atmospheric effects and ionospheric errors settings", on page 200
● Chapter 13.2, "Noise and CW interferer settings", on page 191

Expand left/right
Expands the view to the full width of the dialog.
">>" Expands the left view to the right.
"<<" Expands the right view to the left.

SV/HDOP/PDOP
Displays the current HDOP and PDOP value of the selected satellite constellation and
the number satellites that these values apply to.
The HDOP and PDOP can be used as an indication of 2D and 3D positioning quality.
The general rule here is that the smaller the HDOP and PDOP are, the better the preci-
sion of the position fix.

Simulation monitor
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View Settings
Requires "Display" > "Power View".
Accesses a dialog to define visible signals in the graph that displays the signal power
levels per satellite. Disable or enable visible signals, for example, in hybrid satellite
constellations to highlight visible signals for a specific GNSS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:
SIGNal:L1Band:CA on page 581
(etc. for the other GNSS systems)

Show Echoes
Requires "Display" > "Power View".
If enabled, the "Power View" graph indicates also the echoes per satellite. Echo signals
are present, if you configure a static multipath environment for a receiver with at least
one configured echo.
See also:
● Chapter 10.7.6, "Static multipath", on page 158
● Figure 7-3
Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:ECHoes on page 579

Show Tracks
Requires "Display" > "Ground Track".
If enabled, the "Ground Track" view indicates both, the current satellite positions and
their orbits.
Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRACks:SHOW on page 578

Axis
Requires "Display" > "Map View".
Changes the axis representation of the map. The origin and the distance of the
receiver trajectory to the origin stays the same for each representation.

Simulation monitor
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"Grid" Two-dimensional cartesian coordinates in grid-like representation.
"Circles" Two-dimensional coordinates in circular representation of an eye

chart.
Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:MAP:AXIS on page 578

Yaw / Heading/Pitch / Elev./Roll / Bank
Requires "Display" > "Attitude".
Displays the receiver attitude parameters yaw/heading (Y), pitch/elevation (P), roll/
bank (R) in degrees. The simulation reads out these parameters from the receiver
movement file.
For constant attitude behavior, you can configure initial receiver attitude parameters,
see "Attitude Behaviour, More" on page 57.

System
Requires "Display" > "Elev./Azimuth".
Selects the GNSS for that the simulation varies the satellite elevation and azimuth val-
ues.
Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SYSTem
on page 579

SV-ID
Requires "Display" > "Elev./Azimuth".
Selects the space vehicle for that the simulation varies the satellite elevation and azi-
muth values.
Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SVID
on page 578

Channels
Requires "Display" > "HW Channels".
Displays the number of active GNSS channels ("x") and allocated GNSS channels
("y"). The number of active channels is automatically configured depending on the
number of active GNSS systems, signals, satellites, vehicles and antennas. The num-
ber of allocated channels is also the maximum number of channels.
A GNSS channel refers to a hardware unit that is required to process and generate a
GNSS signal. GNSS channels are uniquely composed of the following configuration
elements: One vehicle/receiver, one antenna, one RF band and one signal of a single
satellite.
The maximum number of channels depends on the installed options. See Chapter G,
"Channel budget", on page 642.

Simulation monitor
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Remote command: 
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:USED?
on page 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:ALLocated?
on page 581

HW Channels table
Requires "Display" > "HW Channels".
Lists GNSS channel information in a table.
Table 3-1: HW channels: Understanding the displayed information

Parameter Description

"Ant" Antenna number

"SV" Space vehicle with GNSS system and number

"Signal" Frequency band and signal

"Path" Type of signal: Line-of-sight (LOS) and echoes

"Power(dBm)" Channel power

Simulation monitor
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4  Simulation time
The default system time in this simulation is given in the UTC (Universal Time Coordi-
nates) time base. The simulation start time is thus defined as date and time and is set
to 2014-02-19 at 06:00:00 am.

Simulation start time

You can change the simulation start time as you can change the time basis at any time.
The time is then automatically recalculated and displayed in the selected time format.

The satellite constellation can comprise SVs from different navigation systems. You
can observe the current simulation time converted into the time basis of each of the
enabled GNSS systems at a glance.

If the satellite constellation comprises SVs from different navigation standards, the time
conversion between the time bases in these navigation standards has to be defined.
With other words, the time conversion settings are necessary for switching from one
timebase to another.

Time conversion parameters and leap second

Time conversion parameters are zero and first order system clock drift parameters and
the current leap second.

The leap second describes the difference between the GPS, Galileo, GLONASS, Bei-
Dou or NavIC system time and UTC system time. Correct the time difference by speci-
fying the leap second transition date, the leap second before transition and the leap
second after transition.

How to: Example"Configuring leap second transition" on page 49

Simulating time conversion errors

Per default, the time conversion between the time basis excludes conversion errors
and drifts between the time basis of the GNSS systems. We recommend that you use
the default configuration, without system time offset or time drift.

If you aim to simulate deliberate errors and change the time conversion settings, see:
● "Additional UTC Parameters" on page 50
● Chapter 13.8, "Time conversion errors settings", on page 225

4.1  Time settings

Access:

1. Select "GNSS" > "GNSS Configuration" > "Time".

Time settings
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2. Select "Additional UTC Parameters".

These dialogs contain the settings required to configure the time conversion from a
navigation standard, for example GPS to UTC. The conversion settings are neces-
sary for switching from one timebase to another.

Settings

Simulation Start.............................................................................................................48
Set Current Time...........................................................................................................48
Leap Second Configuration...........................................................................................49

└ Auto Configure Leap Second (Ref. 1980).......................................................49
└ Leap Second Transition Date......................................................................... 49
└ Leap Second before Transition - ΔtLS............................................................. 49
└ Leap Second after Transition - ΔtLSF...............................................................49

Date / Week, Time / Time of Week /s, UTC Offset /s.................................................... 50
Additional UTC Parameters.......................................................................................... 50

└ Reference Week/Date, Reference Time of Week........................................... 50

Time settings
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└ UTC-UTC(SU).................................................................................................50
└ Integer Offset.................................................................................................. 50
└ Fractional Offset A0, Drift A1.......................................................................... 51

Simulation Start
Sets the simulation start date and time in the selected format.
"Format" Per default, the UTC format used. If different format is selected, the

time is automatically recalculated.
Note: Use the Additional UTC Parameters dialog to configure the
parameters, necessary for time conversion between the proprietary
time of the navigation standard and the UTC.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TBASis on page 342

"Date [yyyy-mm-dd], Time [hh:mm:ss.xxx]"
Enters the date for the simulation in format YYYY-MM-DD (ISO
8601). The date corresponds to the Gregorian calendar and the exact
simulation start time in UTC time format.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:STARt:DATE on page 341
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TIME on page 342

"Week Number, Time of Week (TOW)"
The satellite clocks in the GPS and Galileo navigation systems are
not synchronized to the UTC. They use a proprietary time, the GPS
and the Galileo system time. The format used for these systems is
week number (WN) and time of week (TOW), that is the simulation
start time within this week.
TOW is expressed in number of seconds and covers an entire week.
The value is reset to zero at the end of each week.
The weeks are numbered starting from a reference time point
(WN_REF=0), that depends on the navigation standard:
● GPS reference point: January 6, 1980 (1980-01-06, 00:00:00

UTC)
● GALILEO reference point: August 22, 1999 (1999-08-22)
● BeiDou reference point: January 01, 2006 (2006-01-01)
● NavIC reference point: August 22, 1999 (1999-08-22)
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:STARt:WNUMber on page 343
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TOWeek on page 343

Set Current Time
Applies date and time settings of the operating system to the simulation start time.
To access the operating system time settings, select "System Config" > "Setup" >
"Maintenance" > "Date / Time".
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SCTime on page 342

Time settings
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Leap Second Configuration
Configure leap second transitions for time corrections between UTC system time and
the individual GNSS time.

Example: Configuring leap second transition
The examples below comprise leap second transitions before/after the set transition
date. Also, the functionality allows you to configure no leap second transition at an
arbitrary transition date.
● Leap second transition in the future:

Set simulation start "Date" > "2014-02-19", "Leap Second Transition Date" >
"2015-06-30", "Leap Second before Transition - ΔtLS" > "16", "Leap Second after
Transition - ΔtLSF" > "17".

● Leap second transition in the past, no other transition event announced:
Set simulation start "Date" > "2019-12-10", "Leap Second Transition Date" >
"2016-12-31", "Leap Second before Transition - ΔtLS" > "17", "Leap Second after
Transition - ΔtLSF" > "18".

● No leap second transition at an arbitrary transition date:
Set simulation start "Date" > "2019-12-10", "Leap Second Transition Date" > "yyyy-
mm-dd", "Leap Second before Transition - ΔtLS" > "17", "Leap Second after Transi-
tion - ΔtLSF" > "17".

Auto Configure Leap Second (Ref. 1980) ← Leap Second Configuration
Sets the leap second value according to the simulation time.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:AUTO on page 343

Leap Second Transition Date ← Leap Second Configuration
Editing the parameter requires "Auto Configure Leap Second (Ref. 1980)" > "Off".
Defines the date of the next UTC time correction in format YYYY-MM-DD (ISO 8601).
You can transit leap seconds by adding or subtracting one second to the leap second
value before transition.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:DATE on page 344

Leap Second before Transition - ΔtLS ← Leap Second Configuration
Editing the parameter requires "Auto Configure Leap Second (Ref. 1980)" > "Off".
Specifies the leap second value ΔtLS before the leap second transition.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:BEFore
on page 344

Leap Second after Transition - ΔtLSF ← Leap Second Configuration
Editing the parameter requires "Auto Configure Leap Second (Ref. 1980)" > "Off".
Specifies the leap second value ΔtLSF after the leap second transition.

Time settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:AFTer
on page 344

Date / Week, Time / Time of Week /s, UTC Offset /s
Displays overview information on the parameters used for the time conversion between
the different navigation standards.
The basis for the time conversion is the UTC. The parameters of each of the navigation
standards are set as an offset to the UTC.
For in-depth configuration, use the "Additional UTC Parameters" on page 50 dialog.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:DATE? on page 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:TIME? on page 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:OFFSet? on page 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:WNUMber? on page 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:TOWeek? on page 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:OFFSet? on page 346
(etc. for the other GNSS systems)

Additional UTC Parameters
Sets the time conversion parameters required for switching from one timebase to
another, for example GPS to UTC. The time conversion is performed according to the
following equation:
tUTC = (tE - delta_tUTC) modulo 86400, where:
● delta_tUTC = delta_tLS+A0+A1 (tE-Tot+604800(WN-WNot))
● tE = tGPS or tGalileo

Reference Week/Date, Reference Time of Week ← Additional UTC Parameters
Sets the reference data and time per navigation standard.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:WNOT on page 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT on page 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT:UNSCaled
on page 348
(etc. for the other GNSS systems)

UTC-UTC(SU) ← Additional UTC Parameters
For GLONASS satellites, indicates the UTC-UTC (SU) time conversion reference date.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:DATE? on page 347

Integer Offset ← Additional UTC Parameters
Indicates the integer offset.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:IOFFset? on page 349
(etc. for the other GNSS systems)
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Fractional Offset A0, Drift A1 ← Additional UTC Parameters
Sets the time parameters constant term of polynomial, A0 and 1st order term of polyno-
mial, A1.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo on page 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo:UNSCaled
on page 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE on page 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE:UNSCaled
on page 351
(etc. for the other GNSS systems)

Time settings
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5  Receiver type and position
Throughout this description, receiver is a term describing a summary of conditions. The
conditions comprise receiver coordinates and movement, including the description of
the used vehicle, the number and characteristics of used antennas, surrounding envi-
ronment or environment effects.

This section focuses on the receiver type and position. For a description of the environ-
mental effects and the antenna characteristics, see Chapter 10, "Real-world environ-
ment", on page 116.

The following receiver types can be simulated:
● Static receiver

A receiver with fixed coordinated, given as ECEF WGS84 or PZ-90.11 coordinates.
You can select form a subset of predefined positions or define a specific one.
Regardless of the used coordination system, the latitude, longitude and the altitude
can be set in DEG:MIN:SEC format or as decimal degrees.

● Moving receiver
A receiver with varying coordinates, defined in waypoints, NMEA and KML files.
You can select from a subset of predefined files or load custom-specific files. More-
over, waypoint smoothing can be activated if vehicle description files are used.

● Looped receiver
A receiver is looped with the R&S SMBV100B and a control application. The
R&S SMBV100B is remotely controlled by the control application, which processes
position, motion and attitude data sent by the receiver. The receiver receives a
GNSS signal from the R&S SMBV100B based on the remote control data of a con-
trol application.
You can select from a subset of predefined HIL position files or load custom-spe-
cific files. Moreover, waypoint smoothing can be activated based on real-time data
received from the control application.

For more information on the supported file formats, see:
● Chapter A.1, "Movement or motion files", on page 610
● Chapter A.2, "Vehicle description files (used for smoothening)", on page 622

5.1  General receiver settings

Access:

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

General receiver settings
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The dialog provides general settings to configure a GNSS receiver.

2. Select "Simulation Monitor" to observe the current receiver configuration.

Settings:

Position......................................................................................................................... 53
Position Configuration................................................................................................... 53
Number of Antennas..................................................................................................... 54
Antenna Configuration.................................................................................................. 54

Position
Determines what kind of receiver is simulated.
"Static" Receiver at one of the predefined or at a user-defined position.

See Chapter 5.2, "Static receiver", on page 54.
"Moving" Receiver that is moving according to a trajectory as described in a

file.
Use a moving receiver to simulate pedestrians, cars, ships, or air-
planes.
See Chapter 5.3, "Moving receiver", on page 59.

"Remote Control (HIL)"
Option: R&S SMBVB-K109
The receiver is part of a setup for hardware in the loop (HiL) testing. It
receives the GNSS signal and transmits position data to a motion
simulator. An external simulation software controls the
R&S SMBV100B and the motion simulator.
For details, see Chapter 18.2, "HIL settings", on page 295.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:POSition on page 353

Position Configuration
Accesses the position configuration dialog. You can configure the position of a GNSS
receiver or of an RTK base station.
The GNSS receiver position depends on the GNSS receiver type:
● Chapter 5.2, "Static receiver", on page 54
● Chapter 5.3, "Moving receiver", on page 59
● Chapter 18.2, "HIL settings", on page 295

General receiver settings
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To configure the position of the RTK base station, see Chapter 11.4, "RTK position con-
figuration", on page 166.

Number of Antennas
Defines the number of configurable antennas.
You can create a pool of up to four antenna and body masks and switch between them.
To define which antenna is simulated, set "A#" > "Active".
Note: Switching between the active antenna restarts the simulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:COUNt on page 361

Antenna Configuration
Accesses the antenna configuration dialog. You can configure antennas of a GNSS
receiver or of an RTK base station.
To configure antennas of a GNSS receiver, see Chapter 10.6, "Antenna and body
mask settings", on page 135.
To configure the antenna of an RTK base station, see Chapter 11.5, "RTK antenna
configuration", on page 170.

5.2  Static receiver

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Positioning" > "Static".

3. Select "Positioning Configuration".

Static receiver
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Settings:

Location, Initial Position................................................................................................ 55
Reference Frame.......................................................................................................... 56
Location Coordinates, Position Format......................................................................... 57
Attitude Behaviour, More...............................................................................................57
Attitude Configuration....................................................................................................58

└ Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank.............................................58
└ Spinning Rate................................................................................................. 59

Location, Initial Position
Selects the location or initial position depending on the simulated object:
● Static GNSS receiver ("Position > Static"):

Selects the geographic location of the GNSS receiver.
● R&S SMBVB-K109: Hardware in the loop (HIL) GNSS receiver ("Position > From

Remote"):
Selects the initial position of the GNSS receiver.

● R&S SMBVB-K122: Real-time kinematics (RTK) base station:
Selects the geographic location of the RTK base station.

The representation of the coordinates depends on the selected "Reference Frame" and
"Position Format".
"User Defined" Sets the receiver position in terms of "Latitude", "Longitude" and "Alti-

tude"
"City" Selects a predefined geographic location, see Table 5-1 for an over-

view.
The parameters "Latitude", "Longitude" and "Altitude" are set auto-
matically.

Table 5-1: Coordinates of the simulated predefined positions

Continent City Latitude [deg] Longitude [deg] Altitude [m]

Europe London 51.500625 -0.1246219 22

 Moscow 55.7522222 37.6155556 200

 Munich 48.15 11.5833333 508

 Paris 48.8584 2.2946278 66

America New York 40.714667 -74.0063889 1

 San Francisco 37.8194389 -122.4784939 35

 Anchorage 61.2166667 -149.8833333 115

 Mexico City 19.4510539 -99.1255189 2310

 Bogota 4.7111111 -74.0722222 2640

 Sao Paulo -23.5337731 -46.62529 760

 Santiago de Chile -33.4474869 -70.6736758 522

Asia Beijing 39.9055556 116.3913889 60

 New Delhi 28.6138889 77.2088889 77

Static receiver



Receiver type and positionSatellite Navigation

56User Manual 1178.9403.02 ─ 10

Continent City Latitude [deg] Longitude [deg] Altitude [m]

 Seoul 37.5514997 126.9877939 265

 Singapore 1.3113108 103.8268528 110

 Taipei 25.0223439 121.5147581 10

 Tokyo 35.6838611 139.7450581 45

Africa Cairo 30.0444419 31.2357117 23

 Dakar 14.7166769 -17.4676858 22

 Cape Town -33.9188611 18.4233 6

Australia Sydney -33.8833333 151.2166667 3

 Perth -31.9535119 115.8570481 2

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog
on page 353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]
on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog on page 367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect] on page 367

Reference Frame
For GNSS receiver, selects the reference frame used to define the receiver coordi-
nates. The transformation between the reference frames is performed automatically.
R&S SMBVB-K122: For RTK base station, selects the reference frame used to define
the receiver or RTK base station coordinates. The transformation between the refer-
ence frames is performed automatically.
The following applies:
● XWGS84 = (1 - 0.008*10-6)*XPZ 90 - 0.2041*10-7*YPZ 90 + 0.1716*10-7*ZPZ 90 - 0.013
● YWGS84 = (1 - 0.008*10-6)*YPZ 90 - 0.2041*10-7*XPZ 90 + 0.1115*10-7*ZPZ 90 + 0.106
● ZWGS84 = (1 - 0.008*10-6)*ZPZ 90 - 0.1716*10-7*XPZ 90 - 0.1115*10-7*YPZ 90 + 0.022

Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
RFRame on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame
on page 367
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Location Coordinates, Position Format
In the ECEF coordinate system, a geographic location is identified by three coordi-
nates, the altitude, latitude and longitude. The last two can be displayed in decimal or
DMS format. The display format is determined by the parameter "Position Format".

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degrees"
The display format is decimal degrees, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the reference location. The altitude value is the height
above the ellipsoid (HAE), that is the reference ellipsoid (WGS84 or PZ90).

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

Altitude, latitude and longitude are configurable, if "Location, Initial Position > User
Defined".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
FORMat on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat
on page 368
To enter the coordinates in "Position Format > DEG:MIN:SEC"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:
PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DMS[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ
on page 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:
WGS] on page 369
To enter the coordinates in "Position Format > Decimal Degrees"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal:PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:
PZ on page 368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:
DECimal[:WGS] on page 368

Attitude Behaviour, More
Defines how the attitude information is defined.
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To define the individual attitude parameters for all attitude behaviors, select "More".
This button is available with option R&S SMBVB-K108. See "Attitude Configuration"
on page 58.
"Constant" Sets the attitude of the receiver as a combination of the "Yaw/Head-

ing", "Pitch/Elevation", "Roll/Bank" values.
The resulting attitude is a constant value.

"Spinning" Enables a constant rate of change of the roll.
See "Spinning Rate" on page 59.

"From Waypoint File/Align to Motion"
Option: R&S SMBVB-K108
For "Receiver" > "Position" > "Moving", the attitude parameters are
extracted from the selected waypoint file. Further settings are not
required.
This extraction forces the attitude parameters to motion direction
even if the waypoint has attitude information, like, for example, in a
*.xtd file with <property
waypointformat="position_attitude">.
For specific applications like automotive, it is realistic to set the yaw
and pitch to the motion direction of the vehicle. The usual body axes
angles of a vehicle point to the direction of the velocity vector.
For other applications, however, like aeronautics with a landing plane,
this parameter is not useful. AS an example, the nose of the plane is
in an upward direction at the time when the plane is moving down-
wards.
To visualize the effect, select "Receiver" > "Monitor" > "Attitude View",
see "Display" on page 37.

"From Remote"
Option: R&S SMBVB-K109
For "Receiver" > "Position" > "Remote Control (HIL)", the attitude
parameters are set by the received HIL commands. The selection is
suspended.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
on page 357

Attitude Configuration
Option: R&S SMBVB-K108

Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank ← Attitude Configuration
Option: R&S SMBVB-K108
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Sets the angles of rotation in the corresponding direction, i.e. the rotation around the
respective yaw, pitch and roll axes. "Yaw/Heading, Pitch/Elevation, Roll/Bank" are
defined relative to the local horizon.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:YAW on page 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:PITCh on page 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:ROLL on page 358

Spinning Rate ← Attitude Configuration
Option: R&S SMBVB-K108
Simulates a constant rate of change of the roll, defined with the parameter "Start Roll".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:SPIN:RATE
on page 358

5.3  Moving receiver

5.3.1  Defining a moving receiver

This section provides step-by-step procedures to define a moving receiver. It covers
the following topics:
● "To access moving receiver settings" on page 59
● "To load and play a waypoint file" on page 59
● "To monitor receiver movement characteristics" on page 60
● "To export a predefined waypoint file" on page 61

To access moving receiver settings

► See Chapter 5.3.2, "Receiver position settings", on page 62.

To load and play a waypoint file

1. In the "Position Configuration" dialog, click "Waypoint File".

A standard file-select dialog opens, where you can select predefined waypoint files
or user-defined waypoint files.

2. Select, for example, the predefined waypoint file Munich_Car_Motion.xtd.

The file is loaded to the "Waypoint File" selection. The trajectory duration is read-
out from the file automatically. The parameters "Latitude", "Longitude" and "Alti-
tude" are set according to the first simulated position.
A world map indicates the initial position of the receiver. Also, the trajectory of the
receiver movement is displayed in graph with east coordinates (x-axis) and north
coordinates (y-axis).
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To monitor receiver movement characteristics

After loading and playing a waypoint file, for example, the file
Munich_Car_Motion.xtd, you can monitor movement characteristics in real time
and more detailed.

1. Select "Receiver > Monitor".

The "Simulation Monitor" dialog opens. Per default, it displays the "Ground Track"
view including the receiver position and the "Map View" displaying the current
receiver movement along a defined trajectory.
The blue trajectory displays the last 50 receiver positions, the orange trajectory dis-
plays the expected movement from a waypoint file.

2. To monitor further characteristics due to receiver movement, try out the following:
● Select "Display > Sky View" to monitor changes in the satellite constellation.
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● Select "Display > Attitude View" to monitor the geographic direction of the
receiver. Also monitor the attitude indicator showing the orientation of the
receiver relative to earth's horizon.

● Select "Display > Elevation/Azimuth", to monitor the time variation of the azi-
muth and the satellite's elevation over 24 hours.

See also "Display" on page 37.

To export a predefined waypoint file

Export a predefined waypoint file to modify it, for example, the waypoints defining the
trajectory.

1. Open the "Select Waypoint File > Predefined Files" dialog as in step 1 of "To load
and play a waypoint file" on page 59.

2. Select a file, for example, Munich_Car_Motion.xtd.

3. Click "Export".

The "User Files" tab opens displaying the exported file in the directory /var/user.
The filename is modified by adding _exported to the original filename, for exam-
ple, Munich_Car_Motion_exported.xtd, to distinguish the exported file from
the predefined file.

4. To modify the exported file, open the file in the directory /var/user.

You can use a standard text editor.

5. Save the modified file using the same file extension *.xtd to ensure correct exe-
cution of the file.
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If you need to choose another file extension, waypoint files with file extensions
*.txt, *.nmea, *.kml or *.xtd are executable on the R&S SMBV100B.

5.3.2  Receiver position settings

Access:

1. Select "GNSS" > "Simulation Configuration" > "Receiver".

2. Select "Position" > "Moving".

3. Select "Position Configuration".

Settings:

Waypoint File.................................................................................................................62
Trajectory Length/Duration............................................................................................63
Readout Mode...............................................................................................................63
Reference Frame.......................................................................................................... 63
Motion Behaviour, Smoothing, More.............................................................................64
Motion Configuration > Vehicle Description.................................................................. 65
Attitude Behaviour, More...............................................................................................65
Attitude Configuration....................................................................................................66

└ Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank.............................................66
└ Spinning Rate................................................................................................. 66

Waypoint File
Selects a predefined or user-defined waypoint files to simulate a moving scenario.
A waypoint file is a description of a moving scenario with possibly attitude coordinates
that can have different forms, like, for example, a sequence of positions or vector arc
movement. A waypoint file must have the extension *.txt, *.nmea, *.kml or *.xtd.
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See also Chapter A.1, "Movement or motion files", on page 610 for detailed description
of the waypoint file formats.
Note: Simulating high dynamic moving scenarios. Dynamic waypoint files simulate
moving scenarios with velocities lower than 600 m/s and require option R&S SMBVB-
K520.
If you select a high dynamic waypoint file (v ≥ 600 m/s), the firmware displays a set-
tings conflict. The file is rejected. Instead, the R&S SMBV100B simulates the move-
ment of the default waypoint file Munich_Car_Motion.xtd.
How to: Chapter 5.3.1, "Defining a moving receiver", on page 59
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:FILE
on page 358

Trajectory Length/Duration
Displays the trajectory length (in kilometers) and the duration (in seconds) of the way-
point file.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:
LENGth? on page 359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:
DURation on page 358

Readout Mode
Defines the way the waypoint/attitude file is processed.
If *.xtd files are used, the "Readout Mode" is retrieved from the file
(<endbehaviour>) and cannot be changed, see Chapter A.1.4, "Trajectory descrip-
tion files", on page 616.
"Cyclic" The waypoint file is processed cyclically. Once the last waypoint is

reached, file processing starts again from the beginning.
Using this mode is only recommended if the waypoint file describes
on of the following:
● A circle moving scenario
● A moving scenario in which the start and the end point are close

to each other.
"One Way" The file is processed once.

By reaching the end of the file, the last described position is assumed
to be a static one.

"Round Trip" By reaching the end of the file, the file is processed backwards.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:ROMode
on page 359

Reference Frame
For GNSS receiver, selects the reference frame used to define the receiver coordi-
nates. The transformation between the reference frames is performed automatically.
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R&S SMBVB-K122: For RTK base station, selects the reference frame used to define
the receiver or RTK base station coordinates. The transformation between the refer-
ence frames is performed automatically.
The following applies:
● XWGS84 = (1 - 0.008*10-6)*XPZ 90 - 0.2041*10-7*YPZ 90 + 0.1716*10-7*ZPZ 90 - 0.013
● YWGS84 = (1 - 0.008*10-6)*YPZ 90 - 0.2041*10-7*XPZ 90 + 0.1115*10-7*ZPZ 90 + 0.106
● ZWGS84 = (1 - 0.008*10-6)*ZPZ 90 - 0.1716*10-7*XPZ 90 - 0.1115*10-7*YPZ 90 + 0.022

Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
RFRame on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame
on page 367

Motion Behaviour, Smoothing, More

The discrete positions (waypoints) defined in the waypoints file can cause abrupt
changes in the movement direction.
The R&S SMBV100B provides an internal interpolating algorithm that smooths the
movement or the trajectory. This algorithm evaluates the dedicated vehicle description
(*.xvd) file, retrieves the velocity vector and the <proximity> value, and inserts
waypoints to smooth the trajectory. The resulting movement is more realistic.
To use the algorithm, enable "Smoothing" and select "More" > Motion Configuration >
Vehicle Description to load a *.xvd file.

There are some predefined files provided.
Note: An error message is displayed, if the difference between the predicted and the
original waypoint for a given time point exceeds the proximity value.
If there is an error:
● Check the speed and acceleration values in the used *.xvd file.
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● Check whether these values fit to the flight simulator and the flight scenario.
See also:
● Chapter A.1, "Movement or motion files", on page 610
● Chapter A.2, "Vehicle description files (used for smoothening)", on page 622
● Chapter H, "List of predefined files", on page 647
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:SMOVement
on page 359

Motion Configuration > Vehicle Description
Selects a predefined or user-defined vehicle description (*.xvd) file, see Chapter A.2,
"Vehicle description files (used for smoothening)", on page 622.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:VEHicle:FILE
on page 360
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:PREDefined? on page 360
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:USER? on page 360

Attitude Behaviour, More
Defines how the attitude information is defined.
To define the individual attitude parameters for all attitude behaviors, select "More".
This button is available with option R&S SMBVB-K108. See "Attitude Configuration"
on page 58.
"Constant" Sets the attitude of the receiver as a combination of the "Yaw/Head-

ing", "Pitch/Elevation", "Roll/Bank" values.
The resulting attitude is a constant value.

"Spinning" Enables a constant rate of change of the roll.
See "Spinning Rate" on page 59.

"From Waypoint File/Align to Motion"
Option: R&S SMBVB-K108
For "Receiver" > "Position" > "Moving", the attitude parameters are
extracted from the selected waypoint file. Further settings are not
required.
This extraction forces the attitude parameters to motion direction
even if the waypoint has attitude information, like, for example, in a
*.xtd file with <property
waypointformat="position_attitude">.
For specific applications like automotive, it is realistic to set the yaw
and pitch to the motion direction of the vehicle. The usual body axes
angles of a vehicle point to the direction of the velocity vector.
For other applications, however, like aeronautics with a landing plane,
this parameter is not useful. AS an example, the nose of the plane is
in an upward direction at the time when the plane is moving down-
wards.
To visualize the effect, select "Receiver" > "Monitor" > "Attitude View",
see "Display" on page 37.
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"From Remote"
Option: R&S SMBVB-K109
For "Receiver" > "Position" > "Remote Control (HIL)", the attitude
parameters are set by the received HIL commands. The selection is
suspended.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
on page 357

Attitude Configuration
Option: R&S SMBVB-K108

Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank ← Attitude Configuration
Option: R&S SMBVB-K108
Sets the angles of rotation in the corresponding direction, i.e. the rotation around the
respective yaw, pitch and roll axes. "Yaw/Heading, Pitch/Elevation, Roll/Bank" are
defined relative to the local horizon.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:YAW on page 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:PITCh on page 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:ROLL on page 358

Spinning Rate ← Attitude Configuration
Option: R&S SMBVB-K108
Simulates a constant rate of change of the roll, defined with the parameter "Start Roll".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:SPIN:RATE
on page 358
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6  Satellite constellation
This section addresses basic satellite constellation characteristics including multi-satel-
lite signals, multi-GNSS signals and satellite selection within the constellation.

Single-satellite GNSS signal

The R&S SMBV100B simulates a single satellite GNSS signal, where static satellites
with constant Doppler shifts are provided for simple receiver tests, like receiver sensi-
tivity, acquisition, tracking and production tests. Selection and configuration localization
data is also enabled.

Multi-satellite GNSS signal

The default multi-satellite single GNSS system constellation is the realistic constella-
tion in a theoretical unobscured environment of a static receiver at a specific location. It
includes all visible GNSS satellites, where a line-of-sight (LOS) situation is assumed.

Example: Single GNSS satellite constellations for fully equipped R&S SMBV100B
For a fully equipped R&S SMBV100B, Table 6-1 provides an overview on the default
satellite constellation comprising visible, present and excluded satellites.
Table 6-1: Single GNSS satellite default constellations: Visible, present and excluded satellites

GNSS/SBAS Visible Present Excluded Present (max.)

GPS 11 31 6 37

Galileo 8 29 7 36

GLONASS 9 24 0 24

BeiDou 12 34 29 63

QZSS 0 3 4 7

NavIC 3 6 8 14

EGNOS 2 2 4 6

WAAS 0 3 2 5

MSAS 0 2 0 2

GAGAN 1 2 0 2

Multi-GNSS signal

The default single GNSS system configuration can be extended to support receiver
tests with complex test signal. You can generate mixed signal comprising satellites of
different GNSS systems or signals spread with different codes, possibly also modula-
ted on the other frequency.

See Chapter 6.1, "Systems and signals settings", on page 68.
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Satellite selection

If your test case requires a mixed GNSS signal with predefined minimum and maxi-
mum number of satellites per GNSS system, you can set these limits per GNSS sys-
tem, too.

Moreover, you can adjust the SV handover criteria and thus define when the satellite's
constellation is updated and satellites are exchanged. Satellites exchange is optimized
to fulfill the selected criteria; considered are all available satellites, regardless of the
GNSS system but obeying the limits for maximum and minimum number of satellites.

Visible satellites can be deactivated or reactivated on-the-fly. Current constellation and
an overview of the number of active satellites per GNSS system are displayed.

See Chapter 6.2, "Satellites settings", on page 73.

Dynamic monitor

You can observe the real-world situation of disappearance and reappearance of satel-
lites in real time on the build-in simulation monitor. The monitor is also a dynamic dis-
play of several parameters like HDOP and the PDOP.

See Chapter 3.3, "Simulation monitor", on page 36.

6.1  Systems and signals settings

Access:

1. Select "GNSS" > "GNSS Configuration" > "Systems & Signals".

2. In the dialog, activate frequency bands, systems and their signals.

Systems and signals settings
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Systems mean global navigation satellite systems (GNSS), regional navigation sat-
ellite systems (RNSS) and satellite-based augmentation systems (SBAS).

The figure displays the configuration for an R&S SMBV100B, equipped with triple-
frequency option. In this dialog you can activate signals of L1, L2 and L3 bands
simultaneously. See also "System" on page 69.

Settings:

System.......................................................................................................................... 69
L# Band.........................................................................................................................69
Signals.......................................................................................................................... 71

System
Defines the navigation systems that are part of the system configuration, see Chap-
ter 6.2, "Satellites settings", on page 73.
The available global, regional and satellite-based navigation and augmentation sys-
tems depend on the installed options.
Note: At least one system is always enabled. Switching off a single enabled GNSS is
not possible, a warning message is displayed to indicate the situation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS[:STATe] on page 335
(etc. for the other GNSS systems)

L# Band
Defines the used frequency band "L1/2/5 Band". The satellite signals are modulated on
the carrier frequencies as defined for the corresponding frequency band and system.

Systems and signals settings
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Table 6-2: Carrier frequencies

System RF band (signals) Carrier freq. (MHz) Required option

GPS L1 (C/A, P, L1C)

L2 (C/A, P, L2C)

L5 (L5)

1575.42

1227.6

1176.45

R&S SMBVB-K44

R&S SMBVB-K98

R&S SMBVB-K98

Galileo L1 (E1)

L2 (E6)

L5 (E5a)

L5 (E5b)

1575.42

1278.75

1176.45

1207.14

R&S SMBVB-K66

R&S SMBVB-K66

R&S SMBVB-K66

R&S SMBVB-K66

GLONASS L1 (C/A)

L1 (CDMA L1)

L2 (C/A)

L2 (CDMA L2)

L5 (CDMA L3)

1602

1600.995

1246

1248.06

1202.025

R&S SMBVB-K94

R&S SMBVB-K123

R&S SMBVB-K94

R&S SMBVB-K123

R&S SMBVB-K123

BeiDou L1 (B1I)

L1 (B1C)

L2 (B3I)

L5 (B2I)

L5 (B2a)

L5 (B2b)

1561.098

1575.42

1268.52

1207.14

1176.45

1207.14

R&S SMBVB-K107

R&S SMBVB-K132

R&S SMBVB-K132

R&S SMBVB-K107

R&S SMBVB-K132

R&S SMBVB-K132

QZSS L1 (C/A, L1C)

L2 (L2C)

L5 (L5)

1575.42

1227.6

1176.45

R&S SMBVB-K106

R&S SMBVB-K106

R&S SMBVB-K106

NavIC L5 (SPS) 1176.45 R&S SMBVB-K97

SBAS L1 (C/A)

L5 (Exp L5)

1575.42

1176.45

R&S SMBVB-K106

R&S SMBVB-K106

Note: At least one frequency band is always enabled. Switching off all frequency
bands is not possible. A warning message is displayed to indicate the situation.
Assuming more than one frequency band and GNSS system enabled: If switching off a
GNSS system implies, that an enabled frequency band carries no signals, this fre-
quency band is switched off automatically.
Single-satellite operation: Requires R&S SMBVB-K135
Only one frequency band can be enabled. Switching from L1 to L2 or to L5 disables
the systems defined only for the L1 band. Switching the other way around does not
activate the systems that have been enabled before in the L1 band. For any frequency
band, activated per default is the first supported and available system in the list of
GNSS systems.
Dual-frequency operation: Requires R&S SMBVB-K136
Two frequency bands can be enabled. Enabling a third band causes a warning. To
enable the band, first, disable a previously enabled band.
Triple-frequency operation: Requires R&S SMBVB-K137
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All three frequency bands can be enabled. There is no restriction for en-/disabling sig-
nals for the basic GNSS systems.
Remote command: 
[:SOURce<hw>]:BB:GNSS:L1Band[:STATe] on page 335
[:SOURce<hw>]:BB:GNSS:L2Band[:STATe] on page 335
[:SOURce<hw>]:BB:GNSS:L5Band[:STATe] on page 335

Signals
Enables the signals per system.
The enabled signals are activated automatically for each SV belonging to the GNSS
system. To redefine the signals used by a particular satellite (SV), select "GNSS Con-
figuration" > "Satellites" > "GNSS System" > "SV ID#" > "SV Config" > "Signal" > "Sig-
nal State" on page 89.
Note: At least one GNSS, one frequency band and one signal are always active. If
switching one of them off, a message displays an error.
See also "System" on page 69 and "L# Band" on page 69.
"None" All signals of a GNSS system are disabled assuming, that the GNSS

system itself is disabled. All parameters of the GNSS system are dis-
abled, too.
"Signals = None" implies System > "State = Off".

Systems and signals settings
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"C/A, P, L1C, E1 OS, B1I, B1C, L2C, E6, B3I, L5, E5a, E5b, B2I, B2a, B2b, SPS, Exp
L5"

Table 6-3: Overview of the supported signals

Band System Signal Minimum required option

L1 GPS C/A, P

L1C

R&S SMBVB-K44

R&S SMBVB-K98

 Galileo E1 OS R&S SMBVB-K66

 GLONASS C/A

CDMA L11)

R&S SMBVB-K94

R&S SMBVB-K123

 BeiDou B1I

B1C

R&S SMBVB-K107

R&S SMBVB-K132

 QZSS C/A, L1C R&S SMBVB-K106

 SBAS C/A R&S SMBVB-K106

L2 GPS C/A

P, L2C

R&S SMBVB-K44

R&S SMBVB-K98

 Galileo E6 R&S SMBVB-K66

 GLONASS C/A

CDMA L21)

R&S SMBVB-K94

R&S SMBVB-K123

 BeiDou B3I R&S SMBVB-K132

 QZSS L2C R&S SMBVB-K106

L5 GPS L5 R&S SMBVB-K98

 Galileo E5a, E5b R&S SMBVB-K66

 GLONASS CDMA L3 R&S SMBVB-K123

 BeiDou B2I

B2a

B2b2)

R&S SMBVB-K107

R&S SMBVB-K132

R&S SMBVB-K132

 QZSS L5 R&S SMBVB-K106

 NavIC SPS R&S SMBVB-K97

 SBAS Exp L53) R&S SMBVB-K106

1) The modernized GLONASS signals CDMA L1 and CDMA L2 are
for experimental use only. Any compliance with GLONASS ICD
CDMA open service navigation signal in L1 frequency band or GLO-
NASS ICD CDMA open service navigation signal in L2 frequency
band is not guaranteed. See also Table 2-7.
2) BeiDou B2b_I I-component of the B2b OS signal for space vehicles
PRN 6 to PRN 58. Q-components of AS signals including B2b_Q are
not supported, see also Table 2-8.
3) SBAS "Exp L5" signals are for experimental use only and do not
comply with SBAS interface control document (ICD) specifications,
see also Table 2-11.

Systems and signals settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA[:STATe]
on page 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P[:STATe]
on page 337
(etc. for the other GNSS systems)

6.2  Satellites settings

Access:

1. Activate the GNSS system for that you want to configure satellites settings.
See "System" on page 69.

2. Select "GNSS" > "Simulation Configuration" > "Satellites".

The tab provides settings to configure satellite selection, to configure the reference
power and to access the simulation monitor. Also, it provides settings to configure
individual space vehicles (SV) of the satellite constellation for each activated
GNSS system.
To configure satellite selection, like selection criteria, minimum and maximum num-
ber of SVs of a satellite constellation, see Chapter 6.3, "Space vehicle selection
configuration", on page 77.
To configure individual SV settings, see Chapter 7, "Space vehicle configuration",
on page 82.

Satellites settings
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Understanding satellite constellation characteristics

Figure 6-1: Satellite constellation per GNSS system

1 = Activated GNSS systems
2 = Number of active and available SVs per GNSS system
3 = Visible and active SV that uses reduced power level
4 = Visible and active SV, full power level
5 = Visible and inactive SV ("Satellite's Constellation, SV ID" on page 75 = Off)
6 = Not visible and inactive SV
7 = Excluded from the constellation (Present in Constellation = "Off")

Active and visible satellites are indicated with blue color.

Settings:

SV Selection Configuration........................................................................................... 74
Reference Power.......................................................................................................... 74
Simulation Monitor........................................................................................................ 75
Satellite's Constellation, SV ID......................................................................................75

└ State (SV ID)...................................................................................................76
└ Power Offset................................................................................................... 76
└ SV Config........................................................................................................76

Import Constellation...................................................................................................... 76

SV Selection Configuration
Accesses a dialog to configure satellite selection criteria and minimum and maximum
number of satellites of the satellite constellation. See Chapter 6.3, "Space vehicle
selection configuration", on page 77.

Reference Power
Sets the power level that is used as a reference for the calculation of the power level of
the satellites.
See "About satellite's (SV) power calculation" on page 82.

Satellites settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:POWer:REFerence on page 429

Simulation Monitor
Accesses the "Simulation Monitor" dialog for real-time display of the most important
parameters.
These parameters are, for example, the current satellite constellation with SV states
and position, receiver position or movement trajectory and received satellite power.
See Chapter 3.3, "Simulation monitor", on page 36.

Satellite's Constellation, SV ID
Indicates the SV IDs included in the current constellation.

1 = Enabled GNSS systems
2 = Number of active and available SVs per GNSS system
3 = Visible and active SV that uses reduced power level
4 = Visible and active SV, full power level
5 = Visible and inactive SV ("Satellite's Constellation, SV ID" on page 75 = Off)
6 = Not visible and inactive SV
7 = Excluded from the constellation (Present in Constellation = "Off")

The information is color-coded. Icons provide further information:
● Blue: active SV ID
● Gray: Inactive SV ID
● Sun: Visible SV ID
● Cross out: SV ID is excluded from the constellation, for example if "SV ID > SV

Config" > Present in Constellation > "Off"
● Power bar: Reduced height indicates that the signal of the SV ID is transmitted with

less power than the value indicated as "Configurable Nav. Message".
The height of the power bar reflects enabled "Power Offset", "Power Path-Loss"
and "Power Offset" of the echoes.

The blocks are interactive. Select an SV ID to access further settings for changing its
state, enabling power offset of configuring the orbit simulation and navigation message
parameters.

Satellites settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST:ALL? on page 415
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST[:VALid]? on page 415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy on page 416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:VISibility:STATe? on page 417
(etc. for the other GNSS systems)

State (SV ID) ← Satellite's Constellation, SV ID
Changes the SV ID state on-the-fly.
Per default, only visible satellites can be included in the constellation. SV ID for that
Present in Constellation > "Off" cannot be activated.
Tip: Pressing the On/Off toggle key has the same effect on the selected SV ID.
To enable any SV ID, set "Satellites > SV Selection Criteria > Selection Mode > Man-
ual".
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:STATe on page 428
(etc. for the other GNSS systems)

Power Offset ← Satellite's Constellation, SV ID
Reduces the signal of the selected SV ID by the defined value.
This is a global power offset parameter for a satellite. It affects the power level of all
signal components of a given satellite.
See "About satellite's (SV) power calculation" on page 82. Power changes are applied
on-the-fly.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:OFFSet on page 430
(etc. for the other GNSS systems)

SV Config ← Satellite's Constellation, SV ID
Access a dialog with further settings for configuring the orbit simulation and navigation
message parameters.
See:
● Chapter 7, "Space vehicle configuration", on page 82
● Chapter 13, "Perturbations and errors simulation", on page 191

Import Constellation
Opens the "Import Constellation" dialog that is a standard "File Select" dialog.

Satellites settings
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You can select, for example, almanac or RINEX files. See also:
● "File formats" on page 282.
● Chapter 17.1, "Import constellation settings", on page 284.

6.3  Space vehicle selection configuration

Access:

1. Select "GNSS" > "Simulation Configuration" > "Satellites".

2. Select "SV Selection Configuration".

The dialog provides settings to configure satellite visibility and handover criteria.
Also, you can set the minimum and maximum number of activated satellites per
GNSS system.

The maximum number of satellites and maximum number of channels depends on the
installed options, see Table 2-3. Selection criteria are not available for "Test Mode" >
"Tracking", the satellite selection is manual.

Settings:

Selection Mode............................................................................................................. 77
Earth Obscuration References (Cut-Off Reference)..................................................... 79
Earth Obscuration Offset (Cut-Off Angle)......................................................................80
Number of SVs..............................................................................................................81
Maximum Number of Channels.....................................................................................81

Selection Mode
Sets the space vehicle (SV) selection criteria to define the overall satellite constellation
and applies rules for satellite handover.

Space vehicle selection configuration
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"Visibility Time"
Constellation consists of satellites that are likely to be visible for the
longest time.

"Elevation Angle"
Selected are the satellites with the highest elevation.
For defining the elevation, see "Earth Obscuration References (Cut-
Off Reference)" on page 79 and "Earth Obscuration Offset (Cut-Off
Angle)" on page 80.

"DOP" Selects a satellite constellation which provides good dilution of preci-
sion (DOP) values at simulation start.
The DOP-based satellite selection implies the following:
● The selection prefers satellites that are visible for more than five

minutes.
● The final satellite constellation results from optimizations of sub-

constellations for all active GNSS systems.
These optimizations imply optimized independent geometric con-
ditions for each individual GNSS system.

● During runtime, the selection keeps active satellites as long as
possible in the constellation, even if their DOP values degrade.
Keeping these satellites ensures constant tracking.

● When active satellites sink or new satellites rise and free chan-
nels are available, the selection adds new satellites to the con-
stellation based on their DOP value.

"Adaptive DOP"
Selects a satellite constellation which provides good dilution of preci-
sion (DOP) values at simulation start and during runtime.
The adaptive DOP-based satellite selection implies the following:
● At simulation start, the selection is similar to the DOP-based

selection.
● During runtime, the selection adds or removes active satellites, if

the overall position (3D) dilution of precision (PDOP) value of the
satellite constellation is lower than 2.0.

● Adding or removing active satellites implies a gradual satellite
switching process that is independent over all active GNSS sys-
tems. The switching process has some constrains and starts only,
if the PDOP significantly improves.

"Manual" Manual selection as in the satellite constellation.
Automatic satellite selection is deactivated. Change the state of an
SV ID to change the satellite constellation manually. You can activate
any SV ID, including invisible satellites.
This mode is fixed and suspended for "Test Mode" > "Tracking", see
Chapter 8, "Tracking mode", on page 106.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:SELection:MODE on page 412

Space vehicle selection configuration
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Earth Obscuration References (Cut-Off Reference)
Selects how the behavior of earth obscuration is defined. The behavior also defines the
horizon, which is the reference line for applying the elevation mask angle, see Fig-
ure 6-2.

Figure 6-2: Impact of the Earth Obscuration References on the area of visible satellites (XY cut)

A = "Local Horizon"
B = "Earth Tangent"
α = "Earth Obscuration Offset" applied relative to the selected horizon
h = "Receiver > Positioning Configuration > Altitude"
r = Nadir (an imaginary vertical line that connects the location and the center of the earth)
1a = Horizon line for "Altitude = 0 m" (identical for both elevation mask types)
1b = Area of visible satellites (identical for both elevation mask types)
2a = Horizon line for "Altitude = h, km"; the horizon is parallel to the horizon with "Altitude = 0 m"
2b = Area of visible satellites
3a = Horizon lines for "Altitude = h, km"; the horizon lines are tangential to the earth surface
3b = Area of visible satellites

Use the "Signal Monitor" view to observe the current satellite constellation. The figures
in Table 6-4 show the satellite constellations as seen by receiver at an "Altitude = 200
km" with "Earth Obscuration Offset = 5°". The number of active satellites changes
because of the different elevation mask types.

Space vehicle selection configuration
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Table 6-4: Impact of the Earth Obscuration References on the visible satellites

"Earth Obscuration References > Local Horizon" "Earth Obscuration References > Earth Tangent"

"Local Horizon"
The horizon is a horizontal plane that is perpendicular to the nadir.
For locations with attitudes above the sea level, the horizontal plane
is parallel shifted at the selected attitude.
The "Local Horizon" type is suitable, if you simulate receivers at low
altitude. For example, for pedestrian and automotive application.

"Earth Tangent"
The horizon is the surface of a right circular cone, where:
● The vertex of the cone is at the receiver position.
● The cone axis is along the nadir.
● The cone surface is made of lines that are tangential to the earth

surface.
The "Earth Tangent" type is suitable, if you simulate receivers at
higher altitude, where satellites with negative elevations are also visi-
ble. A typical example is a GNSS receiver mounted on low earth orbit
(LEO) object.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:REFerence
on page 412

Earth Obscuration Offset (Cut-Off Angle)
Sets the elevation mask angle of the satellite. The angle is applied relative to the
selected horizon, see "Earth Obscuration References (Cut-Off Reference)" on page 79.
Satellites that are below the elevation mask angle are obscured. They are invisible for
the GNSS receiver at the selected location. Obscured satellites are displayed in the
"Signal Monitor" view but not simulated. A test receiver cannot use obscured satellites
for determining its position; it has to search for satellites with better visibility. See the
figures in Table 6-4.

Space vehicle selection configuration
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To ensure proper signal analysis, set the parameter "Earth Obscuration Offset" to the
elevation mask of the GNSS receiver under test.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:ANGLe on page 413

Number of SVs
Provides settings in a table to configure and monitor the number of satellites per GNSS
system.
"Min" Minimum number of activated satellites in the satellite constellation

per GNSS system.
"Max" Minimum number of activated satellites in the satellite constellation

per GNSS system.
"Current" Displays the number of active satellites in the satellite constellation

per GNSS system.
The value equals the value on the side tab of the "Satellites" dialog,
see Figure 6-1.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MIN on page 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MAX on page 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:ACTive? on page 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:AVAilable? on page 414
(etc. for the other GNSS systems)

Maximum Number of Channels
Displays the maximum number of channels.
The number depends on the simulation capacity, see Chapter G, "Channel budget",
on page 642.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:SELection:CHANnels:MAX on page 413

Space vehicle selection configuration
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7  Space vehicle configuration
About satellite's (SV) power calculation

In R&S SMBV100B, you define the power level of the individual satellites or their sig-
nals and the power level at the RF output is calculated automatically. All power levels
are set relative to a configurable reference level. By changing this level you boost or
decrease the signal power at the R&S SMBV100B outputs, while maintaining the
power ratio between the satellites, their signals and, if enabled, the multi-path echoes.

Absolute SV power

The absolute SV power for a given signal PSV,signal is calculated as follows:

PSV,signal = PRef + PSV,offset + PSignal,offset + PPathLoss + PAntPat, where:
● PRef is the reference power level, as set with the parameter Reference Power
● PSV,offset is the global power offset of the satellite, as set with the parameter Power

Offset
● PSignal,offset is signal-specific power offset, as set with the parameter Signal Power

Offset
The value reflects the differences between the signals and the frequency bands.

● PPathLoss is the free space path-loss over the satellite to receiver distance (range),
included if Add Power Path-Loss > "On".
See "Free space path-loss power" on page 82.

● PAntPat is the power gain of the antenna, calculated automatically, depending on the
selected body mask
See Chapter 10.6, "Antenna and body mask settings", on page 135.

Free space path-loss power

PPathLoss is the free space path-loss over the satellite to receiver distance (range), cal-
culated as follows:

PPathLoss = 20log10(R0/R), where:
● R0 = √(ROrbit,SV

2 - r2)
R0 is the reference range, equal to the range of a receiver on the ground to an SV0

at 90° elevation
● R is the receiver to satellite range.
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Figure 7-1: Free space path-loss calculation

SV0 = Reference space vehicle
R0 = Reference range
SV = Space vehicle
R = Range between the SV and the receiver
r = Earth's radius

Absolute multi-path echo power

The absolute power of an echo for a given signal PSV,echo is calculated as follows:

PSV,echo = PSV,signal + PEcho,signal, where:
● PSV,signal is the absolute satellite's power
● PEcho,signal is the power offset per echo, as set with the parameter Power Offset.

Satellite constellation recalculation
If you change settings of the space vehicle configuration, e.g., simulated orbit or simu-
lated clock settings, the satellite constellation is recalculated accordingly. Recalculation
interrupts the simulation of the satellite constellation as long as the recalculation proc-
ess takes.
During longer calculation times, the R&S SMBV100B shows a "Busy" state.

Settings:

● Power settings.........................................................................................................83
● Modulation control settings..................................................................................... 88
● Simulated orbit and orbit perturbation settings........................................................93
● Simulated clock settings........................................................................................102

7.1  Power settings

Access:

1. Select "GNSS > Simulation Configuration > Satellites".

2. Set the "Reference Power".

All power values are set relative to the reference power.

Power settings
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3. Select the GNSS system for that you want to change the satellite's power settings,
for example GPS.

4. Select "SV# > SV Config".

5. In the "SV Configuration" dialog, select "Signals Configuration".

6. Select "Add Power Path-Loss > On" to account for the free-space attenuation.

7. Set a "Power Offset" to reduce further the signal power of the satellite.

8. In dual-band or multi-signal configurations, set a "Signal Power Offset" to account
for the power relation between the signals.

9. To apply the power settings of the current satellite to other SV ID, select for exam-
ple "SV-ID = 11" and "Copy Power Settings To".

Figure 7-2: Power settings: understanding the displayed information

1 = Decreases the SV signal power and thus the power of all signals of this SV. SV "Power Offset" is
set relative to the Reference Power.

2 = Boosts or decreases the power of the individual signal components. Power offsets are set relative to
the Reference Power + "Power Offset".

Available power settings depend on the GNSS system and selected RF band.
For information on how these settings affect the SV power, see "About satellite's
(SV) power calculation" on page 82.

10. To simulate multi-path effects:
For more information, see Chapter 10.7.6, "Static multipath", on page 158.

a) Select "Simulation Configuration > Receiver > Environmental Model = Static
Multipath".

b) Select "Environmental Model"
c) Set for example: "Number of Echoes = 1", "Echo 1 > Init. Code Phase = 300

m", "Power Offset = -10 dB".

Power settings
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11. Select "GNSS > Monitor > Satellites > Power View" to observe the power levels of
all satellites at a glance.

Figure 7-3: Power View: understanding the displayed information

R = Reference Power= -120 dB
1 = "SV ID 1 > Power Offset = -10 dB"
2 = "Signal Power Offsets", e.g. L1 C/A = 0 dB and L1 P = - 3dB; the same power relation is observed

SVs with or without power offset and for the multipath echoes
3 = "SV ID 1 > Echo 1 > Power Offset = -10 dB"
4 = One echo per signal ("Number of Echoes = 1"); displayed if "View Settings > Echoes = On"

12. Load and enable body mask files to visualize the effect of antennas on the power.
For more information, see Chapter 10.6, "Antenna and body mask settings",
on page 135.

The remote commands required to define these settings are described in:
● Chapter 21.12, "Signals and power configuration per satellite", on page 419
● Chapter 21.8, "Static multipath configuration", on page 386.

Settings:

State (SV ID)................................................................................................................. 85
Present in Constellation................................................................................................ 86
Healthy.......................................................................................................................... 86
Power Offset..................................................................................................................86
Add Power Path-Loss................................................................................................... 87
Frequency Number....................................................................................................... 87
SV signal configuration table.........................................................................................87

└ Signal Power Offset........................................................................................ 87
Copy Power Settings to,SV-ID...................................................................................... 87

State (SV ID)
Changes the SV ID state on-the-fly.

Power settings
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Per default, only visible satellites can be included in the constellation. SV ID for that
Present in Constellation > "Off" cannot be activated.
Tip: Pressing the On/Off toggle key has the same effect on the selected SV ID.
To enable any SV ID, set "Satellites > SV Selection Criteria > Selection Mode > Man-
ual".
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:STATe on page 428
(etc. for the other GNSS systems)

Present in Constellation
If disabled, the SV ID is excluded from the currents constellation. The SV ID is auto-
matically deactivated ("SV ID > State = Off").
In the "Satellites" dialog, SV IDs that are excluded from the constellation are displayed
in gray color and are crossed out.
To reactivate such satellite, set "Present in Constellation > On" and activate it ("State >
On")
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRESent on page 429
(etc. for the other GNSS systems)

Healthy
Defines if the SV ID is healthy or not. A warning symbol indicates an unhealthy satel-
lite.
The healthy state reflects the value of the corresponding healthy flag in the navigation
message. The healthy flag and the healthy state are interdependent; changing one of
them changes the other.
See:
● GPS > Additional Data > "SV Health" and "L1/L2/L5 Health"
● GLONASS > Additional Data > "SV Health"
● Galileo > Additional Data > "E1BDVS/E5bDVS/E1BHS/E5bHS"
● BeiDou > Additional Data > "SV Health"
● QZSS > Additional Data > "SV Health"
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy on page 416
(etc. for the other GNSS systems)

Power Offset
Reduces the signal of the selected SV ID by the defined value.
This is a global power offset parameter for a satellite. It affects the power level of all
signal components of a given satellite.
See "About satellite's (SV) power calculation" on page 82. Power changes are applied
on-the-fly.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:OFFSet on page 430
(etc. for the other GNSS systems)

Power settings
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Add Power Path-Loss
In "Test Mode = Navigation", enable this parameter to account for the free space
attenuation and simulate real-world conditions.
The power of the SV ID signals is reduced automatically. The power path-loss is calcu-
lated depending on the current satellite's orbit and the distance (range) between the
satellite and the receiver's position on the Earth, see "Free space path-loss power"
on page 82.
To observe the effect, select the "Monitor > Display > Power View", see Chapter 3.3,
"Simulation monitor", on page 36.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:PLOSs on page 430
(etc. for the other GNSS systems)

Frequency Number
For GLONASS satellites, indicates the frequency number of the subcarrier used to
modulate the GLONASS satellite.
If "Nav Msg Type = NAV", the frequency number is retrieved from the imported configu-
ration file.
The value is configurable, if arbitrary data is used, e.g. "Nav Msg Control > Edit" and
"Nav Msg Type > All 0".
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:FNUMber on page 429

SV signal configuration table
Table with one or more rows, one row per enabled signal ("Simulation Configuration >
Systems&Signals" > Signals).

Signal Power Offset ← SV signal configuration table
Adds power offset for the selected signal.
If more than one signal or bands are activated, the power relation between the signals
and between the frequency bands is set automatically, as specified for the GNSS sys-
tem. You can change these default values. Signal-specific power offset values are set
relative to the satellites power level.
See also "About satellite's (SV) power calculation" on page 82.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:POWer:OFFset
on page 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:POWer:OFFset
on page 431
(etc. for the other GNSS systems)

Copy Power Settings to,SV-ID
Applies the power settings of the current satellite to the selected or to all SV-IDs of the
same GNSS system.
The following settings are considered:
● Power Offset
● Add Power Path-Loss

Power settings
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● Signal Power Offset
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:SVID on page 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:EXECute on page 433
(etc. for the other GNSS systems)

7.2  Modulation control settings

Access:

1. Select "GNSS > Simulation Configuration > Signals&Systems".

2. Enable the GNSS system for that you want to control the signal modulation, for
example:

a) "System > GLONASS > On"
b) "System > Galileo > On"

3. Select "GNSS > Simulation Configuration > Satellites".

4. Select "GLONASS > SV# > SV Config".

5. In the "SV Configuration" dialog, select "Signals Configuration".

6. To generate a signal with list mode data, sent on the GLONASS frequency, select:

a) "Primary Code > Off"
b) "Nav Msg Control > Edit"
c) "Nav Msg Type > Data List"
d) Load list mode data, e.g. from the file Glonass_Data.dm_iqd:

"Nav Msg Content > /var/user/Glonass_Data"
e) "Meander Sequence > Off"
f) "Time Sequence > Off"

Modulation control settings
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7. To apply the modulation control settings of the current satellite to other SV ID,
select for example "SV-ID = All" and "Copy Modulation Control To"

Available modulation control settings depend on the GNSS system and selected
RF band.
The remote commands required to define these settings are described in Chap-
ter 21.12, "Signals and power configuration per satellite", on page 419.

Settings:

SV signal configuration table.........................................................................................89
└ Signal State.....................................................................................................89
└ Signal Component.......................................................................................... 90
└ Primary Code..................................................................................................90
└ Secondary Code............................................................................................. 90
└ Nav Msg Control............................................................................................. 90
└ Nav Msg..........................................................................................................91
└ Nav Msg Type.................................................................................................91
└ Nav Msg Content............................................................................................ 92
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SV signal configuration table
Table with one or more rows, one row per enabled signal ("Simulation Configuration >
Systems&Signals" > Signals).

Signal State ← SV signal configuration table
Activates the selected signal.
The available signals depend on GNSS system and the configuration in the Sys-
tems&Signals dialog.
At least one signal has to be activated per satellite. Activate another signal to deacti-
vate a particular signal, if it is the only one active at that moment.
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA[:STATe]
on page 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P[:STATe]
on page 434
(etc. for the other GNSS systems)

Signal Component ← SV signal configuration table
Indicates the signal content (data only or data and pilot).
The information is retrieved automatically from the selected simulation data source file.
Signal components depend on the signal, the frequency band and the GNSS system.
Remote command: 
n.a.

Primary Code ← SV signal configuration table
Enables the primary code to spread the data and pilot components.
If your interference tests require the generation of a continuous wave signal send on
the same frequency as a specific SV, set "Primary Code > Off" and "Nav Msg Control >
Off".
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:PCODe[:
STATe] on page 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:PILot:
PCODe[:STATe] on page 436
(etc. for the other GNSS systems)

Secondary Code ← SV signal configuration table
Enables the secondary code in the pilot and data channel of GPS, Galileo or BeiDou.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:
SCODe[:STATe] on page 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:
SCODe[:STATe] on page 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:
SCODe[:STATe] on page 437
(etc. for the other GNSS systems)

Nav Msg Control ← SV signal configuration table
Requires "Test Mode > Navigation", see "Test Mode" on page 34.
Defines whether the navigation message parameters can be changed or not.
"Auto" Adjusts the navigation message parameters automatically.
"On/Edit" Enables configuration of the navigation message parameters ("Nav

Msg Type = xNav") or configuration of user-defined data ("Nav Msg
Type ≠ xNav").
For SBAS space vehicles (PRN) the content is predefined.
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"Off" Navigation message is disabled.
A pure continuous-wave (CW) signal is output.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:
NMESsage:CONTrol on page 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:
NMESsage:CONTrol on page 439
(etc. for the other GNSS systems)

Nav Msg ← SV signal configuration table
Requires "Test Mode > Tracking", see "Test Mode" on page 34.
Defines whether the navigation message parameters can be changed or not.
"On" Enables configuration of the navigation message parameters ("Nav

Msg Type = xNav") or configuration of user-defined data ("Nav Msg
Type ≠ xNav").

"Off" Navigation message is disabled.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:
NMESsage[:STATe] on page 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:
NMESsage[:STATe] on page 555
(etc. for the other GNSS systems)

Nav Msg Type ← SV signal configuration table
Sets the data source used for the generation of the navigation message.
"LNAV/CNAV/FNAV/INAV/D1NAV/D2NAV/NAV"

The navigation message parameters are "real" since they are
retrieved from the loaded simulation data source file, see Import Con-
stellation.
"D1NAV" denotes navigation messages belonging to BeiDou
medium-altitude earth orbit (MEO) satellites (SV ID 6 to SV ID 35).
"D2NAV" denotes navigation messages belonging to BeiDou geosta-
tionary (GEO) satellites and inclined geostationary (IGSO) satellites
(SV ID 1 to SV ID 5).
Note: Galileo E6 signals carry no real navigation data. The signals
are simulated using data sources "PRBSxx/Data List/Pattern/Zero
NAV".
To change the automatically filled in values, select:
● Nav Msg Control > "Edit"
● Nav Msg Content > Config
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"PRBSxx/Data List/Pattern"
Selects a configurable data source.
The data symbols from the data source are transmitted in the naviga-
tion message. The signal is sufficient for simple functional tests and
sensitivity tests.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd

> Select" to select an existing data list.
– Use the "New" and "Edit" functions to create internally new

data list or to edit an existing one.
– Use the standard "File Manager" function to transfer external

data lists to the instrument.
See also:
● Section "Modulation Data" in the R&S SMBV100B user manual.
● Section "File and Data Management" in the R&S SMBV100B user

manual.
● Section "Data List Editor" in the R&S SMBV100B user manual

"Zero NAV" Sets the broadcasted orbit and clock correction parameters in the
navigation message to zero. Frame structure, timing and channel
coding of the navigation message are retained.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:
NMESsage:TYPE on page 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:
NMESsage:DSELect on page 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:
NMESsage:PATTern on page 444
(etc. for the other GNSS systems)

Nav Msg Content ← SV signal configuration table
Opens the "Navigation Message" dialog, where you can observe the navigation mes-
sage parameter and if enabled, change them.
See Chapter 13, "Perturbations and errors simulation", on page 191.

Meander Sequence ← SV signal configuration table
Enables meandering of GLONASS satellite navigation signals, i.e. doubling the data
rate.
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
MEANdering[:STATe] on page 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
MEANdering[:STATe] on page 444

Time Sequence ← SV signal configuration table
Enables the time signal component of GLONASS satellite navigation signals.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
TSEQuence[:STATe] on page 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
TSEQuence[:STATe] on page 444

Copy Modulation Control Settings to,SV-ID
Applies the power settings of the current satellite to the selected or to all SV-IDs of the
same GNSS system.
The following settings are considered:
● Signal State
● Primary Code
● Secondary Code
● Nav Msg Control
● Nav Msg Type
● Meander Sequence
● Time Sequence
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:SVID on page 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:EXECute
on page 445
(etc. for the other GNSS systems)

7.3  Simulated orbit and orbit perturbation settings

Access:

1. Select "GNSS > Simulation Configuration > Satellites".

2. Select the GNSS system for that you want to configure satellites constellation, for
example GPS.

3. Select "SV# > SV Config".

4. In the "SV Configuration" dialog, select one of the following:
● "Simulated Orbit > Orbit"
● "Simulated Orbit > Orbit Perturbation"

Available navigation message parameters depend on the GNSS system.
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Settings:
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Ground Track
Displays a plot of the trajectory of the selected satellite.
To observe the aggregated ground tracks of all satellites, select "GNSS > Simulation
Monitor > Display = Satellites > Ground Track".

GPS SV
Comprises the navigation message parameters, specific to and common for all GPS
satellites.
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Simulated Orbit ← GPS SV
Comprises the navigation message parameters, specific to and common for all GPS
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:SQRA on page 453

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:ECCentricity on page 454

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:OZERo on page 454

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:IDOT on page 455

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:NDELta on page 456

Orbit Perturbation ← GPS SV
Comprises the navigation message parameters, specific to and common for all GPS
satellites.

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CRS on page 457

Simulated orbit and orbit perturbation settings



Space vehicle configurationSatellite Navigation

96User Manual 1178.9403.02 ─ 10

Parameter Remote command:

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
ORBit:CIS on page 457

Galileo SV
Comprises the navigation message parameters, specific to and common for all Galileo
satellites.

Simulated Orbit ← Galileo SV
Comprises the navigation message parameters, specific to and common for all Galileo
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:SQRA on page 453

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:ECCentricity on page 454

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:OZERo on page 454

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:IDOT on page 455

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:NDELta on page 455

Orbit Perturbation ← Galileo SV
Comprises the navigation message parameters, specific to and common for all Galileo
satellites.
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Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CRS on page 457

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:ORBit:CIS on page 457

GLONASS SV
Comprises the navigation message parameters, specific to and common for all GLO-
NASS satellites.

Simulated Orbit ← GLONASS SV
Comprises the navigation message parameters, specific to and common for all GLO-
NASS satellites.

Parameter Remote command:

"Reference Date" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:DATE on page 452

"Reference Time" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:TIME on page 453

"Xn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:XN on page 451

"Yn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:YN on page 451

"Zn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:ZN on page 451

"X'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:XDN on page 451

"Y'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:YDN on page 451

"Z'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:ZDN on page 451

"X''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:XDDN on page 451
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Parameter Remote command:

"Y''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:YDDN on page 452

"Z''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:ORBit:ZDDN on page 452

BeiDou SV
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.

Simulated Orbit ← BeiDou SV
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:SQRA on page 453

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:ECCentricity on page 454

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:OZERo on page 454

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:IDOT on page 455

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:NDELta on page 456

Orbit Perturbation ← BeiDou SV
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.
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Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CRS on page 457

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CIS on page 457

NavIC SV
Comprises the navigation message parameters, specific to and common for all NavIC
satellites.

Simulated Orbit ← NavIC SV
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:SQRA on page 453

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:ECCentricity on page 454

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:OZERo on page 454

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:IDOT on page 455
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Parameter Remote command:

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:NDELta on page 456

Orbit Perturbation ← NavIC SV
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CRS on page 457

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:ORBit:CIS on page 457

QZSS SV
Comprises the navigation message parameters, specific to and common for all QZSS
satellites.

Simulated Orbit ← QZSS SV
Comprises the navigation message parameters, specific to and common for all QZSS
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:SQRA on page 453

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:ECCentricity on page 453

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:OZERo on page 454
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Parameter Remote command:

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:IDOT on page 455

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:NDELta on page 455

Orbit Perturbation ← QZSS SV
Comprises the navigation message parameters, specific to and common for all QZSS
satellites.

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CRS on page 457

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
ORBit:CIS on page 457

NavIC SV ← QZSS SV
Comprises the navigation message parameters, specific to and common for all NavIC
satellites.

Simulated Orbit ← NavIC SV ← QZSS SV
Comprises the navigation message parameters, specific to and common for all NavIC
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:WNOE on page 452

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:TOE on page 452

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:SQRA on page 453

Simulated orbit and orbit perturbation settings
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Parameter Remote command:

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:ECCentricity on page 453

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:IZERo on page 454

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:OZERo on page 454

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:OMEGa on page 454

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:MZERo on page 455

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:IDOT on page 455

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:ODOT on page 455

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:NDELta on page 455

Orbit Perturbation ← NavIC SV ← QZSS SV
Comprises the navigation message parameters, specific to and common for all NavIC
satellites.

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CUC on page 456

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CUS on page 456

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CRC on page 456

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CRS on page 457

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CIC on page 457

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:ORBit:CIS on page 457

7.4  Simulated clock settings

Access:

1. Select "GNSS > Simulation Configuration > Satellites".

Simulated clock settings
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2. Select the GNSS system for that you want to configure satellites constellation, for
example GPS.

3. Select "SV# > SV Config".

4. In the "SV Configuration" dialog, select "Simulated Clock".

Available navigation message parameters depend on the GNSS system.

Settings:

GPS > Simulated Clock...............................................................................................103
Galileo > Simulated Clock...........................................................................................103
GLONASS > Simulated Clock.....................................................................................104
BeiDou > Simulated Clock.......................................................................................... 104
QZSS > Simulated Clock............................................................................................ 104
NavIC > Simulated Clock............................................................................................ 105

GPS > Simulated Clock
Comprises the navigation message parameters, specific to and common for all GPS
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
CLOCk:WNOC on page 457

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
CLOCk:TOC on page 458

"af0 - af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
CLOCk:AF<s2us0> on page 458

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:
CLOCk:TGD on page 458

Galileo > Simulated Clock
Comprises the navigation message parameters, specific to and common for all Galileo
satellites.

Simulated clock settings
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Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:CLOCk:WNOC on page 457

"Time of Clock - t0c (E1-E5B)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:CLOCk:TOC on page 458

"af0 (E1-E5B)" to "af2 (E1-E5B)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:CLOCk:AF<s2us0> on page 458

"Group Delay - BGD (E1-E5B)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
SIMulated:CLOCk:TGD on page 458

GLONASS > Simulated Clock
Comprises the navigation message parameters, specific to and common for all GLO-
NASS satellites.

Parameter Remote command:

"Reference Date" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:CLOCk:DATE on page 452

"Reference Time" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:CLOCk:TIME on page 453

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:CLOCk:AF<s2us0> on page 458

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIMulated:CLOCk:TGD on page 458

BeiDou > Simulated Clock
Comprises the navigation message parameters, specific to and common for all BeiDou
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:CLOCk:WNOC on page 457

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:CLOCk:TOC on page 458

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
SIMulated:CLOCk:AF<s2us0> on page 458

"Group Delay B1I - TGD1"

"Group Delay B2I - TGD2"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
PRERrors:MODE on page 461

QZSS > Simulated Clock
Comprises the navigation message parameters, specific to and common for all QZSS
satellites.

Simulated clock settings
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Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
CLOCk:WNOC on page 457

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
CLOCk:TOC on page 458

"af0 - af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
CLOCk:AF<s2us0> on page 458

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:
CLOCk:TGD on page 458

NavIC > Simulated Clock
Comprises the navigation message parameters, specific to and common for all NavIC
satellites.

Parameter Remote command:

"Reference Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:CLOCk:WNOC on page 457

"Reference Time of Week" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:CLOCk:TOC on page 458

"af0 - af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:CLOCk:AF<s2us0> on page 458

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:
SIMulated:CLOCk:TGD on page 458

Simulated clock settings
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8  Tracking mode
Per default, the R&S SMBV100B generates a GNSS signal that is suitable for testing
the receiver capabilities to acquire and track the signal and to estimate its position
based.

Some receiver tests, however, focus on testing if the receiver is capable to acquire and
decode the signal; navigation and thus position estimation is not necessary. For such
tests or for receivers' sensitivity tests in zero Doppler conditions or under varying signal
dynamics conditions, the R&S SMBV100B provides the tracking mode.

With the provided signal dynamic settings, you can enable a predefined or constant
velocity profile, or define a user-specific one.

8.1  Signal dynamics settings

Access:

1. Select "GNSS > Test Mode" > "Tracking".

2. Select "GNSS > Simulation Configuration > Satellites".

3. Select the GNSS system for that you want to configure satellites constellation, for
example GPS.

4. Select "SV# > SV Config".

5. In the "SV Configuration" dialog, select "Signal Dynamics".

Signal dynamics settings
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6. Select, for example, "Mode > High Order".

Figure 8-1: Spinal Dynamics: Understanding the displayed information (Mode > Higher Order
and Velocity Profile = User Dynamics)

1 = Velocity at the start of the profile
2 = Period of time the velocity is held constant
3 = Period of time an acceleration is applied
4 = Maximum acceleration together with the acceleration period and, if set the initial velocity, defines

the maximum velocity (7a and 7b)
5 = Defines how fast the maximum acceleration is reached
6 = Profile's duration, calculated from the selected periods of constant speed and acceleration; the

profile is repeated every 240 s.
7a = Maximum velocity = "Initial Velocity" + "Constant Acceleration Period"."Maximum Acceleration" =

500 m/s
7b = "Initial Velocity" - "Constant Acceleration Period"."Maximum Acceleration"

Signal dynamics settings are provided for testing the receiver sensitivity under
varying signal dynamics conditions. You can select a predefined or constant veloc-
ity profile, or define a user-specific one.
The displayed settings depend on the selected "Mode" and "Velocity Profile". Dedi-
cated plots visualize the variations of the velocity, acceleration and the jerk over
time.

Settings:

Mode........................................................................................................................... 108
Inital Pseudorange...................................................................................................... 108
Inital Carrier Phase..................................................................................................... 108
Velocity (Pseudorange Rate)...................................................................................... 108
High-order profile settings........................................................................................... 108

└ Start Time Offset...........................................................................................108
└ Velocity Profile.............................................................................................. 109
└ Initial Velocity................................................................................................ 109
└ Constant Velocity Period...............................................................................109
└ Constant Acceleration Period....................................................................... 109

Signal dynamics settings
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└ Maximum Acceleration..................................................................................109
└ Maximum Jerk...............................................................................................110
└ Repetition Period...........................................................................................110

Mode
Selects the dynamics profile type.
"Constant" Generates a constant velocity profile with configurable velocity, see

Velocity (Pseudorange Rate).
This mode is suitable for testing the receiver characteristics under
more realistic conditions than with zero Doppler.

"High Order" Enables profiles with higher-order dynamics.
There are two predefined profiles and you can define your own one,
see High-order profile settings.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PROFile on page 556
(etc. for the other GNSS systems)

Inital Pseudorange
Sets the pseudorange at the beginning of the simulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PRANge on page 557

Inital Carrier Phase
Sets the carrier phase at the beginning of the simulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CPHase on page 556

Velocity (Pseudorange Rate)
In "Mode = Constant", sets the velocity, i.e. the constant Doppler with that the pseudor-
ange changes. The pseudorange at a give moment is calculated from the initial pseu-
dorange value and the velocity.
Velocity different than zero results in variation of the Doppler shift.
The velocity is constant, hence the acceleration and the jerk are zero. Observe also
the indications on the plots.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:VELocity on page 557
(etc. for the other GNSS systems)

High-order profile settings
In "Mode = High Order", observe the plots indicating the variations of the velocity,
acceleration and the jerk over time, see Figure 8-1.
For both predefined profiles ("Velocity Profile = Low Dynamics or High Dynamics"), the
profile settings are read-only.
To change the settings, set "Velocity Profile = User Dynamics".

Start Time Offset ← High-order profile settings
Sets a time delay before the dynamics profile is applied.

Signal dynamics settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:TOFFset on page 558
(etc. for the other GNSS systems)

Velocity Profile ← High-order profile settings
Selects between the predefined velocity profiles or a user-defined one.
"Low Dynamics, High Dynamics"

Generates a profile using the settings of one of the predefined veloc-
ity profiles.

"User Dynamics"
Generates a velocity profile with user-defined parameters.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CONFig on page 559
(etc. for the other GNSS systems)

Initial Velocity ← High-order profile settings
Indicates the start velocity, used at the beginning of the profile. This value is used at
the simulation start time or after the defined "Start Time Offset" elapses, see Fig-
ure 8-1.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:IVELocity on page 558
(etc. for the other GNSS systems)

Constant Velocity Period ← High-order profile settings
Displays the time period during that velocity is kept constant and the acceleration is
assumed to be 0.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CVPeriod on page 559
(etc. for the other GNSS systems)

Constant Acceleration Period ← High-order profile settings
Displays the time duration during that acceleration is applied and thus the velocity var-
ies.
The acceleration is calculated from the "Maximum Jerk" and the "Maximum Accelera-
tion".
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CAPeriod on page 560
(etc. for the other GNSS systems)

Maximum Acceleration ← High-order profile settings
Indicates the maximum acceleration. This value together with the acceleration period
and, if set the initial velocity, defines the maximum velocity.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:ACCel:MAX on page 560
(etc. for the other GNSS systems)

Signal dynamics settings
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Maximum Jerk ← High-order profile settings
Indicates the maximum jerk that defines how fast the maximum acceleration is
reached.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:JERK:MAX on page 561
(etc. for the other GNSS systems)

Repetition Period ← High-order profile settings
Indicates the profile duration. The value is calculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:RPERiod? on page 561
(etc. for the other GNSS systems)

8.2  Related settings

Configured for signal tracking, the R&S SMBV100B requires only a subset of a GNSS
multi-frequency constellation simulator. To access related settings, follow the proce-
dures below. The description of the related settings is linked at the end of each proce-
dure.

SV Selection Criteria Settings

Access:

1. Select "GNSS > Test Mode > Single-Satellite".

2. Select "GNSS > Simulation Configuration > Satellites > SV Selection Criteria".

The settings are read-only except for the minimum and maximum number of space
vehicles.

For description of the settings, see Chapter 6.2, "Satellites settings", on page 73.

Additional Settings

Configure simulation time, signal power, navigation message, perturbation and data
logging settings as described in this manual.

Related settings
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For a description of the settings, see:
● Chapter 4.1, "Time settings", on page 46
● Chapter 7.1, "Power settings", on page 83
● Chapter 13, "Perturbations and errors simulation", on page 191
● Chapter 15, "Data logging", on page 265

Related settings
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9  Production tester
In manufacturing, GNSS receiver testing refers to sensitivity testing for acquiring and
tracking a satellite signal. The tests do not require decoding of positioning data.

Configured as a production tester, the R&S SMBV100B enables you to generate hybrid
satellite signals in static mode. It supports up to four satellite signals, one for each of
the basic GNSS, that is GPS, Galileo, GLONASS and BeiDou.

You can activate signal components individually. The number of activated signal com-
ponents depends on the simulation capacity. See Chapter G, "Channel budget",
on page 642.

In addition, you can configure various Doppler profiles for receiver sensitivity testing
under varying signal dynamics.

Production tester upgrade

You can upgrade a production tester configuration of the R&S SMBV100B. Install a
basic GNSS option to upgrade to a GNSS simulator for navigation tests and tracking
tests.

Example: Increasing number of satellite signals
The R&S SMBV100B is configured as a production tester, see Chapter 9.1, "Required
options", on page 112. Additional installation, e.g., of the GLONASS system option
R&S SMBVB-K94 increases the number of GLONASS satellites from one to six.
Also, you can add the three satellite signals from the basic GNSS, one for GPS, Gali-
leo and BeiDou. This upgrade implies an increase in simulation capability from four to
nine satellite signals.

9.1  Required options

Configured as a production tester, the R&S SMBV100B requires only a subset of the
options presented in Chapter 2.1, "Required options", on page 17. Particularly, no
GNSS system option is required. The following table lists all options for single- and
multi-frequency production testing.

Option Designation Requirement

R&S SMBVB Base unit Mandatory

R&S SMBVB-K520 Baseband real-time extension Mandatory

R&S SMBVB-K1331) Single-satellite GNSS Mandatory

R&S SMBVB-K1341) Upgrade to dual-frequency Optional

R&S SMBVB-K1351) Upgrade to triple-frequency Optional

Required options
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1) R&S SMBVB-K135 requires R&S SMBVB-K134, which requires R&S SMBVB-K133.

9.2  Related settings

Configured as a production tester, the R&S SMBV100B requires only a subset of a
GNSS multi-frequency constellation simulator. To access related settings, follow the
procedures below. The description of the related settings is linked at the end of each
procedure.

Satellite systems and signals settings

Access:

1. Select "GNSS > Test Mode > Single Satellite per System".

2. Select "GNSS > Simulation Configuration > Systems & Signals".

All basic GNSS systems are activated. Depending on the installed options, L1, L2,
L5 bands are enabled:
R&S SMBVB-K133: Only one band can be activated.
R&S SMBVB-K134: Two bands can be activated.
R&S SMBVB-K135: All three bands can be activated.

Signal dynamics settings

Access:

1. Select "GNSS > Test Mode > Single-Satellite".

2. Select "GNSS > Simulation Configuration > Satellites".

3. Select the GNSS system for that you want to configure satellites constellation, for
example GPS.

4. Select "SV# > SV Config".

Related settings
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5. In the "SV Configuration" dialog, select "Signal Dynamics".

For description of the settings, see Chapter 8.1, "Signal dynamics settings",
on page 106.

SV selection criteria settings

Access:

1. Select "GNSS > Test Mode > Single-Satellite".

2. Select "GNSS > Simulation Configuration > Satellites > SV Selection Criteria".

The settings are read-only. The "Number of SVs > Current = 1" is fixed, since no
additional satellites are required.

For description of the settings, see Chapter 6.2, "Satellites settings", on page 73.

Additional settings

Configure simulation time, signal power, navigation message, perturbation and data
logging settings as described in this manual.

For a description of the settings, see:
● Chapter 4.1, "Time settings", on page 46
● Chapter 7.1, "Power settings", on page 83
● Chapter 13, "Perturbations and errors simulation", on page 191
● Chapter 15, "Data logging", on page 265

9.3  Real-time information

Configured as a production tester, the R&S SMBV100B offers also monitoring of real-
time information. It allows you to monitor allocated channels, channel composition and
the power associated with each channel.

Access:

1. Select "GNSS > Test Mode > Single-Satellite".

2. Select "GNSS > Simulation Monitor".

Real-time information



Production testerSatellite Navigation

115User Manual 1178.9403.02 ─ 10

3. Select "Display > HW Channels" or "Display > Power View".

Monitor power levels of each channel/signal.

For description of the settings, see Chapter 3.3, "Simulation monitor", on page 36.

Real-time information
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10  Real-world environment
Ideal environment versus real-world environment

By default, the GNSS firmware application simulates an ideal environment between a
GNSS receiver and the satellite constellation. This ideal situation includes the follow-
ing:
● The GNSS receiver is static.
● The GNSS receiver has a line-of-sight (LOS) connection to the satellites.
● Excluded satellites from the constellation are invisible to the GNSS receiver.

A more realistic approach includes environmental effects on a dynamic GNSS receiver.
This chapter covers the impact of environmental effects and receiver dynamics on the
receiver positioning (pseudorange calculation) accuracy. The following sections explain
the different impact factors.

Advanced receiver dynamics

Simulating the receiver movement requires definition of the receiver trajectory within a
file. Additional to the movement, the dynamic characteristics include spinning and atti-
tude behavior of the GNSS receiver.

Static multipath propagation

A received GNSS signal does not only consist of the LOS component. Additional com-
ponents are signal scatters or signal echoes that result from reflections from objects in
the environment of the GNSS receiver. The propagation of the GNSS signal is a multi-
path propagation. The GNSS firmware application simulates static multipath effects,
also in addition to effects resulting from an obscured environment.

Obscurations and multipath effects

In obscured environments, the received GNSS signal originates from fewer satellites
than the satellite constellation displays. The number of visible satellites is typically
higher at the same position without obscurations like surrounding buildings. In rural or
suburban areas, in tunnels or in car parking places, some satellites are partly or com-
pletely obscured. A wall or a vertical plane obscures the receiver although the receiver
is theoretically visible for that particular location. From other satellites, the receiver
receives only the echoes, because there is no LOS connection to the satellites.
Receivers experience also effects of signal reflection caused by a water surfaces or
the ground.

Throughout this user manual, the combinations of environmental effects denote obscu-
ration and multipath.

Antenna patterns and body masks

GNSS receivers in vehicles typically have several built-in antennas to improve the reli-
ability of the received signal. The receivers experience additional obscurations that
arise from the vehicle body and the movement. To simulate the effects on the antenna,
you can load antenna patterns and body mask files.
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Required options

For simulation of atmospheric effects, a GNSS system option is sufficient. Simulation of
GNSS receiver spinning, attitude changes and environmental effects including
obscured environments require R&S SMBVB-K108.

See also Chapter 2.1, "Required options", on page 17.

For information on perturbation, pseudorange errors and clock errors, or the impact of
the atmosphere on pseudorange calculation accuracy, see Chapter 13, "Perturbations
and errors simulation", on page 191.

● Spinning and attitude simulation........................................................................... 117
● Antenna pattern and body mask........................................................................... 118
● Supported environment models............................................................................ 120
● Supported multipath models................................................................................. 123
● Simulating real-world effects.................................................................................124
● Antenna and body mask settings..........................................................................135
● Environment configuration settings.......................................................................142

10.1  Spinning and attitude simulation

In a real-world scenario, a receiver placed in an airplane does not always receive the
signal of all theoretically visible satellites at its current position. Depending on the ori-
entation of the vehicle, several satellites can be partly or completely obscured. The ori-
entation of the vehicle is described with the three flight dynamics parameters, the yaw
(heading), pitch (elevation) and roll (bank), see Figure 10-1.

Equipped with option R&S SMBVB-K108, the R&S SMBV100B allows you to configure
a vehicle attitude or the body rotation parameters yaw, pitch, and roll. The instrument
calculates the power and the carrier phase response of a specific satellite or a multi-
path reflection at a specific angle of arrival (AoA).

The calculation is based on the defined attitude profile and the selected antenna pat-
tern. The power values and carrier phase offsets of all satellite signals are updated in
real time and with an update rate of 100 Hz.

With enabled spinning, the software additionally simulates a constant rate of change of
the roll.

Spinning and attitude simulation
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Figure 10-1: Flight dynamics parameters: yaw (heading), pitch (elevation) and roll (bank)

See:
● "Attitude Behaviour, More" on page 57
● "Attitude Configuration" on page 58

10.2  Antenna pattern and body mask

In the practice, a moving receiver is actually a GNSS receiver mounted in a car, air-
plane or other vehicle. A GNSS receiver often comprises of more than one antenna or
uses directional antennas rather than isotropic one for improving the reception.

To account for these effects, the R&S SMBV100B enables you to apply antenna pat-
terns, body masks and to simulate real-life scenarios, like a GNSS antenna placed in a
car. The instrument provides an interface for loading and creating user-defined
antenna patterns and body masks. The antenna patterns and body masks are files with
predefined file extension (*.ant_pat/*.body_mask) and file format as described in
Chapter A.3, "Antenna pattern and body mask files", on page 623.

You can define up to four antennas per vehicle.

Antenna pattern and body mask model

You find a subset of predefined body masks files of some generic vehicular models.
The models are simplified general models based on the following assumptions:
● All surfaces of the vehicle body are considered as planes
● Ground reflection is not considered for land vehicles; described is only the top body

of a car, the part from the window to the roof
● The receiver is placed at the central vertical plane.

A body mask is basically a table with rows of elevation angles in the range +90° to -90°
and columns of azimuth from -180° to +180°. Each table element gives the signal
power attenuation in dB of the incident signal. The predefined body masks have up to
three regions: pass, attenuated pass and non-pass. The resolution of the power
response and carrier phase offsets is up to 1° for both, the elevation and azimuth.

Antenna pattern and body mask
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The resulting body mask of a medium-sized car with roof-top as illustrated on Fig-
ure 10-2 is given on Figure 10-3.

Figure 10-2: Illustration of a medium-sized car with roof-top

Figure 10-3: Body mask of the medium-sized car with roof-tops (Azimuth -180° to +180°)

1 = Roof
2 = Roof window
3 = Back window
4 = Seat
5 = Side window
6 = Front window

Antenna pattern and body mask
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7 = Pass region (dark blue color): the incident signal is not attenuated and the table elements are set to 0 dB
8 = Attenuated pass region (light blue color): the incident signal is attenuated but not fully blocked; the table

elements are set to 15 dB.
9 = Non-pass region (red color): the incident signal is heavily blocked and the table elements are set to 40

dB

Possible application fields

● Automotive applications
Attitude parameters are automatically extracted from the user-defined motion vec-
tor.

● Body mask applications
Three files describe an antenna: the antenna pattern *.ant_pat (or power
response) file, the phase response *.phase file and the body mask file
*.body_mask.
Antenna pattern and phase response files must have the same filename and must
be saved in the same directory.
If the required *.phase file does not exist, the carrier phase matrix is assumed to
be zero.

● Outdoor scenarios
Antenna patterns are applied on reflections from the defined environment model,
e.g multi-path.

● Indoor absorption scenarios
Antenna patterns can also be used to simulate the signal absorption and the carrier
phase bias from any angle around a GNSS receiver.

● Over-the-air (OTA) test
You can also load antenna patterns measured by some over-the-air (OTA) mea-
surements, e.g the R&S®DST200 RF Diagnostic Chamber.

10.3  Supported environment models

R&S SMBV100B equipped with R&S SMBVB-K108 enables you to apply different envi-
ronment models and automatically simulate obscuration and multipath effects caused,
for example, from surrounding buildings in static or moving scenarios.

The Figure 10-4 is an example of a receiver placed in a car driving on a street. You can
define various test scenarios, including the particular moving behavior and surrounding
buildings. Buildings are defined with their height and the distance to the receiver, and
the material they are built from.

Supported environment models
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Figure 10-4: Example: Vertical obstacles for simulation of obscuration and multipath from surround-
ing buildings

Understanding the simulation of obscuration and multipath effects

On signal generation start, the software selects an optimal satellites constellation
based on the enabled GNSS systems and SV selection criteria, like maximum number
of satellites per GNSS system. A line-of-sight propagation (LOS view) is assumed in
the first stage and the satellites constellation is selected to fulfill the selected visibility
criteria, for example HDOP/PDOP. Only now, the selected constellation is filtered by
the selected environment model and the obscuration and multipath effects are applied
on the satellite constellation. The satellite constellation is constantly proved and a sat-
ellite handover is performed automatically. Handover is performed whenever a new
satellite appears or because of the receiver's movement profile, a satellite is not any-
more obscured.

Internal sampling rate

The R&S SMBV100B uses different sample rate on environment model depending
whether only obscuration or the combination of obscuration and automatic multipath is
simulated. For example, the sampling rate of the model "Urban Canyon" is 10 Hz if
only obscuration is enabled and 5 Hz in the other case.

Creating your own environmental model

You can select from the predefined models, adjust their settings and customize them or
if you prefer create your own models. User-defined model can be loaded as files or
created internally. In the latter case, you create the model as a table, where each row
corresponds to an object that causes obscuration, reflection of the signal and/or multi-
path effects.

The following functions help you further and simplify and accelerate the configuration:
● WYSWYG graphical view: visualizes the objects that you create and indicate each

object by its row index.
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● Subset of predefined but customizable user environment models: suitable as tem-
plates for creation of user-defined models.
Provided are suburban area, urban canyon, tunnel, bridge, highway, etc.

● Interface for file handling: enables loading files created with this or third-party soft-
ware or saving user-defined configuration

● Settings for joint obstacle's configuration: for defining of a subset of obstacles and
automatically repeating the configured subset.

Visualizing the obscured satellites

Environmental models are applied on the current satellite's constellation and for the
selected receiver's position. Satellites that are invisible at that position are not simula-
ted. Other satellites are simulated as obscured or as having echoes. The signal of
some others can be simulated with a power attenuation due to antenna pattern
response.

To visualize the satellite's constellation at any given simulation moment, select
"Receiver > Monitor" and observe the "Satellites > Sky View".

Built-in environment models

Provided are the following types of predefined environment models:
● City block

The model assumes: average building height 20m
● Urban canyon

Correspond to an urban canyon in commercial city places.
The model assumes: street width 30m, average building height 30m, gap between
the buildings along a street 10m, street length 1200m

● Suburban area
The model assumes: relatively high distance between the GNSS receiver and the
main reflecting obstacles

● Cutting
The model assumes: obscuration effects from side barriers on the left and right of a
vehicle moving on a highway

● Highway
The model assumes: effects of the barriers and cars moving in the opposite lines
and then interrupting the GNSS signal for a short time in a periodic way

Details and availability

Table 10-1 provides an overview of the environment models, their availability depend-
ing on the receiver's type and their applicability for the different vehicle types.

Supported environment models
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Table 10-1: Supported environment models

Environment model Receiver
types

Mov-
ing
posi-
tion

Static
posi-
tion

Model description

Line of sight (LOS) all x x Near field environment is not defined.

Vertical obstacles Pedestrian

Land vehicle

x x Simulates the whole fix geometry of many objects (locations) to the
left, right, front and back of the user's static location and is suitable for
city block simulation.

The objects are defined relative to the map orientation, i.e to the street
orientation. The map is built on the OX and OY axes and any point on
the map can be defined as a reference point. Each object is defined
with its length and its distance to this reference point.

The receiver's position is configurable and defined as an offset to the
reference point.

See Chapter 10.7.2, "Vertical obstacles", on page 144.

Roadside planes Pedestrian

Land vehicle

x  Describes an environment where the user-defined obstacles repre-
senting roadside planes or surfaces built from different materials are
located to the left and/or to the right side of the receiver. The roadside
planes are assumed parallel to the motion of the vehicle.

See Chapter 10.7.3, "Roadside planes", on page 148.

Full obscuration Pedestrian

Land vehicle

Ship

x x Defines areas with configurable size in that the satellite signals are
completely obscured.

See Chapter 10.7.4, "Full obscuration", on page 152.

Ground/sea reflection Ship

Aircraft

Spacecraft

x x (ship
only)

Simulated is ground/sea reflection and obscuration of satellites due to
modeled canyon obstacles (left and right) with configurable distance to
vehicle, height and surface type with different properties.

Use this model to simulate flights over sea/lakes with surrounding can-
yon or for ships crossing sea straits.

See Chapter 10.7.5, "Ground/sea reflection", on page 156.

Static multipath  x x See Chapter 10.7.6, "Static multipath", on page 158.

10.4  Supported multipath models

Multipath is a term describing the situation when the satellite’s signal reaches the
receiver via two or more paths. The direct signal path is referred as the line-of-sight
(LOS) signal, whereas the reflected paths are called echoes. Multipath propagation
affects the accuracy of the pseudorange measurements.

The severity of the multipath propagation effect depends mainly on the following:
● The signal strength of the echoes
● The delay between the LOS component and the echoes

In R&S SMBV100B you can define static multipath effects per satellite, see Chap-
ter 10.7.6, "Static multipath", on page 158. The multipath model describing the static
multipath propagation is implemented as a tapped delay model. It enables you to con-
figure a LOS component and up to 10 echoes per SV ID.

Supported multipath models
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10.5  Simulating real-world effects

Simulating rel-world effects covers the following topics:

● Simulating antenna patterns and body masks...................................................... 124
● Creating multipath environment scenarios............................................................132
● Creating obscured environment scenarios............................................................134

10.5.1  Simulating antenna patterns and body masks

This chapter covers the following topics:
● "To load an antenna pattern/body mask file" on page 124
● "To simulate antenna pattern" on page 125
● "To change the antenna pattern" on page 128
● "To prepare for automotive applications" on page 129
● "To modify antenna attenuation and phase values" on page 130
● "To create an antenna pattern/body mask file" on page 131

To load an antenna pattern/body mask file

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Antenna Configuration".

The default configuration uses one isotropic antenna in an open sky environment:
"Body Mask" > "OpenSky", "Antenna Pattern" > "Isotropic"

3. To select a body mask file, proceed as follows:

a) Select "A1" > "Body Mask" > "Open Sky".
A standard file-select dialog opens and displays list of available files and the
content of the selected file.

b) Select "Predefined Files" or "User Files".
c) To load the file, confirm with "Select".

4. To select an antenna pattern file, proceed as follows:

a) Select "A1" > "Antenna Pattern" > "Isotropic".
A standard file-select dialog opens and displays list of available files and the
content of the selected file.

b) Select "Predefined Files" or "User Files".

Simulating real-world effects
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c) To load the file, confirm with "Select".

The display is color-coded, where different power/attenuation or phase responses
between satellite carrier and receiver antenna are indicated with different colors
(see "Legend"). The vertical axis displays the elevation, the horizontal axis the azi-
muth.
With a selected antenna pattern, the R&S SMBV100B simulates the satellite power
and carrier phase depending on the antenna pattern and attitude parameters.

To simulate antenna pattern

1. Select "GNSS" > "General" > "Set To Default".

2. Select "Test Mode" > "Navigation".

3. Select "GNSS Configuration" > "Systems & Signals", for example, to activate a
hybrid GNSS constellation:

a) Select "GNSS" > "GPS"/"Galileo"/"GLONASS" > "On".
b) Select "L1 Band" > "On".

4. Select "GNSS Configuration" > "Receiver" > "Position" > "Moving".

5. Select a waypoint file, for example, the file Munich_Flight with file extension
*.xtd:
Select "Position Configuration" > "Waypont File" > "Munich_Flight".

6. Select "Attitude Behaviour" > "Spinning".

7. Select "More" > "Spinning Rate" > "0.1 Hz"

8. Select "Receiver" > "Number of Antennas" > "3".

9. Select "Receiver" > "Antenna Configuration".

10. For all antennas "Ax", select one of the predefined files, for example,
Space_Vehicle_3_antennas with file extension *.ant_pat:
Select "Ax" > "Body Mask" > "Space_Vehicle_3_antennas".

11. Observe the 3D positioning of the three antennas:

Simulating real-world effects
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a) Select "Display" > "Position".
b) Select "3D View" > "On".

The diagram displays the position of the antennas via their distance to the center of
gravity that is the position of the GNSS receiver. A cartesian coordinate system (X,
Y, Z) defines the position via the deviation to origin ("ΔX", "ΔY", "ΔZ").

Tip:
See also:
● Chapter 10.5.1, "Simulating antenna patterns and body masks", on page 124
● Example"Antenna with four sectors" on page 623

12. To activate signal generation, select "GNSS" > "General" > "State" > "On".

13. Select "Simulation Monitor" > "Display" > "Sky View".

Simulating real-world effects
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The simulation updates the sky view and map view in real time. Observe GNSS
signal changes due to satellite visibility changes, spinning rate changes or currently
active antennas.

14. Select "Display" > "Power View".

The simulation updates the power levels of the space vehicles in real time. The
body mask of the active antenna causes a 40 dB attenuation of the power level of
the space vehicle. Also, the attenuation depends on the GNSS receiver position
and orientation towards the direction of the signal of the space vehicles.

15. Select "Display" > "Attitude View".

The attitude indicator confirms the enabled spinning.

Simulating real-world effects
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To change the antenna pattern

We assume that you loaded an antenna pattern, see "To load an antenna pattern/body
mask file" on page 124.

1. Select "GNSS Configuration" > "Receiver".

2. Select, for example, "Number of Antennas" > "2".

3. Select "Antenna Configuration".

The second antenna appears in the table of the "Antenna Configuration" dialog.

4. Select "Display Type" > "Position".

5. Specify antenna position parameters "ΔX", "ΔY" and "ΔZ" for each antenna.
"ΔX", "ΔY" and "ΔZ" are the deviations from the center of gravity (COG)

6. Specify antenna attitude parameters "ΔHeading", "ΔElevation" and "ΔBank" for
each antenna.

The diagram displays the position in top view (in direction of the z-axis) and from
side view (in direction of the y-axis).

7. To visualize the antenna location on 3D view, proceed as follows:

a) Select "3D View" > "On".
b) To define the simulated antenna, select, for example, "A1" > "Active".
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Bars visualize the antenna position displaying the distance to origin that is the
COG. Also, the diagram highlights the simulated antenna "A1".

8. Select "Display" > "Antenna Pattern (Attenuation)"/"Antenna Pattern (Phase)" to
visualize the attenuation and phase response of the simulated antenna.

The display visualizes the orientation of the simulated antenna, which results from
the attitude setting compared to the COG. The power/attenuation response as
defined in the antenna pattern file is also displayed (see "Legend").

To prepare for automotive applications

Extract the attitude parameters from the waypoint file as follows:

1. Select "Receiver" > "Position" > "Moving".

2. Select "Position Configuration" > "Attitude Behaviour" > "From Waypoint File".

Simulating real-world effects



Real-world environmentSatellite Navigation

130User Manual 1178.9403.02 ─ 10

To modify antenna attenuation and phase values

We assume that you have performed the steps 1 to 4 a) or 4 b) described in "To load
an antenna pattern/body mask file" on page 124. The procedures for modifying
antenna pattern and body mask files are the same. The following procedure describes
the steps for modifying an antenna pattern only.

1. Select "Edit" to edit the antenna pattern file.

The "Edit Antenna Pattern File - *" dialog opens. The display is color-coded, where
different attenuation values or phase values between satellite carrier and receiver
antenna are indicated with different colors (see "Legend"). The vertical axis dis-
plays the elevation, the horizontal axis the azimuth.
For body mask files, the "View Type" > "Attenuation" is available only.

2. Select, for example the "View Type" > "Attenuation" to modify attenuation values.

3. Change the "Resolution" of the display matrix:

● Select, for example, "Resolution" > "1°" for fine editing.
● Select, for example, "Resolution" > "30°" for coarse editing.

4. In the graph, use the mouse to drag a rectangular area, to modify the attenuation
of this area.

5. Left mouse click into the rectangular area to access the context menu and select
"Edit Selection".
Set the "Attenuation" value.

Simulating real-world effects
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6. To zoom into an area: select a rectangular area.- In the context menu. Select
"Zoom Into Selection".
Displayed is only the selected area. Values outside this area are still valid. The
"Resolution" does not change.

7. Right mouse click, to zoom out.

8. For editing phase differences, repeat steps 4 and 5.

9. To save the antenna pattern into a file:

a) Select "Save as".
b) Enter a filename.
c) Select "Save".

To create an antenna pattern/body mask file

Three files describe an antenna, the body mask *.body_mask file, the antenna pat-
tern *.ant_pat file and the phase response *.phase file. The latter two files must
have the same filename and must be saved in the same directory. The *.ant_pat file
describes the power response matrix of each antenna.

To create your own antenna pattern/body mask files from xml data:

1. Open a text editor.

2. To create an antenna pattern file for example, follow the *.ant_pat file format
specification:

a) Specify <xml version> and <encoding> ISO type.
b) Define the file content in the <antenna_pattern> container.
c) Specify the description for each antenna in the <antenna_description>

subcontainer: Number of antennas, position and attitude shift parameters com-
pared to the center of gravity.

Simulating real-world effects
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d) Set the azimuth <az_res> and elevation <elev_res> resolution, which spec-
ify the length of the columns and rows in the <data> container.

e) In the <data> container, specify the power/attenuation or phase response val-
ues of the antenna pattern.

3. To save the antenna pattern file and save it on the instrument's hard disk:

a) Enter a filename with extension .ant_pat.
b) Save the file locally on your PC.
c) Use one of the standard file transfer methods to transfer the file to the hard disk

of the R&S SMBV100B.
d) Save the file, for example, in the standard user files directory:

/var/user/gnss/antenna_patterns

4. To load the antenna pattern file on the R&S SMBV100B user interface, perform the
step 4 in "To load an antenna pattern/body mask file" on page 124.

See also:
● Chapter 10.6, "Antenna and body mask settings", on page 135
● Chapter A.3, "Antenna pattern and body mask files", on page 623

10.5.2  Creating multipath environment scenarios

To simulate static multipath propagation for one space vehicle

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Environment Model" > "Static Multipath".

3. Select "Environment Configuration".

The "Environment Configuration" dialog opens. It allows you to configure multipath
propagation for each GNSS and space vehicle.

4. Specify GNSS and space vehicle.

a) Select, for example, "System" > "GPS".
b) Select, for example, "SV-ID" > "1".

5. Specify the number of signal components, that define the multipath propagation:

a) Select the number of echoes, for example, "Number of Echoes" > "1".
b) To simulate an obscured direct signal path between space vehicle and receiver,

disable the LOS component, "Line of Sight (LOS)" > "Off".
This procedure assumes "Line of Sight (LOS)" > "On" that means there are two
components (one echo and LOS), that contribute to the received GNSS signal.

6. Specify characteristics of the echo signal, for example, as follows:

a) Set "Initial Code Phase" > "1000 m".

Simulating real-world effects
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b) Set "Code Phase Drift" > "50 m/s".
The application calculates the "Doppler Shift" automatically. Calculation
includes the code phase drift and the center frequency of the RF band, here
"L1".

c) Set "Power Offset" > "-3 dB".
The echo signal is attenuated by 3 dB compared to the LOS signal.

d) Set "Initial Carrier Phase" > "1 m".
e) Optionally, correct the "Doppler Shift" and the reference RF band.

If corrected, the application readjusts the "Code Phase Drift" as described in
step b).

f) Set angle of arrival for elevation and azimuth, "AoA Elev." > "1 rad" and "AoA
Azimuth" > "1 rad".

The graph to the right visualizes the configuration displaying the LOS component
and echoes. Plotted is the power of the space vehicle (y-axis) versus the initial
code phase (x-axis) of each signal component. The LOS power has reference
power/power offset of 0.0 dB.

Figure 10-5: Static multipath configuration for GPS space vehicles

7. Optionally, you can apply the configuration to other GNSS and space vehicles, for
example, as follows:

a) Set "System" > "GPS".
b) Set "SV-ID" > "All".

All GPS space vehicles have the same static multipath configuration comprising a
LOS component and one echo.

8. Select "GNSS" > "State" > "On".

The R&S SMBV100B generates the GNSS signal of satellite signals that experi-
ence static multipath propagation.
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9. Monitor LOS and echo signal components in the simulation monitor in "Display" >
"Sky View" and "Display" > "Power View".

Figure 10-6: Monitoring effects of static multipath configuration for GPS space vehicles

10.5.3  Creating obscured environment scenarios

See:
● "To simulate vertical obstacles" on page 134
● "To simulate roadside planes" on page 134
● "To simulate full obscuration" on page 135
● "To simulate ground reflections or sea reflections" on page 135

To simulate vertical obstacles

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Environment Model" > "Vertical Obstacles".

3. Select "Environment Configuration".

The "Environment Configuration" dialog opens. It allows you to configure vertical
obstacles parallel to the receiver trajectory.

To simulate roadside planes

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Position" > "Moving".

3. Select "Environment Model" > "Roadside Planes".

4. Select "Environment Configuration".
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The "Environment Configuration" dialog opens. It allows you to configure roadside
planes parallel to the receiver trajectory.

To simulate full obscuration

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Environment Model" > "Full Obscuration".

3. Select "Environment Configuration".

The "Environment Configuration" dialog opens. It allows you to configure fully
obscured environment of a receiver.

To simulate ground reflections or sea reflections

1. Select "GNSS" > "GNSS Configuration" > "Receiver".

2. Select "Environment Model" > "Ground/Sea Reflection".

3. Select "Environment Configuration".

The "Environment Configuration" dialog opens. It allows you to configure
ground/sea reflection, that airborne receivers experience.

10.6  Antenna and body mask settings

Option: R&S SMBVB-K108

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Set the number of simulated antennas, for example, "Number of Antennas = 2".

Try out also the following:

1. In the "Antenna Configuration" dialog, select "3D View > On".

2. Select "Display > Antenna Pattern (Power)/(Phase)" to visualize the power and
phase response.

3. Select "Display > Position" to visualize the antenna's orientation and location com-
pared to the center of gravity (COG).

Automotive applications

Extract the attitude parameters from the waypoint file as follows:

1. Select "Receiver > Position > Moving".

2. Select "Position Configuration > Attitude Behaviour > From Waypoint File".

Antenna and body mask settings
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Settings:

10.6.1  Antenna configuration settings

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Set the number of simulated antennas, for example, "Number of Antennas = 2".

3. Select "Antenna Configuration".

The dialog provides a graphical display of antenna characteristics and settings to
select the simulated antenna.

Antenna characteristics

1. Select "Display > Body Mask".

The default configuration uses favorable conditions: isotropic antennas in open sky
environment.

2. For tests in a more challenging environment, perform the following for each
antenna:

a) To select a body mask description file, select "A# > Body Mask > Open Sky >
Select Antenna Pattern File > Predefined/User Files".

b) To select the antenna pattern file, select "A# > Antenna Pattern > Isotropic >
Select Antenna Pattern File > Predefined/User Files".

c) Confirm with "Select".

The "Select Antenna Pattern File" displays both, a list of available files and the con-
tent of the selected file.

3. To define which antenna is simulated, for example the "A1" antenna, select "A1" >
"Active".

Antenna and body mask settings
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Note: Switching between the active antenna restarts the simulation.

The display is color coded, where the different power levels are indicated with dif-
ferent colors (see "Legend").
Three files describe an antenna, the body mask *.body_mask file, the antenna
pattern *.ant_pat file and the phase response *.phase file. The latter two files
must have the same filename and must be saved in the same directory. The
*.ant_pat file describes the power response matrix of each antenna.
With a selected antenna pattern, the R&S SMBV100B simulates the satellite power
and carrier phase depending on the antenna pattern and attitude parameters.

Number of Antennas................................................................................................... 137
Display........................................................................................................................ 137
3D View.......................................................................................................................138
A x............................................................................................................................... 138
Active.......................................................................................................................... 138
Body Mask, Antenna Pattern...................................................................................... 138
Delta X, Delta Y, Delta Z..............................................................................................139
Delta Heading, Delta Elevation, Delta Bank................................................................139

Number of Antennas
Defines the number of configurable antennas.
You can create a pool of up to four antenna and body masks and switch between them.
To define which antenna is simulated, set "A#" > "Active".
Note: Switching between the active antenna restarts the simulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:COUNt on page 361

Display
Select the antenna characteristics that are currently visualized.
If more than one antenna is enabled (e.g. "Receiver > Number of Antennas = 2"), the
displayed information corresponds to the currently selected one ("A# > Active > On").
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The graph is merely a visualization. To change the values, select "A# > Filename >
Select Antenna Pattern File > Predefined/User Files" > "Edit".
"Position" Two displays that visualize the antenna position relative to the center

of gravity (COG):
● On the left, the top view - shows the x/y direction.
● On the right, the side view - shows the x/z direction.
To change the antenna position, set the parameters "ΔX, ΔY, ΔZ".

"Body Mask" Visual representation of the body mask retrieved from the selected
file ("Body Mask").

"Antenna Pattern (Attenuation), Antenna Pattern (Phase)"
Visual representation of the attenuation/phase distribution as
retrieved from the selected antenna pattern file ("Antenna Pattern").

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:DISPlay on page 362
[:SOURce<hw>:BB:GNSS:RTK:BASE<ch>ANTenna:DISPlay

3D View
Displays an interactive 3D representation of the body mask or the power/phase distri-
bution the antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:V3D on page 362

A x
Subsequent antenna number. It also selects the antenna whose pattern or body mask
is visualized.

Active
Activates the simulated antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:STATe on page 363
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:STATe on page 371

Body Mask, Antenna Pattern
Displays the selected body mask and antenna pattern files.
To change a file, select its filename.
You access the standard "Select Antenna Pattern File" dialog to select (or edit) the file,
describing the body mask or the antenna pattern (*.ant_pat and *.body_mask).
Several predefined antenna patterns are provided but you can load your own files
("User Files"), too.
The "Select Antenna Pattern File" displays both, a list of available files and the content
of the selected file.
Select "Edit" to open a graphical editor for changing the file content.
See:
● Edit > Body Mask/Antenna Pattern File
● Chapter A.3, "Antenna pattern and body mask files", on page 623.
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Remote command: 
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:PREDefined? on page 362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER? on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:APATtern:FILE
on page 363
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:PREDefined on page 362
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:USER on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:BODY:FILE on page 363
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:APATtern:FILE on page 370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:BODY:FILE on page 370

Delta X, Delta Y, Delta Z
Sets an offset relative to the center of gravity (COG) to place the antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DX on page 364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DY on page 364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DZ on page 364
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DX on page 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DY on page 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DZ on page 371

Delta Heading, Delta Elevation, Delta Bank
Displays the information on the antenna orientation and tilt.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DHEading on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DELevation
on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DBANk on page 363

10.6.2  Edit body mask and antenna pattern settings

To edit body mask files

1. Select "Antenna Configuration > A# > Body Mask > Open Sky".

The dialog "Select Body Mask File" opens.

2. Select the body mask file that you want to edit.

a) Select a body mask file between from a list in the tabs "User Files", "Predefined
Files" or "Recent Files".
For example, select "Predefined Files > OpenSky".
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b) Select "Edit".

The "Edit Body Mask File" dialog of the selected file opens. It provides settings to
configure resolution and attenuation for a two-dimensional grid diagram of the body
mask. Also, it displays azimuth, elevation and attenuation for each grid point. You
can also zoom into the grid areas for fine-tuning.

Masked areas and antenna patterns with attenuation values of 40 dB and higher imply,
that the satellites are fully obscured in the masked direction. In the simulation monitor,
these satellites are grey in the "Sky View".

To edit antenna pattern files

1. Select "Antenna Configuration > A# > Antenna Pattern > Isotropic".

The dialog "Select Antenna Pattern File" opens.

2. Select the antenna pattern file that you want to edit.

a) Select an antenna pattern file between from a list in the tabs "User Files", "Pre-
defined Files" or "Recent Files".
For example, select "Predefined Files > PatchAntenna".
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b) Select "Edit".

The "Edit Antenna Pattern File" dialog of the selected file opens. It provides set-
tings to configure resolution, attenuation and phase relations for a two-dimensional
grid diagram of the antenna pattern. Also, it displays azimuth, elevation and attenu-
ation for each grid point. You can also zoom into the grid areas for fine-tuning.

Masked areas and antenna patterns with attenuation values of 40 dB and higher imply,
that the satellites are fully obscured in the masked direction. In the simulation monitor,
these satellites are grey in the "Sky View".

Edit > Body Mask/Antenna Pattern File...................................................................... 141
View Type....................................................................................................................142
Azimuth, Elevation, Attenuation, Phase, Resolution................................................... 142
Save as....................................................................................................................... 142

Edit > Body Mask/Antenna Pattern File
Access: "Antenna Configuration > A# > Body Mask > Open Sky > Select Antenna Pat-
tern File > Predefined/User Files", select the body mask description file and select
"Edit".
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In this dialog you can change the file content, e.g. attenuation values, and zoom in into
display areas.

View Type
Toggles between the phase and power representation.
Works like "Display > Antenna Pattern (Attenuation)" and "Antenna Pattern (Phase)".

Azimuth, Elevation, Attenuation, Phase, Resolution
Displays the corresponding values of the selected point on the attenuation/phase
graph.
To edit the values, select an area on the graph, left mouse click and select "Edit Selec-
tion". Also you can configure the resolution for high or low granularity antenna patterns.

Save as
Accesses the standard "File Select" dialog to save the antenna pattern or body mask
as a file. The predefined files cannot be overwritten. If a predefined file has been
changed, save it with a new filename.
Remote command: 
n.a.

10.7  Environment configuration settings

Option: R&S SMBVB-K108

● Environment model and configuration...................................................................143
● Vertical obstacles.................................................................................................. 144
● Roadside planes................................................................................................... 148
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● Full obscuration.....................................................................................................152
● Ground/sea reflection............................................................................................156
● Static multipath......................................................................................................158

10.7.1  Environment model and configuration

Access:

► Select "GNSS" > "Simulation Configuration" > "Receiver".

Environment Model
Selects the environment model.
"Line of Sight (LOS)"

The environmental model of an ideal environment with no environ-
mental effects. The GNSS signal is a single signal that follows only
the line of sight component of the signal.

"Vertical Obstacles"
The environmental model includes vertical obstacles, for example, for
movement simulation in a city environment.
See Chapter 10.7.2, "Vertical obstacles", on page 144.

"Roadside Planes"
The environmental model includes planes, for example, for move-
ment simulation on a road surrounded by buildings.
See Chapter 10.7.3, "Roadside planes", on page 148.

"Full Obscuration"
The environmental model includes full obscuration, for example, for
movement simulation in tunnels.
See Chapter 10.7.4, "Full obscuration", on page 152.

"Ground/Sea Reflection"
The environmental model includes reflection elements, for example,
for movement simulation with ground and sea reflections.
See Chapter 10.7.5, "Ground/sea reflection", on page 156.

"Static Multipath"
The environmental model includes multipath propagation of the
GNSS signal.
See Chapter 10.7.6, "Static multipath", on page 158.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment[:MODel]
on page 389

Environment Configuration
Accesses the "Enviroment Configuration" dialog to configure settings of the selected
environmental model.
See "Environment Model" on page 143.
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10.7.2  Vertical obstacles

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Environment Model > Vertical Obstacles".

3. Select "Environment Configuration".

The vertical obstacles model is suitable for the simulation of obscurations and mul-
tipath effects expected in a city environment. Vertical obstacles are defined in a
coordinate system and are either parallel to the x-axis or parallel to the y-axis fol-
lowing axis direction.

Settings

Predefined Environment..............................................................................................145
Physical Model............................................................................................................ 145
Obstacles File............................................................................................................. 145
Edit Obstacles Files.................................................................................................... 145

└ Obstacles configuration................................................................................ 146
└ Material Property................................................................................ 146
└ Direction..............................................................................................146
└ 1st Edge X/Y Coord /m.......................................................................146
└ Length /m / Height /m......................................................................... 146
└ Material...............................................................................................146
└ Permittivity/Power Loss...................................................................... 147

└ Insert, Delete, Save, Save as....................................................................... 147
Map Orientation...........................................................................................................147
Receiver Offset............................................................................................................147
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Predefined Environment
Loads a predefined environment configuration.
You can load a user-defined setting or predefined settings that simulate two urban can-
yon environments.

Parameter "Urban Canyon (square)" "Urban Canyon (long)"

"Physical Model" "Obscuration & Multipath" "Obscuration & Multipath"

"Obstacles File" City_Block.rs_obst Urban_Canyon_1.rs_obst

"Map Orientation" "0.00 deg" "0.00 deg"

"Receiver X Offset" "-490.0 m" "15.0 m"

"Receiver Y Offset" "-500.0 m" "0.0 m"

"Receiver Height Offset" "10.0 m" "2.0 m"

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:
PREDefined on page 377

Physical Model
Specifies, if obscuration and/or multipath propagation effects are simulated.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PMODel
on page 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PMODel
on page 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PMODel
on page 375

Obstacles File
Accesses the standard "File Select" dialog to select predefined or user-defined obsta-
cle description files (*.rs_obst).

Remote command: 
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:PREDefined?
on page 378
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:USER? on page 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:FILE
on page 378

Edit Obstacles Files
Opens a dialog to modify obstacles, that are specified in the selected obstacles file.
The dialog provides a table-based editor and a graphical representation of the obsta-
cles configured in the table.
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Obstacles configuration ← Edit Obstacles Files
Provides settings to configure material and physical properties of obstacles. In the
table, each row defines a vertical obstacle. The row index indicates the obstacle on the
display view.

Material Property ← Obstacles configuration ← Edit Obstacles Files
Specifies, if the material is defined by its permittivity/conductivity or by its power loss
characteristic.

Direction ← Obstacles configuration ← Edit Obstacles Files
Determines the alignment of the vertical obstacle.
"|| OX" Alignment is parallel to the x-axis.
"|| OY" Alignment is parallel to the y-axis.

1st Edge X/Y Coord /m ← Obstacles configuration ← Edit Obstacles Files
For vertical obstacles, sets the x-coordinate and y-coordinate of the start point (first
edge) of the obstacle in meters. The first edge has the lowest coordinate value on its
direction axis.

Length /m / Height /m ← Obstacles configuration ← Edit Obstacles Files
Defines the length and height of the obstacles in meters. The obstacle is parallel to the
selected "Direction".

Material ← Obstacles configuration ← Edit Obstacles Files
Requires "Material Property > Permittivity".
Defines the material of the obstacle.
"User Def." User-defined material to configure the "Permittivity" manually.
"Glass/Concrete/Wood/Gypsum/Formica/Marble/Dry Wall/Brick"

Materials with fixed "Permittivity".
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Permittivity/Power Loss ← Obstacles configuration ← Edit Obstacles Files
Displays/defines the material property, permittivity or power loss, for the selected mate-
rial. This value is a measure for the reflection caused by the obstacle.

Insert, Delete, Save, Save as ← Edit Obstacles Files
Standard functions for adding/appending and removing table rows and saving
changes.

Map Orientation
The map is aligned to the points of a compass. The map orientation represents the
angle between west-east direction and X-axis. The compass sign indicates the direc-
tion to the north.

Example: 
A map orientation of 0° means, that the x-axis points to the east direction and the y-
axis points to the north direction. A value of 90° means, that the x-axis points to the
north direction and the y-axis points to the west direction.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:
MORientation on page 377

Receiver Offset
Determines the initial position of a receiver/vehicle in terms of height and left/front off-
set relative to the reference point (i.e. the (0, 0, 0) coordinate). The reference point is
the reference for the definition of the vertical obstacles.
Tip: Use this parameter to redefine the receiver's start position relative to the config-
ured obstacles geometry without changing the obstacles definition in the table.
Note: Simulation of moving receivers. If a moving receiver is simulated, the position
describes a vehicle geometric reference. The offset between antenna and the vehicle’s
reference is described in the antenna pattern (*.ant_pat).
The simulated GNSS signal refers to the antenna and not the vehicle geometric refer-
ence.
"Start Receiver X Offset"

X offset of the first simulated receiver position in the (OX, OY) coordi-
nate system

"Start Receiver Y Offset"
Y offset of the first simulated receiver position in the (OX, OY) coordi-
nate system

"Start Receiver Height Offset"
Height offset
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Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:
X on page 376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:
Y on page 376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:
HEIGht on page 376

10.7.3  Roadside planes

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Position > Moving".

3. Select "Environment Model > Roadside Planes".

4. Select "Environment Configuration".

The roadside planes model is suitable for the simulation of effects that a moving
receiver experiences while moving on a road surrounded, e.g., by buildings.
The vertical roadside planes are defined alongside the road and parallel to the
motion direction of the moving receiver. A maximum of two vertical planes at max
(left and right) are considered based on current user mileage.

Settings

Predefined Environment..............................................................................................149
Physical Model............................................................................................................ 149
Planes File.................................................................................................................. 150
Planes File Edit........................................................................................................... 150
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└ Roadside planes configuration......................................................................150
└ Material Property................................................................................ 150
└ Alignment............................................................................................150
└ Reference Receiver Position /km....................................................... 151
└ Distance /m.........................................................................................151
└ Height /m............................................................................................ 151
└ Material...............................................................................................151
└ Permittivity/Power Loss...................................................................... 151
└ Display................................................................................................151

└ Insert, Delete, Save, Save as....................................................................... 151
Repetition Window...................................................................................................... 151

└ State..............................................................................................................152
└ Repetition......................................................................................................152

Set To Trajectory Length............................................................................................. 152
Receiver Height Offset................................................................................................ 152
Set Length to Infinite................................................................................................... 152

Predefined Environment
Loads a predefined environment configuration.
You can load a user-defined setting or predefined settings that simulate a highway, a
suburban area or cutting environments.

Parameter "Highway" "Suburban Area" "Cutting"

"Physical Model" "Obscuration only" "Obscuration & Multipath" "Obscuration only"

"Planes File" Highway.rs_buil Suburban_1.rs_buil Cutting.rs_buil

"Repetition" "On" "On" "Off"

"Repetition Window" "0.550 km" "0.600 km" "10.000 km"

"Receiver Height Offset" "2.0 m" "2.0 m" "2.0 m"

"Set Length to Infinite" "Off" "Off" "On"

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:
PREDefined on page 377

Physical Model
Specifies, if obscuration and/or multipath propagation effects are simulated.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PMODel
on page 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PMODel
on page 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PMODel
on page 375
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Planes File
Accesses the standard "File Select" dialog to select a user-defined obstacles descrip-
tion file (*.rs_buil).

Remote command: 
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:PREDefined?
on page 378
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:USER? on page 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:FILE
on page 378

Planes File Edit
Opens a dialog to modify roadside planes, that are specified in the selected planes file.
The dialog provides a table-based editor and a graphical representation of the planes
configured in the table.

Roadside planes configuration ← Planes File Edit
Provides settings to configure material and physical properties of obstacles. In the
table, each row defines a roadside plane. The row index indicates the plane on the dis-
play view. Left and right planes are color-coded.

Material Property ← Roadside planes configuration ← Planes File Edit
Specifies, if the material is defined by its permittivity/conductivity or by its power loss
characteristic.

Alignment ← Roadside planes configuration ← Planes File Edit
For roadsides planes, determines according to which axis (left or right) the location is
aligned.
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Reference Receiver Position /km ← Roadside planes configuration ← Planes File
Edit
Distance (mileage) starting from which the corresponding roadside plane is considered
for obscuration and multipath simulation.

Distance /m ← Roadside planes configuration ← Planes File Edit
Defines the distance of the vertical obstacle to the OX or OY axis. The distance is
expressed in meters.

Height /m ← Roadside planes configuration ← Planes File Edit
Defines the obstacles' height in meters.

Material ← Roadside planes configuration ← Planes File Edit
Requires "Material Property > Permittivity".
Defines the material of the obstacle.
"User Def." User-defined material to configure the "Permittivity" manually.
"Glass/Concrete/Wood/Gypsum/Formica/Marble/Dry Wall/Brick"

Materials with fixed "Permittivity".

Permittivity/Power Loss ← Roadside planes configuration ← Planes File Edit
Displays/defines the material property, permittivity or power loss, for the selected mate-
rial. This value is a measure for the reflection caused by the obstacle.

Display ← Roadside planes configuration ← Planes File Edit
Changes the display type of the configured roadside planes.

Figure 10-7: Height vs. Position representation of a highway model

Insert, Delete, Save, Save as ← Planes File Edit
Standard functions for adding/appending and removing table rows and saving
changes.

Repetition Window
Comprises the settings for defining a repetition window including activation and setting
the repetition interval.
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State ← Repetition Window
Activates the repetition window of the obscured area with the set repetition interval.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:
STATe on page 379

Repetition ← Repetition Window
Sets the repetition interval in kilometers or seconds depending on the set "Reference
Scale".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow
on page 379

Set To Trajectory Length
Sets the length of the repetition intervall equal to trajectory length of the waypoint file.
Aligning both lengths is useful to ensure that the obscuration pattern repeats itself at
each repetition of the waypoint file. See "Trajectory Length/Duration" on page 63.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:
STRajectory on page 380

Receiver Height Offset
Determines the start position of a receiver in terms of height offset relative to the refer-
ence point used to define the roadside planes.
Tip: Use this parameter to redefine the vehicle's height relative to the configured
obstacles geometry without changing the obstacles definition in the table.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ROFFset:
HEIGht on page 379

Set Length to Infinite
If enabled, assumes planes with infinite width.
Enable this parameter to simulate cutting scenario.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ILENgth
on page 380

10.7.4  Full obscuration

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Environment Model > Full Obscuration".
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3. Select "Environment Configuration".

The full obscuration model is suitable to simulate areas in that the satellite signal is
fully obscured, like in tunnels.

Predefined Environment..............................................................................................153
Reference Scale..........................................................................................................154
Repetition Window...................................................................................................... 154

└ State..............................................................................................................155
└ Repetition......................................................................................................155

Set To Trajectory Length............................................................................................. 155
Obscured Areas.......................................................................................................... 155

└ Insert, Delete.................................................................................................156

Predefined Environment
Loads a predefined environment configuration.
You can load a user-defined setting or predefined settings that simulate a long tunnel,
multiple bridges or parking environments. The tables below provide an overview of the
configuration of the predefined obscured environments.
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Table 10-2: Predefined environment configuration with Reference Scale > Distance /km

"Predefined Environement" "Repetition State", "Window" Obscured areas:
"Reference /km", "Length /km"

"Long Tunnel" "Off", "10.000 km" "0.000", "24.500"

"Multiple Tunnels" "Off", "10.000 km" "0.000", "0.240"

"0.700", "0.400"

"2.000", "0.100"

"2.500", "0.300"

"3.500", "0.100"

"5.000", "0.200"

"7.000", "0.400"

"9.400", "0.200"

"Multiple Bridges (each 50 m)" "On", "1.000 km" "0.250", "0.050"

"0.750", "0.050"

Table 10-3: Predefined environment configuration with Reference Scale > Time /s

"Predefined Environement" "Repetition State", "Window" Obscured areas:
"Reference /s", "Duration /s"

"Multiple Bridges (each 30 s)" "Off", "10.0 s" "30.0", "30.0"

(13 additional obscured areas
with distance of 60.0 s for contigu-
ous reference points)

"870.0", "30.0"

"Parking (1 min)" "On", "300.0 s" "120.0", "60.0"

"Parking (10 min)" "On", "840.0 s" "120.0", "600.0"

"Parking (1 hour)" "On", "3840.0 s" "120.0", "3600.0"

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:
PREDefined on page 377

Reference Scale
Defines whether the obstacles' positions are defined as distance (in km) or as time (in
s).
Note: Changing between the two scales without saving the configuration leads to data
loss.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:SCALe
on page 380

Repetition Window
Comprises the settings for defining a repetition window including activation and setting
the repetition interval.
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State ← Repetition Window
Activates the repetition window of the obscured area with the set repetition interval.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:
STATe on page 381

Repetition ← Repetition Window
Sets the repetition interval in kilometers or seconds depending on the set "Reference
Scale".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow
on page 381

Set To Trajectory Length
Requires receiver "Position > Moving".
Sets the length of the repetition intervall equal to trajectory length of the waypoint file.
Aligning both lengths is useful to ensure that the obscuration pattern repeats itself at
each repetition of the waypoint file. See "Trajectory Length/Duration" on page 63.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:
STRajectory on page 381

Obscured Areas
Defines fully obscured areas.
An obscured area has a defined reference position and a defined length or duration.
Each zone is defined in one table row.
Tips:
● To simulate repetition of obscured areas, define the obscured areas and the repeti-

tion interval.
Activate the repetition window.

● To zoom into an obscured area on the graphical display, drag a rectangular.
● To visualize all configured full obscuration areas, select "Zoom Out".
Area count Displays the number of the obscured area.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:
FULL:AREA:COUNt? on page 381

"Reference" Defines the reference starting position or timestamp at which a spe-
cific obscured zone is applied.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:
FULL:AREA<ch>:REFerence on page 382
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"Length/Dura-
tion"

Length or duration of the obscured zone defined in kilometers or sec-
onds.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:
FULL:AREA<ch>:LENGth on page 382

Insert, Delete ← Obscured Areas
Standard functions for inserting and removing table rows and saving changes.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:
APPend on page 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:
AREA<ch>:INSert on page 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:
AREA<ch>:DELete on page 382

10.7.5  Ground/sea reflection

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Environment Model > Ground/Sea Reflection".

3. Select "Environment Configuration".

This model is suitable for the simulation of obscurations and multipath effects
caused by ground and sea reflections.
The model is available for ship, aircraft and spacecraft vehicles and describes can-
yon vertical obstacles parallel to the motion direction of the vehicle (direction axis).
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Material Property.........................................................................................................157
Surface Type............................................................................................................... 157
Ground Permittivity/Conductivity, Power Loss............................................................ 157
h1/h2, d1/d2................................................................................................................ 157
Ground Altitude........................................................................................................... 158

Material Property
Define whether the material is defined by its permittivity/conductivity or power loss
characteristic.
The material properties depend on the selected surface type.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:MPRoperty
on page 383

Surface Type
Describes the surface.
Available are "Dry Ground", "Medium Dry Ground", "Wet Ground", "Fresh Water" and
"Sea Water". The different surfaces feature different reflection characteristics.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:STYPe
on page 383

Ground Permittivity/Conductivity, Power Loss
Displays/defines the surface property, permittivity, conductivity or power loss, for the
selected surface type. This value is a measure for the reflection caused by the surface.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:
PERMittivity on page 383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:
CONDuctivity on page 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PLOSs
on page 384

h1/h2, d1/d2
Sets the height of the right/left obstacle and the distance between the receiver and the
obstacles.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:
O1Distance on page 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:
O2Distance on page 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Height
on page 385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Height
on page 385

Environment configuration settings
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Ground Altitude
Sets the altitude of the ground level relative to the WGS84 ellipsoid, i.e. the terrain
ground level is set relative to WGS84 zero level or sea level.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:GALTitude
on page 385

10.7.6  Static multipath

Access:

1. Select "GNSS > Simulation Configuration > Receiver".

2. Select "Environment Model > Static Multipath".

3. Select "Environment Configuration".

With the provided parameters, you can simulate signals undergoing multipath prop-
agation.
You can configure the number of echoes and the individual time and Doppler shifts,
power and carrier phase of each of them. A graph displays the resulting propaga-
tion.
In advanced mode with several antennas, the dialog comprises of several tabs.
There is one per antenna so that you can define individual multipath conditions for
each of the antennas.

Settings:

Standard, SV-ID (source), Copy To, Standard, SV-ID (target).................................... 159
Number of Echos........................................................................................................ 159
Line of Sight (LOS)......................................................................................................159
LOS and Echoes Table............................................................................................... 159

Environment configuration settings
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└ Unit................................................................................................................159
└ Init. Code Phase........................................................................................... 160
└ Code Phase Drift...........................................................................................160
└ Power Offset................................................................................................. 160
└ Init. Carrier Phase.........................................................................................160
└ Doppler Shift /Hz...........................................................................................160
└ AoA Elevation, AoA Azimuth.........................................................................160

Standard, SV-ID (source), Copy To, Standard, SV-ID (target)
Defines the GNSS standard and the SV ID for that the multipath is configured.
To use the same configuration for another SV ID or all other SV IDs, define the SV ID
as "Standard, SV-ID" (target) and select "Copy To".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SYSTem
on page 390
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SVID
on page 390
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:
SYSTem on page 391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:
SVID on page 391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:
EXECute on page 392

Number of Echos
Sets the echoes number. The value determines the number of rows available for con-
figuration.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHos:
COUNt on page 393
(etc. for the other GNSS systems)

Line of Sight (LOS)
Defines if a LOS component is present or not.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:
ENABle on page 392
(etc. for the other GNSS systems)

LOS and Echoes Table
Configuration of the LOS signal and the echoes, one row per multipath tap, where:
● LOS is present if "Line of Sight (LOS) > On"
● Number of echoes is defined by the parameter "Number of Echos"

Unit ← LOS and Echoes Table
You can change the units of the parameters. The affected values are automatically
recalculated.
Note: The selected units are used only in the manual control (display).

Environment configuration settings
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In remote control, SCPI commands always use the default units.

Init. Code Phase ← LOS and Echoes Table
Sets an initial code phase (or delay) for the selected echo. To simulated echo delay
variation with the time, set the parameters Code Phase Drift and Doppler Shift /Hz.
The severity of the multipath effect depends on the delay of the echoes and their
power.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:ICPHase on page 394
(etc. for the other GNSS systems)

Code Phase Drift ← LOS and Echoes Table
Sets a code phase drift that influences the delay of the echoes.
"Code Phase Drift" and "Doppler Shift" are interdependent. Changing either of them
affects the value of the other.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPDRift on page 394
(etc. for the other GNSS systems)

Power Offset ← LOS and Echoes Table
Sets the additional power offset for the echo.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:POWer on page 395
(etc. for the other GNSS systems)

Init. Carrier Phase ← LOS and Echoes Table
Sets the carrier phase at the simulation start.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPHase on page 396
(etc. for the other GNSS systems)

Doppler Shift /Hz ← LOS and Echoes Table
Enters the additional Doppler shift that influences the delay of the echoes.
"Code Phase Drift" and "Doppler Shift" are interdependent. Changing either of them
affects the value of the other.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:DSHift on page 397
(etc. for the other GNSS systems)

AoA Elevation, AoA Azimuth ← LOS and Echoes Table
Sets the angle of arrival parameters elevation and azimuth.
These parameters are considered if non-isotropic antenna patterns are used.

Environment configuration settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation on page 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth on page 398
(etc. for the other GNSS systems)

Environment configuration settings
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11  Real-time kinematics
Key features

The option R&S SMBVB-K122 real-time kinematics (RTK) virtual reference station fea-
tures:
● Simulation of one RTK virtual reference station
● Static position of the RTK virtual reference station including one antenna
● RTK data transfer over LAN interface via NTRIP (Networked Transport of RTCM

via Internet Protocol)

GNSS positioning with RTK

The real-time kinematics (RTK) positioning system consists at least of three compo-
nents: A GNSS reference receiver or reference station, a satellite and a GNSS rover
that is the device under test (DUT). Figure 11-1 illustrates such an RTK system to
determine the positon Rrov of the GNSS rover.

Rsat (Xi,Yi,Zi)

Riref Rirov

Rref (Xref,Yref,Zref) Rrov (Xrov,Yrov,Zrov)

1

2

3

4

Figure 11-1: RTK principle

1 = GNSS reference station (base station) with coordinates Rref

2 = Satellite with coordinates Rsat

3 = GNSS rover (DUT) with coordinates Rrov

4 = Baseline vector Rbase = [Rrov-Rref]
Ri

ref = Distance between GNSS reference station and satellite
Ri

rov = Distance between GNSS rover and satellite

The GNSS reference station has a known location Rref, the trajectory of the satellite
Rsat is also known. Measurements for the distance between satellite and GNSS refer-
ence station Ri

ref and satellite and GNSS rover Ri
rov are available. From these mea-
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surements, you can compute the baseline vector Rbase that is the distance between
GNSS rover and GNSS reference station. Using the baseline vector Rbase and the posi-
tion of the GNSS reference station Rref you can compute the position of the GNSS
rover Rrov. Equation 11-1 provides an overview.

Equation 11-1: GNSS rover position

Note, that this position determination has a limited accuracy. The following errors affect
the position measurements:

● Satellite clock error
● Satellite orbit error
● Atmospheric delay
● Receiver clock error
● Noise and multipath propagation errors

The determination of the baseline vector Rbase = Rrov - Rref uses single location differen-
ces. The technique eliminates the satellite clock error and reduces the satellite orbit
error and the atmospheric delay influences. Further corrections require GNSS carrier
phase corrections.

The RTK approach in this firmware is to provide pseudorange data and carrier range
data via the RTCM protocol to compute the baseline vector more accurately.

● Required options...................................................................................................163
● RTK configuration................................................................................................. 164
● RTK protocol configuration....................................................................................165
● RTK position configuration....................................................................................166
● RTK antenna configuration................................................................................... 170

11.1  Required options

The equipment for real-time kinematics simulation includes the R&S SMBV100B equip-
ped with the options as described in the table below.

Option Designation

R&S SMBVB Base unit

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-K122 RTK virtual reference station

For more information, see Chapter 2.1, "Required options", on page 17.

Required options
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11.2  RTK configuration

Access:

► Select "GNSS" > "RTK Configuration".

The dialog provides settings to configure simulation of a real-time kinematics (RTK)
reference station (base station) at the R&S SMBV100B.
There are dedicated settings for activating RTK and configuring the RTK protocol.
Also, you can configure t, position and environment of an RTK base station.

The remote commands required to define RTK settings are described in Chapter 21.6,
"Real-time kinematics (RTK) commands", on page 364.

Settings:

State............................................................................................................................164
Number of Base Stations............................................................................................ 164
Protocol Configuration.................................................................................................164
Mountpoint.................................................................................................................. 165
Position Configuration................................................................................................. 165
Antenna Configuration................................................................................................ 165

State
Activates real-time kinematics (RTK) simulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:STATe on page 366

Number of Base Stations
Displays the number of RTK base stations.
You can configure one RTK base station. This base station has a dedicated configura-
tion, that you can access via the "Base 1" side tab.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:BSTation:COUNt on page 366

Protocol Configuration
Accesses a dialog to configure the RTK protocol, see Chapter 11.3, "RTK protocol con-
figuration", on page 165.
Also, it displays the used protocol that is "NTRIP/RTCM 3.3".

RTK configuration
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Mountpoint
Sets the mountpoint of the RTK base station for RTK simulation.
"RS0x" Mountpoint of the RTK base station "x", e.g. "RS01" for the first virtual

reference station.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:MOUNtpoint? on page 366

Position Configuration
Accesses the position configuration dialog. You can configure the position of a GNSS
receiver or of an RTK base station.
The GNSS receiver position depends on the GNSS receiver type:
● Chapter 5.2, "Static receiver", on page 54
● Chapter 5.3, "Moving receiver", on page 59
● Chapter 18.2, "HIL settings", on page 295
To configure the position of the RTK base station, see Chapter 11.4, "RTK position con-
figuration", on page 166.

Antenna Configuration
Accesses the antenna configuration dialog. You can configure antennas of a GNSS
receiver or of an RTK base station.
To configure antennas of a GNSS receiver, see Chapter 10.6, "Antenna and body
mask settings", on page 135.
To configure the antenna of an RTK base station, see Chapter 11.5, "RTK antenna
configuration", on page 170.

11.3  RTK protocol configuration

Access:

► Select "GNSS" > "RTK Configuration" > "Protocol Configuration".

The dialog provides settings to configure the RTK protocol used for output of RTK
data at the "LAN" connector on the rear panel of the R&S SMBV100B.

RTK protocol configuration
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Settings:

Protocol....................................................................................................................... 166
Host IP........................................................................................................................ 166
Port..............................................................................................................................166
User ID........................................................................................................................ 166
Password.................................................................................................................... 166

Protocol
Displays the protocol "NTRIP/RTCM 3.3" used for transmitting RTK data.
RTK corrections are provided in RTCM 3 format via an integrated Ntrip server.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:PROTocol on page 372

Host IP
Displays the IP address of the host that is the R&S SMBV100B.
For more information, see chapter "Network Settings" in the R&S SMBV100B user
manual.

Port
Sets the port of the LAN connection.
You can use ports "2101", "4022" and "50000".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:PORT on page 372

User ID
Displays the user ID that is the RTCM user name. The user ID is "instr1".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:PROTocol on page 372

Password
Displays the password. The password is "instr1".
Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:PASSword? on page 372

11.4  RTK position configuration

Access:

► Select "GNSS" > "RTK Configuration" > "Position Configuration".

RTK position configuration
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The dialog provides settings to configure the position of a real-time kinematics
(RTK) base station.

Settings:

Sync to Receiver Position........................................................................................... 167
Location, Initial Position.............................................................................................. 167
Reference Frame........................................................................................................ 169
Location Coordinates, Position Format....................................................................... 169

Sync to Receiver Position
Triggers position synchronization of the RTK base station with the current position of
the GNSS receiver as defined in "Location, Initial Position" on page 55.
Use this setting, for example, to synchronize the RTK base station with the current
position of a moving receiver. Synchronization fails, if the distance between RTK base
station and the receiver is higher than 150 km. A warning message displays synchroni-
zation failure.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:SYNC on page 370

Location, Initial Position
Selects the location or initial position depending on the simulated object:
● Static GNSS receiver ("Position > Static"):

Selects the geographic location of the GNSS receiver.
● R&S SMBVB-K109: Hardware in the loop (HIL) GNSS receiver ("Position > From

Remote"):
Selects the initial position of the GNSS receiver.

● R&S SMBVB-K122: Real-time kinematics (RTK) base station:
Selects the geographic location of the RTK base station.

The representation of the coordinates depends on the selected "Reference Frame" and
"Position Format".

RTK position configuration



Real-time kinematicsSatellite Navigation

168User Manual 1178.9403.02 ─ 10

"User Defined" Sets the receiver position in terms of "Latitude", "Longitude" and "Alti-
tude"

"City" Selects a predefined geographic location, see Table 5-1 for an over-
view.
The parameters "Latitude", "Longitude" and "Altitude" are set auto-
matically.

Table 11-1: Coordinates of the simulated predefined positions

Continent City Latitude [deg] Longitude [deg] Altitude [m]

Europe London 51.500625 -0.1246219 22

 Moscow 55.7522222 37.6155556 200

 Munich 48.15 11.5833333 508

 Paris 48.8584 2.2946278 66

America New York 40.714667 -74.0063889 1

 San Francisco 37.8194389 -122.4784939 35

 Anchorage 61.2166667 -149.8833333 115

 Mexico City 19.4510539 -99.1255189 2310

 Bogota 4.7111111 -74.0722222 2640

 Sao Paulo -23.5337731 -46.62529 760

 Santiago de Chile -33.4474869 -70.6736758 522

Asia Beijing 39.9055556 116.3913889 60

 New Delhi 28.6138889 77.2088889 77

 Seoul 37.5514997 126.9877939 265

 Singapore 1.3113108 103.8268528 110

 Taipei 25.0223439 121.5147581 10

 Tokyo 35.6838611 139.7450581 45

Africa Cairo 30.0444419 31.2357117 23

 Dakar 14.7166769 -17.4676858 22

 Cape Town -33.9188611 18.4233 6

Australia Sydney -33.8833333 151.2166667 3

 Perth -31.9535119 115.8570481 2

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog
on page 353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]
on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog on page 367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect] on page 367

RTK position configuration
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Reference Frame
For GNSS receiver, selects the reference frame used to define the receiver coordi-
nates. The transformation between the reference frames is performed automatically.
R&S SMBVB-K122: For RTK base station, selects the reference frame used to define
the receiver or RTK base station coordinates. The transformation between the refer-
ence frames is performed automatically.
The following applies:
● XWGS84 = (1 - 0.008*10-6)*XPZ 90 - 0.2041*10-7*YPZ 90 + 0.1716*10-7*ZPZ 90 - 0.013
● YWGS84 = (1 - 0.008*10-6)*YPZ 90 - 0.2041*10-7*XPZ 90 + 0.1115*10-7*ZPZ 90 + 0.106
● ZWGS84 = (1 - 0.008*10-6)*ZPZ 90 - 0.1716*10-7*XPZ 90 - 0.1115*10-7*YPZ 90 + 0.022

Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
RFRame on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame
on page 367

Location Coordinates, Position Format
In the ECEF coordinate system, a geographic location is identified by three coordi-
nates, the altitude, latitude and longitude. The last two can be displayed in decimal or
DMS format. The display format is determined by the parameter "Position Format".

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degrees"
The display format is decimal degrees, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the reference location. The altitude value is the height
above the ellipsoid (HAE), that is the reference ellipsoid (WGS84 or PZ90).

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

Altitude, latitude and longitude are configurable, if "Location, Initial Position > User
Defined".

RTK position configuration



Real-time kinematicsSatellite Navigation

170User Manual 1178.9403.02 ─ 10

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
FORMat on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat
on page 368
To enter the coordinates in "Position Format > DEG:MIN:SEC"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:
PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DMS[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ
on page 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:
WGS] on page 369
To enter the coordinates in "Position Format > Decimal Degrees"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal:PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:
PZ on page 368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:
DECimal[:WGS] on page 368

11.5  RTK antenna configuration

Access:

► Select "GNSS" > "RTK Configuration" > "Antenna Configuration".

The dialog provides settings to configure the antenna body and antenna pattern of
a real-time kinematics (RTK) base station.

RTK antenna configuration
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Settings:

Display........................................................................................................................ 171
3D View.......................................................................................................................171
A x............................................................................................................................... 171
Active.......................................................................................................................... 171
Body Mask, Antenna Pattern...................................................................................... 172
Delta X, Delta Y, Delta Z..............................................................................................172
Delta Heading, Delta Elevation, Delta Bank................................................................172
Edit > Body Mask/Antenna Pattern File...................................................................... 172

Display
Select the antenna characteristics that are currently visualized.
If more than one antenna is enabled (e.g. "Receiver > Number of Antennas = 2"), the
displayed information corresponds to the currently selected one ("A# > Active > On").
The graph is merely a visualization. To change the values, select "A# > Filename >
Select Antenna Pattern File > Predefined/User Files" > "Edit".
"Position" Two displays that visualize the antenna position relative to the center

of gravity (COG):
● On the left, the top view - shows the x/y direction.
● On the right, the side view - shows the x/z direction.
To change the antenna position, set the parameters "ΔX, ΔY, ΔZ".

"Body Mask" Visual representation of the body mask retrieved from the selected
file ("Body Mask").

"Antenna Pattern (Attenuation), Antenna Pattern (Phase)"
Visual representation of the attenuation/phase distribution as
retrieved from the selected antenna pattern file ("Antenna Pattern").

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:DISPlay on page 362
[:SOURce<hw>:BB:GNSS:RTK:BASE<ch>ANTenna:DISPlay

3D View
Displays an interactive 3D representation of the body mask or the power/phase distri-
bution the antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:V3D on page 362

A x
Subsequent antenna number. It also selects the antenna whose pattern or body mask
is visualized.

Active
Activates the simulated antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:STATe on page 363
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:STATe on page 371

RTK antenna configuration
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Body Mask, Antenna Pattern
Displays the selected body mask and antenna pattern files.
To change a file, select its filename.
You access the standard "Select Antenna Pattern File" dialog to select (or edit) the file,
describing the body mask or the antenna pattern (*.ant_pat and *.body_mask).
Several predefined antenna patterns are provided but you can load your own files
("User Files"), too.
The "Select Antenna Pattern File" displays both, a list of available files and the content
of the selected file.
Select "Edit" to open a graphical editor for changing the file content.
See:
● Edit > Body Mask/Antenna Pattern File
● Chapter A.3, "Antenna pattern and body mask files", on page 623.
Remote command: 
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:PREDefined? on page 362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER? on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:APATtern:FILE
on page 363
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:PREDefined on page 362
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:USER on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:BODY:FILE on page 363
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:APATtern:FILE on page 370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:BODY:FILE on page 370

Delta X, Delta Y, Delta Z
Sets an offset relative to the center of gravity (COG) to place the antenna.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DX on page 364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DY on page 364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DZ on page 364
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DX on page 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DY on page 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DZ on page 371

Delta Heading, Delta Elevation, Delta Bank
Displays the information on the antenna orientation and tilt.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DHEading on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DELevation
on page 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DBANk on page 363

Edit > Body Mask/Antenna Pattern File
Access: "Antenna Configuration > A# > Body Mask > Open Sky > Select Antenna Pat-
tern File > Predefined/User Files", select the body mask description file and select
"Edit".

RTK antenna configuration
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In this dialog you can change the file content, e.g. attenuation values, and zoom in into
display areas.

RTK antenna configuration
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12  Generating Galileo OSNMA signals
This chapter provides information on generating Galileo open service navigation mes-
sage authentication (OSNMA) signals. For signal generation, the R&S SMBV100B
firmware uses specified OSNMA test vectors.

● About OSNMA.......................................................................................................174
● Generating Galileo OSNMA real-time signals.......................................................176
● Generating Galileo OSNMA test vector signals.................................................... 188

12.1  About OSNMA

Open service navigation message authentication (OSNMA) is an integral function of
the Galileo Open Service, providing data authentication to all enabled receivers.

OSNMA is authenticating data for geolocation information from the Open Service
through the navigation message (I/NAV) broadcast on the E1B signal component. For
authentication, the transmitted E1 I/NAV message contains authentication-specific data
in previously reserved fields.

Reference information

For OSNMA reference information, see latest versions of the following documents at
the European GNSS service center (Galileo ICD):

https://www.gsc-europa.eu/electronic-library/programme-reference-documents

Relevant documents:
● "Galileo OSNMA SIS ICD"
● "Galileo OSNMA Receiver Guidelines"
● "Annex B - OSNMA Test Vectors" provided as *.zip file

Copyright information

The OSNMA Receiver Guidelines is protected by copyright. Any alteration or transla-
tion in any language of the OSNMA Receiver Guidelines as a whole or parts of it is
prohibited unless the Publishing Authority provides a specific written prior permission.
The OSNMA Receiver Guidelines may only be partly or wholly reproduced and/or
transmitted to a third party in accordance with the herein described permitted use and
under the following conditions:

● the present "Terms of Use and Disclaimers" are accepted, reproduced and trans-
mitted entirely and unmodified together with the reproduced and/or transmitted
information;

● the copyright notice "© European Union 2024" is not removed from any page.

The Annex to the OSNMA Receiver Guidelines provides the test vectors and sample
data, supporting the verification of OSNMA functionality implementation. The Terms of
Use and Disclaimers from the OSNMA Receiver Guidelines are applicable to these
files.

About OSNMA
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Required options

For generating Galileo OSNMA signals, the basic equipment including the Galileo sys-
tem option R&S SMBVB-K66 is sufficient. See Chapter 2.1, "Required options",
on page 17.

12.1.1  About Galileo OSNMA real-time signals

The R&S SMBV100B firmware provides real-time signal generation of OSNMA signals
in line with Galileo OSNMA signal in space interface control document, see "Reference
information" on page 174.

OSNMA navigation message data

OSNMA navigation message data is common to all space vehicles of a given Galileo
satellite constellation. The R&S SMBV100B provides settings to configure OSNMA
data in a common dialog within the Galileo satellite constellation, see Chapter 12.2,
"Generating Galileo OSNMA real-time signals", on page 176.

12.1.2  About Galileo OSNMA test vectors

The R&S SMBV100B firmware provides official OSNMA test vectors as specified by
EUSPA including satellite constellation and testing times. These test vectors allow
standardized tests of the OSNMA receiver capabilities, see "Reference information"
on page 174.

The tables Table 12-1 and Table 12-2 list supported OSNMA test vectors including the
related scenario. See also "To load a Galileo OSNMA scenario" on page 188.
Table 12-1: OSNMA test vectors

Test vector
Scenario name

Merkle root Key value (without line feed)

Configuration A

OSNMA: Configuration 1

Key 1 0E63F552C8021709043C239032EFFE94
1BF22C8389032F5F2701E0FBC80148B8

Configuration B

OSNMA: Configuration 2

Key 2 A10C440F3AA62453526DB4AF76DF8D94
10D35D8277397D7053C700D192702B0D

Table 12-2: Galileo OSNMA test vectors for test phase

Test vector
Scenario name

Merkle tree PKID NPKID Public key curve

Configuration A

OSNMA: Configuration A

1 2 N/A ECDSA P-256/SHA-256

Configuration B

OSNMA: Configuration B

1 3 N/A ECDSA P-256/SHA-256

Configuration C

OSNMA: Configuration C

2 8 N/A ECDSA P-521/SHA-256

About OSNMA
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Test vector
Scenario name

Merkle tree PKID NPKID Public key curve

Configuration D

OSNMA: Configuration D

3 2 N/A ECDSA P-256/SHA-256

End of Chain Step 1

OSNMA: EOC_step_1

1 3 N/A ECDSA P-256/SHA-256

End of Chain Step 2

OSNMA: EOC_step_2

1 3 N/A ECDSA P-256/SHA-256

New Public Key Step 1

OSNMA: NPK_step_1

1 3 4 ECDSA P-256/SHA-256

New Public Key Step 2

OSNMA: NPK_step_2

1 1 2 ECDSA P-256/SHA-256

New Public Key Step 3

OSNMA: NPK_step_3

1 2 N/A ECDSA P-256/SHA-256

Public Key Revocation Step 1

OSNMA: PKREV_step_1

1 2 3 ECDSA P-256/SHA-256

Public Key Revocation Step 2

OSNMA: PKREV_step_2

1 3 N/A ECDSA P-256/SHA-256

Public Key Revocation Step 3

OSNMA: PKREV_step_3

1 3 N/A ECDSA P-256/SHA-256

OSNMA Alert Message

OSNMA: OAM

1 0 N/A ECDSA P-256/SHA-256

Simulation duration and test vector length

The duration of the test vector simulations is limited by the test vector length provided
in the reference documents. The simulation can run successfully only for the defined
length which typically is one hour but for some scenarios, the length is two hours or
three hours. For more information, see "Reference information" on page 174.

Scenario "OSNMA: PKREV_step_2" (Public Key Revocation Step 2) can only be suc-
cessful when running the GNSS simulation for more than one hour. As specified in
chapter A 2.5.3.2 of the ICD document "Galileo OSNMA Receiver Guidelines for Test
Phase (v1.1)", an OSNMA-compatible receiver makes use of the scenario key after
one hour of simulation.

12.2  Generating Galileo OSNMA real-time signals

12.2.1  Test setup

This chapter provides a test setup for Galileo OSNMA signal generation.

Generating Galileo OSNMA real-time signals
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Signal generator

R&S SMBV100B vector signal generator equipped with the Galileo system option, see
"Required options" on page 175.

GNSS receiver

GNSS receiver that is compatible with Galileo OSNMA. The configuration among
GNSS receivers can be different but is most likely very similar.

PC

PC with receiver control software for control and configuration of the GNSS receiver.

Signal generator

RF out RF

LAN

LAN

LAN

21

3

PC

DUT

Figure 12-1: OSNMA test setup

1 = R&S SMBV100B
2 = GNSS receiver
3 = PC with control software

12.2.2  Configuring the R&S SMBV100B

This chapter provides step-by-step instructions on how to configure the
R&S SMBV100B for OSNMA signal generation. These instructions cover the following
topics:
● "To transfer Galileo OSNMA output files" on page 177

To transfer Galileo OSNMA output files

1. Select "GNSS" > "GNSS Configuration".

2. Enable a Galileo signal. See "Signals" on page 71.

3. Open Galileo OSNMA space vehicle (SV) settings:

a) Select "Satellites" > "Galileo".
b) Select "OSNMA Configuration ...".

4. Set relevant OSNMA parameters as needed.

Generating Galileo OSNMA real-time signals
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5. Select "GNSS" > "On".

The R&S SMBV100B creates files as in the table Table 12-3 at satellite simulation
start. These files are available in the directory /var/user/gnss/osnma on the
instrument.
Table 12-3: OSNMA simulation output files

File Description

Osnma_MerkleTree_x_Bbz.txt ASCII file of the Merkle tree (index x) in hex for-
mat. Except for Merkle tree transitions, x is
always 0.

OSNMA_MerkleTree_Bbz.xml XML file including public key and all required
Merkle tree nodes at simulation start time.

OSNMA_PublicKey_Bbz.pem PEM-encoded file of public key at simulation
start time.

OSNMA_PublicKey_Bbz.xml XML file including public key information at sim-
ulation start time.

Osnma_PublicKey_y_MerkleTree_x_Bbz.txt ASCII file of the Public key index y (for Merkle
tree index x) in hex format and corresponding
Public key signature in PEM format (at simula-
tion start time). Note that for Public key transi-
tions, the indices of the Merkle tree x and Pub-
lic Key y change. Except for Merkle tree transi-
tions, x is always 0.

Osnma_Database_Bbz.txt Summary of signal generator settings.

Bbz corresponds to the baseband index, for example Bb1 corresponds to base-
band 1.

Load these output files at the OSNMA receiver to provide the receiver with additional
settings like Public Key or Merkle root. Note, that the Public Key in force, together with
its ID and signature algorithm, is provided in the DSM-PKR every 6 hours (starting at
00:00 GST, 06:00 GST, 12:00 GST and 18:00 GST) for 30 minutes, alternated with
broadcast DSM-KROOT and DSM-PKR. For more information, see the Galileo
OSNMA SIS ICD Galileo ICD.

12.2.3  Configuring the GNSS receiver

This chapter provides step-by-step instructions on how to configure the GNSS receiver.
These instructions cover the following topics:
● "To generate a public key" on page 179
● Example"To extract an OSNMA public key" on page 179
● "To reset the GNSS receiver" on page 179
● "To install public keys at the GNSS receiver" on page 180
● "To check for satellites with no test vector data" on page 180
● "To change simulation time and receiver position" on page 180
● "Additional hints" on page 180

Generating Galileo OSNMA real-time signals
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Configure the receiver via a receiver control software or manually, if possible.

To generate a public key

A successful Galileo OSNMA simulation requires installation of specified public keys
onto the GNSS receiver. These keys are based on the Merkle Tree number and the
public key ID number specified in the ICD “Galileo OSNMA Receiver Guidelines".

1. At GSC, download the *.zip file attached to annex “Annex B - OSNMA Test Vec-
tors”.

2. In the file, navigate to a public key directory, for example open the following:
../cryptographic_material/Merkle_tree1/PKID2/
OSNMA_PublicKey_20201210090026.pem

3. To extract the public key, copy the string between -----BEGIN PUBLIC
KEY----- and -----END PUBLIC KEY----- without line feed. See Example"To
extract an OSNMA public key" on page 179.

4. Copy the key to the GNSS receiver.

Tip: For scenarios with two public keys like “New Public Key Step 1” copy two keys
to the GNSS receiver. For example, copy keys as specified for Merkle Tree number
1, PKID number 3 and PKID number 4.

Example: To extract an OSNMA public key
This example illustrates how to extract a public key from the file
OSNMA_PublicKey_20201210090026.pem.
-----BEGIN EC PARAMETERS-----
BggqhkjOPQMBBw==
-----END EC PARAMETERS-----
-----BEGIN PUBLIC KEY-----
MFkwEwYHKoZIzj0CAQYIKoZIzj0DAQcDQgAErUzcTNDCvbMmNTrRm9NmnggsRmsp
tpJ9ne09GTKFpYv/BJpNNMYQykoULWjvAkqF2U7XM/72CXdjKKzy/eAnYA==
-----END PUBLIC KEY-----

To extract the public key, copy the following string without line feed:
MFkwEwYHKoZIzj0CAQYIKoZIzj0DAQcDQgAErUzcTNDCvbMmNTrRm9NmnggsRmsptpJ9ne09GTKFpYv/
BJpNNMYQykoULWjvAkqF2U7XM/72CXdjKKzy/eAnYA==

To reset the GNSS receiver

1. Reset the receiver.

2. Also, reset the following data at the receiver:
● Position, velocity and timing (PVT) data
● Satellite data
● Signal in space authentication data
We recommend a hard reset before running the receiver test.

Generating Galileo OSNMA real-time signals
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To install public keys at the GNSS receiver

1. At the receiver, activate OSNMA usage.

2. Transfer a valid public key to the receiver.

For example, enter a valid public key as in Example"To extract an OSNMA public
key" on page 179.

3. While running receiver tests, make sure that the receiver is active and ready for
receiver the GNSS signal.

When receiving the GNSS signal, the receiver acquires the satellites after several
minutes until it verifies the OSNMA.

To check for satellites with no test vector data

Some satellites of an OSNMA scenario are active but carry no test vector data. For
example, SV 18 in scenario "OSNMA: Configuration B". These satellites were visible at
the date of simulation but are not specified with test vector data by EUSPA.

1. If the GNSS receiver does not authenticate all satellites, check the satellite constel-
lation at the R&S SMBV100B.

Reasons for non-authentication at the receiver can be as follows:
● The visibility state of the satellite changes within the simulation while running

the scenario.
● The GNSS receiver position changed while running the scenario.

2. In the satellite constellation at the R&S SMBV100B, deactivate affected satellites
before starting or restarting the simulation.

To change simulation time and receiver position

You can change the simulation time and receiver position of a test scenario. Changing
these parameters can lead to failure of authentication tests.

1. Make sure that the simulation time is within the timeframe of the test vector data.
The timeframe is typically one hour.

2. Change the receiver position as needed.
When changing the receiver position, some satellites which carry no test vector
data can become visible. These visible satellites are not appropriate for OSNMA
receiver testing.

Additional hints

● Always reset the GNSS receiver data when starting or restarting an OSNMA test.
Typically, GNSS receivers react erroneously to time jumps, for example, into the
past.

● Delete previous authentication data on the GNSS receiver, if necessary and possi-
ble.
Deleting ensures correct reception of OSNMA data.

● The test vector length provided in the reference documents limits the duration of
the simulation of the test vectors.

Generating Galileo OSNMA real-time signals
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Typically a simulation can run successfully for one hour.

12.2.4  OSNMA real-time configuration and settings

Access:

1. Select "GNSS" > "GNSS Configuration".

2. Enable a Galileo signal. See Chapter 12.3.2, "Configuring the R&S SMBV100B",
on page 188.

3. Open Galileo OSNMA space vehicle (SV) settings:

a) Select "Satellites" > "Galileo".
b) Select "OSNMA Configuration ...".

The "OSNMA Configuration" dialog opens and provides OSNMA settings for all
Galileo space vehicles. These settings are in line with the specifications in the Gali-
leo OSNMA signal-in-space interface control document, see "Reference informa-
tion" on page 174.

Settings:

● Navigation message settings................................................................................ 181
● General OSNMA settings......................................................................................182
● TESLA key transition settings............................................................................... 186
● Public key transition settings.................................................................................187

12.2.4.1  Navigation message settings

Access:

1. Select "GNSS" > "GNSS Configuration".

2. Enable a Galileo signal. See Chapter 12.3.2, "Configuring the R&S SMBV100B",
on page 188.

3. Select "Satellites" > "Galileo".

Settings:

OSNMA Configuration ...
Opens the Galileo OSNMA Configuration dialog, see Chapter 12.2.4.2, "General
OSNMA settings", on page 182.
Remote command: 
n.a.

Generating Galileo OSNMA real-time signals
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12.2.4.2  General OSNMA settings

Access:

1. Select "Satellites" > "Galileo".

2. Select "OSNMA Configuration ...".

The upper part of the "OSNMA Configuration" dialog provides common OSNMA
settings.

For key transition settings, see the following sections:
● Chapter 12.2.4.3, "TESLA key transition settings", on page 186
● Chapter 12.2.4.4, "Public key transition settings", on page 187

Settings:

Transition Mode...........................................................................................................182
MACLT........................................................................................................................ 183
TS................................................................................................................................183
KS............................................................................................................................... 184
HF............................................................................................................................... 184
NPKT...........................................................................................................................184
MF............................................................................................................................... 185
CMAC AES Key Length.............................................................................................. 185
PID.............................................................................................................................. 185
Test Phase ADKD4..................................................................................................... 186
Status Preemption.......................................................................................................186
Additional Data Delay for Tag Verification................................................................... 186

Transition Mode
Sets the OSNMA transition mode.
These modes define the provision for the Public Key, TESLA chain and Alert Message.
Also, the modes determine the OSNMA status transitions.
"Public Key Renewal"

Public key renewal mode

Generating Galileo OSNMA real-time signals
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"Public Key Revocation"
Public key revocation mode

"TESLA Chain Renewal"
TESLA chain renewal mode

"TESLA Chain Revocation"
TESLA chain revocation mode

"Merkle Tree Renewal"
Merkle tree renewal mode

"Alert Message"
Alert message mode

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TMODe on page 539

MACLT
Sets the bits in the 8-bit MAC Look-up Table (MACLT) field. MAC is the message
authentication code.
Also, sets the range of the fields Tag Size (TS) and Key Size (KS). Set the "MACLT"
bits before setting "TS" and "KS".
The look-up table specifies the authentication data and key delay (ADKD) type
sequence for the tags provided within the MAC and key (MACK) message. The look-up
table can specify a sequence for one or two MACK messages.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MACLt on page 536

TS
Sets the bits in the 4-bit Tag Size (TS) field.
This field identifies the entry of a look-up table indicating the tag length lT in bits. Also,
the TS field defines the range of the Key Size (KS) field. Set the "TS" bits before set-
ting "KS".
Table 12-4: TS value and tag length

TS value Tag length

0 to 4 Reserved

5 20 bits

6 24 bits

7 28 bits

8 32 bits

9 40 bits

10 to 15 Reserved

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TS on page 540
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KS
Sets the bits in the 4-bit Key Size (KS) field.
This field identifies the entry of a look-up table indicating the key length lKof the chain in
bits.
Table 12-5: KS value and key length

KS value Key length

0 96 bits

1 104 bits

2 112 bits

3 120 bits

4 128 bits

5 160 bits

6 192 bits

7 224 bits

8 256 bits

9 to 15 Reserved

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:KS on page 536

HF
Sets the bits in the 2-bit Hash Function (HF) field.
This field identifies the hash function used for the chain as in the table below.
Table 12-6: HF value and hash function

HF value Hash function

0 SHA-256

1 Reserved

2 SHA3-256

3 Reserved

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:HF on page 535

NPKT
Sets the bits in the 4-bit New Public Key Type (NPKT) field.
This field represents the signature algorithm associated with the public key provided in
the digital signature message for a public key renewal (DSM-PKR).
The table below describes NPKT values and related messages. The R&S SMBV100B
supports "1" and "3". For an OSNMA Alert Message (OAM), select "Transition Mode" >
"Alert Message", see "Transition Mode" on page 182.
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Table 12-7: NPKT value and message type

NPKT value Message

0 Reserved

1 ECDSA P-256

2 Reserved

3 ECDSA P-521

4 OSNMA Alert Message (OAM)

5 to 15 Reserved

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:NPKT on page 536

MF
Sets the bits in the 2-bit MAC Function (MF) field.
This field identifies the MAC Function to authenticate the navigation data.
Table 12-8: MF value and hash function

MF value Hash function

0 HMAC-SHA-256

1 CMAC-AES

2 Reserved

3 Reserved

Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MF on page 536

CMAC AES Key Length
Requires "MF" = "1".
Sets the length of the cipher-based message authentication code (CMAC) key.
"CMAC(AES-128)"

The length of the CMAC key is 128 bits.
"CMAC(AES-256)"

The length of the CMAC key is 256 bits.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:AESKey:LENGth on page 534

PID
Sets the ID of the Public Key (PK) used to verify the signature of the digital signature
message for a root key (DSM-KROOT).
If the transition mode defines the change of the public key, the PKID depends on the
simulation time. This PKID means the public key which is in use and the PKID is
increased by each public key transition.
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For transition mode "Merkle Tree Renewal", the Merkle tree index alternates between 0
and 1 at each Public key transition. All other transition modes use Merkle tree index 0.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PID on page 537

Test Phase ADKD4
Enable the authentication data and key delay (ADKD) for ADKD = 4 for Galileo I/NAV
timing parameters.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADKD on page 534

Status Preemption
Enable the status preemption.
Enable this setting if your test setup requires an alignment of the header and root key
(HKROOT) message. The alignment applies to any change of navigation message
authentication (NMA) status or chain and public key status (CPKS) value.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:SPReemption on page 539

Additional Data Delay for Tag Verification
Sets an additional delay in subframes of the navigation data for the tag verification.
The delay can depend on receiver implementation.
You can set a delay of one subframe. A zero subframe delay corresponds to no delay.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADDelay on page 534

12.2.4.3  TESLA key transition settings

Access:

► Select "OSNMA Configuration ..." > "TESLA Key Transition".

This section of the "OSNMA Configuration" dialog provides settings for transition of
timed efficient stream loss-tolerant authentication (TESLA) keys.

Settings:

Number of Root Key Transitions per Day....................................................................187
Time Offset of Root Key Transition vs. Midnight......................................................... 187
Chain Key Transition Duration (Step 1).......................................................................187
Chain Key Transition Duration (Step 2).......................................................................187
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Number of Root Key Transitions per Day
Sets the number of TESLA chain transitions per day.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:NTDay on page 538

Time Offset of Root Key Transition vs. Midnight
Sets a time offset of the TESLA chain transitions per day.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:TOMidnight on page 538

Chain Key Transition Duration (Step 1)
Sets the duration of step 1 for TESLA chain transitions.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE
on page 537

Chain Key Transition Duration (Step 2)
Sets the duration of step 2 for TESLA chain transitions.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO
on page 538

12.2.4.4  Public key transition settings

Access:

► Select "OSNMA Configuration ..." > "Public Key Transition".

This section of the "OSNMA Configuration" dialog provides settings for the transi-
tion of public keys.

Settings:

Number of Public Key Transitions per Day................................................................. 187
Time Offset of Public Key Transition vs. Midnight.......................................................188
Public Key Transition Duration (Step 1)...................................................................... 188
Public Key Transition Duration (Step 2)...................................................................... 188

Number of Public Key Transitions per Day
Sets the number of Public key transitions per day.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:NTDay on page 538
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Time Offset of Public Key Transition vs. Midnight
Sets a time offset of the Public key transitions per day.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:TOMidnight on page 538

Public Key Transition Duration (Step 1)
Sets the duration of step 1 for Public key transitions.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE
on page 537

Public Key Transition Duration (Step 2)
Sets the duration of step 2 for Public key transitions.
Remote command: 
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO
on page 538

12.3  Generating Galileo OSNMA test vector signals

This chapter provides an overview on how to prepare, configure and operate the
R&S SMBV100B or multiple R&S SMBV100B instruments for generation of extended
bandwidth signals. It covers the following topics:

● Test setup..............................................................................................................188
● Configuring the R&S SMBV100B..........................................................................188
● Configuring the GNSS receiver.............................................................................190
● Related settings.................................................................................................... 190

12.3.1  Test setup

See Chapter 12.2.1, "Test setup", on page 176.

12.3.2  Configuring the R&S SMBV100B

This chapter provides step-by-step instructions on how to configure the
R&S SMBV100B for OSNMA signal generation. These instructions cover the following
topics:
● "To load a Galileo OSNMA scenario" on page 188

To load a Galileo OSNMA scenario

1. Select a predefined OSNMA scenario:

a) Select "Predefined Scenario" > "Galileo OSNMA" > "OSNMA".
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b) Select, for example "OSNMA: Configuration 1".

c) Confirm with "Select".

Selecting loads the scenario. The R&S SMBV100B also loads test vector-specific
configuration of the satellite constellation, simulation time and navigation message
data. For example, the simulation date for the test vector "Configuration 1" is
"2023-08-16".

2. Select "GNSS Configuration" > "System & Signals".

By default, the Galileo L1 band signal "E1 OS" is enabled.

3. Check OSNMA settings of a Galileo space vehicle (SV).

a) Select "Satellites" > "Galileo".
b) Select, for example, "SV 2" > "SV Config".

The navigation message content is predefined list mode data as specified by GSC.
OSNMA coding is active.

To load predefined OSNMA scenarios remotely, see Example"To load a Galileo
OSNMA scenario" on page 419.

Generating Galileo OSNMA test vector signals
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12.3.3  Configuring the GNSS receiver

See Chapter 12.2.3, "Configuring the GNSS receiver", on page 178.

12.3.4  Related settings

Access:

1. Select a predefined OSNMA scenario. See "To load a Galileo OSNMA scenario"
on page 188.

2. Access OSNMA settings of a Galileo space vehicle (SV).

a) Select "Satellites" > "Galileo".
b) Select, for example, "SV 2" > "SV Config".

The table provides settings to enable OSNMA coding for the navigation message
content of the predefined OSNMA scenarios.

Settings:

OSNMA
Enables coding of the OSNMA content of the Galileo navigation message for the pre-
defined OSNMA scenarios.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
OSNMa[:STATe] on page 442

Generating Galileo OSNMA test vector signals
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13  Perturbations and errors simulation
Section Real-world environment deals with the impact of the multipath and other envi-
ronment effects on the position accuracy.

Real receivers experience also perturbations such as noise, interfering signals, atmos-
pheric effects and ionospheric errors. Other signal errors are caused by satellite orbit
and clock errors. The errors remain non-corrected despite the corrections in the broad-
casted navigation message.

To simulate even more challenging conditions, you can add deliberate signal errors by
manipulating the navigation messages of the satellites. Perturbations of the signal and
signal errors of any kind have a direct impact on the receiver’s positioning accuracy.

The following sections illustrate error sources and settings necessary to simulate
errors.

● About noise and CW interferer..............................................................................191
● Noise and CW interferer settings.......................................................................... 191
● About error sources...............................................................................................196
● Atmospheric effects and ionospheric errors settings............................................ 200
● Pseudorange errors settings.................................................................................210
● Orbit and orbit perturbation errors settings........................................................... 213
● Clock errors settings............................................................................................. 221
● Time conversion errors settings............................................................................ 225
● System errors settings.......................................................................................... 230

13.1  About noise and CW interferer

You can add noise or an interfering continuous wave (CW) signal to the generated
GNSS signal.

Required options

Adding noise or an interfering signal to the generated GNSS signal requires the follow-
ing options:
● AWGN (R&S SMBVB-K62)

See R&S SMBV100B user manual, section "Adding Noise to the Signal".

13.2  Noise and CW interferer settings

Option: R&S SMBVB-K62

See also "Required options" on page 191.

Add noise to the GNSS signal or interfere the signal. The settings allow you to apply a
GNSS-specific configuration without accessing the "AWGN" block in the block diagram
of the R&S SMBV100B.

Noise and CW interferer settings
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Access:

► Select "Simulation Configuration" > "Noise / CW Interferer".

The dialog provides settings necessary to configure additive noise and an interfer-
ing CW signal. Also it displays the plotted carrier frequency versus the power den-
sity in a graph. The graph also displays the center frequencies of the L1, L2 and L5
bands via red dotted lines. Also displayed is the noise signal or CW interferer sig-
nal depending on the selected mode.

The remote commands required to define these settings are described in Chap-
ter 21.10, "AWGN configuration", on page 405.

To add noise to a GNSS signal

1. Select "Mode > Additive Noise".

2. Set "Carrier/Noise Density Ratio - C/N0".

Using the default value of 40 dBHz and reference power of -120 dBm, the power
density equals -160 dBm/Hz.

3. To monitor bandwidth and center frequency of the noise signal, proceed as follows:

a) Select "Noise Config > Manual"
b) Click "Edit".

If fully equipped and all bands enabled, the noise signal covers all band signals.
The signal has a bandwidth of 500 MHz at 1.389225 GHz center frequency.

Noise and CW interferer settings
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4. To add the configured noise signal, select "State > On".

The settings are automatically applied to the settings at the "AWGN" block. In the
block diagram of the R&S SMBV100B, the "AWGN" block displays "AWGN GNSS".

To shift noise to one RF band

We assume you configured the R&S SMBV100B as in To add noise to a GNSS signal
until step 2.

1. Enable one RF band only, e.g., "Systems & Signals > L1 > On" and "L2 > Off" and
"L5 > Off".

2. Select "Noise Config > Auto".

The noise signal shifts automatically to the center frequency of the L1 band. The
signal has a bandwidth of 75 MHz at 1.57542 GHz center frequency.

3. To shift the noise signal manually:

Noise and CW interferer settings
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a) Select "Noise Config > Manual"
b) Click "Edit".

4. In the "Noise Configuration" dialog, shift the noise signal by setting the "Center Fre-
quency".

Note: Shifting the noise center frequency fcenter depends on the bandwidth Δfnoise

and is limited to the following range:
1.139225 GHz + Δfnoise/2 ≤ fcenter ≤ 1.6392245 GHz - Δfnoise/2

5. To add the shifted noise signal, select "State > On".

To add a CW interferer to a GNSS signal

1. Select "Mode > CW Interferer".

2. Set "Jammer/Signal Ratio - J/S".

Using the default value of 40 dB and reference power of -120 dBm, the power level
of the CW interferer signal is -80 dBm.

3. Set "CW Frequency".

By default, the frequency equals the center frequency of an RF band. E.g., with L1
enabled, it equals 1.57542 GHz. The signal is displayed as a yellow dotted line in
the graph.

4. To add the configured CW interferer signal, select "State > On".

Settings:

State............................................................................................................................195
Mode........................................................................................................................... 195
Carrier/Noise Density Ratio - C/N0..............................................................................195
Jammer/Signal Ratio - J/S.......................................................................................... 195
Reference Power (Carrier).......................................................................................... 195
Noise Config................................................................................................................196

└ Edit................................................................................................................196

Noise and CW interferer settings
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└ Bandwidth..................................................................................................... 196
└ Center Frequency......................................................................................... 196

CW Frequency............................................................................................................ 196

State
Activates/deactivates the generation of an AWGN signal. The interferer (AWGN or CW
interferer, depending on the selected mode) is generated after the generator is activa-
ted.
Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:STATe on page 408

Mode
Activates/deactivates the generation of an AWGN signal. The interferer (AWGN or CW
interferer, depending on the selected mode) is generated after the generator is activa-
ted.
"Additive Noise"

The AWGN noise signal with selectable system bandwidth is added
to the baseband signal.

"CW Interferer" A sine with a defined frequency offset is added to the baseband sig-
nal.

Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:MODE on page 408

Carrier/Noise Density Ratio - C/N0

Requires "Mode > Additive Noise".
Sets the carrier power to noise power ratio C/N ratio that is the difference of carrier
power and noise power:
C/N ratio = carrier power - noise power

Noise power = Refrence power + 10 * log10(system bandwidth) - C/ N0

Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CNDRatio on page 406

Jammer/Signal Ratio - J/S
Requires "Mode > CW Interferer".
Sets the jammer (interferer) power to signal power ratio C/I ratio that is the difference
of carrier power and noise power:
C/I ratio = carrier power - interferer power

Interferer power = Refrence power + J/S

Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:JSRatio on page 408

Reference Power (Carrier)
Displays the reference power of the GNSS signal.
To edit, click "Edit". The tab "Simulation Configuration > Satellites" opens, where you
can set the reference power value. See also "Reference Power" on page 74.

Noise and CW interferer settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:POWer:REFerence on page 429

Noise Config
Requires "Mode > Additive Noise".
Defines how noise parameters "Bandwidth" and "Center Frequency" are set.
"Auto" Sets bandwidth and center frequency automatically.
"Edit" Enables configuration of bandwidth and center frequency. Click "Edit"

to the right of the selection.
Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CONFig on page 406

Edit ← Noise Config
Opens the "Noise Configuration" dialog, where you can configure "Bandwidth" and
"Center Frequency".

Bandwidth ← Noise Config
Sets the RF bandwidth to which the set carrier/noise ratio relates.
Within this frequency range, the signal is superimposed with a noise signal which level
corresponds exactly to the set C/N or S/N ratio.
Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:BWIDth on page 406

Center Frequency ← Noise Config
Sets center frequency of the noise signal.
Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CENTer on page 407

CW Frequency
Requires "Mode > CW Interferer".
Sets the frequency of the CW interfering signal.
Remote command: 
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CW on page 407

13.3  About error sources

You can observe the effect of the following common error sources on the receiver’s
positioning accuracy:
● Atmospheric (ionospheric and tropospheric) errors

See:
– Chapter 13.3.1, "About the atmospheric effects", on page 197.
– Chapter 13.4, "Atmospheric effects and ionospheric errors settings",

on page 200.

About error sources
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● Difference between the atmospheric condition at the ground station and the
receiver, simulated as difference in the simulated ionospheric model and the broad-
casted ionospheric parameters in the navigation message
See "About simulating errors" on page 200

● Additive noise and CW interferer
● Pseudorange errors

See Chapter 13.5, "Pseudorange errors settings", on page 210.
● Satellite orbit and orbit perturbation errors (ephemeris errors)

See:
– Chapter 13.3.2, "About orbit and orbit perturbation parameters and errors",

on page 198.
– Chapter 13.6, "Orbit and orbit perturbation errors settings", on page 213.

● Satellite clock and time conversion errors, like system time drifts due to difference
in the time conversion sets
See:
– Chapter 13.3.3, "About clock and time conversion parameters and errors",

on page 199.
– Chapter 13.8, "Time conversion errors settings", on page 225.

13.3.1  About the atmospheric effects

When traveling thought the atmosphere, the satellite signal experiences changes in
speed and direction. While the increased travel time due to signal refraction is insignifi-
cant, the variation in the signal propagation speed causes pseudorange measurement
errors.

Tropospheric effects

The troposphere is the lower atmosphere layer that comprises rain, snow, clouds, etc.
and affects the GNSS signals' propagation. GNSS signals experience a variable path
delay, caused mainly by the dry atmosphere. The magnitude of this delay depends on
the pressure, humidity, temperature and the location of the receiver and the satellite.

Ionospheric effects

The magnitude of ionospheric effects depends geographical location of the receiver,
the hour of day and the solar activity.

Ionospheric effects are frequency-dependent and can be counteracted by frequency
measurements. For single frequency receivers, the navigation message contains a set
of parameters that describes an ionospheric prediction model with the goal to remove
the ionospheric effect.

Tropospheric and ionospheric models

The R&S SMBV100B simulates atmospheric effects based on two models, a tropo-
spheric and an ionospheric one. These models define the ionospheric and tropospheric
models used to simulate the channel between the satellite and receiver. You can

About error sources
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enable and set each of them independently. The selected model applies for all satel-
lites, irrespectively to the GNSS system they belong to.

The provided models differ in terms of complexity. The ionospheric models also
assume different approximation of ionospheric effects. For information about the sup-
ported models, see:
● "Tropospheric Model" on page 202
● "Ionospheric Model" on page 203

Ionospheric model vs. ionospheric parameters in the navigation message

The ionospheric model defines the satellite to receiver channel, whereas the iono-
spheric navigation parameters define what the satellites are transmitting (broadcasting)
as ionospheric correction parameters.

13.3.2  About orbit and orbit perturbation parameters and errors

The different GNSS systems use specific approach to describe the satellite’s orbit and
orbit perturbations.

In GPS, Galileo, BeiDou and QZSS systems, the orbit description is based on the first
approximation of 16 Keplerian parameters. The navigation message of a GPS satellite
thus carries the reference time of ephemeris t0e, six orbit elements and three rate
parameters describing the linear time-dependent changes [1].

Figure 13-1: Satellite orbit (GPS): Understanding the displayed information

1 = Issue of data, IODE and reference time, t0e

2 = Orbit elements
3 = Rate parameters

In GPS, Galileo, BeiDou and QZSS, the perturbations are seen as variations of the
orbital elements. In the navigation message, they are described by three pairs of sinus-
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oidal (cosine and sine) corrections CC and CS. Each pair describes the difference in lat-
itude CU, orbital radius Cr and inclination Ci.

GLONASS satellites broadcast their PZ coordinates and velocity at reference epoch
time tb as well as the moon and sun acceleration components [1].

Figure 13-2: Satellite orbit (GLONASS): Understanding the displayed information

1 = Reference epoch, tb; orbit parameters are given at tb
2 = Coordinates in PZ-90
3 = Velocity component
4 = Moon and sun acceleration

13.3.3  About clock and time conversion parameters and errors

Clock and time conversion errors

Satellites and receivers can suffer from timing errors. Although satellites are equipped
with atomic clocks, there is always a clock offset due to:
● Clock drift between the different SVs.
● Misalignment in the time bases of the different GNSS systems.

The clock in the receiver is usually less precise and is hence a prone to an additional
drift.

To counteract the drifts in the satellites and GNSS systems time, the navigation mes-
sage contains satellite clock offset and time conversion parameters, see "Satellite
clock parameters" on page 199.

The receiver clock synchronization errors are estimated and compensated during the
positioning measurements, because the receiver clock offset is a constant value pres-
ent in the measurements of all satellites.

Satellite clock parameters

Satellite clock offset ΔClockSV is described by a second order polynomial given as fol-
lows:

About error sources
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ΔClockSV = af0 + af1(t – t0c) + af2 (t – t0c)2, where:
● t 0c is the reference time of clock
● af0, af1 and af2 are three coefficients that are broadcasted in the navigation mes-

sage.

Polynomial coefficients

In GPS, Galileo, BeiDou and QZSS, polynomial coefficients are:
● af0: SV clock offset
● af1: SV clock drift
● af2: SV clock drift rate

GLONASS considers the first order version of the polynomial (i.e. af2 = 0) and transmits
only two clock parameters:
● Τn: SV clock offset, where:

af0 = -Τn

● Γn: SV relative frequency offset
af1 = Γn

13.3.4  Simulating errors

Per default, the broadcasted navigation message parameters per SV are set automati-
cally to match the simulated orbit, clock and pseudorange parameters. For example,
the clock parameters in the navigation message of GPS SV ID #1 resemble the simula-
ted clock values for this satellite.

About simulating errors

Errors are deviations between the simulated and broadcasted navigation message
parameters. Changing the default navigation message values leads to deviation
between the simulated and the broadcasted navigation information and thus deliber-
ated errors. To simulate clock errors, change for example, the parameter af0 in the
broadcasted navigation message of SV#1 but maintain the af0 value of the simulated
clock.

You can also simulate unusual stations, like, for example, the wrongly broadcasted
clock bias between UTC and GPS system clocks. Such situations are simulated by
configuring different time conversion sets for the UTC-GPS conversion parameters in
the broadcasted navigation message and in the simulated UTC time parameters.

13.4  Atmospheric effects and ionospheric errors settings

Access:

1. Select "Simulation Configuration" > "Atmosphere".

Atmospheric effects and ionospheric errors settings
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2. Set the tropospheric and ionospheric models.
For example, select "Ionospheric Model > NeQuick".

The atmospheric configuration comprises the parameters for adjusting the iono-
spheric and tropospheric models of the simulation. The selected model describes
the actual ionospheric and tropospheric models used in the satellite-receiver
channel simulation.

3. To configure the ionospheric navigation parameters that define what the satellites
are transmitting as ionospheric correction parameters, set the ionospheric
parameters on the navigation message of the particular GNSS system:

a) Select "Simulation Configuration > Satellites > GNSS system > SV# > SV Con-
fig > Signals Configuration".
Ionospheric parameters are read-only and common for all SV of one GNSS
system. To change them, apply the same configuration to all SVs.

b) Select "SV# > SV Config" > "Copy Modulation Control to SVI-ID = All".
c) Select "Nav Msg Control > Edit".
d) Select "Nav Msg Content > Config > Ionosphere".

Per default, the navigation message parameters are set to fixed values. The values
are retrieved from the constellation data source and selected atmospheric model.

Changing these values leads to deviation between the simulated and the broad-
casted navigation message and thus deliberated errors. SBAS corrections can be
activated for error compensation.

Atmospheric effects and ionospheric errors settings
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Available navigation message parameters depend GNSS system and selected
navigation message type.
● The ionospheric model for GLONASS is not yet specified; its satellites transmit

no data on the atmosphere.
● GPS, Galileo and BeiDou assume specific ionospheric models. These systems

transmit different atmospheric navigation parameters.
For GPS satellites, for example, the navigation message carries the parameters
describing the Klobuchar ionospheric model, see Klobuchar Parameters.

Settings:

Atmosphere.................................................................................................................202
└ Tropospheric Model...................................................................................... 202
└ Ionospheric Model.........................................................................................203
└ Klobuchar Parameters.................................................................................. 203
└ NeQuick Parameters.....................................................................................204
└ MOPS-DO-229D...........................................................................................205

└ View Type........................................................................................... 205
└ Import Grid..........................................................................................205
└ Edit Grid..............................................................................................206

└ Time Scale, Time Select...........................................................207
└ Insert/Delete Page....................................................................207
└ View Type................................................................................. 207
└ Longitude, Latitude...................................................................207
└ GIVEI/Vertical Delay.................................................................207

└ Plot Vertical Delays/Plot IGP.............................................................. 207
└ Export Grid..........................................................................................208

└ Show Earth Grid............................................................................................208
GPS > Ionosphere.......................................................................................................208
Galileo > Ionosphere...................................................................................................209
BeiDou > Ionosphere.................................................................................................. 209
QZSS > Ionosphere.................................................................................................... 209
NavIC > Ionosphere.................................................................................................... 209
Show Scaled Values....................................................................................................210

Atmosphere
Comprises the parameters for adjusting the ionospheric and tropospheric models of
the simulation.
The selected model defines the ionospheric and tropospheric models used in the satel-
lite-receiver channel simulation.
See also "Tropospheric and ionospheric models" on page 197.

Tropospheric Model ← Atmosphere
Sets the tropospheric model used in the satellite-receiver channel simulation.
The troposphere is the lower atmosphere layer that comprises rain, snow, clouds, etc.
and affects the GNSS signals propagation. The GNSS signals experience a variable
path delay, caused mainly by the dry atmosphere.
"STANAG" A tropospheric model described in the NATO Standard Agreement

STANAG 4294 Issue 1.

Atmospheric effects and ionospheric errors settings
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"MOPS-DO-229D"
The minimum operational performance standard (MOPS) is a tropo-
spheric model used by the SBAS systems.
The model is based on a mapping function or wet and dry tropo-
sphere.

Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:TROPospheric:MODel on page 401

Ionospheric Model ← Atmosphere
Sets ionospheric model used by the channel simulation.
The selected model applies for all satellites, irrespectively to the navigation standards
they belong to.
"Klobuchar" Klobuchar is the correction model used by GPS.

Although the Klobuchar algorithm estimates the ionospheric delay in
the GPS L1 frequency signal, it can be also used for delay estima-
tions for any GNSS signal.
See "Klobuchar Parameters" on page 203.

"NeQuick" NeQuick is the correction model proposed by Galileo, but the iono-
spheric corrections computed by the NeQuick can be used for any
GNSS signal.
NeQuick is a 3D time-dependent ionospheric electron density model.
It provides electron density in the ionosphere as a function of the
position (longitude, latitude and height), time (UTC or TOW) and the
solar activity. [1]
See "NeQuick Parameters" on page 204.

"MOPS-DO-229D"
The minimum operational performance standard (MOPS) is a model
used by the SBAS systems and based on a mapping function or wet
and dry troposphere.
See "MOPS-DO-229D" on page 205.

Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MODel on page 401

Klobuchar Parameters ← Atmosphere
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The Klobuchar model assumes that the vertical delays are constant values at night
time and follow a half-cosine function in daytime, see Figure 13-3.

Figure 13-3: Klobuchar ionospheric model

The amplitude and the period of this function depend on the receiver location and are
calculated from the eight broadcast coefficients "alpha_0 to alpha_3" and "beta_0 to
beta_3". These coefficients are included in the navigation message of the simulated
satellites.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:
ALPHa<ch0>:UNSCaled on page 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:
BETA<ch0>:UNSCaled on page 405

NeQuick Parameters ← Atmosphere

The NeQuick model provides electron density in the ionosphere as a function of the
position (longitude, latitude and height), time (UTC or TOW) and the solar activity.
It is based on the original profiler proposed by Di Giovanni and Radicella, 1990. The
NeQuick FORTRAN 77 code is available for download at the website of the Interna-
tional Telecommunication Union Radiocommunication Sector (ITU-R).

Atmospheric effects and ionospheric errors settings
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The solar activity is defined with one of the following parameters:
● "Solar Flux"

Flux level generated by the sun at the earth's orbit at a 10.7 cm wavelength (F10.7)
● "Sunspot Number R12"

Averaged sunspot number R12.
You can set the R12 value or, if the "Simulation Time" is within the period form year
1931 to year 2001, use real R12 values.
("Use Measured Sunspot Number R12 > On").

Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SFLux
on page 401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:UMSN
on page 402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SUNSpot
on page 401

MOPS-DO-229D ← Atmosphere
The simulation of ionospheric delays follows the pierce point interpolation technique
described in the RTCA MOPS DO-229.

Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:FILE
on page 402

View Type ← MOPS-DO-229D ← Atmosphere
Toggles between indication of the vertical delay and GIVEI values.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay
on page 402

Import Grid ← MOPS-DO-229D ← Atmosphere
Access: Select "Import Grid > Add File/Add Directory > select the files > Import".

Atmospheric effects and ionospheric errors settings
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Accesses the standard file import dialog for loading predefined and user-defined SBAS
files or ionospheric grid files (*.iono_grid). The ionospheric grid information is
replaced at once.
If more than one file is selected, the ionospheric grid information is aggregated. Com-
bining ionospheric grids allows you to create an ionospheric grid covering the entire
world map.
Provided functions are self-explanatory; for details, see Example"Importing grid files"
on page 399.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:
FILE:EMS on page 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:
FILE:GRID on page 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:
FILE:NSTB on page 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:
DIR on page 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?
on page 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:
EXECute on page 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:
REMove:ALL on page 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:
REMove:FILE<ch> on page 404

Edit Grid ← MOPS-DO-229D ← Atmosphere
Changes the ionospheric vertical delay and GIVEI values for a particular position on
the map.
Changes are applied immediately.
To save the ionospheric grid, select "Export Grid".
To restore the predefined ionospheric grid for the MOPS-DO-229 model, select "Import
Grid > Add File > Predefined Files > 19_02_14_mixed > Import".

Atmospheric effects and ionospheric errors settings
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Time Scale, Time Select ← Edit Grid ← MOPS-DO-229D ← Atmosphere
Displays a time scale (the gray bar) and the current time span (the orange bar).
An arrow indicates the current time ("Time Select").
Projection mechanism ensures that you can select any simulation date. Hence, date
information is irrelevant and not displayed.

Insert/Delete Page ← Edit Grid ← MOPS-DO-229D ← Atmosphere
"Insert Page" splits the current page at the current "Time Select" moment.
"Delete Page" removes the current page; the time span of the previous page is exten-
ded and the content of the new page corresponds to the content of the previous page.

View Type ← Edit Grid ← MOPS-DO-229D ← Atmosphere
Toggles between indication of the vertical delay and GIVEI values.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay
on page 402

Longitude, Latitude ← Edit Grid ← MOPS-DO-229D ← Atmosphere
Indicates the geographic coordinated of the selected ionospheric grid point IGP.

GIVEI/Vertical Delay ← Edit Grid ← MOPS-DO-229D ← Atmosphere
Sets the grid ionospheric vertical error indicator "GIVEI" and the "Vertical Delay" values
of the current IGP.
Changes are applied immediately.
To save the ionospheric grid, select "Export Grid".
To restore the predefined ionospheric grid for the MOPS-DO-229 model, select "Import
Grid > Add File > Predefined Files > 19_02_14_mixed > Import".

Plot Vertical Delays/Plot IGP ← MOPS-DO-229D ← Atmosphere
Displays the 24h vertical delay or GIVEI distribution functions.

Atmospheric effects and ionospheric errors settings
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Access: select a particular position on the "Ionospheric Grid" map and select "Plot
IGP".

Figure 13-4: Example: 24h vertical delay distribution for a given position (the curve shows the MOPS-
DO-229D distribution)

"Longitude, Latitude"
Scrolls between the grid points.

"Display" Toggles between indication of the vertical delay and GIVEI values.
The plot displays the variation of these values over a 24-hour time
period.

Export Grid ← MOPS-DO-229D ← Atmosphere
Access: select "Export Grid > set the filename > Export".
Standard dialog for file handling; provided functions are self-explanatory. Filename is
user-definable, file extension *.iono_grid is assigned automatically.

Use this function to save current ionospheric grid. Files created in this way can be
reloaded with the Import Grid function.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort
on page 403

Show Earth Grid ← Atmosphere
Requires "Ionospheric Model > Klobuchar/NeQuick".
Accesses the dialog that displays the earth grid for ionospheric models Klobuchar or
NeQuick.

GPS > Ionosphere
Comprises the parameters of the GPS satellites.

Atmospheric effects and ionospheric errors settings
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Table 13-1: LNAV and CNAV

Parameter Remote command:

"Alpha0" to "Alpha3" [:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:
NMESsage:LNAV:IONospheric:ALPHa<ch0> on page 530

"Beta0" to "Beta3" [:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:
NMESsage:LNAV:IONospheric:BETA<ch0> on page 532

Galileo > Ionosphere
Comprises the parameters of the Galileo satellites.
Table 13-2: INAV and FNAV

Parameter Remote command:

"ai0" to "ai2" [:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:
NMESsage:INAV:IONospheric:AI<ch0> on page 531

"SF1" to "SF5" [:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:
NMESsage:INAV:IONospheric:SF<ch> on page 532

BeiDou > Ionosphere
Comprises the parameters of the BeiDou satellites.
Table 13-3: DNAV and CNAV

Parameter Remote command:

"Alpha0 - Alpha3" [:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:
NMESsage:DNAV:IONospheric:ALPHa<ch0> on page 530

"Beta0 - Beta3" [:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:
NMESsage:DNAV:IONospheric:BETA<ch0> on page 531

QZSS > Ionosphere
Comprises the parameters of the QZSS satellites.
Table 13-4: NAV and CNAV

Parameter Remote command:

"Alpha0" to "Alpha3" [:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:
NMESsage:NAV:IONospheric:ALPHa<ch0> on page 530

"Beta0" to "Beta3" [:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:
NMESsage:NAV:IONospheric:BETA<ch0> on page 531

NavIC > Ionosphere
Comprises the parameters of the NavIC satellites.

Parameter Remote command:

"Alpha0" to "Alpha3" [:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:
NMESsage:NAV:IONospheric:ALPHa<ch0> on page 530

"Beta0" to "Beta3" [:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:
NMESsage:NAV:IONospheric:BETA<ch0> on page 531
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Show Scaled Values
Switches between scaled and unscaled values representation.
Navigation message values are recalculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SSValues on page 450

13.5  Pseudorange errors settings

Access:

1. Select "Simulation Configuration > Satellites".

2. Select the GNSS system for that you want to configure satellites constellation, for
example GPS.

3. Select "SV# > SV Config".

4. In the "SV Configuration" dialog, select "Pseudorange Errors".

5. Select, for example, "Error Mode > Profile".

6. Define the errors in the table.

For "Error Mode = Profile or Constant", a pseudorange error plot indicates the error
variation over time.

Settings

Error Mode...................................................................................................................211
Copy to,SV-ID..............................................................................................................211
Value............................................................................................................................211
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Start Time Offset..........................................................................................................211
Pseudorange Errors File............................................................................................. 212
Profile Table................................................................................................................ 212

Error Mode
Defines how the pseudorange errors are specified:
"Constant" Applied is the constant pseudorange error set with the parameter

Value.
"Profile" The pseudorange errors are defined in table form, see "Profile Table"

on page 212.
"From SBAS" If "Simulation Configuration > Satellites > SBAS > Error Correction

Mode > Real Historical data and Sync Atmosphere & SVs Errors",
pseudorange errors are extracted from the imported SBAS correction
flies.
All other pseudorange error modes are disabled.

"File" Loads pseudorange error information from a file with extension
*.rs_perr.
To load a file, click "Pseudorange Errors File" and select the file from
the standard "File Select" dialog.

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:MODE on page 461
(etc. for the other GNSS systems)

Copy to,SV-ID
Applies the pseudorange errors of the current satellite to selected or to all SV-IDs.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:SVID on page 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:EXECute
on page 463
(etc. for the other GNSS systems)

Value
Sets a constant pseudorange error value.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:VALue on page 463
(etc. for the other GNSS systems)

Start Time Offset
Applies a delay and shifts the pseudorange error profile in time, for example to allow
the receiver under test to calculate a position fix. Suitable start time offsets are then
longer than the TTFF time.
"Start Time Offset = 0" corresponds to the simulation start time, as defined with the
parameter Simulation Start.
Observe the pseudorange error plot.

Pseudorange errors settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:OFFSet
on page 464
(etc. for the other GNSS systems)

Pseudorange Errors File
Requires "Error Mode > File".
Accesses a standard "File Select" dialog to select pseudorange error files with exten-
sion *.rs_perr.

Remote command: 
[:SOURce<hw>]:BB:GNSS:PERRors:CATalog on page 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:FILE on page 461
(etc. for the other GNSS systems)

Profile Table
A pseudorange error profile is described as a sequence of up to 10 errors defined in
table form.
"Time" Reference time of the error.

The value is set relative to the sum of the simulation start time and
the Start Time Offset.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:
PROFile<gr>:REFerence on page 465
(etc. for the other GNSS systems)

"Value" A positive or negative pseudorange error.
The last "Value" is repeated constantly.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:
PROFile<gr>:VALue on page 466
(etc. for the other GNSS systems)

"Insert" Inserts a row above the selected one.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:
PROFile<gr>:INSert on page 466
(etc. for the other GNSS systems)

"Delete" Removes the selected row.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:
PROFile<gr>:DELete on page 467
(etc. for the other GNSS systems)

Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:COUNt?
on page 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:APPend
on page 464
(etc. for the other GNSS systems)

Pseudorange errors settings
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13.6  Orbit and orbit perturbation errors settings

Access:

1. Select "Simulation Configuration > Satellites".

2. Select the GNSS system for that you want simulate system errors, for example
GPS.

3. Select "SV# > SV Config > Signals Configuration".

4. Select real navigation data as data source.
For example, for a GPS SV ID, select "Nav Msg Type > LNAV".

5. Select "Nav Msg Control > Edit".

6. Select "Nav Msg Content > Config > Orbit".

Per default, the navigation message parameters are set to values corresponding to
the values retrieved from the constellation data source.

Figure 13-5: Satellite orbit: Understanding the displayed information

1 = Issue of data, IODE and reference time, t0e

2 = Orbit elements
3 = Rate parameters

Changing these values leads to deviation between the simulated and the broad-
casted navigation message and thus deliberated errors. The generated signal can
be used for testing the receiver's ability to cope with errors. SBAS corrections can
be activated for error compensation.
Available navigation message parameters depend GNSS system and selected
navigation message type, see Chapter 13.3.2, "About orbit and orbit perturbation
parameters and errors", on page 198.

Orbit and orbit perturbation errors settings
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Settings

GPS > Orbit.................................................................................................................214
GPS > Orbit Perturbation............................................................................................ 215
Galileo > Orbit............................................................................................................. 215
Galileo > Orbit Perturbation.........................................................................................216
GLONASS > Orbit.......................................................................................................216
BeiDou > Orbit.............................................................................................................217
BeiDou > Orbit Perturbation........................................................................................218
QZSS > Orbit...............................................................................................................218
QZSS > Orbit Perturbation..........................................................................................219
NavIC > Orbit.............................................................................................................. 220
NavIC > Orbit Perturbation..........................................................................................220
Show Scaled Values....................................................................................................221

GPS > Orbit
Comprises the orbit parameters of the GPS satellites.
Table 13-5: LNAV and CNAV

Parameter Remote command:

"Reference Time of Ephemeris - t0e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:TOE on page 488

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:SQRA on page 489

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:ECCentricity on page 490

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:IZERo on page 491

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:OZERo on page 492

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:OMEGa on page 493

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:MZERo on page 494

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:IDOT on page 495

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:ODOT on page 495

Table 13-6: LNAV

Parameter Remote command:

"Issue of Data, Ephemeris - IODE" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:IODE on page 487

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:NDELta on page 497
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Table 13-7: CNAV

Parameter Remote command:

"Rate of Right Ascension Diff. - ΔΩ'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:DODot on page 496

"Mean Motion Difference - Δn0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:NDELta on page 497

"Rate of Mean Motion Diff. - Δn0'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:DNDot on page 497

"Change Rate in Semi-major Axis - A'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:ADOT on page 497

"Semi-Major Axis Difference - ΔA" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:ADELta on page 498

GPS > Orbit Perturbation
Comprises the parameters of the GPS satellites.
Table 13-8: LNAV and CNAV

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CUC on page 501

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CUS on page 502

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CRC on page 503

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CRS on page 504

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CIC on page 505

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:CIS on page 506

Galileo > Orbit
Comprises the parameters of the Galileo satellites.
Table 13-9: INAV and FNAV

Parameter Remote command:

"IODnav" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:IODNav on page 487

"Reference Time of Ephemeris - t0e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:TOE on page 488

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:SQRA on page 489

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:ECCentricity on page 490
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Parameter Remote command:

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:IZERo on page 491

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:OZERo on page 492

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:OMEGa on page 492

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:MZERo on page 493

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:IDOT on page 494

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:ODOT on page 495

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:NDELta on page 496

Galileo > Orbit Perturbation
Comprises the parameters of the Galileo satellites.
Table 13-10: INAV and FNAV

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CUC on page 501

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CUS on page 502

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CRC on page 503

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CRS on page 504

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CIC on page 504

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:CIS on page 505

GLONASS > Orbit
Comprises the parameters of the GLONASS satellites.
See also Chapter 13.3.2, "About orbit and orbit perturbation parameters and errors",
on page 198.
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Parameter Remote command:

"tb Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TINDex on page 499

"Time of Day - tb / tb Interval" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TOE? on page 498

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TINTerval? on page 498

"Xn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:XN on page 499

"Yn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:YN on page 499

"Zn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:ZN on page 499

"X'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:XDN on page 500

"Y'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:YDN on page 500

"Z'n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:ZDN on page 500

"X''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:XDDN on page 500

"Y''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:YDDN on page 500

"Z''n" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:ZDDN on page 500

BeiDou > Orbit
Comprises the parameters of the BeiDou satellites.
Table 13-11: DNAV and CNAV

Parameter Remote command:

"AODE" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:IODE on page 487

"Reference Time of Ephemeris - t0e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:TOE on page 488

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:SQRA on page 489

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:ECCentricity on page 490

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:IZERo on page 491

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:OZERo on page 492
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Parameter Remote command:

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:OMEGa on page 493

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:MZERo on page 493

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:IDOT on page 494

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:ODOT on page 495

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:NDELta on page 496

BeiDou > Orbit Perturbation
Comprises the parameters of the BeiDou satellites.
Table 13-12: DNAV and CNAV

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CUC on page 501

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CUS on page 502

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CRC on page 503

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CRS on page 504

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CIC on page 505

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:CIS on page 505

QZSS > Orbit
Comprises the parameters of the QZSS satellites.
Table 13-13: LNAV and CNAV

Parameter Remote command:

"Reference Time of Ephemeris - t0e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:TOE on page 488

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:SQRA on page 489

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:ECCentricity on page 490

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:IZERo on page 491

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:OZERo on page 491
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Parameter Remote command:

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:OMEGa on page 492

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:MZERo:UNSCaled on page 493

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:IDOT on page 494

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:ODOT:UNSCaled on page 495

Table 13-14: LNAV

Parameter Remote command:

"Issue of Data, Ephemeris - IODE" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:IODE on page 487

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:NDELta on page 496

Table 13-15: CNAV

Parameter Remote command:

"Rate of Right Ascension Diff. - ΔΩ'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:DODot on page 496

"Mean Motion Difference - Δn0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:NDELta on page 496

"Rate of Mean Motion Diff. - Δn0'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:DNDot on page 497

"Change Rate in Semi-major Axis - A'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:ADOT on page 497

"Semi-Major Axis Difference - ΔA" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:ADELta on page 498

QZSS > Orbit Perturbation
Comprises the parameters of the QZSS satellites.
Table 13-16: LNAV and CNAV

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CUC on page 501

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CUS on page 502

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CRC on page 502

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CRS:UNSCaled on page 503
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Parameter Remote command:

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CIC on page 504

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CIS on page 505

NavIC > Orbit
Comprises the orbit parameters of the NavIC satellites.

Parameter Remote command:

"Issue of Data, Ephemeris & Clock -
IODEC"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:IODE on page 487

"Reference Time of Ephemeris - t0e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:TOE on page 488

"Square Root of Semi-Major Axis - A1/2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:SQRA on page 489

"Eccentricity - e" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:ECCentricity on page 489

"Inclination Angle - i0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:IZERo on page 490

"Longitude of Ascending Node - Ω0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:OZERo on page 491

"Argument of Perigee - ω" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:OMEGa on page 492

"Mean Anomaly - M0" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:MZERo on page 493

"Rate of Inclination Angle - i'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:IDOT on page 494

"Rate of Right Ascension - Ω'" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:ODOT on page 495

"Mean Motion Difference - Δn" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:NDELta:UNSCaled on page 496

NavIC > Orbit Perturbation
Comprises the parameters of the NavIC satellites.

Parameter Remote command:

"Cosine Difference of Latitude - Cuc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CUC on page 501

"Sine Difference of Latitude - Cus" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CUS on page 501

"Cosine Difference of Orbital Radius - Crc" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CRC on page 502
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Parameter Remote command:

"Sine Difference of Orbital Radius - Crs" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CRS on page 503

"Cosine Difference of Inclination - Cic" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CIC on page 504

"Sine Difference of Inclination - Cis" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:CIS on page 505

Show Scaled Values
Switches between scaled and unscaled values representation.
Navigation message values are recalculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SSValues on page 450

13.7  Clock errors settings

Access:

1. Select "Simulation Configuration > Satellites > GNSS system > SV# > SV Config >
Signals Configuration".

2. Select "Nav Msg Control > Edit".

3. Select "Nav Msg Content > Config > Clock".

Per default, the navigation message parameters are set to values corresponding to
the values retrieved from the constellation data source.

Changing these values leads to deviation between the simulated and the broad-
casted navigation message and thus deliberated errors. The generated signal can
be used for testing the receiver's ability to cope with errors.
SBAS corrections can be activated for error compensation.
Available navigation message parameters depend GNSS system and selected
navigation message type, see Chapter 13.3.3, "About clock and time conversion
parameters and errors", on page 199.

Clock errors settings
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Settings

GPS > Clock................................................................................................................222
Galileo > Clock............................................................................................................222
GLONASS > Clock......................................................................................................223
BeiDou > Clock........................................................................................................... 223
QZSS > Clock............................................................................................................. 224
NavIC > Clock............................................................................................................. 224
Show Scaled Values....................................................................................................225

GPS > Clock
Comprises the parameters of the GPS satellites.
Table 13-17: LNAV and CNAV

Parameter Remote command:

"Reference Time of Clock - t0c" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:CCORrection:TOC on page 507

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:CCORrection:AF<s2us0> on page 508

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:CCORrection:TGD on page 509

Table 13-18: LNAV

Parameter Remote command:

"Issue of Data, Clock - IODC" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:IODC on page 506

Table 13-19: CNAV

Parameter Remote command:

"ISCL1C/A" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:CCORection:ISC:L1CA on page 509

"ISCL2C" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:CCORection:ISC:L2C on page 509

"ISCL5I5" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:CCORection:ISC:L5I on page 509

"ISCL5Q5" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:CCORection:ISC:L5Q on page 509

Galileo > Clock
Comprises the clock parameters of the Galileo satellites.
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Table 13-20: INAV and FNAV

Parameter Remote command:

"Time of Clock - t0c (E1-E5A)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:CCORrection:TOC on page 506

"af0 (E1-E5A)" to "af2 (E1-E5A)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:CCORrection:AF<s2us0> on page 507

"Broadcast Group Delay - BGD (E1-E5A)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:CCORrection:BGDA on page 510

Table 13-21: INAV

Parameter Remote command:

"Broadcast Group Delay - BGD (E1-E5B)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:CCORrection:BGDB on page 510

GLONASS > Clock
Comprises the parameters of the GLONASS satellites.

Parameter Remote command:

"Time of Day - tb" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TOE? on page 498

"tb Interval" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TINTerval? on page 498

"τn (-af0)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:CCORrection:TAUN on page 510

"γn (af1)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:CCORrection:GAMN on page 510

"Δτn (Tgd)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:CCORrection:DTAU on page 510

BeiDou > Clock
Comprises the parameters of the BeiDou satellites.
Table 13-22: DNAV and CNAV

Parameter Remote command:

"ReferenceTime of Clock - t0c" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:CCORrection:TOC on page 507

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:CCORrection:AF<s2us0> on page 508
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Table 13-23: DNAV

Parameter Remote command:

"AODC" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:IODC on page 506

"Group Delay B1| - TGD1", "Group Delay
B2| - TGD2"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:CCORrection:TGD<s2us> on page 508

Table 13-24: CNAV

Parameter Remote command:

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:CNAV:CCORrection:TGD on page 508

QZSS > Clock
Comprises the parameters of the QZSS satellites.
Table 13-25: LNAV and CNAV

Parameter Remote command:

"Reference Time of Clock - t0c" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:CCORrection:TOC on page 506

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:CCORrection:AF<s2us0> on page 507

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:CCORrection:TGD on page 508

Table 13-26: LNAV

Parameter Remote command:

"Issue of Data, Clock - IODC" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:IODC on page 506

Table 13-27: CNAV

Parameter Remote command:

"ISCL1C/A" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:CCORection:ISC:L1CA on page 509

"ISCL2C" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:CCORection:ISC:L2C on page 509

"ISCL5I5" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:CCORection:ISC:L5I on page 509

"ISCL5Q5" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:CCORection:ISC:L5Q on page 509

NavIC > Clock
Comprises the parameters of the NavIC satellites.
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Parameter Remote command:

"Reference Time of Clock - t0c" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:CCORrection:TOC on page 506

"af0" to "af2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:CCORrection:AF<s2us0> on page 507

"Group Delay - Tgd" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:CCORrection:TGD on page 508

Show Scaled Values
Switches between scaled and unscaled values representation.
Navigation message values are recalculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SSValues on page 450

13.8  Time conversion errors settings

Access:

1. Select "Simulation Configuration > Satellites > GNSS system > SV# > SV Config >
Signals Configuration".

2. Select "Nav Msg Control > Edit".

3. Select "Nav Msg Content > Config > Time Conversion".

Time conversion parameters are read-only and common for all SV of one GNSS
system.

4. To change the time conversion parameters of all GPS SVs for example, select
"SV# > SV Config" > "Copy Modulation Control to SV-ID = All".

Per default, the navigation message parameters are set to values corresponding to
the values retrieved from the constellation data source.

Changing these values leads to deviation between the simulated and the broad-
casted navigation message and thus deliberated errors. SBAS corrections can be
activated for error compensation.

Time conversion errors settings
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Available navigation message parameters depend GNSS system and selected
navigation message type.

Settings

GPS > Time Conversion............................................................................................. 226
Galileo > Time Conversion..........................................................................................227
GLONASS > Time Conversion....................................................................................227
BeiDou > Time Conversion......................................................................................... 228
QZSS > Time Conversion........................................................................................... 229
NavIC > Time Conversion........................................................................................... 229
Show Scaled Values....................................................................................................230

GPS > Time Conversion
Comprises the parameters of the GPS satellites.
Table 13-28: GPS - UTC (LNAV and CNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:
TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:
TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:
TIME:CONVersion:UTC:AZERo on page 524

"A1" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:
TIME:CONVersion:UTC:AONE on page 523

Table 13-29: GPS - UTC (CNAV)

Parameter Remote command:

"A2" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:UTC:ATWO on page 522

Table 13-30: GPS - Galileo (CNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GALileo:WNOT on page 527

"Tot" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GALileo:TOT on page 527

"A0" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GALileo:AZERo on page 528

"A1" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GALileo:AONE on page 528

"A2" [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GALileo:ATWO on page 528
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Table 13-31: GPS - GLONASS (CNAV)

Parameter Remote command:

WNot [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GLONass:WNOT on page 528

Tot [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GLONass:TOT on page 529

A0 [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GLONass:AZERo on page 529

A1 [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GLONass:AONE on page 529

A2 [:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:
TIME:CONVersion:GLONass:ATWO on page 530

Galileo > Time Conversion
Comprises the parameters of the Galileo satellites.
Table 13-32: Galileo - UTC (INAV and FNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:UTC:AZERo on page 524

"A1" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:UTC:AONE on page 523

Table 13-33: Galileo - GPS (INAV and FNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:GPS:WNOT on page 525

"Tot" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:GPS:TOT on page 525

"A0" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:GPS:AZERo on page 526

"A1" [:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:
INAV:TIME:CONVersion:GPS:AONE on page 526

GLONASS > Time Conversion
Comprises the parameters of the GLONASS satellites.
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Parameter Remote command:

"τc (-A0)" [:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:
TIME:CONVersion:UTC:AZERo on page 524

"γn (A1)" [:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:
TIME:CONVersion:UTC:AONE on page 523

"τGPS (A0)" [:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:
TIME:CONVersion:GPS:AZERo on page 525

BeiDou > Time Conversion
Comprises the parameters of the BeiDou satellites.
Table 13-34: BeiDou - UTC (DNAV and CNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:UTC:AZERo on page 524

"A1" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:UTC:AONE on page 523

Table 13-35: BeiDou - GPS (DNAV and CNAV)

Parameter Remote command:

"A0" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GPS:AZERo on page 526

"A1" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GPS:AONE on page 526

Table 13-36: BeiDou - Galileo (DNAV and CNAV)

Parameter Remote command:

"A0" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GALileo:AZERo on page 527

"A1" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GALileo:AONE on page 528

Table 13-37: BeiDou - GLONASS (DNAV and CNAV)

Parameter Remote command:

"A0" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GLONass:AZERo on page 529

"A1" [:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:
TIME:CONVersion:GLONass:AONE on page 529
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QZSS > Time Conversion
Comprises the parameters of the QZSS satellites.
Table 13-38: QZSS - UTC (CNAV)

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:
TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:
TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:
TIME:CONVersion:UTC:AZERo on page 524

"A1" [:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:
TIME:CONVersion:UTC:AONE on page 522

"A2" [:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:
TIME:CONVersion:UTC:ATWO on page 522

NavIC > Time Conversion
Comprises the parameters of the NavIC satellites.
Table 13-39: NavIC - UTC

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:UTC:AZERo on page 523

"A1" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:UTC:AONE on page 522

"A2" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:UTC:ATWO on page 521

Table 13-40: NavIC - GPS

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:GPS:WNOT on page 525

"Tot" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:GPS:TOT on page 525

"A0" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:GPS:AZERo on page 525

"A1" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:GPS:AONE on page 526

"A2" [:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:
TIME:CONVersion:GPS:ATWO on page 527
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Show Scaled Values
Switches between scaled and unscaled values representation.
Navigation message values are recalculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SSValues on page 450

13.9  System errors settings

Access:

1. Select "Simulation Configuration > Satellites > GNSS system > SV# > SV Config >
Signals Configuration".

2. Select real navigation data as data source.
For example, for a GPS SV ID, select "Nav Msg Type > LNAV".

3. Select "Nav Msg Control > Edit".

4. Select "Nav Msg Content > Config > Additional Data".

Per default, the navigation message parameters are set to values corresponding to
the values retrieved from the constellation data source.

Available navigation message parameters depend GNSS system and selected
navigation message type.

5. To simulate errors, change the values.
For example, set "User Range Accuracy Index (URA) = 12".

With this URA index, the selected SV is set to unvisible.

Changing any navigation message value leads to deviation between the simulated
and the broadcasted navigation message and thus to a deliberated error.
The generated signal can be used for testing the receiver's ability to cope with
errors.
SBAS corrections can be activated for error compensation.

System errors settings
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Settings

GPS > Additional Data................................................................................................ 231
Galileo > Additional Data.............................................................................................232
GLONASS > Additional Data...................................................................................... 233
BeiDou > Additional Data............................................................................................233
QZSS > Additional Data..............................................................................................234
NavIC > Additional Data..............................................................................................235
Show Scaled Values....................................................................................................235

GPS > Additional Data
Comprises the parameters of the GPS satellites.
Table 13-41: LNAV

Parameter Remote command:

"SV Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:HEALth on page 513

"User Range Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:URA on page 514

"Anti-Spoofing Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:ASFLag on page 514

"SV Config" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:SVConfig on page 514

"Code On L2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:CLTMode on page 514

"L2 P Data Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:LTPData on page 515

"Fit Interval Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:FIFLag on page 515

"Age of Data Offset" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:AODO? on page 515

"Subframe 1, Reserved 1 (23 bits, Word 4")

"Subframe 1, Reserved 2 (24 bits, Word 5")

"Subframe 1, Reserved 3 (24 bits, Word 6")

"Subframe 1, Reserved 4 (16 bits, Word 7")

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:LNAV:EPHemeris:SF1Reserved<s2us>?
on page 515

Table 13-42: CNAV

Parameter Remote command:

"Alert Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:ALERt on page 511

"L1 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:L1Health on page 511

"L2 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:L2Health on page 511
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Parameter Remote command:

"L5 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:L5Health on page 511

"ED Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:URA on page 514

"NED Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:NED0 on page 511

"NED Accuracy Change Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:NED1 on page 512

"NED Accuracy Change Rate Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:NED2 on page 512

"Data Predict Week Number -WNop" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:WNOP on page 512

"Data Predict Time of Week - top" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:TOP on page 512

"Integrity Status Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:ISFLag on page 512

"L2C Phasing" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
NMESsage:CNAV:EPHemeris:L2CPhasing on page 513

Galileo > Additional Data
Comprises the parameters of the Galileo satellites.
Table 13-43: INAV

Parameter Remote command:

"Signal in Space Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:SISA on page 516

"Data Validity Status - E1BDVS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E1BDVS on page 516

"Data Validity Status - E5bDVS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E5BDVS on page 516

"Signal Health Status - E1BHS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E1BHS on page 516

"Signal Health Status - E5bHS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E5BHS on page 516

"SAR configuration"

"Mode" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:SAR:MODE on page 517

"RLM Data 1" to "RLM Data 4/8"

(requires "Mode > Short/Long RLM)"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:SAR:RLM<s2us>
on page 517

"Spare Data"

(requires "Mode > Spare)"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:EPHemeris:SAR:SPARe on page 518

System errors settings
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Table 13-44: FNAV

Parameter Remote command:

"Signal in Space Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:FNAV:EPHemeris:SISA on page 516

"Data Validity Status - E5aDVS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:FNAV:E5ADVS on page 518

"Signal Health Status - E5aHS" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:FNAV:E5AHS on page 518

GLONASS > Additional Data
Comprises the parameters of the GLONASS satellites.

Parameter Remote command:

"SV Health - Bn(ln)" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:HEALth on page 513

"User Range Accuracy - FT" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:URA on page 514

"Satellite Ephemeris Type - M" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:SEType on page 518

"CDMA Field M" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:CFM on page 519

"Satellite Operation mode - P" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:P on page 519

"Age of Ephemeris Page - P1" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:AOEP on page 519

"tb Alignment - P2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:TALignment on page 519

"En" [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:CCORrection:EN on page 519

BeiDou > Additional Data
Comprises the parameters of the BeiDou satellites.
Table 13-45: DNAV

Parameter Remote command:

"SV Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:HEALth on page 513

"User Range Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:DNAV:EPHemeris:URA on page 514

Table 13-46: CNAV

Parameter Remote command:

"Alert Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:
NMESsage:CNAV:EPHemeris:ALERt on page 511

System errors settings



Perturbations and errors simulationSatellite Navigation

234User Manual 1178.9403.02 ─ 10

QZSS > Additional Data
Comprises the parameters of the QZSS satellites.
Table 13-47: LNAV

Parameter Remote command:

"SV Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:HEALth on page 513

"User Range Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:URA on page 514

"SV Config" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:SVConfig on page 514

"Code On L2" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:CLTMode on page 514

"L2 P Data Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:LTPData on page 515

"Fit Interval Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:FIFLag on page 515

"Age of Data Offset" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:AODO? on page 515

"Subframe 1, Reserved 1" to "Subframe
1, Reserved 4"

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:SF1Reserved<s2us>? on page 515

Table 13-48: CNAV

Parameter Remote command:

"Alert Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:ALERt on page 511

"L1 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:L1Health on page 511

"L2 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:L2Health on page 511

"L5 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:L5Health on page 511

"ED Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:URA on page 514

"NED Accuracy Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:NED0 on page 511

"NED Accuracy Change Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:NED1 on page 511

"NED Accuracy Change Rate Index" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:NED2 on page 511

"Integrity Status Flag" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:ISFLag on page 512

"L2C Phasing" [:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
CNAV:EPHemeris:L2CPhasing on page 513
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NavIC > Additional Data
Comprises the parameters of the NavIC satellites.

Parameter Remote command:

"L5 Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:L5Health on page 513

"S Health" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:SHEalth on page 513

"User Range Accuracy" [:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:
NAV:EPHemeris:URA on page 514

Show Scaled Values
Switches between scaled and unscaled values representation.
Navigation message values are recalculated automatically.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SSValues on page 450

System errors settings
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14  SBAS corrections
Option: R&S SMBVB-K44 and R&S SMBVB-K106

A short introduction to the satellite-based augmentation system (SBAS) is provided in
Chapter 2.3, "SBAS overview", on page 23. This section gives an overview of SBAS
features in the context of this software.

14.1  About SBAS

The SBAS uses three types of services to improve augmentation:
● Transmission of ranging information for improved visibility
● Broadcast of correction data (error estimations) for improved accuracy
● Broadcast of coarse integrity information for improved reliability

The SBAS specification RTCA MOPS DO-229 defines different message types that
carry these coarse integrities or both integrity and wide area correction data informa-
tion. The correction data can be fast, long-term and ionospheric, where:
● The fast corrections eliminate pseudorange errors
● The long-term corrections overcome errors in the satellites position or slow chang-

ing clock and ephemeris errors
● The ionospheric corrections are based on the user location

SBAS provides separate corrections for different error sources. In particular, SBAS cor-
rects the following errors: Ionospheric error, GPS satellite timing errors and GPS satel-
lite orbit errors. The latter two corrections are included for all GPS satellites that are
monitored by SBAS. The ionospheric errors are corrected if the satellite orbit crosses
the area covered by the SBAS iono grid points.

SBAS message types (MT)

According to RTCA MOPS DO-229, SBAS correction data is transmitted by a subset of
predefined message types. In this implementation, the SBAS information is not defined
on a message-by-message basis but grouped according to the SBAS service and cor-
rection data type.

The Table 14-1 list the SBAS message type with brief information on their content and
information on the section, describing the related settings.
Table 14-1: SBAS message types (MT)

MT Content Related settings

1 PRN masks assailments See Chapter 14.4.3.3, "PRN mask settings",
on page 252.

2 to 5 Fast corrections See Chapter 14.4.3.4, "Fast correction settings",
on page 253.

6 Integrity information Integrity information is included in Chapter 14.4.3.4,
"Fast correction settings", on page 253.

About SBAS
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MT Content Related settings

7 Fast correction degradation factor See Chapter 14.4.3.6, "Fast correction degradation
factor configuration settings", on page 257.

9 GEO navigation message See Chapter 14.4.2.2, "Broadcasted orbit, clock and
time conversion settings", on page 245.

10 Degradation parameters See "Degradation Factors" on page 263.

12 SBAS network time, UTC offset
parameters

See Chapter 4.1, "Time settings", on page 46.

17 GEO satellites almanacs See "Message Schedule" on page 262.

18 Ionospheric grid point mask Chapter 14.4.3.2, "Ionosphere grid settings",
on page 250.

24 Mixed fast and log-term correction
data

Not supported

25 Long-term satellite error correction
data

See Chapter 14.4.3.5, "Long-term correction file con-
figuration settings", on page 256.

26 Ionospheric delay corrections Chapter 14.4.3.2, "Ionosphere grid settings",
on page 250.

27 SBAS service message See "Service" on page 263.

28 Clock-Ephemeris covariance matrix
message

See Chapter 14.4.3.7, "Clock-ephemeris covariance
matrix configuration settings", on page 258.

8

11

13 to 16

19 to 23

29 to 61

Reserved -

(not simulated)

0

62

63

For SBAS testing only

Initial test message

Null message

-

(This message is filled in with empty timeslots
depending on the transmit period values selected for
the other message types.)

SBAS message scheduling

The SBAS messages are scheduled according to a user-defined period. The default
values reflect the timeouts specified in the specification RTCA MOPS DO-229.

Loading SBAS corrections

Similar to the constellation and navigation data files, you can load SBAS constellation
and correction files, for example, to reproduce a specific situation from the past.

For details, see Chapter 17.2, "Import SBAS settings", on page 286.

Assigning SBAS space vehicles

The assignment of an SBAS space vehicle (PRN) to the corresponding regional aug-
mentation system can change from time to time. You can assign up to six space vehi-
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cles to one individual regional system, see "Mapping SBAS space vehicles (PRN)"
on page 240. For related settings, see "SBAS PRN Mapping" on page 242.

14.2  About SBAS corrections

Applying SBAS corrections

Apply SBAS corrections, if you want to correct errors that result from errors of the
simulated navigation message. These corrections result in a corrected broadcasted
navigation message and improve simulation accuracy of the generated GNSS output
signal.

SBAS corrections are not necessary, if the simulated navigation message and the
broadcasted navigation messages match as they are (default configuration). Activating
SBAS does not improve the positioning accuracy of the GNSS receiver. If, for example,
the receiver under test does not support SBAS, you may observe a degradation of the
positioning performance of the receiver.

SBAS error correction data source

By default, SBAS error correction uses the correction data as defined in the SBAS nav-
igation message, see Chapter 14.4, "SBAS settings", on page 241.

Also, you can import SBAS correction data from *.nstb, *.ems or Rinex files. Select
the data source via "Import Constellation and Correction Data" in the satellite constella-
tion settings of the SBAS, see Chapter 14.4.1, "SBAS satellites settings", on page 242.

Corrections are applied automatically for atmosperic delays and satellite biases (pseu-
dorange and clock biases and satellite orbit errors).

Biases and corrections

The following corrections are applied automatically:
● ΔIonoSV

Vertical delay values, according to the ionospheric grid, broadcasted in the SBAS
messages

● ΔTropoSV

Corrections, as defined by MOPS-DO-229D
● ΔρSV = ΔρFast_corrections

Pseudorange bias corrections are the pseudorange corrections retrieved from the
SBAS fast correction data ("PRC")

● ΔtSV = Δtclk + ΔtLT_corrections

Clock corrections calculated as the sum of:
– The clock bias broadcasted by the SV itself (Δtclk)

– The corrections ΔtLT_corrections retrieved from the SBAS long-term correction data
("δaf0", "δaf1")

● ΔxLT_corrections, ΔyLT_corrections, ΔzLT_corrections

About SBAS corrections
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Correction information on the GEO satellite location retrieved from the SBAS long-
term correction data ("δx/δy/δz")

These corrections are used for the pseudorange and range calculations.

Pseudorange calculation

The pseudorange τSV is a function of the range ρSV and the corrections:

τSV = ρSV + ΔρSV + ΔIonoSV + ΔTropoSV - ΔtSV.

Where the range ρSV is:

ρSV = √[(xRX - xSV)2 + (yRX - ySV)2 + (zRX - zSV)2]

The SV position (xSV, ySV, zSV) is the sum of the ephemeris position (xeph, yeph, zeph) and
the long-term corrections (ΔxLT_corrections, ΔyLT_corrections, ΔzLT_corrections), for example.

xSV = xeph + ΔxLT_corrections

SBAS correction impact on the logged data

SBAS corrects the pseudorange, satellites and receiver position values. If data logging
is used, the logged values include the corrections. The logged data can deviate from
the expected not corrected parameters.

14.3  How to generate SBAS corrections

Activating SBAS

1. Select "System Configuration" > "Systems & Signals".

2. To activate the frequency band, select "L# Band" > "On".
For SBAS, you can activate the L1 band and L5 band.

3. To activate the SBAS, select "SBAS" > "EGNOS/WASS/MSAS/GAGAN" > "On" as
needed.

The figure below shows a configuration with activated L1 band and L5 band. Also
GPS, EGNOS, WASS, MSAS and GAGAN system are activated.

How to generate SBAS corrections
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Mapping SBAS space vehicles (PRN)

This step-by-step instruction describes, how to map individual SBAS space vehicles
("PRN xyz") to the EGNOS SBAS. Mapping to other SBAS is analogous.

1. To activate EGNOS, see "Activating SBAS" on page 239.

2. Select "Satellites" > "SBAS" > "SBAS PRN Mapping".
The dialog "SBAS PRN Mapping" opens. It allows you to map SBAS space vehi-
cles "PRN xyz" with SBAS systems.

By default, SBAS space vehicles and SBAS systems are mapped as described in
the table below.

SBAS SV ID / PRN      

EGNOS PRN 120 PRN 123 PRN 124 PRN 124 PRN 131 PRN 136

WAAS PRN 122 PRN 133 PRN 134 PRN 135 PRN 138 ---

MSAS PRN 129 PRN 137 --- --- --- ---

GAGAN PRN 127 PRN 128 --- --- --- ---

When changing the default mapping, note, that you can map a maximum of six
space vehicles to an individual SBAS system.

3. To change the default mapping of EGNOS space vehicles, proceed as follows.

How to generate SBAS corrections
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a) Deselect space vehicles "PRN xyz", that you do not want to be part of the
EGNOS constellation.
For "PRN 120", select, for example "SBAS System" > "---".

b) Add space vehicles, that you want to include in the EGNOS constellation.
For "PRN 125", select, for example, "SBAS System" > "EGNOS".
If the EGNOS constellation already includes six space vehicles, you cannot
select "EGNOS".

Applying real SBAS corrections

In the following, we use the default SBAS constellation and correction data. These cor-
rections are real SBAS data, downloaded from the SBAS server and applicable to the
default simulation time (2014-02-19).

1. Enable SBAS.

2. Select "Satellites > SBAS".

The SBAS corrections are configurable but the broadcast navigation message of
the GPS satellites cannot be edited. Atmospheric models and pseudorange param-
eters are retrieved from the SBAS corrections and cannot be edited, too.
The default SBAS corrections augment the default clock and orbit parameters of
the GPS satellites. If the simulated orbit and clock parameters are changed or
pseudorange errors are defined, the SBAS corrections have to be adjusted man-
ually.

3. Select "SBAS > SV ID > SV Config".

4. Select "Nav Msg Content > Config".

14.4  SBAS settings

The SBAS settings are distributed among several dialogs, depending on their type.
The SBAS satellites settings, for example, are located in the similar dialogs as the set-
tings of the GPS satellites. You access this dialog on the same way as you access the
dialogs of the other GNSS systems.

Common settings are thus described in the corresponding sections; cross-references
are provided wherever needed. This section focuses on the settings that are dedicated
to SBAS.

SBAS settings
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For step-by-step description, see Chapter 14.3, "How to generate SBAS corrections",
on page 239.

The remote commands required to define these settings are described in Chap-
ter 21.15, "SBAS corrections", on page 540.

● SBAS satellites settings........................................................................................ 242
● GEO ranging information...................................................................................... 243
● Differential corrections.......................................................................................... 248
● Additional SBAS system parameters.................................................................... 259

14.4.1  SBAS satellites settings

Access:

1. Select "GNSS Configuration" > "Systems & Signals".

2. Select "SBAS" > "EGNOS/WASS/MSAS/GAGAN" > "On"

3. Select "Satellites" > "SBAS".

SBAS PRN Mapping................................................................................................... 242
└ SBAS System............................................................................................... 243

SBAS PRN Mapping
Accesses the dialog "SBAS PRN Mapping" to map SBAS space vehicles "PRN xyz"
with SBAS systems.

SBAS settings
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How to: "Mapping SBAS space vehicles (PRN)" on page 240

SBAS System ← SBAS PRN Mapping
Maps the SBAS space vehicle "PRN xyz" with the SBAS system.
"PRN xyz" ranges from "PRN 120" to "PRN 150", so that you can map each of the 39
space vehicles to one individual SBAS system. For an individual space vehicle, "SBAS
System" > "---" means that this space vehicle is excluded from all SBAS constellations.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SYSTem on page 544

14.4.2  GEO ranging information

The SBAS GEO satellites transmit GPS-L1-like signals to extend the number of visible
satellites. The signals transmitted with this purpose are called ranging signals.

As for any other GNSS satellites, you can configure the simulated ranging information
of the GEO satellites and, if necessary, change the broadcasted ranging information.

● Simulated orbit and simulated clock settings........................................................ 243
● Broadcasted orbit, clock and time conversion settings......................................... 245

14.4.2.1  Simulated orbit and simulated clock settings

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > SV ID# > SV Config > Simulated Orbit".

SBAS settings
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3. Select "Satellites > SBAS > SV ID# > SV Config > Simulated Clock".

Settings:

Ground Track.............................................................................................................. 244
Simulated Orbit........................................................................................................... 244
Simulated Clock.......................................................................................................... 245

Ground Track
Displays a plot of the trajectory of the selected satellite.
To observe the aggregated ground tracks of all satellites, select "GNSS > Simulation
Monitor > Display = Satellites > Ground Track".

Simulated Orbit
Comprises the parameters of the EGNOS, WAAS, MSAS satellites.

Parameter Remote command:

"Reference Date" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:DATE on page 452

"Reference Time" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:TIME on page 453

"XG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:XN on page 451

"YG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:YN on page 451

"ZG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:ZN on page 451

"XG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:XDN on page 451
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Parameter Remote command:

"YG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:YDN on page 451

"ZG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:ZDN on page 451

"XG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:XDDN on page 451

"YG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:YDDN on page 451

"ZG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
ORBit:ZDDN on page 451

Simulated Clock
Comprises the parameters of the EGNOS, WAAS, MSAS satellites.

Parameter Remote command:

"Reference Date" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
CLOCk:DATE on page 452

"Reference Time" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
CLOCk:TIME on page 453

"aGf0", "aGf1" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:
CLOCk:AF<s2us0> on page 458

14.4.2.2  Broadcasted orbit, clock and time conversion settings

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

3. Select "SV# > SV Config > Signals Configuration".

4. Select "Nav Msg Control > Edit".

5. Select "Nav Msg Content > Config" > "Orbit".
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6. Open the "Clock", "Time Conversion" and "Additional Data" setting in the same
manner.

Per default, the navigation message parameters are set to values that correspond
to the values retrieved from the constellation data source.

Settings:

Orbit............................................................................................................................ 246
Clock........................................................................................................................... 247
Additional Data............................................................................................................247
Time Conversion......................................................................................................... 247

Orbit
Comprises the parameters of the EGNOS/WAAS/MSAS satellites.

Parameter Remote command:

"Time of Day" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:TOE on page 488

"XG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:XN on page 499

"YG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:YN on page 499

"ZG" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:ZN on page 499

"XG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:XDN on page 500

"YG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:YDN on page 499

"ZG Rate of Change" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:ZDN on page 499

"XG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:XDDN on page 500
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Parameter Remote command:

"YG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:YDDN on page 500

"ZG Acceleration" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:EPHemeris:ZDDN on page 500

Clock
Comprises the parameters of the EGNOS/WAAS/MSAS satellites.

Parameter Remote command:

"aGf0", "aGf1" [:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:
NAV:CCORrection:AF<s2us0> on page 507

Additional Data
The "User Range Accuracy Index" (URA) indicates statistically the SBAS satellite rang-
ing accuracy.
Satellites with "User Range Accuracy Index = 15", for example, are not used for posi-
tion estimation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:URA
on page 514

Time Conversion
Comprises the SBAS time conversion parameters.
Table 14-2: EGNOS - UTC

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:
NAV:TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:
NAV:TIME:CONVersion:UTC:TOT on page 521

"A0" [:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:
NAV:TIME:CONVersion:UTC:AZERo on page 523

"A1" [:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:
NAV:TIME:CONVersion:UTC:AONE on page 522

Table 14-3: GAGAN - UTC

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:
NAV:TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:
NAV:TIME:CONVersion:UTC:TOT on page 520
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Parameter Remote command:

"A0" [:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:
NAV:TIME:CONVersion:UTC:AZERo on page 523

"A1" [:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:
NAV:TIME:CONVersion:UTC:AONE on page 522

Table 14-4: MSAS - UTC

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:
NAV:TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:
NAV:TIME:CONVersion:UTC:TOT on page 520

"A0" [:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:
NAV:TIME:CONVersion:UTC:AZERo on page 523

"A1" [:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:
NAV:TIME:CONVersion:UTC:AONE on page 522

Table 14-5: WAAS - UTC

Parameter Remote command:

"WNot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:
NAV:TIME:CONVersion:UTC:WNOT on page 520

"Tot" [:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:
NAV:TIME:CONVersion:UTC:TOT on page 520

"A0" [:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:
NAV:TIME:CONVersion:UTC:AZERo on page 523

"A1" [:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:
NAV:TIME:CONVersion:UTC:AONE on page 522

14.4.3  Differential corrections

The SBAS GEO satellites broadcast additional correction data, known as differential
corrections, to the existing GNSS navigation messages to improve the positioning
accuracy. The differential corrections include corrections for the satellite orbits and
clocks, and ionospheric corrections.

● Timing setting of the differential corrections..........................................................249
● Ionosphere grid settings........................................................................................250
● PRN mask settings................................................................................................252
● Fast correction settings.........................................................................................253
● Long-term correction file configuration settings.................................................... 256
● Fast correction degradation factor configuration settings..................................... 257
● Clock-ephemeris covariance matrix configuration settings...................................258
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14.4.3.1  Timing setting of the differential corrections

Navigation and correction data are time-specific information and the SBAS parameters
are defined for a specific time span. In this implementation, the SBAS corrections are
valid for 24 hours and this time span is repeated infinitely. Projection mechanism
ensures that you can select any simulation date.

Time span

There is a time slider in each SBAS dialog. With this time slider, you can "scroll" over
the time and edit, for example, the correction data at a particular time. The time span is
displayed as a gray time bar with its start and end time. The orange bar indicates the
current time span for that the SBAS parameters apply.

Figure 14-1: Timing settings

Use the following functions to define the SBAS parameters for a specific time span:
● Set the "Time Select" value to define the start time (and the time span) the SBAS

parameters apply for.
● Insert a page to split the time span and define parameter changes at more precise

time granularity.

1 = "Time Select" defines the page split edge

● Remove pages to merge correction data

1 = "Time Select" defines the merge edge
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Settings:

Insert/Delete Page...................................................................................................... 250
Time Scale, Time Select..............................................................................................250

Insert/Delete Page
"Insert Page" splits the current page at the current "Time Select" moment.
"Delete Page" removes the current page; the time span of the previous page is exten-
ded and the content of the new page corresponds to the content of the previous page.

Time Scale, Time Select
Displays a time scale (the gray bar) and the current time span (the orange bar).
An arrow indicates the current time ("Time Select").
Projection mechanism ensures that you can select any simulation date. Hence, date
information is irrelevant and not displayed.

14.4.3.2  Ionosphere grid settings

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

3. Select "SV# > SV Config > Signals Configuration".

4. Select "Nav Msg Control > Edit".

5. Select "Nav Msg Content > Config" > "Ionosphere".
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The ionospheric grid contains the ionospheric delay correction parameters of MT
26. It also contains the ionospheric grid mask of MT 18, that is the grid of all moni-
tored squares.
MT 26 carries information on the vertical delays and their accuracy (σ2

GIVE) at geo-
graphically defined ionospheric grid points (IGP).
The "GIVEI" and "Vertical Delay" values are displayed as a color-coded grid. Not
monitored (NM) IGPs are indicated in gray.

Settings:

Longitude, Latitude......................................................................................................251
GIVEI/Vertical Delay....................................................................................................251
View Type....................................................................................................................251
Plot Vertical Delays/Plot IGP.......................................................................................251

Longitude, Latitude
Indicates the geographic coordinated of the selected ionospheric grid point IGP.

GIVEI/Vertical Delay
Sets the grid ionospheric vertical error indicator "GIVEI" and the "Vertical Delay" values
of the current IGP.
Changes are applied immediately.
To save the ionospheric grid, select "Export Grid".
To restore the predefined ionospheric grid for the MOPS-DO-229 model, select "Import
Grid > Add File > Predefined Files > 19_02_14_mixed > Import".

View Type
Toggles between indication of the vertical delay and GIVEI values.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay
on page 402

Plot Vertical Delays/Plot IGP
Displays the 24h vertical delay or GIVEI distribution functions.
Access: select a particular position on the "Ionospheric Grid" map and select "Plot
IGP".
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Figure 14-2: Example: 24h vertical delay distribution for a given position (the curve shows the MOPS-
DO-229D distribution)

"Longitude, Latitude"
Scrolls between the grid points.

"Display" Toggles between indication of the vertical delay and GIVEI values.
The plot displays the variation of these values over a 24-hour time
period.

14.4.3.3  PRN mask settings

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

3. Select "SV# > SV Config > Signals Configuration".

4. Select "Nav Msg Control > Edit".
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5. Select "Nav Msg Content > Config" > "Differential Corrections".

The PRN mask is a list of the SVs for which the fast and long-term correction data
apply.

Settings:

GNSS PRNs/SBAS PRNs, State................................................................................ 253

GNSS PRNs/SBAS PRNs, State
To enable an SV ID/PRN: select it and select "State > On".
Up to 51 satellites can be enabled, where an enabled satellite is indicated with blue
color.
It is, however, not necessary to change the PRN mask because currently, only GPS
and SBAS satellites are monitored; EGNOS and WAAS do not change the PRN mask.
In the future, when more GNSS systems are augmented, changing the PRN mask
would be necessary to define the 51 monitored SV ID/PRNs.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN<ch>:
STATe on page 544

14.4.3.4  Fast correction settings

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

3. Select "SV# > SV Config > Signals Configuration".

4. Select "Nav Msg Control > Edit".
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5. Select "Nav Msg Content > Config" > "Differential Corrections".

SBAS differential corrections augment only the GPS satellites. The "Differential
Corrections" displays all GPS SV IDs (or PRNs) for that correction data is availa-
ble.

6. Select "PRN > State > On" to enable transmission of correction data for the particu-
lar satellite.

7. To configure the differential corrections, select "PRN > Corrections > Fast Cor-
rections".
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The fast corrections contain the fast correction parameters of MT 2, 3, 4 and 5.
The four messages MT 2, 3, 4 and 5 carry information on the following:
● The issue of data fast correction (IODF)
● User Differential Range Error Indicator (UDREI) and the UDRE
● The coarse integrity "use/don't use" alarm ("Alert" flag)
● The Pseudo Range Correction (PRC) per PRN for a set of up to 13 PRNs

Table 14-6: UDRE, σ2
UDRE and GPS URA as a function of UDREI

UDREI UDRE, m σ2
UDRE, m2 GPS URA*

0 0.75 0.0520 2

1 1.0 0.0924 2

2 1.25 0.1444 2

3 1.75 0.2830 2

4 2.25 0.4678 2

5 3.0 0.8315 3

6 3.75 1.2992 3

7 4.5 1.8709 4

8 5.25 2.5465 5

9 6.0 3.3260 5

10 7.5 5.1968 5

11 15.0 20.7870 15

12 50.0 230.9661 10

13 150 2078.695 11

14 not monitored ("NM") not monitored ("NM") 5**

(average accuracy)

15 Do not use ("DNU") Do not use ("DNU") 15

Do not use ("DNU")

*) If "Error Correction Mode = Replay Historical Data and Sync Atmosphere & SV
Errors" is enabled, the GPS URA values are automatically set.

**) for UDREI = 14 (not monitored), the GPS URA value is set to average accuracy, i.e.
URA = 5.

Settings:

Display........................................................................................................................ 255
Fast Correction Data Parameters............................................................................... 256

Display
Sets the parameter whose variation over the 24-hour time period is indicated on the
plot.
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Fast Correction Data Parameters
Sets the fast correction data parameters per PRN.
"UDREI" User Differential Range Error Indicator
"UDRE" User Differential Range Error value
"Sigma" UDRE accuracy σ2

UDRE, see Table 14-6.

"PRC" Pseudo Range Corrections
"Alert" If enabled, simulates a short-term alarm, i.e. a coarse integrity "don't

use" information.

14.4.3.5  Long-term correction file configuration settings

Access:

1. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

2. Select "SV# > SV Config > Signals Configuration > Nav Msg Content > Config >
Differential Corrections".

3. For a PRN, select "PRN > Configuration > Long Term Corrections".

The long-term corrections contain the fast correction parameters of MT 1, 24 and
25.
MT 25 and the long-term data set part of MT 24 carry error estimates for slow vary-
ing satellite ephemeris (SV location) and clock errors, including velocity and drift
errors.

Settings:

Use Velocity................................................................................................................ 257
Display........................................................................................................................ 257
Long Term Correction Data Parameters..................................................................... 257
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Use Velocity
Enables signaling of the velocity and clock drift errors.

Display
Sets the parameter whose variation over the 24-hour time period is indicated on the
plot.

Long Term Correction Data Parameters
Sets the long-term correction data parameters per PRN.
"δx/δy/δz, m" Correction information on the GEO satellite location in WGS-84 coor-

dinates.
"δaf0, s" Clock offset error correction

"IODE" Issue of Data Ephemeris (IODE)
Note: The IOD must match the IODC and IODE in the navigation
message of the GPS satellite.
To automatically synchronize the required values and ensure integrity,
select "Error Correction Mode = Replay Historical Data and Sync
Atmosphere & SV Errors".

"δx'/δy'/δz'" Rate of change correction vector
If the "Use Velocity > Off", the rate of change vector is set to 0.

"δaf1" Clock drift error correction.

"TOD" Time of Day, i.e. the time span for that the "δx'/δy'/δz'" and "δaf1" are
applied.

14.4.3.6  Fast correction degradation factor configuration settings

Access:

1. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

2. Select "SV# > SV Config > Signals Configuration > Nav Msg Content > Config >
Differential Corrections".

3. For a PRN, select "PRN > Configuration > FC Degradation".

The fast correction degradation factor ("a"), the applicable IODP and the system
latency time (tlat) are carried by the MT 7.
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Settings:

System Latency...........................................................................................................258
Display........................................................................................................................ 258
Fast Correction Degradation Factor Parameters........................................................ 258

System Latency
Sets the system latency time tlat.

Display
Sets the parameter whose variation over the 24-hour time period is indicated on the
plot.

Fast Correction Degradation Factor Parameters
Sets the fast correction degradation factor per PRN.
"ai" Fast correction degradation factor indicator

This value of this parameter determines the values of the other deg-
radation parameters.

"a, m/s2" Fast correction degradation factor.

"Ifc NPA, s" User timeout interval, En-route through LANV Approach.

"Ifc PA, s" User timeout interval, En-route through LANV/VAN, LV, LP Approach.

"Max. update interval, s"
Maximum fast correction update interval.

14.4.3.7  Clock-ephemeris covariance matrix configuration settings

Access:

1. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".
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2. Select "SV# > SV Config > Signals Configuration > Nav Msg Content > Config >
Differential Corrections".

3. For a PRN, select "PRN > Configuration > C-E Covariance Matrix".

The relative covariance matrix for clock and ephemeris errors is transmitted by MT
28.

Settings:

Display........................................................................................................................ 259
Clock-Ephemeris Covariance Matrix Elements...........................................................259

Display
Sets the parameter whose variation over the 24-hour time period is indicated on the
plot.

Clock-Ephemeris Covariance Matrix Elements
Sets the Clock-Ephemeris covariance matrix elements per PRN.
"Scale Exp." Scale exponent
"E11, E22, ... E44"

10 non-zero elements E1,1 to E4,4 of the covariance matrix.

14.4.4  Additional SBAS system parameters

Access:

1. Select "System Configuration > Systems & Signals > SBAS (e.g. EGNOS) > On".

2. Select "Satellites > SBAS > Error Correction Mode > Replay Historical Data (and
Sync Atmosphere & SV Errors)".

3. Select "SV# > SV Config > Signals Configuration".

SBAS settings



SBAS correctionsSatellite Navigation

260User Manual 1178.9403.02 ─ 10

4. Select "Nav Msg Control > Edit".

5. Select "Nav Msg Content > Config" > "System Parameters" > "Message Sched-
ule".

In this dialog, you select which SBAS messages are generated.

6. Select "System Parameters > Issue of Data".

The dialog list the issue of data-related parameters of all differential correction
types.

7. Select "System Parameters > Service".
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The service information is transmitted by MT 27.

8. Select "System Parameters > Degradation Factors".

The dialog comprises the optional global degradation factors as specified in RTCA
MOPS DO-229. The degradation factors are broadcasted in MT 10.

Settings:

Message Schedule......................................................................................................262
Issue of Data............................................................................................................... 262

└ Ionospheric Grid - IODI.................................................................................262
└ PRN Mask - IODP.........................................................................................263
└ Fast Correction - IODF..................................................................................263
└ Service - IODS..............................................................................................263

Service........................................................................................................................ 263
└ Number of Service Messages.......................................................................263
└ Service Message Number.............................................................................263
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└ Priority Code................................................................................................. 263
└ UDREI Inside/Outside...................................................................................263
└ Number of Regions.......................................................................................263
└ Coordinates and shape of each of up to five regions....................................263

Degradation Factors....................................................................................................263
└ B_rrc............................................................................................................. 263
└ C_ltc_v1, C_ltc_lsb, I_ltc_v1, C_ltc_v0, I_ltc_v0.......................................... 263
└ I_geo, C_geo_lsb, C_geo_v......................................................................... 264
└ C_er.............................................................................................................. 264
└ RSS_iono, C_iono_step, C_geo_v, I_iono....................................................264
└ RSS_UDRE.................................................................................................. 264
└ C_covariance................................................................................................264

Message Schedule
The message schedule is a list of the SBAS messages that are generated.
Each SBAS message type is defined with:
"SBAS message content"

Indicates content of the SBAS message type.
"Message
Type"

Indicates the SBAS message type according to RTCA MOPS DO-229

"State" Enables generation of the particular SBAS correction data.
Almanac and RINEX files, and UTC offset information are required for
the navigation services of SBAS and are always enabled.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:
NAV:ALManac:STATe on page 547

"Period" Sets the periodicity of the SBAS message, i.e. the time interval after
that a message is retransmitted.
The selected value must not exceed the timeout specified in the
specification RTCA MOPS DO-229.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:
NAV:ALManac:PERiod on page 549

Issue of Data
Access: "System Parameters > Issue of Data".
The dialog list the issue of data (IOD) related parameters of the differential correction
types. The IOD values are retrieved from the predefined or the loaded correction data,
see Chapter 17.2, "Import SBAS settings", on page 286.

Ionospheric Grid - IODI ← Issue of Data
Sets the initial Issue of Data ionospheric mask. The IOD is the incremental identifier of
the transmission.
The IODI is internally increased every 240 seconds with the transmission of each
page.
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PRN Mask - IODP ← Issue of Data
Sets the Issue of Data PRN mask parameter.

Fast Correction - IODF ← Issue of Data
Sets the issue of data fast correction IODF, per message type.

Service - IODS ← Issue of Data
Sets the Issue of Data, Service.

Service
Access: "System Parameters > Service".
Comprises the service information as transmitted by MT 27.

Number of Service Messages ← Service
Defines the total number of unique Type 27 messages for the selected "IDOS".

Service Message Number ← Service
Sequential number that indicates a service message.

Priority Code ← Service
If the regions defined in more than messages overlap, this parameter indicates the
message priority. The UDREI values specified in the service message with higher pri-
ority are used.

UDREI Inside/Outside ← Service
Specifies the δUDREI factors.
The "UDREI Inside" factor applies on users within any of the specified regions; the
"UDREI Outside", to the users that are outside.
See "Coordinates and shape of each of up to five regions" on page 263.

Number of Regions ← Service
Sets the number of geographic regions.

Coordinates and shape of each of up to five regions ← Service
Geographic regions are closed polygons, described with their shape ("Triangular" or
"Square") and the coordinates ("Latitude" and "Longitude") of the corners.

Degradation Factors
Access: "System Parameters > Degradation Factors".
Degradation factors are optional global SBAS parameters and are defined in RTCA
MOPS DO-229. The degradation factors are broadcasted in MT 10.

B_rrc ← Degradation Factors
Sets the range-rate correction degradation parameter Brrc.

C_ltc_v1, C_ltc_lsb, I_ltc_v1, C_ltc_v0, I_ltc_v0 ← Degradation Factors
Set the degradation parameters for long-term correction:
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"Iltc_v1, Cltc_v1,
Cltc_lsb"

Apply if both offset and velocity are included in the messages (that is
MT 24 and MT 25 with Use Velocity = "On").

"Iltc_v0, Cltc_v0" Apply if only offset is included in the messages (i.e. Velocity Code =
0).

I_geo, C_geo_lsb, C_geo_v ← Degradation Factors
Set the degradation parameters for GEO navigation message data Igeo, Cgeo_lsb and
Cgeo_v.

C_er ← Degradation Factors
Sets the extra "catch-all" degradation parameter Cer.

RSS_iono, C_iono_step, C_geo_v, I_iono ← Degradation Factors
Define the degradation of the ionospheric corrections, as a function of:
"RSSiono" The root-sum-square flag.

"Ciono_ramp, Iiono" The rate of change and the minimum update interval for ionospheric
corrections.

"Ciono_step" The bound on difference between successive ionospheric grid delay
values.

RSS_UDRE ← Degradation Factors
Sets the root-sum-square flag RSSUDRE, necessary to calculate the fast and long-term
correction degradation.

C_covariance ← Degradation Factors
Sets the degradation factor ccovariance, necessary to calculate the additional term εc that
is broadcasted in MT 28.

SBAS settings
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15  Data logging
Data logging is a feature that enables you to acquire and download navigation data.
You can log real-time data and offline data. Save logged data in files on the hard disk,
in any network directory or on a remote computer.

Data logging not available for hardware-in-the-loop (HIL) receiver testing. If you acti-
vate logging in HiL mode, a warning message indicates a settings conflict. See also
"State" on page 268 and "Position" on page 53.

Application

Download and offline postprocessing of navigation data can be useful source for basic
analysis, for example for validation of the received parameters, for monitoring or docu-
mentation tasks. For example, you can log the simulated longitude, latitude and alti-
tude parameters or the ionospheric errors and compare these values with the values at
the receiver.

Filename syntax

The generated files are saved in the selected Directory and their filenames follow the
syntax log_<Mode>_<Logging_Category/
Format>[_<YYMMDD>_<HHMMSS>]_<Stream#>_<V#>_<A#>_<L#>, where:
● <Mode> corresponds to the selected "Mode" on page 268
● <Logging_Category/Format> corresponds to the enabled category/format in

the Logging formats and categories table.
The available categories/formats are: Satellite, UserMotion.

● <YYMMDD>_<HHMMSS> is the system time, appended if Create New Subdirectory
for Each Run > "On".

● <Stream#>_<V#>_<A#>_<L#> indicate the logged stream, vehicle and antenna
number, and the RF band.

File format of the generated files

Logged navigation data is saved as *.csv files. The coma separated file format is
self-explanatory.

File content

Two kinds of parameters define the content of the logging files: parameters that set
what is logged and parameter that set how long and how often it is logged.

The logged data per file format and logging category is defined in the dialogs:
● "Logged Satellite Parameters" on page 271
● "Logged User Motion Parameters" on page 273

The time span, the number of logged records and the timestamp of the first logged
recorded are:
● Time span
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If logging is performed offline, the parameter "Duration" defines the time span that
is logged.
In real-time mode, the time span is the time that elapses between the moment you
start and stop the logging (select "On" and "Off").

● Number of logged records
The number of logged records is defined by the logged time span and by the log-
ging resolution ("Log Step").

● First logged record
In real-time mode, the timestamp of the first logged record is the time indicated with
the parameter "Simulation Start Time".
In offline mode, it is defined as "Simulation Start Time" + "Time Offset" + "Log
Step".

Example: 
● "Simulation Mode > Orbiting Satellites"
● "Simulation Configuration > System & Signals > GPS C/A on L1 > On"
● "Satellites > SV Selection Configuration > Number of SVs Max = 4"
● "Time > Simulation Start Time = UTC 19:02:2014 06:00:00.000"
● "Data Logging > Time Offset = 0", "Duration = 60s", "Logging Category > Satellite >

On", "Log Step = 10s"
● "Data Logging > Mode > Offline" and "Generate"
Created is the file log_offline_Satellite.csv with file content as shown on Fig-
ure 15-1.
The file content has been formatted for better reading; line numbers are included for
description purposes.
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Figure 15-1: Data logging: Example of a logged data (file extract)

1 = Logging time; first record made at "Time Offset + Log Step"
2 = Logged are 4 GPS satellites (SV IDs = 14, 15, 18, 25)
3 = Logged parameters (not all possible are enabled)
Rows 4, 5 = Difference in time between the rows 4 and 5, 8 and 9 etc. is the "Log Step"
Row 20 = Last record made 50s after the logging start ("Log Step = 10s" and the next record would be

exact 60s after logging start that is the end of the logging duration)

15.1  Data logging general settings

Access:

► Select "Data Generatiom" > "Data Logging".

The provide settings depend on the selected Mode. The differences are self-
explanatory.

Data logging general settings
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The remote commands required to define these settings are described in Chap-
ter 21.19, "Data logging commands", on page 593.

Settings:

Mode........................................................................................................................... 268
State............................................................................................................................268
Generate..................................................................................................................... 269
Time Offset..................................................................................................................269
Duration.......................................................................................................................269
Directory......................................................................................................................269
Create New Subdirectory for Each Run...................................................................... 269
Logging formats and categories..................................................................................270

└ State..............................................................................................................270
└ Format...........................................................................................................270
└ Log Step /s....................................................................................................270
└ Configure Logging.........................................................................................270

Mode
Sets the logging mode.
You can log real-time and offline navigation data for
"Real-Time" Logs real-time navigation data during runtime of the GNSS simula-

tion.
"Offline" Logs offline navigation data for a specified duration of the GNSS sim-

ulation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:MODE on page 595

State
Starts/stops data logging.
Note: Existing files with the same name are overwritten. If you save the logged data to
files, first check if the selected folder is empty. The folder is specified via the Directory
configuration.
To prevent overwriting, activate Create New Subdirectory for Each Run.
"On" Logging is initialized and logging starts.
"Off" Logging files are saved.

Data logging general settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:RT:STATe on page 596

Generate
Crates and saves logging files.
Note: Existing files with the same name are overwritten. If you save the logged data to
files, first check if the selected folder is empty. The folder is specified via the Directory
configuration.
To prevent overwriting, activate Create New Subdirectory for Each Run.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:GENerate on page 595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:ABORt on page 595

Time Offset
In "Mode > Offline", delays the logging start.
The first logged point of time is defined as "Simulation Start Time" + "Time Offset" +
"Log Step".
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:TOFFset on page 596

Duration
In "Mode > Offline", sets the time span that is logged.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:DURation on page 596

Directory
Access the standard "File Select" dialog and defines the storage place.
See also "Filename syntax" on page 265.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:DIRectory
on page 597

Create New Subdirectory for Each Run
Adds time stamp to the logged files.
Creates subdirectories with time stamp and saves the logged files in them. Enable this
parameter to prevent that files are overwritten.
If logging is enabled, the filenames of the created files and the folder structure are indi-
cated.
See also "Filename syntax" on page 265.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:DIRectory
on page 597
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:TAPPend[:STATe]
on page 597

Data logging general settings
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Logging formats and categories
The logging categories and logging formats are listed in table form.
Each logging category is defined with:

State ← Logging formats and categories
Enables/disables logging of this particular category.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STATe on page 597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STATe on page 597

Format ← Logging formats and categories
Sets the file format in that the logged data is saved.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:FORMat? on page 597

Log Step /s ← Logging formats and categories
Sets the logging step, i.e. the resolution of the logged data per format and category.

Example: 
A file generated in "Mode > Offline" with "Duration = 60 s" and "Log Step = 10 s" has
six records per SV ID.
The first one is made 10s after the "Simulation Start Time" + "Time Offset" and the next
steps are made after 10s each.
Observe also the file content of the log file. The first logged parameter
Elapsed_Time_ms indicates the log steps.

Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STEP on page 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STEP on page 598

Configure Logging ← Logging formats and categories
Accesses the "Logging Satellites/User Motion" dialog to configure the messages to be
logged, see Chapter 15.2, "Configure logging settings", on page 270.

15.2  Configure logging settings

Access:

1. Select "Data Generatiom > Data Logging".

2. In the logging formats and category table, select "Satellite > Logged Data > Config-
ure".

Configure logging settings
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3. Select "User Motion > Logged Data > Configure".

Settings:

Logged Satellite Parameters.......................................................................................271
Logged User Motion Parameters................................................................................ 273

Logged Satellite Parameters
Selects the information to be logged.
Use the "Select All/Deselect All" function to select all or none of the parameters.

Configure logging settings
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Parameter Description Remote command

Elevation (deg)

Azimuth (deg)

Elevation and azimuth arrival
angles of the satellites signal

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:ELEVation on page 598

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:AZIMuth on page 598

Position (ECEF) (m)

Velocity (ECEF) (m/s)

Acceleration (ECEF) (m/s2)

Satellites position, velocity and
acceleration

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:POSition:ECEF on page 598

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:VELocity:ECEF on page 598

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:ACCeleration:ECEF on page 598

Clock Bias (m) Change in satellite's range in
the satellite clock over a time
interval

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:CBIas on page 598

Signal Level (dBm) Power of the LOS (Line of
sight) signal;

Multipath effects or attenuation
because of used antenna pat-
terns are not considered

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:SLEVel on page 598

Pseudorange (m) Simulated signal delay [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:PRANge on page 598

Pseudorange Rate (m/s) Rate of change of simulated
signal delay

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:PRRate on page 598

Pseudorange Bias (m)  [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:PRBias on page 598

Pseudorange Bias Rate (m/s)  [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:PRBRate on page 598

Range (m) Satellite range [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:RANGe on page 598

Range Rate (m/s) Rate of change of range [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:RRATe on page 598

Doppler Shift (Hz) Pseudorange rate converted to
frequency

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:DSHift on page 598

Carrier Range (m) Range of the carrier [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:CRANge on page 598

Tropospheric Delay (m) Tropospheric signal delay [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:TDELay on page 598

Ionospheric Delay (m) Ionospheric signal delay [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
SATellite:IDELay on page 598

Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:ALL
on page 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:NONE
on page 598

Configure logging settings
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Logged User Motion Parameters
Selects the parameters to be logged.
Use the "Select All/Deselect All" function to select all or none of the parameters.

Parameter Description Remote command

Position (LLA) (deg,deg,m) Latitude, Longitude, Altitude of
a vehicle in WGS84 coordi-
nates, rad

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:POSition:LLA on page 599

Position (ENU) (m,m,m) Position of the vehicle in ENU
(East, North, Up) Cartesian
coordinates

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:POSition:ENU on page 599

Position (ECEF) (m)

Velocity (ECEF) (m/s)

Acceleration (ECEF) (m/s2)

Jerk (ECEF) (m/s3)

Position, velocity and accelera-
tion of the vehicle in ECEF
(Earth-Centered, Earth-Fixed)
coordinates

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:POSition:ECEF on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:VELocity:ECEF on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:ACCeleration:ECEF on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:JERK:ECEF on page 599

Velocity (Local NED) (m/s)  [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:VELocity:LNED on page 599

Ground Speed (m/s) Vehicle speed [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:GSPeed on page 599

Antenna Offset (ECEF) (m)  [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:AOFFset on page 599

Altitude (YPR)

Altitude Rate (YPR)

Altitude Acceleration (YPR)

Altitude Jerk (YPR)

Altitude means the HAE
(Height Above the Ellipsoid)
altitude.

Altitude parameters in local
Geodetic coordinates (Yaw/
Heading, Pitch/Elevation, Roll/
Bank)

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:ATTitude on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:ATTitude:JERK on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:ATTitude:ACCeleration on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:ATTitude:JERK on page 599

Number of Visible SVs  [:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:SVS on page 599

GDOP

PDOP

HDOP

VDOP

TDOP

Geometric DOP

Positional DOP

Horizontal DOP

Vertical DOP

Time DOP

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:GDOP on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:PDOP on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:HDOP on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:VDOP on page 599

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:
UMOTion[:CSV]:TDOP on page 599

Configure logging settings



Data loggingSatellite Navigation

274User Manual 1178.9403.02 ─ 10

In HIL scenarios ("Receiver > Position > Remote Control (HIL)"), some parameters are
not logged.
Remote command: 
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:ALL
on page 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:NONE
on page 598

Configure logging settings
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16  Assistance data generation
Access:

1. Select "GNSS" > "Data Generation" > "Assistance Data Generation".

2. Set the "Assistance Mode".

3. Select "Synchronize".

Relevant settings, like active satellites, receiver location or timing information are
retrieved automatically but you can change them later.

4. To create an assistance data file, proceed as follows:

a) Select the corresponding file type.
b) Enter a filename.

With the provided settings, you can generate assistance data files for Assisted-
GNSS testing.
In a test setup with a protocol tester and a DUT, the generated assistance data files
can be formatted into mobile communication message formats. These files can be
used to accelerate the time to first fix (TTFF).

Settings:

Assistance Mode.........................................................................................................276
Navigation Data Format.............................................................................................. 276
Synchronize................................................................................................................ 276
Space Vehicles............................................................................................................276
Time of Assistance Data............................................................................................. 277

└ Start Time......................................................................................................277
└ Date.............................................................................................................. 277
└ Time.............................................................................................................. 277
└ Week Number............................................................................................... 277
└ Time of Week................................................................................................277
└ Duration........................................................................................................ 278
└ Step...............................................................................................................278

Reference Location..................................................................................................... 278
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└ Reference Frame..........................................................................................278
└ Reference Location.......................................................................................279

File Generation............................................................................................................279
└ Generate Almanac........................................................................................279
└ Generate Navigation.....................................................................................280
└ Generate Acquisition.....................................................................................280

Assistance Mode
Defines the type of assistance data to be loaded.
Selectable values require installation of a GNSS system option, see table below.

Value Required option

A-GPS R&S SMBVB-K44

A-GALILEO R&S SMBVB-K66

A-GLONASS R&S SMBVB-K94

A-BeiDou R&S SMBVB-K107

A-QZSS R&S SMBVB-K106

A-NavIC R&S SMBVB-K97

Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:MODE on page 565

Navigation Data Format
Requires "Assistance Mode" > "A-GPS".
Sets the format of the generated GPS navigation data file.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:DFORmat on page 565

Synchronize
Retrieves relevant settings, like active satellites, receiver location or timing information
automatically but you can change them later.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SYNChronize on page 565
(etc. for the other GNSS systems)

Space Vehicles
Displays the space vehicles (SV) that are part of the current satellites constellation.
Highlighted SV ID are included in the generated assistance data.
To retrieve the SV IDs of the active satellites, select "Synchronize".
To redefine the included SV IDs, toggle its state.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SVID<ch>:STATe on page 565
(etc. for the other GNSS systems)
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Time of Assistance Data
Comprises the time-related parameters for the assistance data.

Start Time ← Time of Assistance Data
Sets the time basis of the time parameter for the assistance data.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TBASis on page 569
(etc. for the other GNSS systems)

Date ← Time of Assistance Data
For "Time Basis > UTC or GLONASS", sets the date for the assistance data. The date
applies to the Gregorian calendar in format YYYY-MM-DD (ISO 8601).
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DATE on page 570
(etc. for the other GNSS systems)

Time ← Time of Assistance Data
For "Time Basis > UTC or GLONASS", sets the exact start time for the assistance data
in UTC time format HH.MM.SS.xxx.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TIME on page 570
(etc. for the other GNSS systems)

Week Number ← Time of Assistance Data
For "Time Basis > GPS, GALILEO, QZSST or BDT", sets the week number (WN) the
assistance data is generated for.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:WNUMber on page 572
(etc. for the other GNSS systems)

Time of Week ← Time of Assistance Data
For "Time Basis > GPS, GALILEO, QZSST or BDT", sets the Time of Week (TOW) the
assistance data is generated for.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TOWeek on page 572
(etc. for the other GNSS systems)
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Duration ← Time of Assistance Data
Sets the duration of the assistance data.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DURation
on page 571
(etc. for the other GNSS systems)

Step ← Time of Assistance Data
Sets the resolution of the assistance data.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:RESolution
on page 571
(etc. for the other GNSS systems)

Reference Location
Comprises reference frame and reference position parameters for the assistance data.

Reference Frame ← Reference Location
Select the reference frame used to define the receiver coordinates.
The transformation between the reference frames is performed automatically.
Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:
RFRame on page 566
(etc. for the other GNSS systems)
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Reference Location ← Reference Location
Defines the position format, coordinates, altitude and uncertainty radius of the refer-
ence location.

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the geographic altitude of the reference location in meters above sea
level.

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

"Uncertainty Radius" Sets the maximum radius of the area within which the two-dimensional loca-
tion of the UE is bounded.

The uncertainty radius determines the required sensitivity of the DUT.

Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:COORdinates:FORMat
on page 566
To enter the coordinates in "Position Format > DEG:MIN:SEC"
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:
DMS[:WGS] on page 568
(etc. for the other GNSS systems)
To enter the coordinates in "Position Format > Decimal Degrees"
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:
DMS[:WGS] on page 568
(etc. for the other GNSS systems)

File Generation
Each of the provided function triggers the generation of the respective file:

Generate Almanac ← File Generation
Accesses the standard "File Select" dialog for file handling.
In this dialog, set the filename. The data format is defined with the parameter Naviga-
tion Data Format.
The almanac file is generated in one of following file formats:
● Comma-separated file format *.rs_al

See Table 16-1.
● Standard Yuma formatted file *.rs_yuma

– For GPS, Galileo, BeiDou, QZSS and NavIC, you can use the *.rs_yuma
almanac file as the main almanac source for the specific GNSS.

– For GLONASS, this file format is not supported.
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Table 16-1: Contents of the generated almanac file (GPS)

Parameter Unit

SatID -

e -

toa s

delta_i semicircles

OMEGADOT semicircles/s

SV Health Boolean

SQRT(A) meters

OMEGA0 semicircles

M0 semicircles

w semicircles

af0 s

af1 s/s

The generated almanac file conforms with the format appended to standards TS
34.108, TS 51.010-1 and TS 37.571-1.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:ALManac:CREate on page 573

Generate Navigation ← File Generation
Accesses the standard "File Select" dialog.
Set the filename and file extension. The generated navigation file conforms with RINEX
file formats, see Table B-1.
Navigation data comprises the ephemeris page of each satellite for the selected Time
of Assistance Data.
Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:CREate on page 573

Generate Acquisition ← File Generation
Accesses the standard "File Select" dialog to create an acquisition file.
Define the filename and save the file. The firmware assigns the file extension .rs_acq
automatically.
The acquisition file consists of:
● One or more rows, each corresponding to the time parameter listed in Table 16-2.

The number of generated rows is calculated as follows:
Number of generated rows = "Duration Of Assistance Data" / "Resolution of Assis-
tance Data"

● One or more sequential acquisition blocks per row, where each block comprises
the parameters listed in Table 16-3.
The number of the acquisition blocks depends on the number of enabled space
vehicles.
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The generated acquisition file conforms with the format as specified for standards TS
34.108, TS 51.010-1 and TS 37.571-1.
Table 16-2: Time parameter

GNSS Parameter Description Unit

All except
GLONASS

GNSS TOW Receiver referenced GNSS time of week

All except GLONASS: GPS, Galileo, Bei-
Dou, QZSS, NavIC

s

GLONASS Time of Validity Elapsed time relative to GLONASS time of
assistance data

ms

Table 16-3: Acquisition block (one sequence)

GNSS Parameter Description Unit

All SVID/PRNID Satellite ID that corresponds to the record -

All Doppler (0th order
term)

Zero order Doppler term m/s

All Doppler (1st order
term)

First order Doppler term m/s2

All Doppler Uncertainty Uncertainty of the Doppler shift m/s

All Code Phase Code phase

Or half-Chip index at epoch Time of Trans-
mission (GPS Sat Time)

Chips (GPS)

ms (non-GPS)

All Integer Code Phase Integer code phase

Or ms unit index at epoch Time of Trans-
mission (GPS Sat Time)

CA periods (GPS)

ms (non-GPS)

All Code Phase Search
Window

Correlation code phase search radius Chips (GPS)

ms (non-GPS)

All Azimuth Azimuth angle of the satellite in ENU coor-
dinate system centered at reference point

deg

All Elevation Elevation angle of the satellite in ENU coor-
dinate system centered at reference point

deg

Remote command: 
[:SOURce<hw>]:BB:GNSS:ADGeneration:ACQuisition:CREate on page 573
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17  Loading constellation and navigation mes-
sage data
The default satellite's constellation and the navigation message are extracted from offi-
cial navigation source files and emulates the GNSS navigation system at 9 February
2016 at 06:00:00 am.

Internal algorithms use the predefined navigation source information and predict the
satellite's constellation and the navigation messages at any given moment of time. For
most test cases, the prediction is sufficient.

Applications

Load constellation data and navigation data for any of the GNSS systems separately.
Use loaded data to simulate a realistic GNSS signal or to reproduce a historical satel-
lite constellation.

Loading user-defined constellation is useful, if the HDOP and PDOP values exceed
your specific limits. To observe current values, select "GNSS" > "Simulation Monitor" >
"Sky View".

File formats

Supported are constellation and navigation message files in the following formats:
● GPS: YUMA, SEM, TXT or RINEX files

See:
– "YUMA, SEM and XML file download" on page 282
– "RINEX file download" on page 283

● Galileo: XML
See "YUMA, SEM and XML file download" on page 282

● GLONASS and QZSS: AGL, YUMA and XML
See "YUMA, SEM and XML file download" on page 282

● BeiDou: ALC
See "YUMA, SEM and XML file download" on page 282

● SBAS: *.ems or *.nstb
See "SBAS correction file download" on page 283

YUMA, SEM and XML file download

You can download YUMA, SEM and XML files via the Internet. Transfer them to the
R&S SMBV100B and load them if necessary.

Use, for example, the following sources:
● US Coast Guard Navigation Center GPS Homepage

https://www.navcen.uscg.gov/archives
Provides YUMA (xxx.alm) and SEM (xxx.al3 files, where xxx denotes the day
of a year

● https://www.celestrak.com/GPS/almanac/

https://www.navcen.uscg.gov/archives
https://www.celestrak.com/GPS/almanac/
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Provides almanac.sem/yuma.weekXXXX.YYYYYY.txt files, where
xxxx denotes the GPS week and yyyyyy the time of almanac (TOA)

● European GNSS Service Center (GSC) Galileo almanac file repository
https://www.gsc-europa.eu/product-almanacs
Provides XML (zzzz-yy-xx.xml) files, where zzzz, yy and xx denote year,
month and day.

● ftp://ftp.glonass-iac.ru/MCC/ALMANAC/
GLONASS files xxx.agl

● Test and Assessment Research Center (TARC) of China Satellite Navigation Office
(CSNO) BeiDou almanac file server
ftp://59.252.100.32/almanac/
Provides ALC files tarc0xxx0.zzalc, where xxx denotes the file number and
zz the year. For example, *.19alc files contain almanac data from the year 2019.
The file number is approximately the day of the year, but can deviate. The ALC file
format is similar to the YUMA file format.

● Japanese Space Agency homepage https://qz-vision.jaxa.jp/USE/en/almanac
Provides QZSS or QZSS+GPS YUMA ( zzyyyyxxx.alm) or XML
(zzyyyyxxx.alm.xml) files, where
zz=q indicates the QZSS and zz=qg the QZSS+GPS files;
yyyy denotes the year and xxx the day of a year.

For detailed information on the content and frame structure of navigation data, refer to
the specifications.

RINEX file download

RINEX files are standard formats generated by control stations (CS) and many com-
mercial receivers. RINEX navigation files usually comprise the ephemeris sets for sev-
eral satellites with different TOE and TOC. One RINEX file is enough to describe satel-
lite orbits for a period longer than two hours and sometimes up to one day.

Use, for example, the following sources:
● https://cddis.nasa.gov/archive/gnss/data/daily/
● ftp://ftp.glonass-iac.ru/MCC/BRDC
● https://qz-vision.jaxa.jp/USE/en/ephemeris

Provided are *.rnx or *.<xx>n, where <xx> denotes the year in two-digit format.
See also Chapter B, "RINEX files", on page 626.

SBAS correction file download

The *.ems and *.nstb files are files with augmentation messages broadcast by
EGNOS and WAAS.

You can find files in this format at:
● EGNOS message server (EMS):

http://www.egnos-pro.esa.int/ems/index.html.
The provided files are hierarchy grouped per PRN (PRN#), per year (y#), per day
(d#) and per hour (h#). Each EMS file contains information on one PRN for the
time span of one hour.

https://www.gsc-europa.eu/product-almanacs
ftp://ftp.glonass-iac.ru/MCC/ALMANAC/
ftp://59.252.100.32/almanac/2019
https://qz-vision.jaxa.jp/USE/en/almanac
https://cddis.nasa.gov/archive/gnss/data/daily/
ftp://ftp.glonass-iac.ru/MCC/BRDC
https://qz-vision.jaxa.jp/USE/en/ephemeris
http://www.egnos-pro.esa.int/ems/index.html
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Correction data is extracted form one of the loaded files; the exact PRN is configu-
rable.

● http://www.nstb.tc.faa.gov/DisplayNSTBDataDownload.htm.
Provided are files from different control stations. The files are grouped per day,
where each file contains information on several PRNs for the time span of 24
hours.
The downloaded files do not have an extension. Add the extension *.nstb man-
ually.

● Import constellation settings..................................................................................284
● Import SBAS settings............................................................................................286

17.1  Import constellation settings

Access:

1. Select "GNSS" > "Simulation Configuration" > "Satellites".

2. In the side tab, select the GNSS system, for that you want to import a satellite con-
stellation.

3. Select "Import Constellation".

4. Select "Constellation Source File", to load a constellation source file.
For GPS, for example, load a RINEX file with file extension *.rnx.

The filename of the last imported file is displayed on the button accessing the stan-
dard "File Select" dialog.

5. Optionally, use a different data source for the navigation message.

6. Optionally, apply the specifications in the source file for all active GNSS systems.

7. Select "Import".

Triggers extracting the data, the satellite constellation and the navigation changes
as specified in the file.

Import constellation settings

http://www.nstb.tc.faa.gov/DisplayNSTBDataDownload.htm
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Settings:

Constellation Source File............................................................................................ 285
Use Different Source File for Navigation Message..................................................... 285
Navigation Message Source File................................................................................ 285
Use Constellation Source File for all active GNSS system......................................... 285
Import, Cancel.............................................................................................................285

Constellation Source File
Selects the file from that the satellites constellation and navigation data are extracted.
Simulation data (i.e. the almanac part of the navigation message) and the navigation
data per SV ID (i.e. ephemeris) can be extracted from the same or from different files.
Supported are almanacs and RINEX files, in any of the standard formats for these files.
For an overview of supported file types, see Table 21-1.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation on page 417
(etc. for the other GNSS systems)

Use Different Source File for Navigation Message
Loads a dedicated file as source for the navigation data.
Per default, navigation data is extracted from the same file that is used as source for
the simulation (satellite constellation).
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UDSource on page 418
(etc. for the other GNSS systems)

Navigation Message Source File
Selects the file from that the navigation data is extracted.
Use this function, if navigation data differs from the constellation file. For overview of
the supported file types, see Table 21-1.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage on page 418
(etc. for the other GNSS systems)

Use Constellation Source File for all active GNSS system
Requires RINEX files version 3.x or later, see Table B-1.
Applies extracted data from the constellation source to all active GNSS.
Use this function when importing comprehensive constellation source files covering
data for several GNSS. If you have a defined constellation of an active GNSS and the
file has no constellation data for this GNSS, the constellation of this GNSS is deactiva-
ted.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage on page 418
(etc. for the other GNSS systems)

Import, Cancel
Triggers the import or discards the selected files.

Import constellation settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:EXECute on page 419
(etc. for the other GNSS systems)

17.2  Import SBAS settings

Access:

1. Select "GNSS" > "Simulation Configuration" > "System & Signals".

2. Select "System" > "SBAS" > "On".

3. Select "Import Constellation/Import Constellation and Correction Data".

4. Select "Add File" or "Add Directory".
You can add predefined files or load a specific constellation. For example, for
importing EGNOS system data, load *.ems files.

5. Select "Import".

The dialog provides standard file handling functions.

Settings:

Add File....................................................................................................................... 286
Add Directory.............................................................................................................. 287
Remove File, Remove All............................................................................................287
Input Files....................................................................................................................287
Import, Cancel.............................................................................................................287

Add File
Selects a predefined or user-defined file.
Supported are files defined in "SBAS correction file download" on page 283.

Import SBAS settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:FILE on page 549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:FILE on page 549

Add Directory
Selects a set of files in one step.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:DIR on page 549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:DIR on page 549

Remove File, Remove All
Remove a file or all files from the list.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:FILE<ch>
on page 551
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:FILE<ch>
on page 551
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:ALL on page 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:ALL on page 550

Input Files
When a file is loaded, its "Filename" and "Start/End Date and Time" are retrieved and
displayed.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:LIST? on page 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:LIST? on page 550

Import, Cancel
Loads the files or aborts the import action.
Remote command: 
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:EXECute on page 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:EXECute on page 550

Import SBAS settings
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18  Hardware in the loop (HIL)
The term hardware in the loop (HIL) describes the mode in which the R&S SMBV100B
is remotely controlled by control application software (see Figure 18-1). The control
application software sends remote commands over LAN in real time, possibly from a
motion simulator. The R&S SMBV100B processes the received position, motion and
attitude information and generates the required signal.

The output GNSS signal is sent to system under test, that typically includes a GNSS
receiver forwarding the calculated position to the application software. The application
software can use the retrieved position for display purposes (such as infotainment plat-
form in a vehicle) or to control the actual position of the vehicle (e.g. auto-pilot).

Figure 18-1: Example of HIL test setup

Refer to the following sections, for definition of the terms used in the context of HIL
testing and settings. The description also gives recommendations on working with the
R&S SMBV100B in HIL setups.

● Tips for best results...............................................................................................289
● HIL settings........................................................................................................... 295
● UDP position data................................................................................................. 301
● SCPI position data................................................................................................ 302
● Remote-control commands...................................................................................303
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18.1  Tips for best results

We recommend that you consider the following measures.

Measures for proper operation

1. Synchronize the R&S SMBV100B and the motion simulator.
(see Chapter 18.1.1, "Synchronization", on page 289).

2. Take measures for latency calibration.
(see Chapter 18.1.3, "Latency calibration", on page 290).

3. Add additional buffer time.
Chapter 18.1.4, "Adding a constant delay to compensate for command jitter",
on page 292

4. If the first position fix and the latency calibration are successful but during the
motion simulation the receiver loses its position fix, try out the following:

a) Analyze the sent HIL data.

● Evaluate the trajectory smoothness and search in particular for unwanted
abrupt positions changes ("jumps").

● Send HIL commands with lower update rate, for example each 100 ms.
Reducing the update rate leads to interpolation and thus spreads the
severity of the "jumps" over several 10 ms update intervals.
See Chapter 18.1.5, "Interpolation", on page 294.

b) Avoid abrupt positions changes.
The motion simulator itself can cause position changes. Consult the specifica-
tion of the used receiver for information on the high-order dynamic stress it is
able to handle.

The measures for proper operation use the SCPI interface and the R&S SMBV100B is
in remote state. Switch to manual state after you finish the measures, if the
R&S SMBV100B retrieves HIL position data via UDP packets.

18.1.1  Synchronization

To process the HIL commands, the R&S SMBV100B uses its internal 100 Hz clock sig-
nal, that corresponds to a time resolution of 10  ms.

The motion simulator uses its own clock. Depending on the capabilities of the pro-
cessor (general purpose or real time) that the motion simulator uses, the processing
time and the accuracy of the clock can vary. The R&S SMBV100B internal clock signal
is precise and stable. This clock is not only used to generate the GNSS signals but is
also the time reference for the whole HIL setup.

We recommend that you synchronize the motion simulator to the R&S SMBV100B.
Consider the following:
● Follow the rules described in "Measures for proper operation" on page 289

Tips for best results
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● Always take the measures for latency calibration as described in Chapter 18.1.3,
"Latency calibration", on page 290.

● If your motion simulator can receive and process the marker signal of the
R&S SMBV100B, generate a 1PPS (one pulse per second) or 10PPS (10 pulses
per second) marker signal. Feed the marker signal to the motion simulator.
If synchronized, the motion simulator sends the HIL commands right after each
1PPS marker signal.
Related settings:
– "GNSS > Marker > Marker Mode"

(see "Mode" on page 318)

18.1.2  System latency

System latency is a term that describes the time it takes the R&S SMBV100B to
receive and process an incoming HIL command, calculate, output and transmit the sig-
nal to the GNSS receiver. The default system latency is 20 ms; this value corre-
sponds to the R&S SMBV100B hardware processing time.

In the context of this description, the term latency (tcal.latency) describes the additional
latency (i.e. delay) caused, for example, by the transmission and processing time of
the HIL commands. If the system latency value is a constant parameter that cannot be
reduced, the additional latency tcal.latency is a variable value, that can be partly or fully
compensated. This description focuses on the measures to measure and compensate
for additional latency.

You can query the additional latency value as described in Chapter 18.1.3, "Latency
calibration", on page 290. The system latency and the latency are related as follows:

System Latency = tcal.latency + 0.02

The minimum system latency of the HIL setup is 2 ms and is achieved if the
tcal.latency = 0 ms. The situation when tcal.latency = 0 ms is referred as a zero latency situa-
tion; it is also the best case scenario.

See also:
● Chapter 18.1, "Tips for best results", on page 289
● "Understanding the response of the query SOURce:BB:GNSS:RT:RECeiver1:HIL-

Position:LATency:STATistics?" on page 303

18.1.3  Latency calibration

Latency calibration is the process of compensating the latency time. Calibrate the
latency at the beginning of the simulation and repeat the process periodically, every 5
or 10 seconds.

Initial latency calibration process

1. Synchronize the R&S SMBV100B and the motion simulator.
(see Chapter 18.1.1, "Synchronization", on page 289).

Tips for best results
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2. Set the same initial position (P0) in both the motion simulator and the
R&S SMBV100B.
The initial position is the position in the moment t0.
In R&S SMBV100B, set the receiver postion with the parameters "Receiver Posi-
tion > Location Coordinates".

Tip: We recommend that you use the position that you are going to use as the first
simulation position in the motion simulation.

3. Wait until the GNSS receiver performs its first position fix.

4. Retrieve an initial time reference information from the R&S SMBV100B.
Send the command [:SOURce<hw>]:BB:GNSS:RT:HWTime? to query the
elapsed time from the simulation begin (ΔHW,0).

The response is a value that reflects the difference between the current time in the
R&S SMBV100B (tGNSS,0) and the motion simulator (tMS,0) at the moment t0:

ΔHW,0 ≈ tMS,0 - tGNSS,0

Note: The retrieved value is a rough estimation. It does not consider the round-trip
time of the HIL commands.
Although not exact, the response of the command is suitable for the initial time
alignment (first approximation).
The precise calibration is performed with the next steps.

5. Send the first HIL command as a function of the moment tMS,1.
HIL commands define position Pi at a given moment of time tElapsedTime,i.
To compensate for the time difference between the R&S SMBV100B and the
motion simulator, correct the tElapsedTime,i value:

a) Calculate the first elapsed time tElapsedTime,1

tElapsedTime,1 = tMS,1 - ΔHW,0

b) Use the coordinates of the initial position P0

c) Send a remote command containing the timestamp with position and attitude
information.
If you use UDP packets, send the command &GTL first and then send the UDP
packets.
If you use SCPI commands, send the command depending on the position
coordinates:
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:
MODE:A for position data in ECEF coordinates.
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:
MODE:B for position data in NED coordinates.

6. Query the time difference (tcal.latency,i) between the elapsed time in the
R&S SMBV100B (tHW,j) and the elapsed time in the last HIL command (tElapsedTime,i).
Send the command [:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:
HILPosition:LATency:STATistics?.

Tips for best results
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The query returns several parameters and statistical information. For more informa-
tion, see the description of the remote command.

Observe the value tcal.latency,1 = tHW,0 - tElapsedTime,1.
If UDP is used, send the &GTL command after the query.

7. If tcal.latency,i ≥ |System Latency - 20 ms|, perform the following:

a) Calculate ΔHW,j = ΔHW,j-1 + tcal.latency,i

Where:
● i reflects the HIL update rate
● j is the latency calibration iteration number

b) Calculate the elapsed time tElapsedTime,i+1 = tMS,i+1 - ΔHW,j

c) Send the subsequent HIL command as a function of tMS,i+1 and Pi

The latency is successfully calibrated, if one of the following is true:
● -10 ms < <MinLatency> < <MaxLatency>  < 10 ms
● <CmdReceived> = <CmdSync> + <CmdInterp>
● <MinUsed>min ≥ 1
Where <MaxLatency>, <MinLatency>, <MinUsed>, <CmdReceived>,
<CmdSync> and <CmdInterp> are the value returned by the query [:
SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics?.
If UDP is used, send the &GTL command.
A latency of 0 ms corresponds to a system latency of 20 ms.
If the latency calibration is unsuccessful:
● Add a buffer time, see Chapter 18.1.4, "Adding a constant delay to compen-

sate for command jitter", on page 292.
● Query HIL statistical information and analyze the values of the parameters

<CmdExtrap> and <CmdPredict>.
They indicate the number of times the prediction algorithm has been applied,
see Chapter 18.1.6, "Trajectory prediction", on page 294.

18.1.4  Adding a constant delay to compensate for command jitter

If the motion simulator is not equipped with a real-time processor, it can happen that it
sends the HIL commands with varying update rate. This effect is often referred as a
command jitter.

The R&S SMBV100B can compensate command jitter in the range of 1 ms to 30 ms.
The mechanism is to add a buffer time tBuffer so that the R&S SMBV100B has enough
time to process and realign the HIL commands. The drawback of this mechanism is the
adding of an extra constant delay to the system.

Tips for best results
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Adding buffer time (tBuffer)

To compensate for the command jitter:

► Send the command [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:
SLATency.

The command sets the system latency, i.e. a delay tDelay. The additional buffer time
tBuffer is calculated as follows:
tBuffer = tDelay - 0.02
Where tBuffer is the additional time available for processing.
The value 0.02 s is the hardware processing time of the R&S SMBV100B.

If the value tBuffer > 0 ms, the system latency equation changes as follows:
System Latency = tcal.latency + tDelay = tcal.latency + tBuffer + 0.02

Finding out the best system latency value tDelay

1. Select the initial tDelay value depending on whether the motion simulator is equip-
ped with real-time processor or not:

● With real-time processor: <Delay> = 0.02 s
● Without real-time processor: <Delay> = 0.15 s

2. Collect statistical information with the query [:SOURce<hw>]:BB:GNSS:RT:
RECeiver[:V<st>]:HILPosition:LATency:STATistics? for at least 30
min.

3. Evaluate the absolute minimum value returned for the parameter <MinUsed>.

4. Reduce the tDelay value. Evaluate the statistics again.
Repeat this step until <MinUsed>min ≥ 1.

Example: 
If the R&S SMBV100B and the motion simulator are connected in a HIL setup and:
● HIL update rate = 0.1 s
● tDelay = 0.05 s
● tBuffer = 0.03 s.

● In a non-synchronized setup with, for example, tcal.latency = 0.04 s, the current sys-
tem latency is:
System Latency = 0.04 + 0.05 = 0.09 s

● After the R&S SMBV100B and the motion simulator are synchronized (tcal.latency = 0
s), the system latency becomes:
System Latency = 0 + 0.05 = 0.05 s
With the buffer time of 0.03 s, R&S SMBV100B tolerates command jitter of up to
0.03 s.
Because of the buffer time, prediction is not applied.

Tips for best results
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Adding of buffering time does not substitute the latency calibration. It is an add-on to it.
Always calibrate the latency as described in Chapter 18.1.3, "Latency calibration",
on page 290.

Related settings:
● Chapter 18.1.2, "System latency", on page 290

18.1.5  Interpolation

If the update rate of the HIL commands is less than 100 Hz, the instrument interpolates
the two last received commands to achieve the required update rate. Interpolation can
be applied if the system latency is higher than the update rate and if at least one HIL
command was received and buffered. The former situation is present, if the query [:
SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics? returns <MinUsed> = 1.

The interpolation mechanism can achieve a continuous signal and hence results in bet-
ter result than the extrapolation and the prediction methods (see Chapter 18.1.6, "Tra-
jectory prediction", on page 294).

18.1.6  Trajectory prediction

The R&S SMBV100B tries to compensate for the latency (tcal.latency) by applying a pre-
diction algorithm. If the R&S SMBV100B and the motion simulator are synchronized
and the latency is less than 10 ms, prediction is not applied. If the latency exceeds 10
ms, prediction is applied. The R&S SMBV100B uses the last received high-order
dynamics (speed, acceleration and jerk) and predicts or extrapolates the position of the
motion simulator at the subsequent update time.

Where:
● Extrapolation describes the process, where the position is calculated from a

received command with an old timestamp and is based on the received speed,
acceleration and jerk

● Prediction is applied if no command was received, for example if the update period
is larger than 10 ms. When predicted, subsequent positions are calculated based
on the last known speed, acceleration and jerk

Retrieving the number of automatically performed extrapolations and predic-
tions

You can query statistical information on the number of times the R&S SMBV100B
applied predictions or extrapolation with the command [:SOURce<hw>]:BB:GNSS:
RT:RECeiver[:V<st>]:HILPosition:LATency:STATistics?.

Observe the values of the parameters <CmdExterp> and <CmdPredict>.

Tips for best results
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Example: How extrapolation can impair the results
Imagine that at the moment t0 a vehicle is moving with a velocity v = 1 m/s and it stops
(v = 0 m/s) after 0.1 s (t1 = t0 +  0.1 s).

If the latency exceeds 10 ms, then the R&S SMBV100B projects the movement
assuming that the vehicle keeps its velocity v = 1 m/s. This result of position offset of
0.01 m.
At the next update period, for example 100 ms later, the R&S SMBV100B receives the
subsequent command and the correct velocity v = 0 m/s. The instrument corrects the
position and removes the 0.01 m position offset.
This causes an abrupt change (a "jump") between the two consecutive positions.

As illustrated in the example, the prediction algorithm alone cannot assure that the tra-
jectory is continuous. Without further measures, the predicted positions can cause
abrupt changes between consecutive positions or lead to tracking loss of the GNSS
signal. The severity of these abrupt changes depends on both the latency value and
the current dynamics and therefore are tolerated or not by the GNSS receiver.

Prediction for instance is useful, if the application requires low latency and tolerates
"jumps". Otherwise, we recommend that you use real-time PC with synchronized
marker or add buffer to increase the system latency.

See Chapter 18.1, "Tips for best results", on page 289.

18.2  HIL settings

Option: R&S SMBVB-K109

Access:

1. Select "GNSS" > "Simulation Configuration" > "Receiver".

2. Select "Position" > "Remote Control (HIL)".

3. Select "Position Configuration".

HIL settings
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Location, Initial Position
Selects the location or initial position depending on the simulated object:
● Static GNSS receiver ("Position > Static"):

Selects the geographic location of the GNSS receiver.
● R&S SMBVB-K109: Hardware in the loop (HIL) GNSS receiver ("Position > From

Remote"):
Selects the initial position of the GNSS receiver.

● R&S SMBVB-K122: Real-time kinematics (RTK) base station:
Selects the geographic location of the RTK base station.

The representation of the coordinates depends on the selected "Reference Frame" and
"Position Format".
"User Defined" Sets the receiver position in terms of "Latitude", "Longitude" and "Alti-

tude"

HIL settings
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"City" Selects a predefined geographic location, see Table 5-1 for an over-
view.
The parameters "Latitude", "Longitude" and "Altitude" are set auto-
matically.

Table 18-1: Coordinates of the simulated predefined positions

Continent City Latitude [deg] Longitude [deg] Altitude [m]

Europe London 51.500625 -0.1246219 22

 Moscow 55.7522222 37.6155556 200

 Munich 48.15 11.5833333 508

 Paris 48.8584 2.2946278 66

America New York 40.714667 -74.0063889 1

 San Francisco 37.8194389 -122.4784939 35

 Anchorage 61.2166667 -149.8833333 115

 Mexico City 19.4510539 -99.1255189 2310

 Bogota 4.7111111 -74.0722222 2640

 Sao Paulo -23.5337731 -46.62529 760

 Santiago de Chile -33.4474869 -70.6736758 522

Asia Beijing 39.9055556 116.3913889 60

 New Delhi 28.6138889 77.2088889 77

 Seoul 37.5514997 126.9877939 265

 Singapore 1.3113108 103.8268528 110

 Taipei 25.0223439 121.5147581 10

 Tokyo 35.6838611 139.7450581 45

Africa Cairo 30.0444419 31.2357117 23

 Dakar 14.7166769 -17.4676858 22

 Cape Town -33.9188611 18.4233 6

Australia Sydney -33.8833333 151.2166667 3

 Perth -31.9535119 115.8570481 2

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog
on page 353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]
on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog on page 367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect] on page 367

HIL settings
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Reference Frame
For GNSS receiver, selects the reference frame used to define the receiver coordi-
nates. The transformation between the reference frames is performed automatically.
R&S SMBVB-K122: For RTK base station, selects the reference frame used to define
the receiver or RTK base station coordinates. The transformation between the refer-
ence frames is performed automatically.
The following applies:
● XWGS84 = (1 - 0.008*10-6)*XPZ 90 - 0.2041*10-7*YPZ 90 + 0.1716*10-7*ZPZ 90 - 0.013
● YWGS84 = (1 - 0.008*10-6)*YPZ 90 - 0.2041*10-7*XPZ 90 + 0.1115*10-7*ZPZ 90 + 0.106
● ZWGS84 = (1 - 0.008*10-6)*ZPZ 90 - 0.1716*10-7*XPZ 90 - 0.1115*10-7*YPZ 90 + 0.022

Both reference frames are ECEF frames with a set of associated parameters.
"WGS-84" The World Geodetic System WGS-84 is the reference frame used by

GPS.
"PZ 90.11 (GLONASS)"

Parametry Zemli PZ (Parameters of the Earth) is the reference frame
used by GLONASS.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
RFRame on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame
on page 367

Location Coordinates, Position Format
In the ECEF coordinate system, a geographic location is identified by three coordi-
nates, the altitude, latitude and longitude. The last two can be displayed in decimal or
DMS format. The display format is determined by the parameter "Position Format".

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degrees"
The display format is decimal degrees, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the reference location. The altitude value is the height
above the ellipsoid (HAE), that is the reference ellipsoid (WGS84 or PZ90).

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

Altitude, latitude and longitude are configurable, if "Location, Initial Position > User
Defined".

HIL settings
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Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
FORMat on page 354
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat
on page 368
To enter the coordinates in "Position Format > DEG:MIN:SEC"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:
PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DMS[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ
on page 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:
WGS] on page 369
To enter the coordinates in "Position Format > Decimal Degrees"
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal:PZ on page 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:
DECimal[:WGS] on page 355
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:
PZ on page 368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:
DECimal[:WGS] on page 368

Attitude Behaviour, More
Defines how the attitude information is defined.
To define the individual attitude parameters for all attitude behaviors, select "More".
This button is available with option R&S SMBVB-K108. See "Attitude Configuration"
on page 58.
"Constant" Sets the attitude of the receiver as a combination of the "Yaw/Head-

ing", "Pitch/Elevation", "Roll/Bank" values.
The resulting attitude is a constant value.

"Spinning" Enables a constant rate of change of the roll.
See "Spinning Rate" on page 59.

HIL settings
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"From Waypoint File/Align to Motion"
Option: R&S SMBVB-K108
For "Receiver" > "Position" > "Moving", the attitude parameters are
extracted from the selected waypoint file. Further settings are not
required.
This extraction forces the attitude parameters to motion direction
even if the waypoint has attitude information, like, for example, in a
*.xtd file with <property
waypointformat="position_attitude">.
For specific applications like automotive, it is realistic to set the yaw
and pitch to the motion direction of the vehicle. The usual body axes
angles of a vehicle point to the direction of the velocity vector.
For other applications, however, like aeronautics with a landing plane,
this parameter is not useful. AS an example, the nose of the plane is
in an upward direction at the time when the plane is moving down-
wards.
To visualize the effect, select "Receiver" > "Monitor" > "Attitude View",
see "Display" on page 37.

"From Remote"
Option: R&S SMBVB-K109
For "Receiver" > "Position" > "Remote Control (HIL)", the attitude
parameters are set by the received HIL commands. The selection is
suspended.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
on page 357

System Latency
Option: R&S SMBVB-K109
System latency is the time period, which the R&S SMBV100B needs to receive and
process incoming HIL commands.
The minimum value of 20 ms corresponds to the R&S SMBV100B hardware process-
ing time. Values higher than 20 ms constitute a delay or a buffer time to process incom-
ing HIL position data.
The parameter is crucial for latency calibration between the R&S SMBV100B and the
control application program.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency on page 309

Interface Type
Option: R&S SMBVB-K109
Two interface types are provided for the HIL communication between the
R&S SMBV100B and the control application program, which remotely controls the
R&S SMBV100B:

HIL settings
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"SCPI" A SCPI connection is used for communication.
In some case, the Transfer Control Protocol (TCP) can suffer from the
overhead caused by the acknowledgments and retransmission. In
such cases, enable the socket option "TCP_NODELAY" on the sender
side.

"UDP Raw Socket"
The R&S SMBV100B listens to a unidirectional UDP stream, gener-
ated by the control application program.

Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe on page 310

UDP Port
Option: R&S SMBVB-K109
Requires "Interface Type" > "UDP Raw Socket".
Sets the port for incoming UDP packets at the R&S SMBV100B.
Remote command: 
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT on page 310

18.3  UDP position data

Compared to the SCPI interface, the User Data Protocol (UDP) offers the following two
advantages:
● UDP is known to have less communication overhead, and therefore recommended

in time critical simulations.
● The user interface is not blocked (remote state) like when using the SCPI interface.

Thus, using UDP you can change the satellite states, power offset and pseudor-
ange bias on-the-fly.

Table 18-2 shows the structure of a UDP data packet containing position data. The
position data is provided in a binary format as specified in the IEEE Standard 754 for
Binary Floating-Point Arithmetic.

The measures for proper operation use the SCPI interface and require remote control.
After calibration and for retrieving position data via UDP, you have to switch the
R&S SMBV100B from remote state to manual state.
On the control application, use the command &GTL for this purpose.

Table 18-2: UDP packet and parameter description for HIL position data

Data Type Size Parameter Description Default unit

integer 4 bytes reserve0 - -

integer 4 bytes reserve1   

integer 4 bytes reserve2   

integer 4 bytes reserve3   

UDP position data
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Data Type Size Parameter Description Default unit

double 8 bytes ElapsedTime Elapsed time since the simulation start s

double
double
double

8 bytes

8 bytes

8 bytes

<X>
<Y>
<X>

Coordinate in the Earth Fixed Earth Cen-
tered (ECEF) coordinate system

m

double
double
double

8 bytes

8 bytes

8 bytes

<XDot>
<YDot>
<ZDot>

Velocity vector in ECEF

(equivalently <Vx>, <Vy>, <Vz>)

m/s

double
double
double

8 bytes

8 bytes

8 bytes

<XDotDot>
<YDotDot>
<ZDotDot>

Acceleration vector in ECEF

(equivalently <Ax>, <Ay>, <Az>)
m/s2

double
double
double

8 bytes

8 bytes

8 bytes

<XDotDotDot>
<YDotDotDot>
<ZDotDotDot>

Jerk vector in ECEF

(equivalently <Jx>, <Jy>, <Jz>)
m/s3

double
double
double

8 bytes

8 bytes

8 bytes

<Yaw>
<Pitch>
<Roll>

Attitude angles

(yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more than
one cycle rotation between two updates

rad

double
double
double

8 bytes

8 bytes

8 bytes

<YDot>
<PDot>
<RDot>

Attitude angular rate of change rad/s

double
double
double

8 bytes

8 bytes

8 bytes

<YDotDot>
<PDotDot>
<RDotDot>

Attitude angular second order derivative rad/s2

double
double
double

8 bytes

8 bytes

8 bytes

<YDotDotDot>
<PDotDotDot>
<RDotDotDot>

Attitude angular third order derivative rad/s3

18.4  SCPI position data

During remote operation, the control application program sends real-time HIL (SCPI)
commands to the R&S SMBV100B. The HIL commands are sent with low and varying
time resolution. This time resolution is also referred as a HIL update rate. It is typically
a value from 10 Hz to 100 Hz (or 10 ms and 100 ms) and depends on the motion simu-
lator, in particular on its real-time capabilities.

HIL position data is provided by two commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
The command defines the HIL position, motion (velocity, acceleration, jerk) and attitude
at a specific moment of time. The position is defined by earth centered earth fixed

SCPI position data
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(ECEF) coordinates for mode A and by north east down (NED) coordinates for mode
B. The moment of time is given as a time offset (<ElapsedTime>) from the simulation
time start.

18.5  Remote-control commands

Option: R&S SMBVB-K109

Understanding the response of the query SOURce:BB:GNSS:RT:RECeiver1:HIL-
Position:LATency:STATistics?

The following are three examples that illustrate how the HIL update rate and the buffer
time influence the way the received HIL commands are processed.

The query is sent each 5 s as indicated by the difference between two subsequently
<CmdHwTime> values.

The response of each individual query is a string. The set of strings per example have
been converted to a *.csv file and formatted for better understanding.

Example: Non-real-time (RT) processor, HIL update rate = 100 Hz, tDelay = 0.02 s

Figure 18-2: Example of latency statistics

1 = Varying latency of up to 50 ms
2 = Number of non-zero latency values varies
3 = Number of commands received during each period = 500
4 = Not all received commands are used (<CmdUsed> < <CmdReceived>)
5 = Not all commands are applied at their specified time (<CmdSync> < <CmdUsed>)
6 = Interpolation not applied; commands do not arrive in advance
7 = Number of times the prediction algorithm was applied

Remote-control commands
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Example: Non-real-time (RT) processor, HIL update rate = 100 Hz, tDelay = 0.15 s
This example illustrates that the increased tDelay improves the number of processed HIL
commands. The system latency however also increases.

Figure 18-3: Impact of the increased t_Delay

1 = All commands are used synchronous
2 = Interpolation or prediction is not necessary and not applied
3 = Increased number of buffered commands; the values indicate that there is a room to decrease (optimize)

the tDelay (see Chapter 18.1.4, "Adding a constant delay to compensate for command jitter", on page 292)

Example: Non-real-time (RT) processor, HIL update rate = 10 Hz, tDelay = 0.15 s
This example illustrates that varying the HIL update rate while keeping the same tDelay

also improves the HIL command processing. The generated signal is continuous. The
system latency however also increases.

Figure 18-4: Impact of the reduced HIL update rate

1 = All commands are used synchronous
2 = Interpolation is required and applied (ideal situation where each HIL command is executed synchronous

and there are enough HIL commands to interpolate the values from)

The last two examples show approaches that are suitable if your system tolerates sys-
tem delays.

Commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A................................305
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B................................306
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency?.............................. 307
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:STATistics?...............307
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency.............................................. 309
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe....................................................310
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT....................................................310
[:SOURce<hw>]:BB:GNSS:RT:HWTime?..........................................................................310

Remote-control commands
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[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
<ElapsedTime>, <X>, <Y>, <Z>, <XDot>, <YDot>, <ZDot>, <XDotDot>,
<YDotDot>, <ZDotDot>, <XDotDotDot>, <YDotDotDot>, <ZDotDotDot>, <Yaw>,
<Pitch>, <Roll>, <YawDot>, <PitchDot>, <RollDot>, <YawDotDot>,
<PitchDotDot>, <RollDotDot>, <YawDotDotDot>, <PitchDotDotDot>,
<RollDotDotDot>

Sets hardware in loop (HIL) position, motion (velocity, acceleration, jerk) and attitude in
Earth Fixed Earth Centered ECEF coordinates.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame. The frame is rotated starting from an
aligned state with the local NED frame. Three consecutive Euler rotations are: around
the z axis, the y axis and the x axis.
Table 18-3: SCPI parameter description

Parameter  Description Default unit

<X>,<Y>,<Z> Mandatory Coordinate in the Earth Fixed Earth Centered (ECEF)
coordinate system

m

<XDot>,<YDot>,
<ZDot>

Mandatory Velocity vector in ECEF (equivalently Vx, Vy, Vz) m/s

<XDotDot>,
<YDotDot>,
<ZDotDot>

Mandatory Acceleration vector in ECEF (equivalently Ax, Ay,
Az)

m/s2

<XDotDotDot>,
<YDotDotDot>,
<ZDotDotDot>

Mandatory Jerk vector in ECEF (equivalently Jx, Jy, Jz) m/s3

[<Yaw>,<Pitch>,
<Roll>]

Optional Attitude angles (yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more that one cycle
rotation between two updates

rad

[<YDot>,<PDot>,
<RDot>]

Optional Attitude angular rate of change rad/s

[<YDotDot>,
<PDotDot>,
<RDotDot>]

Optional Attitude angular second order derivative rad/s2

[<YDotDotDot>,
<PDotDotDot>,
<RDotDotDot>]

Optional Attitude angular third order derivative rad/s3

See also Chapter 18.1.3, "Latency calibration", on page 290.

For HIL mode A, position data can also be retrieved via UDP packets, see Chap-
ter 18.3, "UDP position data", on page 301.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start, as queried with the com-
mand [:SOURce<hw>]:BB:GNSS:RT:HWTime?.
For description of the other parameters, see Table 18-3.
Range: 0  to  99999999

Remote-control commands
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Usage: Setting only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
<ElapsedTime>, <Latitude>, <Longitude>, <Altitude>, <NDot>, <EDot>, <DDot>,
<NDotDot>, <EDotDot>, <DDotDot>, <NDotDotDot>, <EDotDotDot>,
<DDotDotDot>, <Yaw>, <Pitch>, <Roll>, <YawDot>, <PitchDot>, <RollDot>,
<YawDotDot>, <PitchDotDot>, <RollDotDot>, <YawDotDotDot>,
<PitchDotDotDot>, <RollDotDotDot>

Sets hardware in loop (HIL) position, motion (velocity, acceleration, jerk) and attitude in
North East Down (NED) coordinates.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame. The frame is rotated starting from an
aligned state with the local NED frame. Three consecutive Euler rotations are: around
the z axis, the y axis and the x axis.
Table 18-4: Parameter description

Parameter  Description Default unit

<Latitude>,
<Longitude>,
<Altitude>

Mandatory Geodetic location °

<NDot>,<EDot>,
<DDot>

Mandatory Velocity vector in the North East Down (NED) coordi-
nate system (equivalently Vn, Ve, Vd)

m/s

<NDotDot>,
<EDotDot>,
<DDotDot>

Mandatory Acceleration vector in NED (equivalently An, Ae, Ad) m/s2

<NDotDotDot>,
<EDotDotDot>,
<DDotDotDot>

Mandatory Jerk vector in NED (equivalently Jn, Je, Jd) m/s3

[<Yaw>,<Pitch>,
<Roll>]

Optional Attitude angles (yaw/heading, pitch/elevation, roll/bank)

Unlimited value range to simulate more that one cycle
rotation between two updates

rad

[<YDot>,<PDot>,
<RDot>]

Optional Attitude angular rate of change rad/s

[<YDotDot>,
<PDotDot>,
<RDotDot>]

Optional Attitude angular second order derivative rad/s2

[<YDotDotDot>,
<PDotDotDot>,
<RDotDotDot>]

Optional Attitude angular third order derivative rad/s3

See also Chapter 18.1.3, "Latency calibration", on page 290.

This mode is currently supported for position data retrieved via SCPI commands only.
For HIL mode A, position data can also be retrieved via UDP packets, see Chap-
ter 18.3, "UDP position data", on page 301.

Remote-control commands
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Parameters:
<ElapsedTime> float

Elapsed time from the simulation start, as queried with the com-
mand [:SOURce<hw>]:BB:GNSS:RT:HWTime?.
For description of the other parameters, see Table 18-4.
Range: 0  to  99999999

Usage: Setting only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency?

Queries the predicted latency that is the time delay between the elapsed time of HIL
mode command and the time to execute this command in the R&S SMBV100B. HIL
command refers to HiL mode A or HiL mode B commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B
How to: Chapter 18.1.3, "Latency calibration", on page 290

Return values: 
<Latency> float

Range: min  to  max
Increment: 0.001
*RST: 0
Default unit: s

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:
STATistics?

Queries the current latency tcal.latency,i and statistics on the latency values.

This command returns also the minimum deviation and the maximum deviation from
zero latency. Also, it returns the measured number of non-zero latency values since
the last query with this command.

The following terms are used:
● HIL command refers to HiL mode A or HiL mode B commands:

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B

● Dropped commands are commands that are evaluated, buffered but not applied
because they become outdated as more up-to-date information is received

● Return values apply for the period since the last query with this command.

How to: Chapter 18.1.3, "Latency calibration", on page 290

Remote-control commands
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Return values: 
<CmdHwTime> float

The hardware time at the moment the last HIL command is
received.
Increment: 0.001
*RST: 0

<LastLatency> float
Time delay between the time specified with the parameter
<ElapsedTime> in a HIL command and the time this command
is executed in the R&S SMBV100B.
Increment: 0.001
*RST: 0
Default unit: s

<MaxLatency> float
The largest latency value since the last time this query was sent.
Increment: 0.001
*RST: 0
Default unit: s

<MinLatency> float
The smallest latency value since the last time this query was
sent.
Increment: 0.001
*RST: 0
Default unit: s

<NoZeroValues> integer
Number of non-zero latency values since the last time this query
was sent.
*RST: 0

<CmdReceived> integer
Accumulated <LastLatency> values since the last time this
query was sent.
*RST: 0

<CmdUsed> integer
The number of used HIL commands, excluding the dropped HIL
commands, since the last time this query was sent.
*RST: 0

<CmdSync> integer
The number of HIL commands applied at their specified time
*RST: 0

Remote-control commands
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<CmdExterp> integer
The number of extrapolated HIL commands. The commands are
applied later than their specified time.
*RST: 0

<CmdInterp> integer
The number of internal position updates.
The value includes commands describing both situations,
moment of time in past and moment of time in the future.
*RST: 0

<CmdPredict> integer
The number of internal position updates performed by the pre-
diction algorithm, see Chapter 18.1.6, "Trajectory prediction",
on page 294.
*RST: 0

<MaxUsed> integer
The maximum number buffered commands
*RST: 0

<MinUsed> integer
The minimum number buffered commands
*RST: 0

Example: See "Understanding the response of the query
SOURce:BB:GNSS:RT:RECeiver1:HILPosition:LATency:STATis-
tics?" on page 303.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency <SystemLatency>

Sets the time delay between the time specified with the parameter <ElapsedTime> in
the HIL mode A position data command and the time this command is executed in the
R&S SMBV100B.

See also Chapter 18.1.2, "System latency", on page 290.

You can use the retrieved value for latency calibration, see Chapter 18.1.3, "Latency
calibration", on page 290.

Parameters:
<SystemLatency> float

Range: 0.02  to  0.15
Increment: 0.001
*RST: 0.02
Default unit: s

Example: See "Understanding the response of the query
SOURce:BB:GNSS:RT:RECeiver1:HILPosition:LATency:STATis-
tics?" on page 303.

Remote-control commands
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Manual operation: See "System Latency" on page 300

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe <InterfaceType>

Set the interface type for the remote communication between R&S SMBV100B and the
control application.

Parameters:
<InterfaceType> SCPI | UDP

*RST: SCPI

Example: SOURce1:BB:GNSS:RECeiver:V1:HIL:ITYPe UDP

Manual operation: See "Interface Type" on page 300

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT <UdpPort>

Set the UDP port number at the R&S SMBV100B for the HIL interface.

Parameters:
<UdpPort> integer

Range: 0  to  65535
*RST: 7755

Example: SOURce1:BB:GNSS:RECeiver:V1:HIL:PORT 7756

Manual operation: See "UDP Port" on page 301

[:SOURce<hw>]:BB:GNSS:RT:HWTime?

Queries the time elapsed since the simulation start.

To query the simulation start time, use the command:

[:SOURce<hw>]:BB:GNSS:TIME:STARt:TIME.

Return values: 
<ElapsedTime> float

Range: 0  to  max
Increment: 0.001
*RST: 0
Default unit: s

Example: See [:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:
HILPosition:MODE:A on page 305.

Usage: Query only

Remote-control commands
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19  Signal generation control
This section lists settings provided for defining the signal generation start and for gen-
erating signals necessary for synchronization with other instruments.

Settings:

● Trigger settings......................................................................................................311
● Marker settings......................................................................................................316
● Clock settings........................................................................................................320
● Global connectors settings....................................................................................321

19.1  Trigger settings

Access:

► Select "GNSS" > "Trigger In".

This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

To trigger on a single event

1. Set "Mode" > "Single".

2. Set "Source" > "Internal".

3. Set the "Signal Duration", to specify how long the R&S SMBV100B generates the
signal after the trigger event.

4. Select "General" > "State" > "On".

5. If no trigger event occurs, press "Execute Trigger" to execute the trigger manually.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chap-
ter 19.4, "Global connectors settings", on page 321.

Trigger settings
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You can map trigger signals to one or more User x connectors.

Global connectors settings allow you to configure the signal mapping, the polarity,
the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMBV100B starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMBV100B user manual.

Settings:

Mode........................................................................................................................... 312
Signal Duration............................................................................................................313
Running/Stopped........................................................................................................ 313
Time Based Trigger.....................................................................................................313
Trigger Time................................................................................................................ 313
Arm..............................................................................................................................314
Execute Trigger...........................................................................................................314
Source.........................................................................................................................314
Sync. Output to External Trigger/Sync. Output to Trigger...........................................314
External Inhibit/Trigger Inhibit......................................................................................315
External Delay/Trigger Delay...................................................................................... 315

Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".

Trigger settings
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Every subsequent trigger event (internal or external) causes a restart.
Remote command: 
[:SOURce<hw>]:BB:GNSS[:TRIGger]:SEQuence on page 601

Signal Duration
Requires trigger "Mode" > "Single".
Enters the length of the trigger signal sequence.
Use this parameter, for example, for the following applications:
● To output the trigger signal partly.
● To output a predefined sequence of the trigger signal.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:SLENgth on page 603

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:RMODe? on page 601

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".
Activates time-based triggering with a fixed time reference.
The R&S SMBV100B triggers signal generation when its operating system time ("Cur-
rent Time") matches a specified time trigger ("Trigger Time"). As trigger source, you
can use an internal trigger or an external global trigger.
How to: Chapter "Time-based triggering" in the R&S SMBV100B user manual.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME[:STATe] on page 603

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".
Sets date and time for a time-based trigger signal.
Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMBV100B. If you set an earlier trigger time than the current
time, time-based triggering is not possible.
How to: Chapter "Time-based triggering" in the R&S SMBV100B user manual.

"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:DATE on page 602

Trigger settings
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"Time" Sets the time of the time-based trigger in format hh:mm:ss.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:TIME on page 602

Arm
Stops the signal generation until subsequent trigger event occurs.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:ARM:EXECute on page 603

Execute Trigger
For internal trigger source, executes trigger manually.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:EXECute on page 603

Source
The following sources of the trigger signal are available:
● "Internal"

The trigger event is executed manually by the "Execute Trigger".
● "External Global Trigger"

The trigger event is the active edge of an external trigger signal provided and con-
figured at the User x connectors.

● "Baseband Sync In"
In primary-secondary instrument mode, secondary instruments are triggered by the
active edge of the synchronization signal.

How to: "Routing and activating a trigger signal" on page 311
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:SOURce on page 601

Sync. Output to External Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.
● "On"

Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

● "Off"

Trigger settings
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The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

In primary-secondary instrument mode, this setting ensures that once achieved, syn-
chronization is not lost if the baseband signal sampling rate changes.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:EXTernal:SYNChronize:OUTPut
on page 604

External Inhibit/Trigger Inhibit
Applies for external trigger signal.
Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.
For more information, see chapter "Basics" in the R&S SMBV100B user manual.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:INHibit on page 605

External Delay/Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces
● Compensate delays and align the signal generation start in multi-instrument setup
For more information, see chapter "Basics on ..." in the R&S SMBV100B user manual.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:DELay on page 604

Trigger settings
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19.2  Marker settings

Access:

1. Select "GNSS" > "Marker".

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.
By default, the settings for "Marker 1" are displayed. The set "Marker Mode" is also
displayed for each marker on the "Marker x" side tabs.

2. To configure another marker, select e.g. the "Marker 2" side tab.

Maximum two markers can be mapped in the GNSS firmware. "Marker 3" is not
available. This marker operates in "Mode" > "Disabled" and is suspended.

To derive the frequency of a pulse marker signal

1. Select marker "Mode" > "Pattern" and set "Pattern" = "10".

2. Route the marker signal to one of the "User x" output connectors, e.g. for "User 1".

a) Select "Marker" > "Global Connectors" > "Routing".
b) Set "Direction" > "Output".
c) Set "Signal" > "Baseband Marker 1".

With a fixed symbol rate of 1.023 Msym/s, the frequency of the marker signal mea-
sured at the "User x" output connector is 511.5 kHz.
The same value results from the setting "Mode" > "Pulse" and "Divider" > "2".

To generate a high-precision marker PPS signal

The procedure illustrates how to generate and output a high-precision marker signal
associated with "Marker 1". The signal is useful, e.g., for time alignment in hardware in
the loop (HIL) test setups.

1. Specify the following:

Marker settings
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a) Select between marker modes "1PPS", "1PP2S" or "10PPS".
b) Define the pulse width.
c) Set the marker delay.

2. Optionally, specify an additional delay for fine-tuning the marker alignment to the
output RF signal.

3. To monitor the output connectors that output the high-precision PPS marker signal,
click "Show Connector".

The dialog displays the physical location of the associated connectors on the rear
panel of the instrument.

4. Select "Generate High Precision PPS > On".

The high-precision PPS marker signal is output at the analog I/Q connectors "I"
and "Q" on the rear panel of the instrument.

Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 19.4, "Global con-
nectors settings", on page 321.
You can map marker signals to one or more User x connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMBV100B adds the marker signal to the baseband signal. Also,
R&S SMBV100B outputs this signal at the configured User x connector.

About marker output signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMBV100B user manual.

Marker settings
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Settings:

Mode........................................................................................................................... 318
Delay........................................................................................................................... 319
High Precision PPS Marker on I/Q Out....................................................................... 319

└ Generate High Precision PPS.......................................................................319
└ Additional Delay............................................................................................319
└ Show Connector........................................................................................... 319

Mode
Marker configuration for up to 3 markers. The settings are used to select the marker
mode defining the shape and periodicity of the markers. The contents of the dialog
change with the selected marker mode.
How to: "Routing and activating a marker signal" on page 317
"1PPS"/"10PPS"/"1PP2S"

A marker signal is generated at:
● The start of every second
● 10 times per second or once every 100 ms
● Once every two seconds
Set the "Pulse Width" in the corresponding field.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:
WIDTh on page 608

"Pulse" Regular marker signal.
To define the pulse frequency, set the divider. The pulse frequency is
derived by dividing the chip rate by the divider; the resulting "Fre-
quency" value is displayed.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:
DIVider on page 607
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:
FREQuency? on page 608

"Pattern" Marker signal that is defined by a bit pattern. The pattern has a maxi-
mum length of 64 bits.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PATTern
on page 607

Marker settings
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"On/Off Ratio"
Regular marker signal that is defined as on-time and off-time; a
period lasts one on and off cycle.

Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:ONTime
on page 606
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:OFFTime
on page 606

Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:MODE on page 606

Delay
Delays the marker signal at the marker output relative to the signal generation start.
Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:DELay on page 606

High Precision PPS Marker on I/Q Out
The panel comprises settings to configure high-precision marker signals output at the
analog I/Q output connectors "I"/"Q".

Generate High Precision PPS ← High Precision PPS Marker on I/Q Out
Enables generation of a high-precision PPS marker signal.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:STATe on page 607

Additional Delay ← High Precision PPS Marker on I/Q Out
Sets an additional delay for the high-precision PPS marker signal.
Remote command: 
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:ADELay on page 607

Show Connector ← High Precision PPS Marker on I/Q Out
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Marker settings
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19.3  Clock settings

Access:

► Select "GNSS" > "Clock".

This tab provides settings to select and configure the clock signal, like the clock
source and clock mode.

Defining the clock

1. Select "Clock" > "Source" to define the source of clock signal.

2. For external clock signals, define the connector for signal input. See Chapter 19.4,
"Global connectors settings", on page 321.
You can map clock signals to one or more User x connectors.

Global connectors settings allow you to configure the signal mapping, the polarity,
the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMBV100B starts baseband signal generation with a symbol rate that
equals the clock rate.

About clock signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMBV100B user manual.

Settings:

Clock Source...............................................................................................................320

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
How to: "Defining the clock" on page 320
Remote command: 
[:SOURce<hw>]:BB:GNSS:CLOCk:SOURce on page 609

Clock settings
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19.4  Global connectors settings

Accesses a dialog to configure global connectors.

The button is available in the following dialogs or tabs:
● "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block

diagram.
● "Trigger In", "Marker" and "Clock" tabs that are accessible via the "Baseband"

block in the block diagram.

See also chapter "Global connectors settings" in the user manual.

Global connectors settings
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20  How to perform signal generation tasks with
the GNSS options
● General workflow for signal generation tasks....................................................... 322
● How to generate GNSS signals for simple receiver tests..................................... 324
● How to simulate real-world effects........................................................................ 324
● How to add noise or CW interferer........................................................................324
● How to load historical data....................................................................................324

20.1  General workflow for signal generation tasks

The general workflow shows the main configuration steps to be performed for almost
all configuration tasks. Therefore, the examples generally refer to the workflow. Addi-
tional steps and settings are described in the examples explicitly.

General workflow for signal generation tasks
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Figure 20-1: General workflow

General workflow for signal generation tasks
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20.2  How to generate GNSS signals for simple receiver
tests

See
● "To generate a GNSS signal" on page 28
● "To generate a multi-constellation GNSS signal" on page 31

20.3  How to simulate real-world effects

For simulating antenna patterns and body masks, see:
● "To load an antenna pattern/body mask file" on page 124
● "To simulate antenna pattern" on page 125
● "To change the antenna pattern" on page 128
● "To prepare for automotive applications" on page 129
● "To modify antenna attenuation and phase values" on page 130
● "To create an antenna pattern/body mask file" on page 131

20.4  How to add noise or CW interferer

See
● "To add noise to a GNSS signal" on page 192
● "To shift noise to one RF band" on page 193
● "To add a CW interferer to a GNSS signal" on page 194

20.5  How to load historical data

See
● Chapter 17.1, "Import constellation settings", on page 284
● Chapter 17.2, "Import SBAS settings", on page 286
● Chapter 14.3, "How to generate SBAS corrections", on page 239

How to load historical data
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21  Remote-control commands
The following commands are required for signal generation with the satellite navigation
options in a remote environment. We assume that the R&S SMBV100B has already
been set up for remote operation in a network as described in the R&S SMBV100B
documentation. A knowledge about the remote control operation and the SCPI com-
mand syntax is assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMBV100B user manual.

The :SOURce<hw>:BB:GPS|GALileo|GLONass|BEIDou|NAVic|QZSS subsystem
contains commands for configuring the GNSS standards.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> 1 Available baseband signals

OUTPut<ch> 1 to 3 Available markers

SVID<ch> 1 to 37 for GPS

1 to 36 for Galileo

1 to 24 for GLONASS

1 to 35 for BeiDou

1 to 14 for NavIC

193 to 195 for QZSS

Distinguishes between satellite SV IDs

A<ch>
A<gr>

1 to 4 Simulated antenna

BASE<st> 1 Simulated RTK base station

ECHO<s2us0> 1 to 9 Echoes in the multipath configuration

MONitor<ch> 1 to 2 Pane in the "Simulation Monitor" dialog

RF<ch> 1 RF paths for noise configuration

STReam<st> 1 to 6 Simulated GNSS stream

V<st>
V<us>

1 Simulated vehicle

Required options

For an overview, see Chapter 2.1, "Required options", on page 17.
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SCPI command contains Required option

SYSTem:GPS
TIME:STARt:GPS
TIME:CONVersion:GPS
SVID<ch>:GPS
SVID:GPS
SV:SELection:GPS
SV:IMPOrt:GPS
ADGeneration:GPS

R&S SMBVB-K44

R&S SMBVB-K98

L2C
L5S

R&S SMBVB-K98

SYSTem:GALileo
TIME:STARt:GALileo
TIME:CONVersion:GALileo
SVID<ch>:GALileo
SVID:GALileo
SV:SELection:GALileo
SV:IMPort:GALileo
ADGeneration:GALileo
E1OS
E5A
E5B

R&S SMBVB-K66

SYSTem:GLONnas
TIME:STARt:GLONnas
TIME:CONVersion:GLONnas
SVID<ch>:GLONnas
SVID:GLONnas
SV:SELection:GLONnas
SV:IMPOrt:GLONnas
ADGeneration:GLONnas

R&S SMBVB-K94

SYSTem:BEIDou
TIME:STARt:BEIDou
TIME:CONVersion:BEIDou
SVID<ch>:BEIDou
SVID:BEIDou
SV:SELection:BEIDou
SV:IMPOrt:BEIDou
ADGeneration:BEIDou

R&S SMBVB-K107

R&S SMBVB-K132



Remote-control commandsSatellite Navigation

327User Manual 1178.9403.02 ─ 10

SCPI command contains Required option

SYSTem:NAVic
TIME:STARt:NAVic
TIME:CONVersion:NAVic
SVID<ch>:NAVic
SVID:NAVic
SV:SELection:NAVic
SV:IMPOrt:NAVic
ADGeneration:NAVic

R&S SMBVB-K197

SBAS
QZSS

R&S SMBVB-K106

RECeiver[:V<st>]:ATTitude
RECeiver[:V<st>]:ENVironment
MPATh

R&S SMBVB-K108

HIL R&S SMBVB-K109

BASE<st> R&S SMBVB-K122.

Programming examples

This section provides simple programming examples. The purpose of the examples is
to present all commands for a given task. In real applications, you typically use an
appropriate subset of these commands.

For verification and testing purposes, a software tool executed these programming
examples. To keep the example as simple as possible, the examples report clean SCPI
syntax elements. Non-executable command lines, for example comments, start with
two characters //.

Before executing a SCPI sequence, most remote control programs reset or preset the
instrument to a definite state. The commands *RST and SYSTem:PRESet are equiva-
lent for this purpose. *CLS also resets the status registers and clears the output buffer.

The following commands specific to the GNSS options are described here:

● General commands...............................................................................................328
● System and signal commands.............................................................................. 333
● Time conversion configuration.............................................................................. 337
● Receiver positioning configuration commands......................................................351
● Antenna pattern and body mask........................................................................... 360
● Real-time kinematics (RTK) commands................................................................364
● Environment configuration commands..................................................................373
● Static multipath configuration................................................................................386
● Atmospheric configuration commands..................................................................399
● AWGN configuration............................................................................................. 405
● Satellites constellation...........................................................................................409
● Signals and power configuration per satellite........................................................419
● Navigation message commands...........................................................................446
● Galileo OSNMA commands.................................................................................. 532



Remote-control commandsSatellite Navigation

328User Manual 1178.9403.02 ─ 10

● SBAS corrections..................................................................................................540
● Signal dynamics....................................................................................................551
● Assistance data commands.................................................................................. 561
● Monitoring and real-time commands.....................................................................574
● Data logging commands....................................................................................... 593
● Trigger commands................................................................................................ 599
● Marker commands................................................................................................ 605
● Clock commands...................................................................................................609

21.1  General commands

Example: Save/Recall files with user settings
Query and load settings files, saved with the save/recall function.

MMEM:CDIR '/var/user/settings'
SOURce1:BB:GNSS:SETTing:CATalog?
// Response: gnss_settings,settings
SOURce1:BB:GNSS:SETTing:STORe '/var/user/settings/gnss'
SOURce1:BB:GNSS:SETTing:LOAD '/var/user/settings/gnss_settings'
SOURce1:BB:GNSS:SETTing:DELete '/var/user/settings/settings'
// Deletes the file settings.gnss
SOURce1:BB:GNSS:SETTing:CATalog?
// Response: gnss_settings,gnss

Example: Selecting a predefined test scenario
Enable a predefined scenario.

// ********************************************************************************
// Select and enable the predefined test scenario 3GPP FDD Signaling Test Scenario 2.
// ********************************************************************************
SOURce1:BB:GNSS:PRESet
// Lists all predefined scenarios in a comma-separated list.
SOURce1:BB:GNSS:SETTing:CATalog:PREDefined?
// Response: "Assisted GNSS+EUTRA/LTE+3GPP TS 37.571-2:  S7  Signaling ST1; ..."
SOURce1:BB:GNSS:SETTing:LOAD:PREDefined "3GPP TS 37.571-2:  S7  Signaling ST2"
SOURce1:BB:GNSS:SCENario?
// Response: "3GPP TS 37.571-2:  S7  Signaling ST2"
// Query simulation information.
SOURce1:BB:GNSS:SIMulation:INFO?
// Response: "L1 / GLONASS only"

SOURce1:BB:GNSS:TMODe?
// Response: "NAV"

SOURce1:BB:GNSS:STATe ON
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Commands:

[:SOURce<hw>]:BB:GNSS:PRESet................................................................................. 329
[:SOURce<hw>]:BB:GNSS:STATe................................................................................... 329
[:SOURce<hw>]:BB:GNSS:SCENario?............................................................................ 329
[:SOURce<hw>]:BB:GNSS:TMODe................................................................................. 330
[:SOURce<hw>]:BB:GNSS:SIMulation:INFO?...................................................................331
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog?................................................................. 331
[:SOURce<hw>]:BB:GNSS:SETTing:STORe.....................................................................331
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD...................................................................... 331
[:SOURce<hw>]:BB:GNSS:SETTing:DELete.................................................................... 332
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog:PREDefined?...............................................332
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD:PREDefined....................................................332

[:SOURce<hw>]:BB:GNSS:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:GNSS:STATe.

Example: See Example"Selecting a predefined test scenario"
on page 328.

Usage: Event

Manual operation: See "Set to Default" on page 33

[:SOURce<hw>]:BB:GNSS:STATe <State>

Enables/disables the GNSS signal simulation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Selecting a predefined test scenario"
on page 328.

Manual operation: See "State" on page 33

[:SOURce<hw>]:BB:GNSS:SCENario?

Queries the current scenario.

Return values: 
<Scenario> string

NONE
Indicates the preset configuration or a user-defined configura-
tion.
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Scenario name
Returns the scenario name of a predefined scenario, e.g.
"3GPP TS 37.571-2: S7 Signaling ST1". See Chap-
ter E, "Predefined GNSS scenarios", on page 630.
Filename
Returns the filename of a saved, user-defined scenario. The
scenario file has the extension *.gnss.

Example: See Example"Selecting a predefined test scenario"
on page 328.

Usage: Query only

Manual operation: See "Scenario" on page 34

[:SOURce<hw>]:BB:GNSS:TMODe <SMode>

Sets the test mode.

Parameters:
<SMode> TRACking | NAVigation | SINGle

TRACking
Tracking mode
The generated signal contains no positioning data. You do not
need to configure the GNSS receiver. Navigation and acquiring
of position fix is not possible.
The signal is sufficient to test the ability of the DUT to find the
channel and to decode the signal. It is also sufficient for receiver
sensitivity testing. Use this mode to simulate high signal dynam-
ics. For example, simulate spinning vehicles and precision code
(P code) signals.
NAVigation
Navigation mode
The generated signal contains satellite signals to simulate a par-
ticular location of a GNSS receiver.
This signal implies a realistic navigation scenario. The DUT can
achieve position fix, since the satellite constellation comprises of
at least three satellites. The signal is suitable for signal acquisi-
tion and TTFF tests.
SINGle
Single-satellite mode
The generated GNSS signal contains one satellite signal for
each GNSS system GPS, Galileo, GLONASS, COMPASS/
BeiDou and NavIC. Use this mode for production tests.
Navigation and acquiring of position fix is not possible. The sig-
nal is sufficient to test the ability of the DUT to find the channel
and to decode the signal. It is also sufficient for receiver sensitiv-
ity testing.
*RST: NAVigation
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Example: See Example"Selecting a predefined test scenario"
on page 328.

Options: SINGle requires option R&S SMBVB-K133.

Manual operation: See "Test Mode" on page 34

[:SOURce<hw>]:BB:GNSS:SIMulation:INFO?

Queries information on the current enabled RF bands, signals and GNSS standards.

Return values: 
<SimConfigInfo> string

Example: See Example"Selecting a predefined test scenario"
on page 328.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:SETTing:CATalog?

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.gnss.

Example: See Example"Save/Recall files with user settings" on page 328.

Usage: Query only

Manual operation: See "Recall Scenario/Save Scenario" on page 33

[:SOURce<hw>]:BB:GNSS:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.gnss) is
assigned automatically.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Example: See Example"Save/Recall files with user settings" on page 328.

Usage: Setting only

Manual operation: See "Recall Scenario/Save Scenario" on page 33

[:SOURce<hw>]:BB:GNSS:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.gnss.
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Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted
Query the existing files with the command [:SOURce<hw>]:
BB:GNSS:SETTing:CATalog?.

Example: See Example"Save/Recall files with user settings" on page 328.

Usage: Setting only

Manual operation: See "Recall Scenario/Save Scenario" on page 33

[:SOURce<hw>]:BB:GNSS:SETTing:DELete <Filename>

Deletes the selected file from the default or the specified directory.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See Example"Save/Recall files with user settings" on page 328.

Usage: Setting only

Manual operation: See "Recall Scenario/Save Scenario" on page 33

[:SOURce<hw>]:BB:GNSS:SETTing:CATalog:PREDefined?

Queries the files with predefined settings.

Example: See Example"Selecting a predefined test scenario"
on page 328.

Usage: Query only

Manual operation: See "Predefined Scenario" on page 34

[:SOURce<hw>]:BB:GNSS:SETTing:LOAD:PREDefined <Scenario>

Loads the selected scenario file.

Setting parameters: 
<Scenario> "<ScenarioName>"

Name of a predefined scenario, as queried with the command
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog:
PREDefined?.

Example: See Example"Selecting a predefined test scenario"
on page 328.

Usage: Setting only

Manual operation: See "Predefined Scenario" on page 34
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21.2  System and signal commands

Example: Enabling GNSS systems and signals
The example illustrates how to enable RF bands, GNSS systems and signals.

SOURce1:BB:GNSS:TMODe NAV
********************************************************************************
// Enable and query RF band states.
********************************************************************************
SOURce1:BB:GNSS:L1Band:STATe 1
SOURce1:BB:GNSS:L2Band:STATe? 0
SOURce1:BB:GNSS:L5Band:STATe 1
********************************************************************************
// Enable and query GNSS system states.
********************************************************************************
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
SOURce1:BB:GNSS:SYSTem:GLONass:STATe? 0
SOURce1:BB:GNSS:SYSTem:BEIDou:STATe? 0
SOURce1:BB:GNSS:SYSTem:NAVic:STATe? 0
SOURce1:BB:GNSS:SYSTem:QZSS:STATe? 0
********************************************************************************
// Enable signals within GNSS systems and RF band.
********************************************************************************
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:CA:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:L2C:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L5Band:L5S:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:SIGNal:L1Band:E1OS:STATe 1

********************************************************************************
// Query information on active RF bands, central RF frequency and GNSS systems.
********************************************************************************
SOURce1:BB:GNSS:SIMulation:INFO?
// Response: "L1,L2,L5 / GPS,Galileo"
SOURce1:BB:GNSS:CFRequency?
// Response in Hz: 1389225000

Commands:

[:SOURce<hw>]:BB:GNSS:CFRequency?........................................................................334
[:SOURce<hw>]:BB:GNSS:L5Band[:STATe]......................................................................335
[:SOURce<hw>]:BB:GNSS:L2Band[:STATe]......................................................................335
[:SOURce<hw>]:BB:GNSS:L1Band[:STATe]......................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS[:STATe]..............................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN[:STATe]..............................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS[:STATe]................................................ 335
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS[:STATe]................................................ 335
[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic[:STATe]...........................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS[:STATe].......................................................... 335
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou[:STATe]........................................................ 335
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass[:STATe]..................................................... 335
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo[:STATe]........................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS[:STATe]............................................................ 335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS[:STATe]?.........................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L5Band:EL5S[:STATe].......................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L1Band:CA[:STATe]..............................336
[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic:SIGNal:L5Band:SPS[:STATe]............................336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L5Band:L5S[:STATe]............................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L2Band:L2C[:STATe]............................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:L1C[:STATe]............................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:CA[:STATe]..............................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2I[:STATe]...........................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2A[:STATe]..........................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2B[:STATe]..........................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L2Band:B3I[:STATe]...........................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1I[:STATe]...........................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1C[:STATe]......................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:CA[:STATe]........................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:L1CDma[:STATe]................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:CA[:STATe]........................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:L2CDma[:STATe]................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L5Band:L3CDma[:STATe]................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L2Band:E6S[:STATe]......................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5B[:STATe]......................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5A[:STATe]......................... 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L1Band:E1OS[:STATe].......................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L5Band:L5S[:STATe].............................. 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:L2C[:STATe].............................. 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:P[:STATe]..................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:CA[:STATe]................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C[:STATe].............................. 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P[:STATe]..................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA[:STATe]................................337

[:SOURce<hw>]:BB:GNSS:CFRequency?

Queries the central RF frequency. The response is a mean value depending on
enabled RF bands and GNSS systems.

Return values: 
<CentralRfFreq> integer

Range: 1E9  to  2E9
*RST: 1E9
Default unit: Hz

Example: See Chapter 21.2, "System and signal commands",
on page 333.
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Usage: Query only

[:SOURce<hw>]:BB:GNSS:L5Band[:STATe] <L5BandState>
[:SOURce<hw>]:BB:GNSS:L2Band[:STATe] <L2BandState>
[:SOURce<hw>]:BB:GNSS:L1Band[:STATe] <L1BandState>
Activates the RF band.

Parameters:
<L1BandState> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "L# Band" on page 69

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS[:STATe] <State>
Defines if satellites from the selected GNSS system are included in the simulated sat-
ellites constellation.

Parameters:
<State> 1 | ON | 0 | OFF

Disabling a GNSS system deactivates all SVID and signals from
this system.
*RST: 0

Example: See Example"Enabling GNSS systems and signals"
on page 333.

Manual operation: See "System" on page 69

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS[:STATe]?

Queries if at least one of the SBAS system is enabled.

Return values: 
<State> 1 | ON | 0 | OFF

1
At least one SBAS system is enabled.
To enable each of the SBAS systems, use the corresponding
command, e.g. [:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:
EGNOS[:STATe].
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0
All SBAS systems are disabled.
*RST: 0

Example: See Example"Enabling GNSS systems and signals"
on page 333.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L5Band:EL5S[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L1Band:CA[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic:SIGNal:L5Band:SPS[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L5Band:L5S[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L2Band:L2C[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:L1C[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:CA[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2I[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2A[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2B[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L2Band:B3I[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1I[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1C[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:CA[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:L1CDma[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:CA[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:L2CDma[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L5Band:L3CDma[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L2Band:E6S[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5B[:STATe]
<SignalState>
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[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5A[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L1Band:E1OS[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L5Band:L5S[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:L2C[:STATe]
<SignalState>

[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:P[:STATe] <SignalState>
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:CA[:STATe]

<SignalState>
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C[:STATe]

<SignalState>
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P[:STATe] <SignalState>
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA[:STATe]

<SignalState>
Enables the corresponding signal from the GNSS system in the corresponding RF
band.

Parameters:
<SignalState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Enabling GNSS systems and signals"
on page 333.

Manual operation: See "Signals" on page 71

21.3  Time conversion configuration

Example: Configuring the time conversion and leap seconds settings
The example illustrate how to define simulation start and how to configure time set-
tings.

********************************************************************************
// Set test mode and activate GNSS systems.
********************************************************************************
SOURce1:BB:GNSS:TMODe NAV
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
SOURce1:BB:GNSS:SYSTem:GLONass:STATe 1
********************************************************************************
// Set simulation start date and time in UTC format.
********************************************************************************
SOURce1:BB:GNSS:TIME:STARt:TBASis UTC
SOURce1:BB:GNSS:TIME:STARt:DATE 2016,2,19
SOURce1:BB:GNSS:TIME:STARt:TIME 7,0,0
// Query the simulation start in GPS format.
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SOURce1:BB:GNSS:TIME:STARt:TBASis GPS
SOURce1:BB:GNSS:TIME:STARt:WNUMber?
// Response: 1884
SOURce1:BB:GNSS:TIME:STARt:TOWeek?
// Response: 457216.3154372
********************************************************************************
// Query week number and time of week for active GNSS systems.
********************************************************************************
SOURce1:BB:GNSS:TIME:STARt:GPS:WNUMber?
// Response: 1884
SOURce1:BB:GNSS:TIME:STARt:GPS:TOWeek?
// 457216.3154372
SOURce1:BB:GNSS:TIME:STARt:GALileo:WNUMber?
// Response: 1884
SOURce1:BB:GNSS:TIME:STARt:GALileo:TOWeek?
// Response: 457210.078614114
SOURce1:BB:GNSS:TIME:STARt:GLONass:DATE?
// Response: 2016,2,19
SOURce1:BB:GNSS:TIME:STARt:GLONass:TIME?
// Response: 9,59,46.158
/ Set the simulation start to the current operating system time.
SOURce1:BB:GNSS:TIME:STARt:SCTime
SOURce1:BB:GNSS:TIME:STARt:DATE?
// Response: 2020,7,28
SOURce1:BB:GNSS:TIME:STARt:TIME?
// Response: 11,35,0
********************************************************************************
// Activate automatic leap second calculation.
********************************************************************************
SOURce1:BB:GNSS:TIME:CONVersion:LEAP:AUTO 1
SOURce1:BB:GNSS:TIME:CONVersion:LEAP:DATE?
// Response: 2015,6,30
SOURce1:BB:GNSS:TIME:CONVersion:LEAP:BEFore?
// Response in seconds: 16
SOURce1:BB:GNSS:TIME:CONVersion:LEAP:AFTer?
// Response in seconds: 17
********************************************************************************
// Set time conversion parameters for automatic time conversion.
********************************************************************************
SOURce1:BB:GNSS:TIME:CONVersion:GPS:UTC:WNOT 244
SOURce1:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT:UNSCaled 475200
SOURce1:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE:UNSCaled 0
SOURce1:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo:UNSCaled 0
SOURce1:BB:GNSS:TIME:CONVersion:GPS:UTC:IOFFset?
// Response: 16
SOURce1:BB:GNSS:TIME:CONVersion:UTCSu:UTC:DATE?
// Response: 2014,2,19
SOURce1:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo:UNSCaled 0
SOURce1:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo:UNSCaled 0
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SOURce1:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE:UNSCaled 0
// etc. for each GNSS system

Commands:

[:SOURce<hw>]:BB:GNSS:TIME:STARt:DATE................................................................. 341
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SCTime.............................................................. 342
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TBASis............................................................... 342
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TIME.................................................................. 342
[:SOURce<hw>]:BB:GNSS:TIME:STARt:TOWeek............................................................. 343
[:SOURce<hw>]:BB:GNSS:TIME:STARt:WNUMber...........................................................343
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:AUTO............................................... 343
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:AFTer.................................344
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:BEFore.............................. 344
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:DATE................................................344
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:DATE?........................................................ 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:DATE?................................................ 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:TIME?.........................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:TIME?................................................. 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:WNUMber?...................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:WNUMber?...................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:WNUMber?..................................... 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:WAAS:WNUMber?..................................... 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:WNUMber?............................................... 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:WNUMber?............................................... 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:WNUMber?.............................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:WNUMber?............................................ 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:WNUMber?................................................. 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:TOWeek?..................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:TOWeek?..................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:TOWeek?........................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:WAAS:TOWeek?....................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:TOWeek?..................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:TOWeek?..................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:TOWeek?............................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:TOWeek?...............................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:TOWeek?....................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:OFFSet?..................................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:OFFSet?.......................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:OFFSet?.......................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:OFFSet?......................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:OFFSet?................................................... 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:OFFSet?...................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:OFFSet?.................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:OFFSet?................................................ 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:OFFSet?..............................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:OFFSet?.....................................................346
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:WNOT.................................... 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:WNOT..........................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:WNOT..........................347
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:WNOT............................ 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:WNOT............................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:WNOT...................................... 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:WNOT......................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:WNOT....................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:WNOT................................... 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:WNOT.................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:WNOT.............................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:WNOT........................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:DATE?....................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT:UNSCaled........................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT........................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT:UNSCaled............. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT............................. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT:UNSCaled............. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT............................. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT:UNSCaled................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT:UNSCaled............... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT............................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT:UNSCaled..........................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT..........................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT:UNSCaled..........................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT......................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT:UNSCaled....................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT....................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT:UNSCaled.......................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT.......................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT:UNSCaled.................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT.................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT:UNSCaled................ 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT................................ 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT:UNSCaled............................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT........................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:IOFFset?.................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:IOFFset?......................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:IOFFset?......................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:IOFFset?........................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:IOFFset?........................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:IOFFset?.................................. 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:IOFFset?.................................. 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:IOFFset?................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:IOFFset?................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:IOFFset?.........................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:IOFFset?.................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo:UNSCaled.........349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo.........................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo:UNSCaled.........349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo.........................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo:UNSCaled........... 349
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo........................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo:UNSCaled........... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo........................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo:UNSCaled..................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo......................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo:UNSCaled..................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo..................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo:UNSCaled...................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo:UNSCaled.................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo...................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo:UNSCaled................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo................................ 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo:UNSCaled............350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo............................ 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo:UNSCaled................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo....................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo:UNSCaled....................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo....................................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE:UNSCaled.......... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE.......................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE:UNSCaled.......... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE.......................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE:UNSCaled.............350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE.............................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE:UNSCaled............ 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE.............................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE:UNSCaled.......................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE.......................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE:UNSCaled...................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE.......................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE:UNSCaled.................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE.................................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE:UNSCaled....................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE....................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE:UNSCaled................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE................................. 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE:UNSCaled............. 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE............................. 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE:UNSCaled.....................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE.....................................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE:UNSCaled........................ 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE.........................................351

[:SOURce<hw>]:BB:GNSS:TIME:STARt:DATE <Year>, <Month>, <Day>

If the time base is UTC, defines the date for the simulation in DD.MM.YYYY format of
the Gregorian calendar.
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Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Simulation Start" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:STARt:SCTime

Applies date and time settings of the operating system to the simulation start time.

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Event

Manual operation: See "Set Current Time" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:STARt:TBASis <SystemTime>

Determines the time basis used to enter the simulation start time.

Parameters:
<SystemTime> UTC | GPS | GST | GLO | BDT | NAV

*RST: UTC

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Simulation Start" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:STARt:TIME <Hour>, <Minute>, <Second>

If the time base is UTC, sets the simulation start time in UTC time format.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> float
Range: 0  to  59.999
Increment: 0.001
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Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Simulation Start" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:STARt:TOWeek <TOW>

If time base is GPS or GST, sets the simulation start time within week set with the com-
mand [:SOURce<hw>]:BB:GNSS:TIME:STARt:WNUMber.

Parameters:
<TOW> float

Number of seconds since the beginning of the week
Range: 0  to  604799.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Simulation Start" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:STARt:WNUMber <Week>

If time base is GPS or GST, sets the week number (WN).

Parameters:
<Week> integer

The weeks are numbered starting from a reference time point
(WN_REF=0), that depends on the navigation standard.
Range: 0  to  9999*53
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Simulation Start" on page 48

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:AUTO <AutoConfigure>

Enables the simulation of the leap second transition.

Parameters:
<AutoConfigure> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Auto Configure Leap Second (Ref. 1980)" on page 49
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:AFTer
<LeapSeconds>

Specifies the leap second value after the leap second transition.

Parameters:
<LeapSeconds> integer

Range: 0  to  50
*RST: 17

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Leap Second after Transition - ΔtLSF" on page 49

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:BEFore
<LeapSecends>

Specifies the leap second value before the leap second transition.

Parameters:
<LeapSecends> integer

Range: 0  to  50
*RST: 16

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Leap Second before Transition - ΔtLS" on page 49

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:DATE <Year>, <Month>,
<Day>

Defines the date of the next UTC time correction.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Leap Second Transition Date" on page 49
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[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:DATE?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:DATE?
Queries the date at the simulation start time of the selected navigation standard.

Return values: 
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:TIME?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:TIME?
Queries the simulation start time of the selected navigation standard.

Return values: 
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> float
Range: 0  to  59.999
Increment: 0.001

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:WAAS:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:WNUMber?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:WNUMber?
Queries the week number at the simulation start of the selected navigation standard.
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Return values: 
<SystemWeekNumb> integer

Range: 0  to  10000
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

Manual operation: See "Date / Week, Time / Time of Week /s, UTC Offset /s"
on page 50

[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:WAAS:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:TOWeek?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:TOWeek?
Queries the time of week at the simulation start of the selected navigation standard.

Return values: 
<TOW> float

Range: 0  to  604799.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

Manual operation: See "Date / Week, Time / Time of Week /s, UTC Offset /s"
on page 50

[:SOURce<hw>]:BB:GNSS:TIME:STARt:UTC:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:NAVic:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:OFFSet?
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:OFFSet?
Queries the time offset between the time in the navigation standard and UTC.
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Return values: 
<UtcOffset> float

Range: -1E6  to  1E6
Increment: 0.001
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

Manual operation: See "Date / Week, Time / Time of Week /s, UTC Offset /s"
on page 50

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:WNOT <Wnot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:WNOT <Wnot>
Sets the UTC data reference week number, WNt.

Parameters:
<Wnot> integer

Range: 0  to  255
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Reference Week/Date, Reference Time of Week"
on page 50

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:DATE?

Enters the date for the UTC-UTC(SU) data in DMS format.

Return values: 
<Year> integer

Range: 1996  to  9999

<Month> integer
Range: 1  to  12
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<Day> integer
Range: 1  to  31

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

Manual operation: See "UTC-UTC(SU)" on page 50

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT:UNSCaled

<Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT:UNSCaled <Tot>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT <Tot>
Sets the UTC data reference time of week, tot.

Parameters:
<Tot> integer

Range: 0  to  255
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Time conversion configuration



Remote-control commandsSatellite Navigation

349User Manual 1178.9403.02 ─ 10

Manual operation: See "Reference Week/Date, Reference Time of Week"
on page 50

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:IOFFset?
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:IOFFset?
Queries the integer offset.

Return values: 
<IntegerOffset> integer

Range: 0  to  604800
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Usage: Query only

Manual operation: See "Integer Offset" on page 50

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo:
UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo
<AZero>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo:
UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo
<AZero>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo:
UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo:

UNSCaled <A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo:UNSCaled <A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo:UNSCaled <A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo:UNSCaled

<A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo <AZero>
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo:UNSCaled
<A0>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo:UNSCaled

<A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo:

UNSCaled <A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo:UNSCaled

<A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo <AZero>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo:UNSCaled <A0>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo <AZero>
Sets the constant term of polynomial, A0.

Parameters:
<AZero> integer

Range: -2147483648  to  2147483647
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Fractional Offset A0, Drift A1" on page 51

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE:
UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE:

UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE:UNSCaled

<A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE:

UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE:UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE:UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE:UNSCaled

<A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE:UNSCaled

<A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE:UNSCaled

<A1>
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE:UNSCaled

<A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE:UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE <AOne>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE:UNSCaled <A1>
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE <AOne>
Sets the first order term of polynomial, A1.

Parameters:
<AOne> integer

Range: -8388608  to  8388607
*RST: 0

Example: See Example"Configuring the time conversion and leap seconds
settings" on page 337.

Manual operation: See "Fractional Offset A0, Drift A1" on page 51

21.4  Receiver positioning configuration commands

This section describes the commands for configuring the position of GNSS receivers.

Example: Setting the initial position of a receiver
// Select a user-defined position.
SOURce1:BB:GNSS:RECeiver:V1:LOCation:CATalog?
// Respone: "User Defined, Waypoints, New York, .."
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SELect "User Defined"

SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:RFRame WGS84
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:DMS:WGS?
// 11,35,0,EAST,48,9,0,NORT,508
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:FORMat DEC
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:DEC:WGS?
// 11.583333,48.150000,508

Example: Simulating attitude behavior of a static receiver
SOURce1:BB:GNSS:RECeiver:V1:POSition STAT
// query predefined positions and select one of them
SOURce1:BB:GNSS:RECeiver:V1:LOCation:CATalog?
// User Defined,Waypoints,New York,San Francisco,Beijing,Seoul,...
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SELect "Munich"

SOURce1:BB:GNSS:RECeiver:V1:ATTitude:BEHaviour CONS
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:YAW 0
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SOURce1:BB:GNSS:RECeiver:V1:ATTitude:PITCh 0
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:ROLL 0

Example: Simulating a moving receiver
// Simulate a moving receiver, e.g. a car.
SOURce1:BB:GNSS:RECeiver:V1:POSition MOV

// Query predefined waypoint files and select one of them
SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:FILE "Munich_Car_Motion.xtd"
SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:ROMode?
// SYCL
SOURce1:BB:GNSS:RECeiver1:LOCation:WAYPoints:DURation?
// 109.8
SOURce1:BB:GNSS:RECeiver:V1:LOCation:COORdinates:RFRame WGS84
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SMOVement?
// 0
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:BEHaviour?
// FILE

// Activate trajectory smoothening.
// query predefined vehicle description files
// select one of them
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SMOVement 1
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:BEHaviour?
// MOT
SOURce1:BB:GNSS:VEHicle:CATalog:PREDefined?
// Aircraft1,HiL_Big_Aircraft,HiL_Helicopter,HiL_Jet_Aircraft,...
SOURce1:BB:GNSS:RECeiver:V1:LOCation:VEHicle:FILE "LandVehicle1.xvd"

// Simulate an airplane.
// Enable trajectory smoothening by using *.xvd file. Enable spinning.
SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:FILE "Munich_Flight.xtd"
SOURce1:BB:GNSS:RECeiver:V1:LOCation:SMOVement 1
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:BEHaviour MOT
SOURce1:BB:GNSS:RECeiver:V1:LOCation:VEHicle:FILE "Small_Jet.xvd"
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:BEHaviour SPIN
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:SPIN:RATE 10
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:PITCh 10
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:YAW 15
SOURce1:BB:GNSS:RECeiver:V1:ATTitude:ROLL 10

SOURce1:BB:GNSS:STATe 1

Example: Using user-defined vehicle description files
// Query the available vehicle description files and load one of them
:MMEM:CDIR "/var/user/myXVDFiles"
SOURce1:BB:GNSS:VEHicle:CATalog:USER? 
// my_Pedestrian
SOURce1:BB:GNSS:RECeiver:V1:LOCation:VEHicle:FILE "/var/user/myXVDFiles/my_Pedestrian.xvd"
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Commands:

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:POSition......................................................353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog........................................ 353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]........................................354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:RFRame.................. 354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:FORMat...................354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal:PZ............. 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal[:WGS]........355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:PZ...................355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS[:WGS]............. 355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]....................................357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:YAW.............................................. 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:PITCh............................................357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:ROLL.............................................358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:SPIN:RATE.................................... 358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:FILE............................ 358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:DURation..................... 358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:LENGth?......................359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:ROMode...................... 359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:SMOVement..................................359
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:PREDefined?................................................360
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:USER?.........................................................360
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:VEHicle:FILE.................................360

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:POSition <Positioning>

Sets what kind of receiver is simulated.

Parameters:
<Positioning> STATic | MOVing | HIL

Example: See Example"Simulating attitude behavior of a static receiver"
on page 351.

Options: HIL requires R&S SMBVB-K109

Manual operation: See "Position" on page 53

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog

Queries the names of predefined geographic locations of the GNSS receiver. The
query returns a comma-separated list of available locations.

For predefined geographic locations, see Table 5-1.

Example: See Example"Setting the initial position of a receiver"
on page 351.

Manual operation: See "Location, Initial Position" on page 55
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect] <Location>

Selects the geographic location of the GNSS receiver.

Parameters:
<Location> string

User Defined
Enables the definition of the "Latitude", "Longitude" and "Alti-
tude" of the GNSS receiver with fixed position in the ECEF
WGS84 coordinate system.
"<City>"
Selects one of the predefined geographic locations, see
Table 5-1. The parameters latitude, longitude and altitude are set
according to the selected position.

Example: See Example"Setting the initial position of a receiver"
on page 351.

Manual operation: See "Location, Initial Position" on page 55

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:RFRame
<ReferenceFrame>

Selects the reference frame used to define the receiver coordinates.

Parameters:
<ReferenceFrame> PZ90 | WGS84

*RST: WGS84

Example: See Example"Simulating attitude behavior of a static receiver"
on page 351.

Manual operation: See "Reference Frame" on page 56

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:FORMat
<PositionFormat>

Sets the format in which the latitude and longitude are set.

Parameters:
<PositionFormat> DMS | DECimal

*RST: DMS

Example: See Example"Setting the initial position of a receiver"
on page 351.

Manual operation: See "Location Coordinates, Position Format" on page 57
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal:
PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal[:
WGS] <Longitude>, <Latitude>, <Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in decimal for-
mat.

Parameters:
<Longitude> float

Defines the longitude.
Range: -180  to  180
Increment: 1E-7
*RST: 0

<Latitude> float
Defines the latitude.
Range: -90  to  90
Increment: 1E-7
*RST: 0

<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Simulating attitude behavior of a static receiver"
on page 351.

Manual operation: See "Location Coordinates, Position Format" on page 57

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:PZ
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in degrees,
minutes and seconds.

Parameters:
<LongitudeDeg> integer

Defines the longitude degrees.
Range: 0  to  180
*RST: 0
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<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Simulating attitude behavior of a static receiver"
on page 351.

Manual operation: See "Location Coordinates, Position Format" on page 57
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]
<AtitudeBehaviou>

Defines how the attitude information is defined.

Parameters:
<AtitudeBehaviou> CONStant | FILE | MOTion | SPINning | REMote

FILE enabled if smoothing is not used.

Example: See Example"Simulating a moving receiver" on page 352.

Options: CONStant | FILE | MOTion | SPINning require R&S SMBVB-
K108
REMote requires R&S SMBVB-K109

Manual operation: See "Attitude Behaviour, More" on page 57

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:YAW <Yaw>

Sets the attitude parameter relative to the local horizon.

Parameters:
<Yaw> float

Only for backward compatibility, the range of this command and
waypoint file import is from -180 degrees to +360 degrees. The
values are internally mapped to a range of 0 degrees to 360
degrees.
Range: 0  to  360
Increment: 0.001
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank"
on page 58

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:PITCh <Pitch>

Sets the attitude parameter relative to the local horizon.

Parameters:
<Pitch> float

Values outside the value range are not supported.
If you import trajectory files with out-of-range pitch value defini-
tions, the set values are not considered. Convert the trajectory
files respectively.
Range: -90  to  90
Increment: 0.001
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.
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Manual operation: See "Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank"
on page 58

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:ROLL <Roll>

Sets the attitude parameter relative to the local horizon.

Parameters:
<Roll> float

Range: -180  to  180
Increment: 0.001
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Yaw/Heading, Pitch/Elevation, (Start) Roll/Bank"
on page 58

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:SPIN:RATE <Rate>

Sets the constant rate of change of the roll.

Parameters:
<Rate> float

Range: -400  to  400
Increment: 0.01
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.

Options: R&S SMBVB-K108

Manual operation: See "Spinning Rate" on page 59

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:FILE
<WayPoints>

Selects a predefined or user-defined waypoint files to simulate a moving scenario.

Parameters:
<WayPoints> Filename or complete file path incl. extension

Waypoint files have the extension *.txt, *.nmea, *.kml or
*.xtd.

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Waypoint File" on page 62

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:DURation
<Duration>

Queries the trajectory duration.
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Parameters:
<Duration> float

Range: 0  to  INT_MAX
Increment: 0.001
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Trajectory Length/Duration" on page 63

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:LENGth?

Queries the trajectory length.

Return values: 
<Length> integer

Range: 0  to  (double(INT_MAX))
*RST: 0

Example: See Example"Simulating a moving receiver" on page 352.

Usage: Query only

Manual operation: See "Trajectory Length/Duration" on page 63

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:ROMode
<RoMode>

Defines the way the waypoint/attitude file is processed.

Parameters:
<RoMode> CYCLic | RTRip | OWAY

*RST: OWAY

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Readout Mode" on page 63

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:SMOVement
<SmoothMovement>

Applies an internal algorithm to smooth the trajectory.

Parameters:
<SmoothMovement> 1 | ON | 0 | OFF

*RST: OFF

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Motion Behaviour, Smoothing, More" on page 64

Receiver positioning configuration commands
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[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:PREDefined?

Queries the names of the predefined vehicle description files in the system directory.

Listed are files with the file extension *.xvd.

Example: See Example"Simulating a moving receiver" on page 352.

Usage: Query only

Manual operation: See "Motion Configuration > Vehicle Description" on page 65

[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:USER?

Queries the names of the user-defined vehicle description files in the default or in a
specific directory. Listed are files with the file extension *.xvd.

Example: See Example"Using user-defined vehicle description files"
on page 352.

Usage: Query only

Manual operation: See "Motion Configuration > Vehicle Description" on page 65

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:VEHicle:FILE <Filename>

Selects a predefined or user-defined vehicle description (*.xvd) file.

Parameters:
<Filename> Filename or complete file path; file extension is optional

Query the existing files with:
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:
PREDefined?
[:SOURce<hw>]:BB:GNSS:VEHicle:CATalog:USER?

Example: See Example"Simulating a moving receiver" on page 352.

Manual operation: See "Motion Configuration > Vehicle Description" on page 65

21.5  Antenna pattern and body mask

Option: R&S SMBVB-K108

Antenna pattern and body mask
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Example: Selecting an antenna pattern and body mask file
SOURce1:BB:GNSS:TMODe NAV
// Enable 2 antennas.
SOURce1:BB:GNSS:RECeiver:V1:ANTenna:COUNt 2
SOURce1:BB:GNSS:RECeiver:V1:ANTenna:DISPlay BODY
SOURce1:BB:GNSS:RECeiver:V1:ANTenna:V3D 1
// Query the available body mask files and load a file.
SOURce1:BB:GNSS:BODY:CATalog:PREDefined?
// Response: "Bus,Car_Medium,Car_Medium_OpenRoof,Car_Small, ..."

SOURce1:BB:GNSS:RECeiver:V1:A1:BODY:FILE "Car_Medium_OpenRoof"
SOURce1:BB:GNSS:RECeiver:V1:ANTenna:DISPlay POS
SOURce1:BB:GNSS:RECeiver:V1:A1:DX 0.9
SOURce1:BB:GNSS:RECeiver:V1:A1:DY 0
SOURce1:BB:GNSS:RECeiver:V1:A1:DZ -0.6
SOURce1:BB:GNSS:RECeiver:V1:A1:DHEading 0
SOURce1:BB:GNSS:RECeiver:V1:A1:DELevation 5
SOURce1:BB:GNSS:RECeiver:V1:A1:DBANk 0

// Query user-defined antenna pattern files.
SOURce1:BB:GNSS:APATtern:CATalog:PREDefined?
SOURce1:BB:GNSS:RECeiver:V1:A1:APATtern:FILE "/var/user/test_antenna"
SOURce1:BB:GNSS:RECeiver:V1:A1:STATe 1

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:COUNt.......................................... 361
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:DISPlay.........................................362
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:V3D.............................................. 362
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:PREDefined.................................................... 362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:PREDefined?..............................................362
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:USER.............................................................363
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER?...................................................... 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:BODY:FILE........................................363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:APATtern:FILE................................... 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:STATe............................................... 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DBANk..............................................363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DHEading..........................................363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DELevation........................................363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DX....................................................364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DY....................................................364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DZ.................................................... 364

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:COUNt
<NumberOfAntenna>

Sets the number of simulated antennas.

For more information, refer to the specifications document.

Antenna pattern and body mask
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Parameters:
<NumberOfAntenna> integer

Range: 1  to  depends on the instrument
*RST: 1

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Options: R&S SMBVB: maximum four simulated antennas

Manual operation: See "Number of Antennas" on page 54

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:DISPlay <AntennaView>

Select the antenna characteristics that are currently visualized.

Parameters:
<AntennaView> AATTenuation | APHase | BODY | POSition

*RST: POSition

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "Display" on page 137

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:V3D <Visualize3D>

Activates the interactive 3D representation of the body mask or the power/phase distri-
bution the antenna.

Parameters:
<Visualize3D> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "3D View" on page 138

[:SOURce<hw>]:BB:GNSS:BODY:CATalog:PREDefined
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:PREDefined?
Queries the names of the predefined antenna pattern/body mask files in the system
directory.

Listed are files with the file extension *.ant_pat/*.body_mask.

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Usage: Query only

Manual operation: See "Body Mask, Antenna Pattern" on page 138

Antenna pattern and body mask
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[:SOURce<hw>]:BB:GNSS:BODY:CATalog:USER
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER?
Queries the names of the user-defined antenna pattern/body mask files in the default
or in a specific directory. Listed are files with the file extension *.ant_pat/
*.body_mask.

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Usage: Query only

Manual operation: See "Body Mask, Antenna Pattern" on page 138

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:BODY:FILE <BodyMaskFile>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:APATtern:FILE <Filename>
Loads the selected file from the default or the specified directory. Loaded are files with
extension *.ant_pat/*.body_mask.

Parameters:
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted.
Query the existing files with the following commands:
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:
PREDefined? on page 362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER?
on page 363

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "Body Mask, Antenna Pattern" on page 138

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:STATe <State>

Activates the antenna.

Parameters:
<State> 1 | ON | 0 | OFF

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "Active" on page 138

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DBANk <DeltaBank>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DHEading <DeltaHeading>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DELevation <DeltaElevation>
Sets the orientation and tilt of the antenna of the GNSS receiver.

The values are relative to the center of gravity (COG).

Antenna pattern and body mask
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Parameters:
<DeltaElevation> float

Range: -180  to  180
Increment: 0.001
*RST: 0

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "Delta Heading, Delta Elevation, Delta Bank" on page 139

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DX <DeltaX>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DY <DeltaY>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DZ <DeltaZ>
Sets the antenna position of the GNSS receiver as an offset on the x, y and z axis.

The offset is relative to center of gravity (COG).

Parameters:
<DeltaZ> float

Range: -200  to  200
Increment: 0.001
*RST: 0

Example: See Example"Selecting an antenna pattern and body mask file"
on page 361.

Manual operation: See "Delta X, Delta Y, Delta Z" on page 139

21.6  Real-time kinematics (RTK) commands

Option: R&S SMBVB-K122

The following examples provide a configuration of an RTK setup with one base station.

Example: Activating RTK simulation
// Query RTK simulation properties.
SOURce1:BB:GNSS:RTK:BSTation:COUNt?
// Response: "1"
// One RTK base station is simulated.
// Query base station 1 properties.
SOURce1:BB:GNSS:RTK:BASE1:MOUNtpoint?
// Response: "RS01"
SOURce1:BB:GNSS:RTK:STATe 1

Real-time kinematics (RTK) commands
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Example: Configuring RTK base station location
// Specify location parameters of RTK base station 1.
// Select a user-defined position.
SOURce1:BB:GNSS:RTK:BASE1:LOCation:CATalog?
// Respone: "User Defined, New York, .."
SOURce1:BB:GNSS:RTK:BASE1:LOCation:SELect "User Defined"
// Select the reference frame for the base station coordinates.
SOURce1:BB:GNSS:RTK:BASE1:LOCation:COORdinates:RFRame WGS84
SOURce1:BB:GNSS:RTK:BASE1:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GNSS:RTK:BASE1:LOCation:COORdinates:DMS:WGS?
// Response: "11,35,0,EAST,48,9,0,NORT,508"
SOURce1:BB:GNSS:RTK:BASE1:LOCation:COORdinates:FORMat DEC
SOURce1:BB:GNSS:RTK:BASE1:LOCation:COORdinates:DEC:WGS?
// Response: "11.583333,48.150000,508"

// Optionally synchronize, that means update, the base station location with the
// current location of the GNSS receiver. Synchronization is successful for
// distances below 150 km between RTK base station and GNSS receiver.
SOURce1:BB:GNSS:RTK:BASE1:LOCation:SYNC

Example: Configuring RTK base station antenna
SOURce1:BB:GNSS:RTK:BASE1:A1:BODY:FILE "Car_Medium_OpenRoof"
SOURce1:BB:GNSS:RTK:BASE1:A1:DX 0.9
SOURce1:BB:GNSS:RTK:BASE1:A1:DY 0
SOURce1:BB:GNSS:RTK:BASE1:A1:DZ -0.6
SOURce1:BB:GNSS:RTK:BASE1:A1:DHEading 0
SOURce1:BB:GNSS:RTK:BASE1:A1:DELevation 5
SOURce1:BB:GNSS:RTK:BASE1:A1:DBANk 0

// Query user-defined antenna pattern files.
SOURce1:BB:GNSS:APATtern:CATalog:PREDefined?
SOURce1:BB:GNSS:RTK:BASE1:A1:APATtern:FILE "/var/user/test_antenna"
SOURce1:BB:GNSS:RTK:BASE1:A1:STATe 1

Example: Configuring real-time kinematics (RTK) protocol
// Query RTK simulation properties.
SOURce1:BB:GNSS:RTK:BSTation:COUNt?
// Response: "1"
// One RTK base station is simulated.

Commands:

● RTK general commands....................................................................................... 366
● RTK location commands.......................................................................................366
● RTK antenna commands...................................................................................... 370
● RTK protocol commands.......................................................................................372
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21.6.1  RTK general commands

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:MOUNtpoint?..................................................366
[:SOURce<hw>]:BB:GNSS:RTK:BSTation:COUNt............................................................. 366
[:SOURce<hw>]:BB:GNSS:RTK:STATe............................................................................ 366

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:MOUNtpoint?

Sets the mountpoint for RTK simulation.

Return values: 
<Mountpoint> string

Example: See Example"Activating RTK simulation" on page 364.

Usage: Query only

Manual operation: See "Mountpoint" on page 165

[:SOURce<hw>]:BB:GNSS:RTK:BSTation:COUNt <NumberOfBases>

Queries the number of RTK base stations.

Parameters:
<NumberOfBases> 1

*RST: 1

Example: See Example"Activating RTK simulation" on page 364.

Manual operation: See "Number of Base Stations" on page 164

[:SOURce<hw>]:BB:GNSS:RTK:STATe <RtkState>

Activates real-time kinematics simulation.

Parameters:
<RtkState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Activating RTK simulation" on page 364.

Manual operation: See "State" on page 164

21.6.2  RTK location commands

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog...........................................367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect]...........................................367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame.....................367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat......................368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:PZ................ 368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal[:WGS]...........368
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[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ......................369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:WGS]................ 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:SYNC..............................................370

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog

Queries the names of predefined geographic locations of the RTK base station. The
query returns a comma-separated list of available locations.

For predefined geographic locations, see Table 5-1.

Example: See Example"Configuring RTK base station location"
on page 365.

Manual operation: See "Location, Initial Position" on page 55

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect] <Location>

Selects the geographic location of the RTK base station.

Parameters:
<Location> string

"User Defined"
Enables the definition of the "Latitude", "Longitude" and "Alti-
tude" of the GNSS receiver with fixed position in the ECEF
WGS84 coordinate system.
"<City>"
Selects one of the predefined geographic locations, see
Table 5-1. The parameters latitude, longitude and altitude are set
according to the selected position.

Example: See Example"Activating RTK simulation" on page 364.

Manual operation: See "Location, Initial Position" on page 55

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame
<ReferenceFrame>

Selects the reference frame used to define the RTK base station coordinates.

Parameters:
<ReferenceFrame> PZ90 | WGS84

*RST: WGS84

Example: See Example"Configuring RTK base station location"
on page 365.

Manual operation: See "Reference Frame" on page 56
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[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat
<PositionFormat>

Sets the format in which the latitude and longitude are set.

Parameters:
<PositionFormat> DMS | DECimal

*RST: DMS

Example: See Example"Configuring RTK base station location"
on page 365.

Manual operation: See "Location Coordinates, Position Format" on page 57

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:PZ
<Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal[:
WGS] <Longitude>, <Latitude>, <Altitude>

Defines the coordinates of the geographic location of the RTK base station in decimal
format.

Parameters:
<Longitude> float

Defines the longitude in degrees.
Range: -180  to  180
Increment: 1E-7
*RST: 0

<Latitude> float
Defines the latitude in degrees.
Range: -90  to  90
Increment: 1E-7
*RST: 0

<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Activating RTK simulation" on page 364.

Manual operation: See "Location Coordinates, Position Format" on page 57
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[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:WGS]
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the geographic location of the RTK base station in degrees,
minutes and seconds.

Parameters:
<LongitudeDeg> integer

Defines the longitude degrees.
Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT
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<Altitude> float
Defines the altitude. The altitude value is in meters and is the
height above the reference ellipsoid.
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Configuring RTK base station location"
on page 365.

Manual operation: See "Location Coordinates, Position Format" on page 57

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:SYNC

Triggers synchronization of the RTK base station location and receiver location.

Example: See Example"Activating RTK simulation" on page 364.

Usage: Event

Manual operation: See "Sync to Receiver Position" on page 167

21.6.3  RTK antenna commands

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:BODY:FILE.......................................... 370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:APATtern:FILE......................................370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:STATe..................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DBANk.................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DHEading............................................ 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DELevation.......................................... 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DX.......................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DY.......................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DZ.......................................................371

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:BODY:FILE <BodyMaskFile>
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:APATtern:FILE <Filename>
Loads the selected file from the default or the specified directory. Loaded are files with
extension *.ant_pat/*.body_mask.

Parameters:
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted.
Query the existing files with the following commands:
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:
PREDefined? on page 362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER?
on page 363

Example: See Example"Configuring RTK base station location"
on page 365.

Real-time kinematics (RTK) commands



Remote-control commandsSatellite Navigation

371User Manual 1178.9403.02 ─ 10

Manual operation: See "Body Mask, Antenna Pattern" on page 138

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:STATe <State>

Activates the antenna.

Parameters:
<State> 1 | ON | 0 | OFF

Example: See Example"Configuring RTK base station antenna"
on page 365.

Manual operation: See "Active" on page 138

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DBANk <DeltaBank>
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DHEading <DeltaHeading>
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DELevation <DeltaElevation>
Sets orientation and tilt of the antenna of the RTK base station.

The values are relative to the center of gravity (COG).

Parameters:
<DeltaElevation> float

Range: -180  to  180
Increment: 0.001
*RST: 0

Example: See Example"Configuring RTK base station antenna"
on page 365.

[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DX <DeltaX>
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DY <DeltaY>
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DZ <DeltaZ>
Sets the antenna position of an RTK base station as an offset on the x, y and z axis.

The offset is relative to center of gravity (COG).

Parameters:
<DeltaZ> float

Range: -200  to  200
Increment: 0.001
*RST: 0

Example: See Example"Configuring RTK base station antenna"
on page 365.

Manual operation: See "Delta X, Delta Y, Delta Z" on page 139
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21.6.4  RTK protocol commands

[:SOURce<hw>]:BB:GNSS:RTK:PASSword?.................................................................... 372
[:SOURce<hw>]:BB:GNSS:RTK:PORT............................................................................ 372
[:SOURce<hw>]:BB:GNSS:RTK:PROTocol.......................................................................372
[:SOURce<hw>]:BB:GNSS:RTK:USER?...........................................................................372

[:SOURce<hw>]:BB:GNSS:RTK:PASSword?

Queries the password, that belongs to the RTCM user name.

Return values: 
<Password> string

Example: See Example"Configuring real-time kinematics (RTK) protocol"
on page 365.

Usage: Query only

Manual operation: See "Password" on page 166

[:SOURce<hw>]:BB:GNSS:RTK:PORT <PortNumber>

Sets the port number of the LAN connection.

Parameters:
<PortNumber> 2101 | 4022 | 50000

*RST: 2101

Example: See Example"Configuring real-time kinematics (RTK) protocol"
on page 365.

Manual operation: See "Port" on page 166

[:SOURce<hw>]:BB:GNSS:RTK:PROTocol <Protocol>

Queries the protocol for transmitting RTK data.

Parameters:
<Protocol> RTCM

NTRIP/RTCM 3.3 protocol
*RST: RTCM

Example: See Example"Configuring real-time kinematics (RTK) protocol"
on page 365.

Manual operation: See "Protocol" on page 166
See "User ID" on page 166

[:SOURce<hw>]:BB:GNSS:RTK:USER?

Queries the user ID, that is the RTCM user name.
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Return values: 
<UserId> string

Example: See Example"Configuring real-time kinematics (RTK) protocol"
on page 365.

Usage: Query only

21.7  Environment configuration commands

Option: R&S SMBVB-K108

Example: Defining a full obscuration environment
// Select and enable a full obscuration user defined environment.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:ENVironment FULL
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:TYPE USER
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:OBSCuration

// Define a full obscuration area as a sequence of obscured zones.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:SCALe DISTance
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA:COUNt 2
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA1:REFerence 0.5
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA1:LENGth 0.1
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA2:REFerence 2.5
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA2:LENGth 1
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA:APPend
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA:COUNt?
// Response: 3
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA3:DELete
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA:COUNt?
// Response: 2
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA1:INSert
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA2:REFerence 1.5
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA2:LENGth 0.5
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:AREA:COUNt?
// Response: 3

// Define a full obscuration area as a zone pattern.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:SCALe TIME
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:RWINdow 1000
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:FULL:RWINdow:STATe ON
// The defined objects are repeated every 1000 seconds.

Example: Selecting a vertical obscuration environment
// Select and enable a vertical obscuration environment.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MODel VOBS
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:TYPE URB1
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:OMPath
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// Query available obstacles files and load a file.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:CATalog:PREDefined?
// Response: Urban_Canyon_1
:MMEM:CDIRectory "/var/user/my_vobs"
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:CATalog:USER?
// Response: canyon_2
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:FILE "/var/user/my_vobs/canyon_2"

// Define the receiver position.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:ROFFset:X 15
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:ROFFset:Y 2
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:ROFFset:HEIGht 0
// Define map orienation.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:VOBS:MORientation 90
// x-axis points to north direction, y-axis points to west direction

Example: Defining roadside planes
// Select and enable a roadside planes environment.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MODel RPL

Example: Defining a user-defined ground and sea reflection
SOURce1:BB:GNSS:SMODe AUTO
SOURce1:BB:GNSS:VEHicle:TYPE AIRCraft
// Select and enable a ground and sea reflection environment.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:ENVironment GSR
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:TYPE USER
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:OMPath

// Define material property parameters.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:STYPe USER
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:MPRoperty PERM
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:PERMittivity 10
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:CONDuctivity 1
// Define obstacles and the distance between ground and obstacle.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:GALTitude 0
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:O1Height 500
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:O2Height 1000
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:O1Distance 1000
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:GSP:O2Distance 1000

Commands:

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PMODel........................... 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PMODel........................ 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PMODel.................................. 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:X.....................376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:Y.....................376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:HEIGht............ 376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:MORientation.................377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PREDefined.............................377
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:PREDefined.................... 377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PREDefined......................377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PREDefined...................377
[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:PREDefined?................................ 378
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:PREDefined?.................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:PREDefined?.............................. 378
[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:USER?.........................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:USER?..........................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:USER?....................................... 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:LMM:FILE................................378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:FILE.................................378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:FILE..............................378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ROFFset:HEIGht...............379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow.........................379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:STATe...............379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:STRajectory...... 380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:DISPLay...........................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ILENgth............................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:SCALe............................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow....................... 381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:STATe............. 381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:STRajectory.....381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:COUNt?................381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:APPend................ 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:INSert............382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:DELete.......... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:REFerence.... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:LENGth......... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:MPRoperty...................... 383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:STYPe............................ 383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PERMittivity..................... 383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:CONDuctivity................... 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PLOSs............................ 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Distance......................384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Distance......................384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Height......................... 385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Height......................... 385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:GALTitude........................385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:OORientation................... 385

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PMODel <Model>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PMODel

<Model>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PMODel

<PhysicalModel>
Selects the physical effects to be simulated on the GNSS signal.

Parameters:
<PhysicalModel> OBSCuration | OMPath
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OBSCuration
Simulates obscuration effects.
OMPath
Simulates obscuration and multipath propagation effects.
*RST: OBSCuration

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Physical Model" on page 145

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:X
<XOffset>

Sets the initial X position of a receiver relative to the reference point that is the (0, 0, 0)
coordinate.

Parameters:
<XOffset> float

Range: -1500  to  1500
Increment: 0.1
*RST: 0

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Receiver Offset" on page 147

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:Y
<YOffset>

Sets the initial Y position of a receiver relative to the reference point that is the (0, 0, 0)
coordinate.

Parameters:
<YOffset> float

Range: -1500  to  1500
Increment: 0.1
*RST: 0

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Receiver Offset" on page 147

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:
HEIGht <HeightOffset>

Sets the initial height position (Z) of a receiver relative to the reference point that is the
(0, 0, 0) coordinate.

Environment configuration commands



Remote-control commandsSatellite Navigation

377User Manual 1178.9403.02 ─ 10

Parameters:
<HeightOffset> float

Range: 0  to  500
Increment: 0.1
*RST: 0

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Receiver Offset" on page 147

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:MORientation
<MapOrientation>

Defines the map orientation of obstacles relative to the west-east axis.

Parameters:
<MapOrientation> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Map Orientation" on page 147

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PREDefined <Type>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:PREDefined

<PredefinedEnv>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PREDefined

<PredefinedEnv>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PREDefined

<PredefinedEnv>
Loads a predefined environment configuration.

You can load a user-defined setting or a predefined settings that simulate two urban
canyon environments.

Parameters:
<PredefinedEnv> USER | URB1 | URB2

USER
User-defined environment configuration
URB1|URB2
Urban canyon environment configuration
*RST: URB2

Example: See Example"Selecting a vertical obscuration environment"
on page 373.
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Manual operation: See "Predefined Environment" on page 145
See "Predefined Environment" on page 149

[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:PREDefined?
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:PREDefined?
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:PREDefined?
Queries the names of predefined files in the system directory.

Listed are only the following file types:
● Obstacles description files (*.rs_obst)
● Roadside buildings description files (*.rs_buil)
● Land mobile multipath (LMM) files (*.lmm)

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Usage: Query only

Manual operation: See "Obstacles File" on page 145

[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:USER?
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:USER?
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:USER?
Queries the names of the user-defined files in the default directory. The default direc-
tory is set using command :MMEM:CDIRectory.

Listed are the following file types:
● Obstacles description files (*.rs_obst)
● Roadside buildings description files (*.rs_buil)
● Land mobile multipath (LMM) files (*.lmm)

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Usage: Query only

Manual operation: See "Obstacles File" on page 145

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:LMM:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:FILE

<Filename>
Loads the selected file.

Loaded are only obstacles description files (*.rs_obst) or roadside buildings descrip-
tion files (*.rs_buil).

Loaded are only the following files types:
● Obstacles description files (*.rs_obst)
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● Roadside buildings description files (*.rs_buil)
● Land mobile multipath (LMM) files (*.lmm)

Parameters:
<Filename> string

Example: See Example"Selecting a vertical obscuration environment"
on page 373.

Manual operation: See "Obstacles File" on page 145

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ROFFset:HEIGht
<Heigth>

Sets the receiver height offset, i.e. the antenna altitude relative to the ground.

Parameters:
<Heigth> float

Range: 0  to  500
Increment: 0.1
*RST: 0

Example: See Example"Defining roadside planes" on page 374.

Manual operation: See "Receiver Height Offset" on page 152

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow
<RepWindow>

Sets the repetition window. This window defines the distance of repeated obstacles
that means contiguous objects.

Parameters:
<RepWindow> integer

Range: 1  to  1E6
*RST: 10E3
Default unit: m

Example: See Example"Defining roadside planes" on page 374.

Manual operation: See "Repetition" on page 152

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:STATe
<State>

Enables the repetition of the defined objects.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: OFF

Example: See Example"Defining roadside planes" on page 374.
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Manual operation: See "State" on page 152

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:
STRajectory

Sets the length of the repetition intervall equal to trajectory length of the waypoint file.

Aligning both lengths is useful to ensure that the obscuration pattern repeats itself at
each repetition of the waypoint file.

Example: See Example"Defining roadside planes" on page 374.

Usage: Event

Manual operation: See "Set To Trajectory Length" on page 152

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:DISPLay
<Display>

Switches between available views.

Parameters:
<Display> DISTance | HEIGht

DISTance
Distance versus position view
HEIGht
Height versus position view
*RST: HEIGht

Example: See Example"Defining roadside planes" on page 374.

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ILENgth <State>

If enabled, assumes roadside planes with infinite width.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: ON

Example: See Example"Defining roadside planes" on page 374.

Manual operation: See "Set Length to Infinite" on page 152

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:SCALe
<ReferenceScale>

Defines whether the obstacles' positions are defined as distance (in km) or as time (in
s).

Parameters:
<ReferenceScale> TIME | DISTance

*RST: DIST
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Example: See Example"Defining a full obscuration environment"
on page 373.

Manual operation: See "Reference Scale" on page 154

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow
<RepWindow>

Sets the repeating period (in km or s) of repeating objects.

Parameters:
<RepWindow> integer

Range: 0  to  1000
*RST: 10

Example: See Example"Defining a full obscuration environment"
on page 373.

Manual operation: See "Repetition" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:
STATe <State>

Enables the repetition of the defined objects.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: OFF

Example: See Example"Defining a full obscuration environment"
on page 373.

Manual operation: See "State" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:
STRajectory

Sets the length of the repetition intervall equal to trajectory length of the waypoint file.

Aligning both lengths is useful to ensure that the obscuration pattern repeats itself at
each repetition of the waypoint file.

Example: See Example"Defining a full obscuration environment"
on page 373.

Usage: Event

Manual operation: See "Set To Trajectory Length" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:COUNt?

Sets the number of the obscured area/zones.

Environment configuration commands



Remote-control commandsSatellite Navigation

382User Manual 1178.9403.02 ─ 10

Return values: 
<AreasCount> integer

Range: 0  to  50
*RST: 0

Example: See Example"Defining a full obscuration environment"
on page 373.

Usage: Query only

Manual operation: See "Obscured Areas" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:APPend
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:

INSert
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:

DELete
Appends, insertes or deletes an obscured zone.

Example: See Example"Defining a full obscuration environment"
on page 373.

Usage: Event

Manual operation: See "Insert, Delete" on page 156

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:
REFerence <Reference>

Defines the reference starting position (in km) or time stamp (in s) of a specific
obscured zone.

Parameters:
<Reference> float

Range: 0  to  1E4
Increment: 1E-3
*RST: 0

Example: See Example"Defining a full obscuration environment"
on page 373.

Manual operation: See "Obscured Areas" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:
LENGth <Length>

Sets the length of the obscuring zone, defined in km or sec.
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Parameters:
<Length> float

Range: 1E-3  to  50
Increment: 1E-3
*RST: 0.1

Example: See Example"Defining a full obscuration environment"
on page 373.

Manual operation: See "Obscured Areas" on page 155

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:MPRoperty
<MaterialPropert>

Specifies, if the material is defined by its permittivity/conductivity or by its power loss
characteristic.

Parameters:
<MaterialPropert> PLOSS | PERM

*RST: PERM

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Material Property" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:STYPe
<SurfaceType>

Defines the type of surface.

Parameters:
<SurfaceType> SEA | WATER | WET | MDRY | DRY | USER

*RST: USER

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Surface Type" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PERMittivity
<Permittyvity>

Sets the surface permittivity.

Parameters:
<Permittyvity> float

Range: 1  to  100
Increment: 0.1
*RST: 10
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Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:CONDuctivity
<Conductivity>

Sets the surface conductivity.

Parameters:
<Conductivity> float

Range: 1E-6  to  20
Increment: 1E-6
*RST: 1

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PLOSs
<PowerLoss>

Sets the surface power loss.

Parameters:
<PowerLoss> integer

Range: 0  to  20
*RST: 5

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Distance
<Distance>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Distance
<Distance>

Sets the distance between the receiver and the left/right obstacles.

Parameters:
<Distance> float

Range: 0  to  1E4
Increment: 0.1
*RST: 1000

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "h1/h2, d1/d2" on page 157
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Height
<Height>

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Height
<Height>

Determines the height of the left/right obstacle.

Parameters:
<Height> float

Range: 0  to  10000
Increment: 0.1
*RST: 100

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "h1/h2, d1/d2" on page 157

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:GALTitude
<GroundAltitude>

Sets the altitude of the receiver according to the WGS84 geodetic system.

Parameters:
<GroundAltitude> float

Range: 0  to  10000
Increment: 0.1
*RST: 0

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.

Manual operation: See "Ground Altitude" on page 158

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:OORientation
<Orientation>

Sets the obstacle orientation.

Parameters:
<Orientation> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Example: See Example"Defining a user-defined ground and sea reflection"
on page 374.
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21.8  Static multipath configuration

Option: R&S SMBVB-K108

Example: Enabling static multipath effects
// Enable a satellite constellation with GPS and Galileo satellites.
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1

// Enable static multipath.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MODel MPAT
// Select SVIDs and GNSS system.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MPATh:SYSTem GPS
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MPATh:SVID 1
// Enable line-of-sight (LOS) and one echo.
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:ENABle 1
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHos:COUNt 1
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:ICPHase 100
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:CPDRift 5.3
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:POWer -5
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:CPHase 3.14
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:DSHift 1
// Set automatically based on the Doppler shift
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:CPDRift 5.25503546857073
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:AELEVation 1.5
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:AAZimuth 1
// Query LOS parameters.
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:ICPHase?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:CPDRift?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:POWer?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:CPHase?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:DSHift?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:AELEVation?
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:LOS:AAZimuth?
// Apply the same configuration to GPS SVID 5.
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MPATh:COPY:SYSTem GPS
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MPATh:COPY:SVID 5
SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MPATh:COPY:EXECute

Commands:

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment[:MODel]...................................389
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SYSTem.......................390
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SVID............................390
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:SYSTem.............391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:SVID..................391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:EXECute............ 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:ENABle............. 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:ENABle.............392
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:ENABle.......... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:ENABle................392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:ENABle................392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:ENABle................392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ENABle..................392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHos:COUNt.......... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHos:COUNt..........393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHos:COUNt....... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHos:COUNt.............393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHos:COUNt.............393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHos:COUNt.............393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHos:COUNt...............393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?.............. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:ICPHase?..........393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:ICPHase?......... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:ICPHase?.......393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?............ 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:ICPHase?............ 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?............ 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

ICPHase............................................................................................................. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase.394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:CPDRift?........... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPDRift.............................................................................................................. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:CPDRift?...........394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPDRift.............................................................................................................. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:CPDRift?........ 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPDRift.............................................................................................................. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?............. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:CPDRift?............. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?..............394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?............... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift..394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:POWer?............ 395
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:
POWer............................................................................................................... 395

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:POWer?............395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

POWer............................................................................................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:POWer?......... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

POWer............................................................................................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:POWer?...............395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:POWer?...............395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:POWer?...............395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:POWer?................ 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:CPHase?...........396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPHase..............................................................................................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:CPHase?.......... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPHase..............................................................................................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:CPHase?........396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPHase..............................................................................................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPHase?............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:CPHase?............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:CPHase?............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPHase?............... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:DSHift?............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:DSHift?............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:DSHift?.......... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

DSHift.................................................................................................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:DSHift?................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:DSHift?................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:DSHift?................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:DSHift?..................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?.............397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?.........397
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:
AAZimuth............................................................................................................397

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?........ 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?..... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?...........397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?........... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?........... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AAZimuth............................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?..........398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:AELEVation?..... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:AELEVation?..... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.. 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?........398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:AELEVation?........ 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?........ 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

AELEVation.........................................................................................................398

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment[:MODel]
<Environment>

Sets the environment model.

Parameters:
<Environment> LOS | MPATh

*RST: LOS

Example: See Example"Enabling static multipath effects" on page 386.
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Manual operation: See "Environment Model" on page 143

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SYSTem
<SystemSource>

Sets the GNSS system.

If the copy to function is used, this setting refers to the source.

Parameters:
<SystemSource> GPS | GALileo | GLONass | BEIDou | QZSS | SBAS

*RST: GPS

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Standard, SV-ID (source), Copy To, Standard, SV-ID (tar-
get)" on page 159

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SVID
<SvIdSource>

Sets the SV ID number.

If the copy to function is used, this setting refers to the source.

Parameters:
<SvIdSource> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL
*RST: 1

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Standard, SV-ID (source), Copy To, Standard, SV-ID (tar-
get)" on page 159
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:
SYSTem <SystemSource>

Sets the GNSS system.

If the copy to function is used, this setting refers to the target.

Parameters:
<SystemSource> GPS | GALileo | GLONass | BEIDou | QZSS | SBAS

*RST: GPS

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Standard, SV-ID (source), Copy To, Standard, SV-ID (tar-
get)" on page 159

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:SVID
<SvIdDestination>

Sets the SV ID number.

If the copy to function is used, this setting refers to the target.

Parameters:
<SvIdDestination> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL
*RST: 1

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Standard, SV-ID (source), Copy To, Standard, SV-ID (tar-
get)" on page 159
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[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:
EXECute

Copies the multipath configuration of the source GNSS System and SV ID to the target
SV ID and GNSS system or to all SV IDs from a system.

Set the source with:
● [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:

SYSTem
● [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SVID
Set the target with:
● [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:

COPY:SYSTem
● [:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:

COPY:SVID
Setting parameters: 
<CopyTo> Event

Example: See Example"Enabling static multipath effects" on page 386.

Usage: Event

Manual operation: See "Standard, SV-ID (source), Copy To, Standard, SV-ID (tar-
get)" on page 159

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
ENABle <EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
ENABle <EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
ENABle <EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:ENABle
<EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:ENABle
<EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:ENABle
<EnableLOS>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ENABle
<EnableLOS>

Activates the line-of-sight component.

Parameters:
<EnableLOS> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Line of Sight (LOS)" on page 159
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHos:
COUNt <NumberOfEchos>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHos:COUNt
<NumberOfEchos>

Sets the echoes number.

Parameters:
<NumberOfEchos> integer

Range: 0  to  9
*RST: 0

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Number of Echos" on page 159

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:ICPHase <InitCodePhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:ICPHase <InitCodePhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:ICPHase <InitCodePhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:ICPHase <InitCodePhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:ICPHase <InitCodePhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:

ICPHase?
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:ICPHase <InitCodePhase>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:
ICPHase <InitCodePhase>

Sets an initial code phase for the selected echo.

Parameters:
<InitCodePhase> float

Range: 0  to  3000
Increment: 0.1
*RST: 0
Default unit: m

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Init. Code Phase" on page 160

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
CPDRift?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPDRift <CodePhaseDrift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
CPDRift?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPDRift <CodePhaseDrift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
CPDRift?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPDRift <CodePhaseDrift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPDRift <CodePhaseDrift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:

CPDRift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPDRift <CodePhaseDrift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:

CPDRift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPDRift <CodePhaseDrift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPDRift <CodePhaseDrift>
Sets a code phase drift.
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Parameters:
<CodePhaseDrift> float

Range: 0  to  2000
Increment: 0.1
*RST: 0
Default unit: m/s

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Code Phase Drift" on page 160

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
POWer?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:POWer <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
POWer?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:POWer <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
POWer?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:POWer <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:POWer?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:POWer <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:POWer?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:POWer <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:POWer?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:POWer <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:POWer?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

POWer <PowerOffset>
Sets the additional power offset for the selected echoes.

Parameters:
<PowerOffset> float

Range: -15  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Power Offset" on page 160
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
CPHase?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPHase <CarrierPhase>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
CPHase?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPHase <CarrierPhase>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
CPHase?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:CPHase <CarrierPhase>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPHase <CarrierPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:

CPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPHase <CarrierPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:

CPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:CPHase <CarrierPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPHase?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

CPHase <CarrierPhase>
Sets the carrier phase at the simulation start.

Parameters:
<CarrierPhase> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0
Default unit: rad

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Init. Carrier Phase" on page 160

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
DSHift?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:DSHift <DopplerShift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
DSHift?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:DSHift <DopplerShift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
DSHift?
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:DSHift <DopplerShift>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:DSHift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:DSHift <DopplerShift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:DSHift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:DSHift <DopplerShift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:DSHift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:

ECHO<s2us0>:DSHift <DopplerShift>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:DSHift?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:

DSHift <DopplerShift>
Sets an additional Doppler shift.

Parameters:
<DopplerShift> float

Range: -10E3  to  10E3
Increment: 0.01
*RST: 0
Default unit: Hz

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "Doppler Shift /Hz" on page 160

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:
AAZimuth?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AAZimuth <AoaAzimuth>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:
AAZimuth <AoaAzimuth>

Sets the angle of arrival azimuth.

Parameters:
<AoaAzimuth> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0
Default unit: rad

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "AoA Elevation, AoA Azimuth" on page 160

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:
AELEVation?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:
ECHO<s2us0>:AELEVation <AoaElevation>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:
AELEVation <AoaElevation>

Sets the angle of arrival elevation.
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Parameters:
<AoaElevation> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0
Default unit: rad

Example: See Example"Enabling static multipath effects" on page 386.

Manual operation: See "AoA Elevation, AoA Azimuth" on page 160

21.9  Atmospheric configuration commands

Example: Configuring the ionospheric and troposphere models
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:ATMospheric:TROPospheric:MODel MOPS

SOURce1:BB:GNSS:ATMospheric:IONospheric:MODel KLOBuchar
SOURce1:BB:GPS:ATMospheric:IONospheric:KLOBuchar:ALPHa0?
// 5
SOURce:BB:GPS:ATMospheric:GPS:IONospheric:ALPHa0?
// 5

SOURce1:BB:GNSS:ATMospheric:IONospheric:MODel NEQuick
SOURce1:BB:GPS:ATMospheric:IONospheric:NEQuick:UMSN OFF
SOURce1:BB:GPS:ATMospheric:IONospheric:NEQuick:SUNSpot 100
SOURce1:BB:GPS:ATMospheric:IONospheric:NEQuick:SFLux 145.4

SOURce1:BB:GNSS:ATMospheric:IONospheric:MODel MOPS

Example: Importing grid files
The example shows how to import a grid configuration using multiple files with different
extensions.

For a detailed file description, see:
● "SBAS correction file download" on page 283 for *.ems and *.nstb files.
● Chapter F, "Ionospheric grid file format", on page 641 for *.iono_grid files.

Additionally, a grid configuration can simply be loaded from a predefined file or user-
defined file.

********************************************************************************
// Add files with *.ems, *.nstb or *.iono_grid extension to an import file list.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:EMS 
"/var/user/gnss/PRN120_y2018_d067_h14.ems"
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:NSTB 
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"/var/user/gnss/wfaip1c1_84c1_1991_02.nstb"
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:GRID 
"/var/user/gnss/Mops_2018_03_07.iono_grid"
********************************************************************************
// Alternatively, add all files from a directory to an import file list.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:DIR "/var/user/gnss"
********************************************************************************
// Query the files to import.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?
// "/var/user/gnss/Mops_2018_03_07.iono_grid;19.02.2014 00:03:40;20.02.2014 00:03:40,
// /var/user/gnss/PRN120_y2018_d067_h14.ems;08.03.2018 14:00:00;08.03.2018 14:59:59,
// /var/user/gnss/wfaip1c1_84c1_1991_02.nstb;06.03.2018 00:00:02;07.03.2018 00:00:02"
// For each file the filename, start/end date and time are listed.
********************************************************************************
// Remove a particular file from the import file list.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:FILe1
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?
// "/var/user/gnss/PRN120_y2018_d067_h14.ems;08.03.2018 14:00:00;08.03.2018 14:59:59,
// /var/user/gnss/wfaip1c1_84c1_1991_02.nstb;06.03.2018 00:00:02;07.03.2018 00:00:02"
********************************************************************************
// Load all files from the latest import file query and export the configuration.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:EXECute
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort
"/var/user/gnss/Mops_2018_03_08.iono_grid"
********************************************************************************
// Reload a previous grid configuration.
********************************************************************************
SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:FILE 
"/var/user/gnss/Mops_2018_03_07.iono_grid"

Commands:

[:SOURce<hw>]:BB:GNSS:ATMospheric:TROPospheric:MODel.........................................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MODel............................................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SFLux...............................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SUNSpot...........................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:UMSN...............................402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:FILE.....................................402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay................................402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort................................. 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:DIR....................403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:EMS...........403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:NSTB......... 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:GRID..........403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?........................ 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:EXECute....................404
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[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:ALL.............. 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:FILE<ch>......404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:ALPHa<ch0>:UNSCaled.404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:BETA<ch0>:UNSCaled...405

[:SOURce<hw>]:BB:GNSS:ATMospheric:TROPospheric:MODel <Model>

Determines the tropospheric model.

Parameters:
<Model> NONE | STANag | MOPS

*RST: NONE

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "Tropospheric Model" on page 202

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MODel <Model>

Determines the applied ionospheric model.

Parameters:
<Model> NONE | KLOBuchar | MOPS | NEQuick

*RST: NONE

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "Ionospheric Model" on page 203

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SFLux
<SolarFlux>

Sets the solar flux level.

Parameters:
<SolarFlux> float

Range: 0  to  300
Increment: 1E-3
*RST: 0

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "NeQuick Parameters" on page 204

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SUNSpot
<SunspotNumber>

Sets the sunspot number.
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Parameters:
<SunspotNumber> float

Range: -99.636  to  248.870
Increment: 1E-3
*RST: 100

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "NeQuick Parameters" on page 204

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:UMSN <State>

Enables the instrument to use the measured sunspot number value.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "NeQuick Parameters" on page 204

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:FILE <Filename>

Select a ionospheric grid file.

Parameters:
<Filename> string

To load a predefined file, specify only the filename.
To load a user-defined file, specify the absolute file path with file-
name and extension (*.iono_grid).

Example: See Example"Importing grid files" on page 399

Manual operation: See "MOPS-DO-229D" on page 205

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay
<DisplayType>

Toggles between indication of the vertical delay and GIVEI values.

Parameters:
<DisplayType> GIVei | VDELay

*RST: VDELay

Example: SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay VDELay

Manual operation: See "View Type" on page 205
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[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort <Filename>

Saves the current ionospheric grid configuration in a file.

Setting parameters: 
<Filename> string

Specify the file path, filename and extension. Allowed file exten-
sions are *.rs_ion or *.iono_grid.

Example: SOURce1:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort 
/var/user/GnssMops1.rs_ion

Usage: Setting only

Manual operation: See "Export Grid" on page 208

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:DIR
<Directory>

Adds a set of files to the input files selection in one step.

Setting parameters: 
<Directory> string

File path

Example: See Example"Importing grid files" on page 399

Usage: Setting only

Manual operation: See "Import Grid" on page 205

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:
EMS <Filename>

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:
NSTB <Filename>

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:
GRID <Filename>

Add *.ems, *.nstb or *.iono_grid files to an import file list.

Setting parameters: 
<Filename> string

The <Filename> string comprises the file directory, filename and
extension. For more information about
*.ems and *.nstb files, see"SBAS correction file download"
on page 283 .
*.iono_grid files, see Example"Ionospheric grid file content
(extract)" on page 641.

Example: See Example"Importing grid files" on page 399

Usage: Setting only

Manual operation: See "Import Grid" on page 205
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[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?

Queries all files of the import file list in a comma separated list.

Example: See Example"Importing grid files" on page 399

Usage: Query only

Manual operation: See "Import Grid" on page 205

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:EXECute

Loads all files from an import file list.

Example: See Example"Importing grid files" on page 399

Usage: Event

Manual operation: See "Import Grid" on page 205

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:
ALL

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:
FILE<ch>

Remove all or one particular file at the n-th position from an import file list.

Suffix: 
<ch>

.
1 to n

Example: See Example"Importing grid files" on page 399

Usage: Event

Manual operation: See "Import Grid" on page 205

[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:ALPHa<ch0>:
UNSCaled <AlphaUnscaled>

Sets the klobuchar parameters alpha_0 to alpha_3.

Suffix: 
<ch0>

.
0 to 3

Parameters:
<AlphaUnscaled> float

Range: dynamic
Increment: dynamicResolution
*RST: 0

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "Klobuchar Parameters" on page 203
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[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:BETA<ch0>:
UNSCaled <BetaUnscaled>

Sets the klobuchar parameters beta_0 to beta_3.

Suffix: 
<ch0>

.
0 to 3

Parameters:
<BetaUnscaled> integer

Range: dynamic
*RST: 0

Example: See Example"Configuring the ionospheric and troposphere mod-
els" on page 399

Manual operation: See "Klobuchar Parameters" on page 203

21.10  AWGN configuration

Option: R&S SMBVB-K62

Example: Configure additive noise
SOURce1:BB:GNSS:AWGN:MODE ADD
SOURce1:BB:GNSS:AWGN:FREQuency:REFerence? 1389225000 Hz
SOURce1:BB:GNSS:AWGN:RF1:CONFig MANual
SOURce1:BB:GNSS:AWGN:BWIDth 500000000
SOURce1:BB:GNSS:AWGN:CNDRatio 30
SOURce1:BB:GNSS:AWGN:STATe 1

Example: Configure a CW interferer
SOURce1:BB:GNSS:AWGN:MODE CW
SOURce1:BB:GNSS:AWGN:FREQuency:TARGet 100000000
SOURce1:BB:GNSS:AWGN:JSRatio 30
SOURce1:BB:GNSS:AWGN:STATe 1

Commands:

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:BWIDth........................................................ 406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CNDRatio..................................................... 406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CONFig........................................................406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CENTer......................................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CW............................................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:REFerence?...............................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:TARGet......................................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:JSRatio........................................................ 408
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:MODE..........................................................408
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:STATe.......................................................... 408
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[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:BWIDth <SystemBAndwidth>

Sets the RF bandwidth to which the set carrier/noise ratio relates.

Within this frequency range, the signal is superimposed with a noise signal which level
corresponds exactly to the set C/N or S/N ratio.

Parameters:
<SystemBAndwidth> integer

Range: 1E3  to  500E6
*RST: 500E6

Example: See Example"Configure additive noise" on page 405.

Manual operation: See "Bandwidth" on page 196

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CNDRatio <CnDensityRatio>

Sets the carrier power to noise power ratio C/N ratio, that is the difference of carrier
power and noise power:

C/N ratio = Carrier power - Noise power

Noise power = Refrence power + 10 * log10(System Bandwidth) - C/ N0

Parameters:
<CnDensityRatio> float

Range: 0  to  55
Increment: 0.01
*RST: 40

Example: See Example"Configure additive noise" on page 405.

Manual operation: See "Carrier/Noise Density Ratio - C/N0" on page 195

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CONFig <AutoConfigState>

Defines how noise bandwidth and noise center frequency are set.

Parameters:
<AutoConfigState> AUTO | MANual

AUTO
Sets bandwidth and center frequency automatically.
MANual
Enables configuration of noise and CW parameters.
*RST: AUTO

Example: See Example"Configure additive noise" on page 405.

Manual operation: See "Noise Config" on page 196
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[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CENTer
<CenterFrequency>

Sets center frequency of the noise signal.

Parameters:
<CenterFrequency> integer

Range: 1E9  to  2E9
*RST: 1.389225E9

Example: See Example"Configure additive noise" on page 405.

Manual operation: See "Center Frequency" on page 196

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CW <CwFrequency>

Sets the frequency of the CW interfering signal.

Parameters:
<CwFrequency> integer

Range: 1E9  to  2E9
*RST: 1.389225E9
Default unit: Hz

Example: See Example"Configure a CW interferer" on page 405.

Manual operation: See "CW Frequency" on page 196

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:REFerence?

Queries the reference frequency, that is the RF carrier frequency.

Set the freqquency with the following remote command:

SOURce1:FREQuency
Return values: 
<ReferenceFreque> integer

Range: 1E9  to  2E9
*RST: 1E9

Example: See Example"Configure additive noise" on page 405.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:TARGet <CwFreqOffset>

Sets the frequency offset of the sine wave relative to the "Reference Frequency".
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Parameters:
<CwFreqOffset> float

Range: -250E6  to  250E6
Increment: 1E-3
*RST: 0

Example: See Example"Configure a CW interferer" on page 405.

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:JSRatio <JsRatio>

Sets the jammer (interferer) power to signal power ratio C/I ratio, that is the difference
of carrier power and noise power:

C/I ratio = Carrier power - Interferer power

Interferer power = Refrence power + J/S

Parameters:
<JsRatio> float

Range: -50  to  50
Increment: 0.01
*RST: 40

Example: See Example"Configure a CW interferer" on page 405.

Manual operation: See "Jammer/Signal Ratio - J/S" on page 195

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:MODE <AwgnMode>

Activates/deactivates the generation of an AWGN signal. The interferer (AWGN or CW
interferer, depending on the selected mode) is generated after the generator is activa-
ted.

Parameters:
<AwgnMode> ADD | CW

*RST: ADD

Example: See Example"Configure additive noise" on page 405.

Manual operation: See "Mode" on page 195

[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:STATe <AwgnState>

Activates/deactivates the generation of an AWGN signal. The interferer (AWGN or CW
interferer, depending on the selected mode) is generated after the generator is activa-
ted.

Parameters:
<AwgnState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configure additive noise" on page 405.
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Manual operation: See "State" on page 195

21.11  Satellites constellation

Example: Configuring the satellite's constellation
SOURce1:BB:GNSS:PRESet
SOURce1:BB:GNSS:TMODe NAV

SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1

SOURce1:BB:GNSS:SV:SELection:MODE ELEV
SOURce1:BB:GNSS:SV:SELection:EOBScuration:REFerence LHOR
SOURce1:BB:GNSS:SV:SELection:EOBScuration:ANGLe 5
// query the number of satellites available
SOURce1:BB:GNSS:SV:SELection:GPS:AVAilable?
// 37
SOURce1:BB:GNSS:SV:SELection:GALileo:AVAilable?
// 29
SOURce1:BB:GNSS:SV:SELection:GPS:MIN 1
SOURce1:BB:GNSS:SV:SELection:GPS:MAX 24
SOURce1:BB:GNSS:SV:SELection:GALileo:MIN 1
SOURce1:BB:GNSS:SV:SELection:GALileo:MAX 15
// query the number of active statellites in the constellation
SOURce1:BB:GNSS:SV:SELection:GPS:ACTive?
// 10
SOURce1:BB:GNSS:SV:SELection:GALileo:ACTive?
// 8

// Query all SV IDs per GNSS system, i.e. SVs included in and excluded
// from the satellite constellation.
SOURce1:BB:GNSS:SVID:GPS:LIST:ALL?
// 1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,
// 28,29,30,31,32,33,34,35,36,37
// Query valid SV IDs per GNSS system, i.e. SVs included in the
// satellite constellation.
SOURce1:BB:GNSS:SVID:GPS:LIST:VALid?
// 1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,
// 28,29,30,31
// Query, if an SV ID is healhy or not.
SOURce1:BB:GNSS:SVID1:GPS:HEALthy?
// 1
SOURce1:BB:GNSS:SVID30:GPS:HEALthy?
// 0
// Query, if an SV ID is visible or not.
SOURce1:BB:GNSS:SVID1:GPS:VISibility:STATe?
// 1
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SOURce1:BB:GNSS:SVID30:GPS:VISibility:STATe?
// 0

SOURce1:BB:GNSS:SVID1:GPS:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:POWer:OFFSet -10

Example: Importing a satellite constellation
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1

// Import a GPS satellite constellation source file.
SOURce1:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation 
"/var/user/19_02_2014_gps.txt"
SOURce1:BB:GNSS:SV:IMPort:GPS:EXECute

// Import separate constellation source and navigation message file.
SOURce1:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation 
"/var/user/19_02_2014_gps.txt"
SOURce1:BB:GNSS:SV:IMPort:GPS:UDSource 1
SOURce1:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage 
"/var/user/19_02_2014_gps.14n"
// Apply data from the constellation source file to all active GNSS systems.
SOURce1:BB:GNSS:SV:IMPort:GPS:UALL 0
SOURce1:BB:GNSS:SV:IMPort:GPS:EXECute

Commands:

[:SOURce<hw>]:BB:GNSS:SV:SELection:MODE.............................................................. 412
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:REFerence.................................. 412
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:ANGLe........................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:CHANnels:MAX.................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MIN........................................................ 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MAX....................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MIN........................................................ 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MAX....................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MIN........................................................ 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MAX....................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MIN......................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MAX.....................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MIN...................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MAX..................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MIN......................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MAX.................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MIN.......................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MAX......................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:ACTive?.................................................. 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:ACTive?..................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:ACTive?..................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:ACTive?................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:ACTive?............................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:ACTive?............................................... 414
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[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:ACTive?....................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:AVAilable?...............................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:AVAilable?...............................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:AVAilable?...............................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:AVAilable?............................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:AVAilable?......................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:AVAilable?............................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:AVAilable?.................................................414
[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST:ALL?............................................................415
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST:ALL?............................................................415
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST:ALL?............................................................415
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST:ALL?......................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST:ALL?...................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST:ALL?.........................................................415
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST:ALL?............................................................. 415
[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST[:VALid]?.......................................................415
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST[:VALid]?.......................................................415
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST[:VALid]?.......................................................415
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST[:VALid]?.................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST[:VALid]?................................................. 415
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST[:VALid]?.................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST[:VALid]?.........................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:HEALthy.......................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:HEALthy.......................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:HEALthy...................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:HEALthy.................................................... 416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:HEALthy................................................. 416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:HEALthy....................................................416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy........................................................ 416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:VISibility:STATe?........................................... 417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:VISibility:STATe?........................................... 417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:VISibility:STATe?...........................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:VISibility:STATe?.........................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:VISibility:STATe?..................................... 417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:VISibility:STATe?........................................ 417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:VISibility:STATe?.............................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:CONStellation....................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:CONStellation....................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:CONStellation.....................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:CONStellation..................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:CONStellation.................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation......................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UDSource.....................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UDSource.................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UDSource.................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UDSource............................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UDSource..................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UDSource...................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:NMESsage........................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:NMESsage........................................... 418
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[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:NMESsage.........................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:NMESsage......................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:NMESsage.........................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage............................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UALL.........................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UALL.........................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UALL......................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UALL............................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UALL........................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UALL........................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:EXECute...................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:EXECute...................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:EXECute....................................................419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:EXECute.................................................419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:EXECute................................................... 419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:EXECute........................................................ 419

[:SOURce<hw>]:BB:GNSS:SV:SELection:MODE <SelectionMode>

Selects a criterium to define the initial satellite constellation.

Parameters:
<SelectionMode> MANual | ELEVation | VISibility | DOP | ADOP

MANual
Manual selection to add active space vehicles of the satellite
constellation and remove inactive space vehicles from the satel-
lite constellation. You can also activate invisible space vehicles.
ELEVation
Automatic selection of space vehicles according to their highest
elevation angle.
VISibility
Automatic selection of space vehicles according to their longest
visibility time.
DOP
Automatic selection with good dilution of precision (DOP) values
at simulation start.
ADOP
Adaptive DOP mode providing automatic selection with good
DOP values at simulation start and during runtime.
*RST: VISibility

Example: See Example"Configuring the satellite's constellation"
on page 409.

Manual operation: See "Selection Mode" on page 77

[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:REFerence <Type>

Selects how the behavior of earth obscuration is defined.
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Parameters:
<Type> ETANgent | LHORizon

*RST: ETANgent

Example: See Example"Configuring the satellite's constellation"
on page 409.

Manual operation: See "Earth Obscuration References (Cut-Off Reference)"
on page 79

[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:ANGLe <ElevMaskAngle>

Sets the satellite's elevation mask angle. The angle is applied relative to the selected
horizon.

Parameters:
<ElevMaskAngle> float

Range: -10  to  90
Increment: 0.1
*RST: 5

Example: See Example"Configuring the satellite's constellation"
on page 409.

Manual operation: See "Earth Obscuration Offset (Cut-Off Angle)" on page 80

[:SOURce<hw>]:BB:GNSS:SV:SELection:CHANnels:MAX <MaxNumbChannels>

Queries the maximum number of GNSS channels.

The number depends on the simulation capacity, see Chapter G, "Channel budget",
on page 642.

Parameters:
<MaxNumbChannels>integer

Range: 6  to  612
*RST: 24

Manual operation: See "Maximum Number of Channels" on page 81

[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MIN <MinimumSVs>
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[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MAX <MaximumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MIN <MinimumSVs>
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MAX <MaximumSVs>
Sets the minimum and maximum number of satellites per GNSS system that can be
included in the satellite constellation.

Parameters:
<MaximumSVs> integer

Range: 0  to  24
*RST: 24

Example: See Example"Configuring the satellite's constellation"
on page 409.

Manual operation: See "Number of SVs" on page 81

[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:ACTive?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:ACTive?
Queries the number of active satellites per GNSS system that are currently part of the
satellite's constellation.

Return values: 
<ActiveSVs> integer

Range: 0  to  24
*RST: 0

Example: See Example"Configuring the satellite's constellation"
on page 409.

Usage: Query only

Manual operation: See "Number of SVs" on page 81

[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:AVAilable?
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:AVAilable?
Queries the number of available satellites per GNSS system.
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Return values: 
<AvailableSVs> integer

Range: 0  to  40
*RST: 0

Example: See Example"Configuring the satellite's constellation"
on page 409.

Usage: Query only

Manual operation: See "Number of SVs" on page 81

[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST:ALL?
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST:ALL?
Queries the SV IDs of all satellites of the GNSS system.

The query lists SV IDs of the satellites included in and excluded from the satellite con-
stellation (Figure 6-1).

Example: See Example"Configuring the satellite's constellation"
on page 409.

Usage: Query only

Manual operation: See "Satellite's Constellation, SV ID" on page 75

[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST[:VALid]?
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST[:VALid]?
Queries the SV IDs of all valid satellites for the GNSS system.

The query lists SV IDs of the satellites included in the satellite constellation.

Example: See Example"Configuring the satellite's constellation"
on page 409.

Usage: Query only

Manual operation: See "Satellite's Constellation, SV ID" on page 75

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:HEALthy <HealthyState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:HEALthy <HealthyState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:HEALthy <HealthyState>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:HEALthy <HealthyState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:HEALthy <HealthyState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:HEALthy <HealthyState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy <HealthyState>
Indicates if the selected SV ID is healthy or not.

Parameters:
<HealthyState> 1 | ON | 0 | OFF

1 = healthy satellite
The healthy state reflects the value of the corresponding healthy
flag in the navigation message:
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
LNAV:EPHemeris:HEALth on page 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:L1Health on page 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:L2Health on page 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:
CNAV:EPHemeris:L5Health on page 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E1BDVS on page 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E1BHS on page 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:
NMESsage:INAV:E5BHS on page 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:
DNAV:EPHemeris:HEALth on page 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
NMESsage:NAV:EPHemeris:HEALth on page 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:
NAV:EPHemeris:HEALth on page 513
The values are interdependent; changing one of them changes
the other.
*RST: 1

Example: See Example"Configuring the satellite's constellation"
on page 409.

Example: SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:HEALth 0
SOURce1:BB:GNSS:SVID1:GPS:HEALthy?
// 1
SOURce1:BB:GNSS:SVID1:GPS:HEALthy 0
SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:HEALth?
// 63

Manual operation: See "Satellite's Constellation, SV ID" on page 75
See "Healthy" on page 86
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:VISibility:STATe?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:VISibility:STATe?
Queries if the selected SV ID is visible in the satellite constellation.

Return values: 
<VisibilityState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the satellite's constellation"
on page 409.

Usage: Query only

Manual operation: See "Satellite's Constellation, SV ID" on page 75

[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:CONStellation <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:CONStellation <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:CONStellation <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:CONStellation <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:CONStellation <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation <Filename>
Selects the file from that the satellites constellation and navigation data are extracted.
Table 21-1: Supported file extensions for satellites constellation and navigation data

GNSS File extension

GPS *.rnx, *.txt, *.alm, *.al3, *.<xx>n,

Galileo *.rnx, *.txt, *.alm, *.al3, *.<xx>n, *.<xx>l, *.xml

GLONASS *.rnx, *.alg, *.<xx>n

BeiDou *.rnx, *.txt, *.<xx>n, *.<xx>c

QZSS *.rnx, *.txt, *.alm, *.<xx>n,

NavIC *.rnx, *.<xx>i

Parameters:
<Filename> string

Filename, including file path and file extension.

Example: See Example"Importing a satellite constellation" on page 410.

Manual operation: See "Constellation Source File" on page 285
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[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UDSource <UseDiffSrcState>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UDSource <UseDiffSrcState>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UDSource <UseDiffSrcState>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UDSource <UseDiffSrcState>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UDSource <UseDiffSrcState>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UDSource <UseDiffSrcState>
Enables loading the dedicated files as source for the navigation data.

Parameters:
<UseDiffSrcState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Importing a satellite constellation" on page 410.

Manual operation: See "Use Different Source File for Navigation Message"
on page 285

[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:NMESsage <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:NMESsage <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:NMESsage <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:NMESsage <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:NMESsage <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage <Filename>
Selects the file from that the navigation data is extracted.

For an overview of the supported file types, see Table 21-1.

Parameters:
<Filename> string

Filename, incl. file path and file extension.

Example: See Example"Importing a satellite constellation" on page 410.

Manual operation: See "Navigation Message Source File" on page 285
See "Use Constellation Source File for all active GNSS system"
on page 285

[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UALL <UseToAllSystems>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UALL <UseToAllSystems>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UALL <UseToAllSystems>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UALL <UseToAllSystems>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UALL <UseToAllSystems>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UALL <UseToAllSystems>
Parameters:
<UseToAllSystems> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:EXECute
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:EXECute
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[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:EXECute
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:EXECute
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:EXECute
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:EXECute
Triggers the import of constellation and navigation data from the selected files.

Example: See Example"Importing a satellite constellation" on page 410.

Usage: Event

Manual operation: See "Import, Cancel" on page 285

21.12  Signals and power configuration per satellite

Example: To configure SV power and modulation control
SOURce1:BB:GNSS:PRESet
SOURce1:BB:GNSS:TMODe NAV
// Activate C/A and P codes in L1 band.
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C:STATe 0
// Activate GPS SVID#1.
SOURce1:BB:GNSS:SVID1:GPS:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:PRESent 1

// Set power-related settings.
SOURce1:BB:GNSS:POWer:REFerence -120
SOURce1:BB:GNSS:SVID1:GPS:POWer:PLOSs 1
SOURce1:BB:GNSS:SVID1:GPS:POWer:OFFSet -3
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:POWer:OFFset 0
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:P:POWer:OFFset -3
// Apply the settings to SVID#11.
SOURce1:BB:GNSS:SVID1:GPS:POWer:COPY:SVID 11
SOURce1:BB:GNSS:SVID1:GPS:POWer:COPY:EXECute

// Set the modulation control settings.
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:DATA:PCODe:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:P:DATA:PCODe:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol AUTO
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE RND
SOURce1:BB:GNSS:SVID1:GPS:MCONtrol:COPY:SVID 5
SOURce1:BB:GNSS:SVID1:GPS:MCONtrol:COPY:EXECute

Example: To load a Galileo OSNMA scenario
Load a predefined Galileo OSNMA scenario and check Galileo signal and satellite
characteristics.
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// Load a scenario, for example, the scenario 'OSNMA: Configuration A'.
SOURce1:BB:GNSS:SETTing:LOAD:PREDefined "OSNMA: Configuration A"
SOURce1:BB:GNSS:SCENario?
// Response: "OSNMA: Configuration A"
// Query simulation information.
SOURce1:BB:GNSS:SIMulation:INFO?
// Response: "L1 / Galileo only"

// Query signal and SV 2 information.
SOURce1:BB:GNSS:SYSTem:GALileo:SIGNal:L1Band:E1OS:STATe?
// Response: "1"
SOURce1:BB:GNSS:SVID2:GALileo:STATe?
// Response: "1"
SOURce1:BB:GNSS:SVID2:GALileo:POWer:OFFSet?
// Response in dB: "0"

// Query navigation message data and OSNMA state.
SOURce1:BB:GNSS:SVID2:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:DSELect?
// Response: "/opt/data/Lists/Gnss/Predefined/OSNMA/
// osnma_test_vectors/configuration_A/confA_Sat02.dm_iqd"
SOURce1:BB:GNSS:SVID2:GALileo:SIGNal:L1Band:E1OS:DATA:OSNMa:STATe?
// Response: "1"

// Activate GNSS and check signal characteristics of the RF output signal.
SOURce1:BB:GNSS:STATe 1
SOURce1:FREQuency:CW?
// Response in Hz: "1575420000"
SOURce1:POWer:PEP?
// Response in dB: "-77.35"
SOURce1:POWer:LEVel:IMMediate:AMPLitude?
// Response in dB: "-80.36"
OUTPut1:STATe 1

Commands:

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:STATe.......................................................... 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:STATe.......................................................... 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:STATe.......................................................... 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:STATe........................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:STATe.....................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:STATe....................................................... 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:STATe............................................................ 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRESent...................................................... 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRESent...................................................... 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRESent......................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRESent....................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRESent.................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRESent................................................... 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRESent........................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:FNUMber................................................429
[:SOURce<hw>]:BB:GNSS:POWer:REFerence.................................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:PLOSs..............................................430
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:PLOSs..............................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:PLOSs..............................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:PLOSs........................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:PLOSs........................................ 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:PLOSs...........................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:PLOSs................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:OFFSet.............................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:OFFSet.............................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:OFFSet............................................ 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:OFFSet.......................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:OFFSet....................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:OFFSet..........................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:OFFSet.............................................. 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:POWer:OFFset.............430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:POWer:OFFset................ 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:POWer:OFFset.............. 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:POWer:OFFset...............430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:POWer:OFFset...............430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:POWer:OFFset...............431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:POWer:OFFset................ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:POWer:OFFset............. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:POWer:OFFset............ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:POWer:OFFset............ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:POWer:OFFset............. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:POWer:OFFset............. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:POWer:OFFset............ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:POWer:OFFset...431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:POWer:OFFset...431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:POWer:OFFset...........431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:POWer:OFFset...431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:POWer:OFFset...........431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:POWer:OFFset............431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:POWer:OFFset............431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:POWer:OFFset............431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:POWer:OFFset......... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:POWer:OFFset.................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:POWer:OFFset.................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:POWer:OFFset.....................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:POWer:OFFset.................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:POWer:OFFset.................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:POWer:OFFset.....................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:POWer:OFFset.................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:SVID.......................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:SVID...................................... 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:SVID...................................... 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:SVID.................................... 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:SVID.................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:SVID....................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:SVID........................................ 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:EXECute.................................432
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:EXECute.................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:EXECute.................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:EXECute.............................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:EXECute........................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:EXECute..............................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:EXECute...................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S[:STATe]........................ 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA[:STATe]............................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS[:STATe]..........................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S[:STATe].......................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C[:STATe].......................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C[:STATe]..........................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA[:STATe]........................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I[:STATe].........................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A[:STATe]....................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B[:STATe]....................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I[:STATe].........................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I[:STATe].........................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C[:STATe]....................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma[:STATe]..............433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma[:STATe]..............433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA[:STATe]...................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma[:STATe]..............433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B[:STATe]....................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A[:STATe]....................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S[:STATe]....................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS[:STATe].....................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S[:STATe]............................ 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA[:STATe]............................. 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C[:STATe]............................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P[:STATe]................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C[:STATe]............................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P[:STATe]................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA[:STATe]............................. 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:PCODe[:STATe]... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]...... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:PCODe[:STATe].... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:PCODe[:STATe]..... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:PCODe[:STATe]......434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:PCODe[:STATe].....434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:PILot:PCODe[:STATe]..... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:PCODe[:STATe].....434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:PCODe[:STATe]..... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]...... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:PILot:PCODe[:STATe].......434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:PCODe[:STATe]....434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:PCODe[:STATe].. 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:PCODe[:STATe]...434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:PCODe[:STATe].. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:PCODe[:STATe]....435
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:PCODe[:STATe]...435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:PCODe[:STATe]....435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:PCODe[:STATe].... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:PCODe[:STATe].. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

PCODe[:STATe]...................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:

PCODe[:STATe]...................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:

PCODe[:STATe]...................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:PCODe[:STATe].435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:PILot:PCODe[:STATe]. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:

PCODe[:STATe]...................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:PILot:

PCODe[:STATe]...................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:PCODe[:STATe].435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:PILot:PCODe[:STATe]. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:PCODe[:STATe].. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:PCODe[:STATe]...435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:PCODe[:STATe].. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:PCODe[:STATe]...435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:PCODe[:STATe].. 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:PCODe[:STATe]...435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:PCODe[:

STATe]................................................................................................................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:PCODe[:STATe] 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:PCODe[:STATe]....... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:PCODe[:STATe]........435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:PCODe[:STATe]........ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:PILot:PCODe[:STATe].........436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:PCODe[:STATe].......436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:PILot:PCODe[:STATe]....... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:PCODe[:STATe]...........436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:PILot:PCODe[:STATe]........... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:PCODe[:STATe].......436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:PCODe[:STATe]....... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:PCODe[:STATe]...........436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:PILot:PCODe[:STATe]........... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:PILot:PCODe[:STATe].........436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]........ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:SCODe[:STATe]..... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:SCODe[:STATe]......436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:SCODe[:STATe]..... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:SCODe[:STATe].. 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:SCODe[:STATe]...436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:SCODe[:STATe]....436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:SCODe[:STATe]....436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:SCODe[:STATe]...437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:SCODe[:STATe]....437

Signals and power configuration per satellite



Remote-control commandsSatellite Navigation

424User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:SCODe[:STATe].... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

SCODe[:STATe]...................................................................................................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:

SCODe[:STATe]...................................................................................................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:

SCODe[:STATe]...................................................................................................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:

SCODe[:STATe]...................................................................................................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:SCODe[:STATe].. 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:SCODe[:STATe]...437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:SCODe[:STATe].. 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:SCODe[:STATe]...437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:SCODe[:STATe]...437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:SCODe[:

STATe]................................................................................................................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:SCODe[:STATe] 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:SCODe[:STATe]....... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:SCODe[:STATe]........437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:SCODe[:STATe]....... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:

CONTrol............................................................................................................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

NMESsage:CONTrol............................................................................................ 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:

CONTrol............................................................................................................. 438
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage:CONTrol............................................................................................ 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:
CONTrol............................................................................................................. 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage:CONTrol............................................................................................ 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:
CONTrol............................................................................................................. 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:
CONTrol............................................................................................................. 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:
CONTrol............................................................................................................. 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:CONTrol............................................................................................ 438

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:CONTrol 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:CONTrol. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:CONTrol 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:CONTrol....439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:CONTrol 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:CONTrol....439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol. 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:TYPE 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE....439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:TYPE..439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:TYPE.. 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:TYPE.. 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE....439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:TYPE.. 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:TYPE439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:TYPE439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:TYPE.439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:TYPE.439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:TYPE440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:TYPE.440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

NMESsage:TYPE................................................................................................ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:

TYPE..................................................................................................................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:

NMESsage:TYPE................................................................................................ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:

TYPE..................................................................................................................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:

NMESsage:TYPE................................................................................................ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:

TYPE..................................................................................................................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:

TYPE..................................................................................................................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:

TYPE..................................................................................................................440
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:TYPE................................................................................................ 440

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:TYPE.... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:TYPE......440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:TYPE.... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:TYPE........ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:TYPE.... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:TYPE........ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE......440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:DSELect441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

NMESsage:DSELect............................................................................................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:

NMESsage:DSELect............................................................................................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:

DSELect............................................................................................................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:

NMESsage:DSELect............................................................................................442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:

DSELect............................................................................................................. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:

DSELect............................................................................................................. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:

DSELect............................................................................................................. 442
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:DSELect............................................................................................442

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:DSELect 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:DSELect. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:DSELect442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:DSELect....442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:DSELect442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:DSELect....442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:DSELect. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:OSNMa[:

STATe]................................................................................................................442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:

NMESsage:PATTern.............................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:

NMESsage:PATTern.............................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:

NMESsage:PATTern.............................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:

PATTern..............................................................................................................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:

PATTern..............................................................................................................443
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:
PATTern..............................................................................................................443

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:PATTern.............................................................................................443

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:PATTern.443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:PATTern.. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:PATTern.444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:PATTern.... 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:PATTern.444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:PATTern.... 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern.. 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:

MEANdering[:STATe]............................................................................................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:

MEANdering[:STATe]............................................................................................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:

TSEQuence[:STATe]............................................................................................ 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:

TSEQuence[:STATe]............................................................................................ 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:SVID...................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:SVID...................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:SVID...................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:SVID................................ 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:SVID............................. 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:SVID................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:SVID.................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:EXECute.............................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:EXECute.............................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:EXECute.............................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:EXECute.......................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:EXECute....................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:EXECute.......................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:EXECute...............................445

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:STATe <SvState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:STATe <SvState>
Activates the SV ID.

Parameters:
<SvState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure SV power and modulation control"
on page 419.
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Manual operation: See "State (SV ID)" on page 76

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRESent <PresentInConst>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRESent <PresentInConst>
Includes the SV ID in the currents constellation.

Parameters:
<PresentInConst> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Present in Constellation" on page 86

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:FNUMber <FreqNum>

Queries the frequency number of the subcarrier.

Parameters:
<FreqNum> integer

Range: -7  to  13
*RST: 0

Example: SOURce1:BB:GNSS:SVID15:GLONass:FNUMber?

Manual operation: See "Frequency Number" on page 87

[:SOURce<hw>]:BB:GNSS:POWer:REFerence <ReferencePower>

Sets the power level that is used as a reference for the calculation of the power level of
the satellites.

Parameters:
<ReferencePower> float

Range: -145  to  20
Increment: 0.01
*RST: -30

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Reference Power" on page 74
See "Reference Power (Carrier)" on page 195
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:PLOSs <PathLossState>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:PLOSs <PathLossState>
If enabled, the power of the SV ID signals is reduced to account for the free space
attenuation.

Parameters:
<PathLossState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Add Power Path-Loss" on page 87

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:OFFSet <PowerOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:OFFSet <PowerOffset>
Reduces the signal of the selected SV ID by the defined value.

Parameters:
<PowerOffset> float

Range: -21  to  0
Increment: 0.01
*RST: 0

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Power Offset" on page 76

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:POWer:OFFset
<PowerOffset>

Signals and power configuration per satellite



Remote-control commandsSatellite Navigation

431User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:POWer:
OFFset <PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:POWer:OFFset
<PowerOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:POWer:OFFset
<PowerOffset>

Sets a power offset for the selected signal.
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Parameters:
<PowerOffset> float

Range: -6  to  0
Increment: 0.01
*RST: 0

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Signal Power Offset" on page 87

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:SVID <Svid>
Sets the SV ID to that the configuration form the current satellite (SVID<ch>) is
applied.

Both SV IDs belong to the same GNSS system.

Parameters:
<Svid> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL
*RST: 1

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Copy Power Settings to,SV-ID" on page 87

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:EXECute
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:EXECute
Applies the configuration of the current satellite (SVID<ch>:<GNSS system>) to the
satellite defined with the command [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
POWer:COPY:SVID.

Both SV IDs belong to the same GNSS system.

Example: See Example"To configure SV power and modulation control"
on page 419.

Usage: Event

Manual operation: See "Copy Power Settings to,SV-ID" on page 87

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S[:STATe]
<State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B[:STATe]

<State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A[:STATe]

<State>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S[:STATe]
<State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS[:STATe]
<State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P[:STATe] <State>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA[:STATe] <State>
Activates the selected signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Signal State" on page 89

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:
PCODe[:STATe] <State>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:
PCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:PCODe[:
STATe] <State>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:PILot:PCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:PCODe[:
STATe] <State>

Activates spreading by using the primary code.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Primary Code" on page 90

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:SCODe[:
STATe] <State>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:
SCODe[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:SCODe[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:SCODe[:
STATe] <State>

Activates the secondary code in the data/pilot channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:L1C 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L5Band:L5S 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:L1C:PILot:SCODE 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L5Band:L5S:PILot:SCODE 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L5Band:L5S:DATA:SCODE 1

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Secondary Code" on page 90

Signals and power configuration per satellite



Remote-control commandsSatellite Navigation

438User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:
CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:
CONTrol <NavMsgControl>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:
CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:
NMESsage:CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:
CONTrol <NavMsgControl>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:
CONTrol <NavMsgControl>

Defines whether the navigation message parameters can be changed or not.

Parameters:
<NavMsgControl> OFF | EDIT | AUTO | OFF | EDIT | AUTO

OFF
Disables sending the navigation message.
EDIT
Enables configuration of the navigation message.
AUTO
Navigation message is generated automatically.
*RST: AUTO

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Nav Msg Control" on page 90

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:
NMESsage:TYPE <Data>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:
TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:
TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:
TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:
NMESsage:TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:
TYPE <Data>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:
TYPE <Data>

Sets the data source used for the generation of the navigation message.

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | RNData | ZNData
ZERO|ONE|PATTern|PN9|PN11|PN15|PN16|PN20|PN21|PN23|
DLISt
Arbitrary data source.
Define the pattern and load an existing data list file with the com-
mands:
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:
L1Band:CA:DATA:NMESsage:PATTern
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:
L1Band:CA:DATA:NMESsage:DSELect
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RNData
Summary indication for real navigation data.
Current navigation message type depends on the GNSS system
and the RF band, e.g. for GPS in L1 RNData means LNAV.
ZNData
Zero navigation data
Sets the orbit and clock correction parameters in the broadcas-
ted navigation message to zero.
*RST: RNData

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Nav Msg Type" on page 91

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
NMESsage:DSELect <DSelect>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:
DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:
DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:
DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:
NMESsage:DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:
DSELect <DSelect>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:
DSELect <DSelect>

Selects an existing data list file from the default directory or from the specific directory.

Parameters:
<DSelect> string

Filename incl. file extension or complete file path

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Nav Msg Type" on page 91

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
OSNMa[:STATe] <State>

Activates OSNMA coding of net content of the Galileo navigation message.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To load a Galileo OSNMA scenario" on page 419.

Manual operation: See "OSNMA" on page 190
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:
PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:
PATTern <Pattern>

Signals and power configuration per satellite



Remote-control commandsSatellite Navigation

444User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:
PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:
NMESsage:PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:
PATTern <Pattern>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:
PATTern <Pattern>

Sets a bit pattern as data source.

Parameters:
<Pattern> 64 bits

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Nav Msg Type" on page 91

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
MEANdering[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
MEANdering[:STATe] <State>

Enables meandering, i.e. doubling the data rate of a GLONASS satellite navigation sig-
nal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See [:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:
SIGNal:L1Band:CA:DATA:TSEQuence[:STATe]
on page 444.

Manual operation: See "Meander Sequence" on page 92

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
TSEQuence[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
TSEQuence[:STATe] <State>

Enables the time signal component of GLONASS signals.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: :SOURce1:BB:GNSS:SYSTem:GLONass:STATe 1
:SOURce1:BB:GNSS:SVID2:GLONass:SIGNal:L1Band:CA:DATA:MEANdering:STATe 1
:SOURce1:BB:GNSS:SVID2:GLONass:SIGNal:L1Band:CA:DATA:TSEQuence:STATe 1
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Manual operation: See "Time Sequence" on page 93

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:SVID <Svid>
Sets the SV ID to that the configuration form the current satellite (SVID<ch>) is
applied.

Both SV IDs belong to the same GNSS system.

Parameters:
<Svid> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL
*RST: 1

Example: See Example"To configure SV power and modulation control"
on page 419.

Manual operation: See "Copy Modulation Control Settings to,SV-ID" on page 93

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:EXECute
Applies the configuration of the current satellite (SVID<ch>:<GNSS system>) to the
satellite defined with the command [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
MCONtrol:COPY:SVID.
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Both SV IDs belong to the same GNSS system.

Example: See Example"To configure SV power and modulation control"
on page 419.

Usage: Event

Manual operation: See "Copy Modulation Control Settings to,SV-ID" on page 93

21.13  Navigation message commands

Example: Setting scaled or unscaled navigation message parameters
// Unscaled values imply, that commands with mnemonic "UNSCaled" are used.
SOURce1:BB:GNSS:SSValues 0
SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:TOE:UNSCaled 28800

// Scaled values imply, that commands without mnemonic "UNSCaled" are used.
SOURce1:BB:GNSS:SSValues 1
SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:TOE  1800

Example: Configuring a pseudorange error ramp
SOURce1:BB:GNSS:SVID1:GPS:STATe 1

SOURce1:BB:GNSS:SVID1:GPS:PRERrors:MODE PROF
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile1:OFFSet 50
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile1:REFerence 0
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile1:VALue -10
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile2:REFerence 5
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile2:VALue 10
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile3:REFerence 10
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile3:VALue 20
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile4:REFerence 15
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile4:VALue 30
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile5:REFerence 20
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile5:VALue 40
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile6:REFerence 25
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile6:VALue 50
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile:COUNt?
// Response: "6"
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile:APPend
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile:COUNt?
// Response: "7"
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile7:REFerence 30
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile7:VALue 30
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile7:DELete 
// Apply the same profile to "SV-ID 5".
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:COPY:SVID 5
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:COPY:EXECute
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Example: Loading pseudorange errors from a file
SOURce1:BB:GNSS:SVID1:GPS:STATe 1

SOURce1:BB:GNSS:PRERrors:CATalog?
// Response: "GPS_PRERRORS"
// The file GPS_PRERRORS.rs_perr is available.
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:MODE FILE
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:FILE GPS_PRERRORS
// Loads the file GPS_PRERRORS.rs_perr for GPS SVID1 pseudorange errors.
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile1:OFFSet 50

Example: Configuring Galileo Search-and-Rescue (SAR) data
The example illustrates how to configure Galileo SAR data.

// ********************************************************************************
// Enable Galileo system and nav. message configuration of, e.g., space vehicle 6.
// ********************************************************************************
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
SOURce1:BB:GNSS:SVID6:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:CONTrol EDIT
// ********************************************************************************
Configure long return link message (RLM) data.
// ********************************************************************************
// Set for long RLM data SAR mode.
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:MODE LRLM
// Set data bits of RLM parts 1 to 8.
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM1 0
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM2 1
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM3 2
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM4 3
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM5 4
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM6 5
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM7 6
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:RLM8 1048575
// ********************************************************************************
// Configure spare data.
// ********************************************************************************
// Set for spare data SAR mode.
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:MODE SPARe
// Set the 21 bits of spare SAR data.
SOURce1:BB:GNSS:SVID6:GAL:NMES:INAV:EPH:SAR:SPARe 699050

Commands:

● Simulated orbit, orbit perturbation and clock commands...................................... 448
● Pseudorange commands...................................................................................... 459
● Orbit, clock, system, time conversion and ionospheric errors...............................467
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21.13.1  Simulated orbit, orbit perturbation and clock commands

[:SOURce<hw>]:BB:GNSS:SSValues...............................................................................450
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XN......................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YN......................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZN...................................... 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XN................................ 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YN................................ 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZN.................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDN....................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDN....................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDN....................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDN.............................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDN.............................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDN.............................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDDN................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDDN................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDDN................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDDN............................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDDN............................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDDN............................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:WNOE................................ 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:WNOE................................ 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:WNOE............................. 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:WNOE..............................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:WNOE.................................. 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:TOE....................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:TOE....................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:TOE.................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:TOE................................. 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:TOE......................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:DATE.................................. 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:DATE................................ 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:DATE............................ 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:DATE.......................... 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:TIME...................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:TIME.................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:TIME............................. 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TIME........................... 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:SQRA................................. 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:SQRA................................. 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:SQRA.............................. 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:SQRA...............................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:SQRA................................... 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ECCentricity........................ 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ECCentricity........................ 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ECCentricity......................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ECCentricity......................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ECCentricity.......................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IZERo................................. 454
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IZERo................................. 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IZERo.............................. 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IZERo...............................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IZERo................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OZERo................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OZERo............................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OZERo.............................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OZERo............................. 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OZERo................................. 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OMEGa...............................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OMEGa...............................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OMEGa............................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OMEGa............................ 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OMEGa.................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:MZERo............................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:MZERo............................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:MZERo.............................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:MZERo.............................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:MZERo................................. 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IDOT...................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IDOT.................................. 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IDOT................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IDOT................................ 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IDOT.................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ODOT................................. 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ODOT.................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ODOT.............................. 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ODOT...............................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ODOT...................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:NDELta............................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:NDELta...............................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:NDELta............................ 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:NDELta.............................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:NDELta.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUC................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUC................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUC.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUC.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUC..................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUS....................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUS................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUS.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUS................................. 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUS..................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRC................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRC................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRC.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRC.................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRC..................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRS....................................457
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRS................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRS.................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRS................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRS..................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIC.....................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIC.....................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIC..................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIC.................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIC.......................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIS.....................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIS.....................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIS.................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIS.................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIS.......................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:WNOC.............................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:WNOC.............................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:WNOC........................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:WNOC............................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:WNOC................................ 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TOC..................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TOC................................. 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TOC...............................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TOC............................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TOC................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:AF<s2us0>........................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:AF<s2us0>........................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:AF<s2us0>........................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:AF<s2us0>..................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:AF<s2us0>.................. 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:AF<s2us0>..................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:AF<s2us0>..........................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TGD..................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TGD................................. 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TGD...............................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TGD............................ 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TGD<s2us>.................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TGD................................... 458

[:SOURce<hw>]:BB:GNSS:SSValues <ShowScaledValue>

Defines if the navigation message parameters are set as scaled or unscaled values
and thus which subset of remote-control commands is used.

Parameters:
<ShowScaledValue> 1 | ON | 0 | OFF

0
Used are unscaled values
The SOURce<hw>:BB:GNSS:...:UNSCaled commands
apply.
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1
Used are scaled values
Commands without the mnemonic UNSCaled apply.
*RST: 0

Example: SOURce1:BB:GNSS:SSValues 0
SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:TOE:UNSCaled
// 28800 
SOURce1:BB:GNSS:SSValues 1
SOURce1:BB:GNSS:SVID1:GPS:NMESsage:LNAV:EPHemeris:TOE?
// 1800

Manual operation: See "Show Scaled Values" on page 210

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XN <Xn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YN <Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZN <Zn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XN <Xn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YN <Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZN <Zn>
Set the Xn, Yn and Zn coordinates in PZ-90.

Parameters:
<Zn> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDN <XnDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDN <YnDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDN <ZnDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDN <XnDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDN <YnDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDN <ZnDot>
Sets the velocity components X'n, Y'n and Z'n.

Parameters:
<ZnDot> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDDN <XnDotDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDDN <YnDotDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDDN <ZnDotDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDDN

<XnDotDot>

Navigation message commands



Remote-control commandsSatellite Navigation

452User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDDN
<YnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDDN
<ZnDotDot>

Sets the moon and sun acceleration parameters X''n, Y''n and Z''n.

Parameters:
<ZnDotDot> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:WNOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:WNOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:WNOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:WNOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:WNOE <SimToe>
Sets the reference week.

Parameters:
<SimToe> integer

Range: 0  to  10000
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:TOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:TOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:TOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:TOE <SimToe>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:TOE <SimToe>
Sets the reference time of week.

Parameters:
<SimToe> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:DATE <Year>,
<Month>, <Day>

Sets the reference date.
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Parameters:
<Year> integer

Range: 1996  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TIME <Hour>,
<Minute>, <Second>

Sets the reference time.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> float
Range: 0  to  59.999
Increment: 0.001

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:SQRA <SqrtA>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:SQRA <SqrtA>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:SQRA <SqrtA>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:SQRA <SqrtA>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:SQRA <SqrtA>
Sets the square root of semi-major axis.

Parameters:
<SqrtA> integer

Range: 0.190735  to  8192
Increment: 1E-6
*RST: 0.190735

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ECCentricity
<Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ECCentricity
<Eccentricity>

Navigation message commands



Remote-control commandsSatellite Navigation

454User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ECCentricity
<Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ECCentricity
<Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ECCentricity
<Eccentricity>

Sets the eccentricity.

Parameters:
<Eccentricity> integer

Range: 0  to  4294967295
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IZERo <I0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IZERo <I0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IZERo <I0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IZERo <I0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IZERo <I0>
Sets inclination angle.

Parameters:
<I0> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OZERo <Omega0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OZERo <Omega0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OZERo

<Omega0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OZERo

<Omega0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OZERo <Omega0>
Sets the longitude of ascending node.

Parameters:
<Omega0> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OMEGa <Omega>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OMEGa <Omega>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OMEGa

<Omega>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OMEGa <Omega>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OMEGa <Omega>
Sets the argument of perigee.
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Parameters:
<Omega> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:MZERo <M0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:MZERo <M0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:MZERo <M0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:MZERo <M0>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:MZERo <M0>
Sets the mean anomaly.

Parameters:
<M0> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IDOT <Idot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IDOT <Idot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IDOT <Idot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IDOT <Idot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IDOT <Idot>
Sets the rate of inclination angle.

Parameters:
<Idot> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ODOT <OmegaDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ODOT <OmegaDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ODOT

<OmegaDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ODOT

<OmegaDot>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ODOT <OmegaDot>
Sets the rate of right ascension.

Parameters:
<OmegaDot> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:NDELta <DeltaN>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:NDELta <DeltaN>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:NDELta <DeltaN>

Navigation message commands



Remote-control commandsSatellite Navigation

456User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:NDELta <DeltaN>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:NDELta <DeltaN>
Sets the mean motion difference.

Parameters:
<DeltaN> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUC <Cuc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUC <Cuc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUC <Cuc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUC <Cuc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUC <Cuc>
Sets the cosine difference of latitude.

Parameters:
<Cuc> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUS <Cus>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUS <Cus>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUS <Cus>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUS <Cus>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUS <Cus>
Sets the sine difference of latitude.

Parameters:
<Cus> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRC <Crc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRC <Crc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRC <Crc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRC <Crc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRC <Crc>
Sets the cosine difference of orbital radius.

Parameters:
<Crc> float

Increment: 1E-15
*RST: 0

Navigation message commands



Remote-control commandsSatellite Navigation

457User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRS <Crs>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRS <Crs>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRS <Crs>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRS <Crs>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRS <Crs>
Sets the sine difference of orbital radius.

Parameters:
<Crs> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIC <Cic>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIC <Cic>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIC <Cic>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIC <Cic>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIC <Cic>
Sets the cosine difference of inclination.

Parameters:
<Cic> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIS <Cis>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIS <Cis>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIS <Cis>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIS <Cis>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIS <Cis>
Sets the sine difference of inclination.

Parameters:
<Cis> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:WNOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:WNOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:WNOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:WNOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:WNOC <Toc>
Sets the reference week.
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Parameters:
<Toc> integer

Range: 0  to  10000
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TOC <Toc>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TOC <Toc>
Sets the reference time of week.

Parameters:
<Toc> float

Increment: 1E-15
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:AF<s2us0> <Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:AF<s2us0> <Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:AF<s2us0> <Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:AF<s2us0> <Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:AF<s2us0>

<Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:AF<s2us0> <Af>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:AF<s2us0> <Af>
Sets the values of af0, af1 or - af2.

Parameters:
<Af> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TGD <Tgd>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TGD <Tgd>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TGD <Tgd>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TGD <Tgd>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TGD<s2us>

<Tgd>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TGD <Tgd>
Sets the group delay.

Parameters:
<Tgd> float

Increment: 1E-15
*RST: 0
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21.13.2  Pseudorange commands

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:MODE.......................................... 460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:MODE.......................................... 460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:MODE....................................... 460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:MODE.....................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:MODE.......................................... 460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:MODE........................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:MODE............................................ 461
[:SOURce<hw>]:BB:GNSS:PERRors:CATalog.................................................................. 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:FILE............................................. 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:FILE.............................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:FILE.......................................... 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:FILE........................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:FILE............................................. 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:FILE...........................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:FILE...............................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:SVID.................................. 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:SVID.................................. 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:SVID................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:SVID.............................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:SVID.................................. 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:SVID................................ 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:SVID.................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:EXECute.............................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:EXECute.............................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:EXECute..........................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:EXECute....................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:EXECute.............................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:EXECute.......................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:EXECute...............................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:VALue.......................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:VALue.......................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:VALue........................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:VALue.....................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:VALue.......................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:VALue........................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:VALue............................................ 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:OFFSet........................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:OFFSet........................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:OFFSet.........................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:OFFSet......................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:OFFSet........................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:OFFSet.........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:OFFSet............................. 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:COUNt?...........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:COUNt?.......................... 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:COUNt?........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:COUNt?..................... 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:COUNt?...........................464
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:COUNt?........................ 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:COUNt?............................ 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:APPend...........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:APPend...........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:APPend........................ 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:APPend..................... 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:APPend...........................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:APPend........................ 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:APPend.............................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:REFerence................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:REFerence................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:REFerence.............465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:REFerence.......... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:REFerence............. 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:REFerence.......... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:REFerence..................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:VALue.......................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:VALue...................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:VALue....................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:VALue................. 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:VALue.......................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:VALue.................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:VALue........................ 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:INSert.......................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:INSert.......................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:INSert.................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:INSert................. 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:INSert....................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:INSert.................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:INSert.........................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:DELete..................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:DELete..................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:DELete.................. 467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:DELete................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:DELete..................... 467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:DELete...................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:DELete....................... 467

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:MODE <PRErrorsMode>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:MODE <PRErrorsMode>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:MODE <PRErrorsMode>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:MODE

<PRErrorsMode>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:MODE <PRErrorsMode>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:MODE <PRErrorsMode>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:MODE <PRErrorsMode>
Sets how the pseudorange errors are defined.

Parameters:
<PRErrorsMode> FSBas | CONStant | PROFile | FILE

FSBas
Extracted from the imported SBAS corrections.
CONStant
Set with the command [:SOURce<hw>]:BB:GNSS:
SVID<ch>:GPS:PRERrors:VALue
PROFile
Defined with the command pairs [:SOURce<hw>]:BB:GNSS:
SVID<ch>:GPS:PRERrors:PROFile<gr>:REFerence and
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:
PROFile<gr>:VALue
FILE
Sets pseudorange errors according to a file with extension
*.rs_perr. Select the file via [:SOURce<hw>]:BB:GNSS:
SVID<ch>:GPS:PRERrors:FILE.
*RST: CONStant

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Example: See Example"Loading pseudorange errors from a file"
on page 447.

Manual operation: See "Error Mode" on page 211

[:SOURce<hw>]:BB:GNSS:PERRors:CATalog

Queries the names of the pseudorange errors files in the default or in a specific direc-
tory. Listed are files with the file extension *.rs_perr.

Example: See Example"Loading pseudorange errors from a file"
on page 447.

Manual operation: See "Pseudorange Errors File" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:FILE <Filename>
Loads a pseudorange error file with extension *.rs_perr from the default directory.
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Parameters:
<Filename> string

Example: See Example"Loading pseudorange errors from a file"
on page 447.

Manual operation: See "Pseudorange Errors File" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:SVID <Svid>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:SVID <Svid>
Sets the SV ID to that the configuration form the current satellite (SVID<ch>) is
applied.

Both SV IDs belong to the same GNSS system.

Parameters:
<Svid> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL
*RST: 1

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Manual operation: See "Copy to,SV-ID" on page 211

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:EXECute
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:EXECute
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:EXECute
Applies the configuration of the current satellite (SVID<ch>:<GNSS system>) to the
satellite defined with the command [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:
PRERrors:COPY:SVID.

Both SV IDs belong to the same GNSS system.

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Usage: Event

Manual operation: See "Copy to,SV-ID" on page 211

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:VALue <PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:VALue <PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:VALue <PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:VALue

<PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:VALue <PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:VALue <PRErrorsValue>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:VALue <PRErrorsValue>
Sets the constant pseudorange error.

Parameters:
<PRErrorsValue> float

Range: -1000  to  1000
Increment: 0.001
*RST: 0

Example: SOURce1:BB:GNSS:SVID1:GPS:PRERrors:MODE CONStant
SOURce1:BB:GNSS:SVID11:GPS:PRERrors:VALue -100

Manual operation: See "Value" on page 211

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:OFFSet
<ProfileOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:OFFSet
<ProfileOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:OFFSet
<ProfileOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:OFFSet
<ProfileOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:OFFSet
<ProfileOffset>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:OFFSet
<ProfileOffset>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:OFFSet
<ProfileOffset>

Adds a start time offset.

Parameters:
<ProfileOffset> float

Range: 0  to  86400
Increment: 0.1
*RST: 0

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Manual operation: See "Start Time Offset" on page 211

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:COUNt?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:COUNt?
Queries the number of entry in the profile table.

Return values: 
<ProfileTableLen> integer

Range: 0  to  10
*RST: 0

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Usage: Query only

Manual operation: See "Profile Table" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:APPend
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:APPend
Appends a row in the profile table.

Setting parameters: 
<ProfileAppend> Event
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Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Usage: Event

Manual operation: See "Profile Table" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:
REFerence <ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:
REFerence <ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:
REFerence <ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:REFerence
<ProfileRefTime>

Sets the reference time for the pseudorange error.

Suffix: 
<gr>

.
1 to 10
Pseudorange error

Parameters:
<ProfileRefTime> float

Range: 0  to  86400
Increment: 0.1
*RST: 0

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Manual operation: See "Profile Table" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:VALue
<ProfileValue>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:VALue
<ProfileValue>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:VALue
<ProfileValue>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:VALue
<ProfileValue>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:VALue
<ProfileValue>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:VALue
<ProfileValue>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:VALue
<ProfileValue>

Sets the pseudorange error value.

Suffix: 
<gr>

.
1 to 10
Pseudorange error

Parameters:
<ProfileValue> float

Range: -1000  to  1000
Increment: 0.001
*RST: 0

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Manual operation: See "Profile Table" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:INSert
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:INSert
Inserts a row before the selected pseudorange error.

Suffix: 
<gr>

.
1 to 10
Pseudorange error

Setting parameters: 
<ProfileInsert> Event

Example: SOURce1:BB:GNSS:SVID1:GPS:PRERrors:COUNt?
// 5
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:PROFile5:INSert
// insert a row before the last one
SOURce1:BB:GNSS:SVID1:GPS:PRERrors:COUNt?
// 6

Usage: Event

Manual operation: See "Profile Table" on page 212

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:DELete
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:DELete
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:DELete
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:DELete
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:DELete
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:DELete
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:DELete
Deletes the selected pseudorange error.

Suffix: 
<gr>

.
1 to 10
Pseudorange error

Setting parameters: 
<ProfileDelete> Event

Example: See Example"Configuring a pseudorange error ramp"
on page 446.

Usage: Event

Manual operation: See "Profile Table" on page 212

21.13.3  Orbit, clock, system, time conversion and ionospheric errors

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IODNav......... 487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IODNav.......... 487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IODE..................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODE..................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODE.............487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODE..................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE:UNSCaled...488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE:UNSCaled...488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE:UNSCaled 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE.................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE:UNSCaled...488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE...................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE:

UNSCaled...........................................................................................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE.............. 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE:

UNSCaled...........................................................................................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE............... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE:

UNSCaled...........................................................................................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE.............. 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE:

UNSCaled...........................................................................................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE.............. 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE:UNSCaled.. 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE...................488
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE:UNSCaled...488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA:UNSCaled 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA................ 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA.............. 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA:UNSCaled 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA................ 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SQRA:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SQRA............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SQRA:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SQRA.............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:SQRA:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:SQRA............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:SQRA:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:SQRA............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA:UNSCaled489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA:UNSCaled 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA................ 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ECCentricity:

UNSCaled...........................................................................................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ECCentricity........489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:

ECCentricity:UNSCaled........................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ECCentricity..... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ECCentricity:

UNSCaled...........................................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ECCentricity....... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:

ECCentricity:UNSCaled........................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ECCentricity...490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:

ECCentricity:UNSCaled........................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ECCentricity....490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:

ECCentricity:UNSCaled........................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ECCentricity...490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:

ECCentricity:UNSCaled........................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ECCentricity...490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ECCentricity:

UNSCaled...........................................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ECCentricity....... 490
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ECCentricity:
UNSCaled...........................................................................................................490

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ECCentricity........490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo:UNSCaled 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo................ 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo:

UNSCaled...........................................................................................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo.............. 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo:UNSCaled 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo................ 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IZERo............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IZERo.............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IZERo............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IZERo............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo:UNSCaled491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo:UNSCaled 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo................ 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo...............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OZERo............ 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo...............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OZERo.......... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OZERo........... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OZERo.......... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OZERo.......... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo.............. 492
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo:
UNSCaled...........................................................................................................492

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo...............492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa..............492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OMEGa........... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa..............492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OMEGa......... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OMEGa.......... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OMEGa......... 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OMEGa......... 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa............. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa.............. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo...............493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:MZERo............ 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo...............493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:MZERo..........493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:MZERo...........493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:MZERo..........493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................493
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:MZERo..........493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo.............. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo...............494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT:UNSCaled.. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT..................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT:UNSCaled494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT............... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT:UNSCaled..494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT..................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IDOT:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IDOT............. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT.............. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT............. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT:

UNSCaled...........................................................................................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT............. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT:UNSCaled..494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT................. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT:UNSCaled.. 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT..................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT:UNSCaled 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT................ 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT:

UNSCaled...........................................................................................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT..............495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT:UNSCaled 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT................ 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ODOT:

UNSCaled...........................................................................................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ODOT........... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ODOT:

UNSCaled...........................................................................................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ODOT.............495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ODOT:

UNSCaled...........................................................................................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ODOT........... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ODOT:

UNSCaled...........................................................................................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ODOT........... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT:UNSCaled495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT................495
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT:UNSCaled 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT................ 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot............. 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot............... 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta.............. 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NDELta............496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta.............. 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:NDELta......... 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:NDELta...........496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:NDELta......... 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:NDELta......... 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta..............497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta.............. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot............. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:DNDot:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:DNDot........... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot............... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT.............. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADOT:

UNSCaled...........................................................................................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADOT............497
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT:UNSCaled 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT................ 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADELta:

UNSCaled...........................................................................................................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADELta............ 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADELta:

UNSCaled...........................................................................................................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADELta..........498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta:

UNSCaled...........................................................................................................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta.............. 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINTerval?.... 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TOE?............498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINDex:

UNSCaled...........................................................................................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINDex......... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN:UNSCaled..... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN..................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN:UNSCaled..... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN..................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN:UNSCaled..... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN..................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN:UNSCaled499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN:

UNSCaled...........................................................................................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN:

UNSCaled...........................................................................................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN:UNSCaled...499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN:UNSCaled...499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN...................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN:UNSCaled...499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN...................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDN............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDN............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN:UNSCaled 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN.................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN:UNSCaled 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN................ 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN:UNSCaled 500

Navigation message commands



Remote-control commandsSatellite Navigation

474User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN................ 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDDN........... 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDDN...........500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDDN:

UNSCaled...........................................................................................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDDN...........500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC:UNSCaled.. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC...................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC:UNSCaled501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC................ 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC:UNSCaled.. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC.................. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC:

UNSCaled...........................................................................................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC..............501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC:

UNSCaled...........................................................................................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC...............501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC:

UNSCaled...........................................................................................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC..............501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC:

UNSCaled...........................................................................................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC..............501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC:UNSCaled..501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC.................. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC:UNSCaled.. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC...................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS:UNSCaled...501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS...................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS:UNSCaled 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS................ 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS:UNSCaled.. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS...................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS:

UNSCaled...........................................................................................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS.............. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS:

UNSCaled...........................................................................................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS............... 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS:

UNSCaled...........................................................................................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS.............. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS.............. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS:

UNSCaled...........................................................................................................502
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS:UNSCaled.. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS.................. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS:UNSCaled...502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS...................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC:UNSCaled.. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC...................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC:UNSCaled502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC................ 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC:UNSCaled.. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC.................. 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC..............503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC...............503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC..............503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC..............503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC:UNSCaled..503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC.................. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC:UNSCaled.. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC...................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS:UNSCaled...503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS...................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS:UNSCaled 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS................ 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS:UNSCaled.. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS...................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS.............. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS:

UNSCaled...........................................................................................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS............... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS:

UNSCaled...........................................................................................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS.............. 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS:

UNSCaled...........................................................................................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS.............. 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS:UNSCaled.. 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS.................. 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS:UNSCaled...504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS...................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC:UNSCaled....504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC.................... 504
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC:UNSCaled. 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC..................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC:UNSCaled....504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC....................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC:

UNSCaled...........................................................................................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC............... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC:UNSCaled 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC................ 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC:

UNSCaled...........................................................................................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC............... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC:

UNSCaled...........................................................................................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC............... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC:UNSCaled... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC....................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC:UNSCaled....505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC.................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS:UNSCaled.... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS.................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS:UNSCaled..505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS..................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS:UNSCaled....505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS.................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS:

UNSCaled...........................................................................................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS............... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS:UNSCaled 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS................ 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS:

UNSCaled...........................................................................................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS............... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS:

UNSCaled...........................................................................................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS............... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS:UNSCaled....505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS....................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS:UNSCaled.... 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS.................... 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODC................. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODC.............506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODC..................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC:UNSCaled506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC:

UNSCaled...........................................................................................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC............. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC:UNSCaled506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC................506
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:TOC:
UNSCaled...........................................................................................................506

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:TOC........... 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:TOC:

UNSCaled...........................................................................................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:TOC............ 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TOC:

UNSCaled...........................................................................................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TOC........... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TOC:

UNSCaled...........................................................................................................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TOC........... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC:

UNSCaled...........................................................................................................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC............... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC:UNSCaled507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC................ 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:AF<s2us0>...... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:AF<s2us0>...... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:AF<s2us0>....507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:AF<s2us0>...... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:AF<s2us0>. 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:AF<s2us0>.. 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:AF<s2us0>. 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:AF<s2us0>. 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:AF<s2us0>......508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:

AF<s2us0>:UNSCaled......................................................................................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:AF<s2us0>...... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD:UNSCaled508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD................508
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD:
UNSCaled...........................................................................................................508

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD............. 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD:UNSCaled508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TGD:

UNSCaled...........................................................................................................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TGD........... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:

TGD<s2us>:UNSCaled........................................................................................ 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TGD<s2us> 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD:

UNSCaled...........................................................................................................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD............... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD:UNSCaled509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5Q:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5Q.........509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5I:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5I...........509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L2C:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L2C......... 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L1CA:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L1CA.......509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5Q:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5Q...........509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5I:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5I.............509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L2C:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L2C........... 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L1CA:

UNSCaled...........................................................................................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L1CA.........509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:BGDA:

UNSCaled...........................................................................................................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:BGDA.........510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDB:

UNSCaled...........................................................................................................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDB..........510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDA:

UNSCaled...........................................................................................................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDA..........510
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:TAUN:
UNScaled........................................................................................................... 510

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:TAUN.........510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:GAMN:

UNSCaled...........................................................................................................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:GAMN....... 510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:DTAU:

UNSCaled...........................................................................................................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:DTAU.........510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ALERt.............. 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ALERt............511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ALERt................ 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L5Health.......... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L2Health.......... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L1Health.......... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L5Health............ 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L2Health............ 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L1Health............ 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED0...............511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED1...............511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED2...............511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED0.................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED1................ 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED2................ 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:WNOP............... 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP:UNSCaled.. 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP...................512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ISFLag.............512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ISFLag...............512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L2CPhasing......513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L2CPhasing....... 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:L5Health.............513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SHEalth..............513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:HEALth.............. 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:HEALth.........513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:HEALth..........513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:HEALth...............513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:URA...................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:URA...................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:URA................ 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:URA...................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:URA............. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:URA.............. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:URA.................. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:URA...................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ASFLag.............. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SVConfig............514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SVConfig............ 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CLTMode............514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CLTMode............514
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:LTPData.............515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:LTPData............. 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:FIFLag............... 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:FIFLag............... 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:AODO?.............. 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:AODO?.............. 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:

SF1Reserved<s2us>?..........................................................................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:

SF1Reserved<s2us>?..........................................................................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SISA............. 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SISA...............516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BDVS.......................... 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BHS.............................516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BDVS.......................... 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BHS.............................516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:MODE.....517
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:

RLM<s2us>.........................................................................................................517
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:SPARe....518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5ADVS......................... 518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5AHS........................... 518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:SEType.........518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:CFM............. 519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:P..................519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:AOEP........... 519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TALignment...519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:EN.............519
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

WNOT................................................................................................................ 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:

WNOT................................................................................................................ 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:

WNOT................................................................................................................ 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:

WNOT................................................................................................................ 520
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:WNOT........ 520
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT...... 520
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:WNOT........ 520
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:WNOT....520
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:WNOT.....520
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT....520
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:WNOT....520
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT........ 520
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:WNOT.........520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

TOT:UNSCaled....................................................................................................520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT..520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:

TOT:UNSCaled....................................................................................................520
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[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT..520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:

TOT:UNSCaled....................................................................................................520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:

TOT....................................................................................................................520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:

TOT:UNSCaled....................................................................................................520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:

TOT....................................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:TOT............521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT......... 521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:TOT............521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:TOT....... 521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:TOT........ 521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:TOT....... 521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:TOT....... 521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT........... 521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:TOT:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:TOT............ 521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:ATWO:

UNSCaled...........................................................................................................521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:ATWO.........521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:

ATWO:UNSCaled................................................................................................ 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO...... 522
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO:

UNSCaled...........................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO........ 522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

AONE.................................................................................................................522
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[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled.................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE.................................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled.................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:
AONE.................................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled.................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE.................................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AONE:
UNSCaled...........................................................................................................522

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AONE......... 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE:

UNSCaled...........................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE.......522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AONE:

UNSCaled...........................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AONE......... 522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AONE.... 522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AONE..... 523
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AONE....523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AONE.... 523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:

AONE:UNSCaled.................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AONE.... 523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE:

UNSCaled...........................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE.........523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AONE:

UNSCaled...........................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AONE......... 523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:

AZERo................................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:

AZERo................................................................................................................523
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[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo:UNSCaled............................................................................................... 523

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo................................................................................................................523

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo:UNSCaled............................................................................................... 523

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo................................................................................................................523

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:
UNSCaled...........................................................................................................523

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AZERo........523
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo..... 524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:

UNSCaled...........................................................................................................524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo........524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AZERo... 524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AZERo.... 524
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AZERo.. 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:

AZERo:UNSCaled............................................................................................... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AZERo... 524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo:

UNSCaled...........................................................................................................524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo....... 524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AZERo:

UNSCaled...........................................................................................................524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AZERo........ 524
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:WNOT........ 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:WNOT... 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:WNOT.....525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:TOT:

UNSCaled...........................................................................................................525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:TOT............525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:TOT:

UNSCaled...........................................................................................................525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:TOT....... 525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:TOT:

UNSCaled...........................................................................................................525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:TOT....... 525
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[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:TOT:
UNSCaled...........................................................................................................525

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:TOT....... 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:TOT:

UNSCaled...........................................................................................................525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:TOT........ 525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AZERo:

UNSCaled...........................................................................................................525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AZERo........525
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:

AZERo:UNSCaled............................................................................................... 525
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:AZERo.. 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:

AZERo:UNSCaled............................................................................................... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AZERo...526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:

AZERo:UNSCaled............................................................................................... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AZERo.... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:

AZERo:UNSCaled............................................................................................... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AZERo...526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:

AZERo:UNSCaled............................................................................................... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AZERo...526
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AONE:

UNSCaled...........................................................................................................526
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AONE......... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:

AONE:UNSCaled.................................................................................................526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AONE.... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:

AONE:UNSCaled.................................................................................................526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AONE..... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:

AONE:UNSCaled.................................................................................................526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AONE.... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:

AONE:UNSCaled.................................................................................................526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AONE.... 526
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:ATWO:

UNSCaled...........................................................................................................527
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:ATWO.........527
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:WNOT... 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:

TOT:UNSCaled....................................................................................................527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT.. 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:

TOT:UNSCaled....................................................................................................527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:TOT.. 527
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[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT:
UNSCaled...........................................................................................................527

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT.......527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:

AZERo:UNSCaled............................................................................................... 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:

AZERo................................................................................................................527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:

AZERo:UNSCaled............................................................................................... 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:

AZERo................................................................................................................527
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:

AZERo:UNSCaled............................................................................................... 528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AZERo...528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:

AONE:UNSCaled.................................................................................................528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:

AONE:UNSCaled.................................................................................................528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:AONE528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:

AONE:UNSCaled.................................................................................................528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE....528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:

ATWO:UNSCaled................................................................................................ 528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:ATWO....528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:WNOT 528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:

TOT:UNSCaled....................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:

TOT:UNSCaled....................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:TOT529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:

TOT:UNSCaled....................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT....529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:

AZERo:UNSCaled............................................................................................... 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:

AZERo................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:

AZERo:UNSCaled............................................................................................... 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:

AZERo................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:

AZERo:UNSCaled............................................................................................... 529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AZERo529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:

AONE:UNSCaled.................................................................................................529
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[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:
AONE.................................................................................................................529

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:
AONE:UNSCaled.................................................................................................529

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:
AONE.................................................................................................................529

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:
AONE:UNSCaled.................................................................................................529

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AONE. 529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:

ATWO:UNSCaled................................................................................................ 530
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:ATWO.530
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:ALPHa<ch0>.530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:

ALPHa<ch0>.......................................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:ALPHa<ch0>.530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:

ALPHa<ch0>.......................................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:

ALPHa<ch0>.......................................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:ALPHa<ch0> 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:

ALPHa<ch0>:UNSCaled.......................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:ALPHa<ch0>.530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:

AI<ch0>:UNSCaled..............................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:AI<ch0>... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:

AI<ch0>:UNSCaled..............................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:AI<ch0>.... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:BETA<ch0>...531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:BETA<ch0> 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
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[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:BETA<ch0>...531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:

BETA<ch0>.........................................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:

BETA<ch0>.........................................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:BETA<ch0>.. 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:

BETA<ch0>:UNSCaled.........................................................................................532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:BETA<ch0>...532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:SF<ch>....532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:SF<ch>.....532

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
IODNav <IODnav>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
IODNav <IODnav>

Sets the IODnav parameter.

Parameters:
<IODnav> integer

Range: 0  to  1023
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IODE
<IODde>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODE
<IODde>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODE
<IODe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODE
<IODe>

Sets the issue of data, emphemeris.

Parameters:
<IODe> integer

Range: 0  to  255
*RST: 0

Navigation message commands



Remote-control commandsSatellite Navigation

488User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE
<Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE:
UNSCaled <Toe>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE
<Toe>

Sets the reference time of ephemeris.

Parameters:
<Toe> integer

*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA:
UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA
<SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA:
UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA
<SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA:
UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA
<SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
SQRA:UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
SQRA <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
SQRA:UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
SQRA <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
SQRA:UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
SQRA <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
SQRA:UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
SQRA <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA:
UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA
<SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA:
UNSCaled <SqrtA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA
<SqrtA>

Sets the square root of semi-major axis.

Parameters:
<SqrtA> integer

Range: 0  to  4294967295
*RST: depends on installed options

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:
ECCentricity <Eccentricity>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
ECCentricity <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:
ECCentricity:UNSCaled <Eccentricity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:
ECCentricity <Eccentricity>

Sets the eccentricity.

Parameters:
<Eccentricity> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo:
UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo
<I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo:
UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo
<I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo:
UNSCaled <I0>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo
<I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
IZERo:UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
IZERo <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
IZERo:UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
IZERo <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
IZERo:UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
IZERo <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
IZERo:UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
IZERo <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo:
UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo
<I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo:
UNSCaled <I0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo
<I0>

Sets the inclination angle.

Parameters:
<I0> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo:
UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo
<Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
OZERo:UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OZERo
<Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo:
UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo
<Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
OZERo:UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
OZERo <Omega0>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
OZERo:UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
OZERo <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
OZERo:UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
OZERo <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
OZERo:UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
OZERo <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo:
UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo
<Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo:
UNSCaled <Omega0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo
<Omega0>

Sets the longitude of ascending node.

Parameters:
<Omega0> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa:
UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa
<Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
OMEGa:UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
OMEGa <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa:
UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa
<Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
OMEGa:UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
OMEGa <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
OMEGa:UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
OMEGa <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
OMEGa:UNSCaled <Omega>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
OMEGa <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
OMEGa:UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
OMEGa <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa:
UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa
<Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa:
UNSCaled <Omega>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa
<Omega>

Sets the argument of perigee.

Parameters:
<Omega> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo:
UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo
<M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
MZERo:UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:MZERo
<M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo:
UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo
<M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
MZERo:UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
MZERo <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
MZERo:UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
MZERo <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
MZERo:UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
MZERo <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
MZERo:UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
MZERo <M0>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo:
UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo
<M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo:
UNSCaled <M0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo
<M0>

Sets the mean anomaly.

Parameters:
<M0> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
IDOT:UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT
<Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT
<Idot>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT:
UNSCaled <Idot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT
<Idot>

Sets the rate of inclination angle.

Parameters:
<Idot> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT:
UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT
<OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT:
UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT
<OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT:
UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT
<OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
ODOT:UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
ODOT <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
ODOT:UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
ODOT <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ODOT:UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ODOT <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
ODOT:UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
ODOT <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT:
UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT
<OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT:
UNSCaled <OmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT
<OmegaDot>

Sets the rate of right ascension.
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Parameters:
<OmegaDot> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot:
UNSCaled <DeltaOmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot
<DeltaOmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot:
UNSCaled <DeltaOmegaDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot
<DeltaOmegaDot>

Sets the Rate of right ascension difference.

Parameters:
<DeltaOmegaDot> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta:
UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta
<DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
NDELta:UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
NDELta <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta:
UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta
<DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
NDELta:UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:
NDELta <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
NDELta:UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:
NDELta <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
NDELta:UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
NDELta <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
NDELta:UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
NDELta <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta:
UNSCaled <DeltaN>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta
<DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta:
UNSCaled <DeltaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta
<DeltaN>

Sets the mean motion difference delta.

Parameters:
<DeltaN> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot:
UNSCaled <DeltaNDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot
<DeltaNDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
DNDot:UNSCaled <DeltaNDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
DNDot <DeltaNDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot:
UNSCaled <DeltaNDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot
<DeltaNDot>

Sets the rate of mean motion difference delta.

Parameters:
<DeltaNDot> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT:
UNSCaled <ADot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT
<ADot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ADOT:UNSCaled <ADot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ADOT <ADot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT:
UNSCaled <ADot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT
<ADot>

Sets the change rate in semi-major axis.

Parameters:
<ADot> integer

*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
ADELta:UNSCaled <DeltaA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
ADELta <DeltaA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ADELta:UNSCaled <DeltaA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ADELta <DeltaA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta:
UNSCaled <DeltaA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta
<DeltaA>

Sets the semi-major axis difference.

Parameters:
<DeltaA> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
TINTerval?

Queries the Tb-interval.

Return values: 
<TbInterval> string

Usage: Query only

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
TOE?

Queries the reference epoch time tb.

Return values: 
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> float
Range: 0  to  59
Increment: 1

Usage: Query only
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
TINDex:UNSCaled <TbIndex>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
TINDex <TbIndex>

Sets the tb Index parameter.

Parameters:
<TbIndex> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN:
UNSCaled <Zn>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN <Zn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN:

UNSCaled <Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN <Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN:

UNSCaled <Xn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN <Xn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN:

UNSCaled <Zn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN

<Zn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN:

UNSCaled <Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN

<Yn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN:

UNSCaled <Xn>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN

<Xn>
Sets the Xn, Yn and Zn coordinates in PZ-90.

Parameters:
<Xn> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN:
UNSCaled <ZnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN
<ZnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN:
UNSCaled <YnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN
<YnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN:
UNSCaled <XnDot>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN
<XnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN:
UNSCaled <ZnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN
<ZnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
YDN:UNSCaled <YnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDN
<YnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
XDN:UNSCaled <XnDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDN
<XnDot>

Sets the velocity components X'n, Y'n and Z'n.

Parameters:
<XnDot> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN:
UNSCaled <ZnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN
<ZnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN:
UNSCaled <YnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN
<YnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN:
UNSCaled <XnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN
<XnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
ZDDN:UNSCaled <ZnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
ZDDN <ZnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
YDDN:UNSCaled <YnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
YDDN <YnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
XDDN:UNSCaled <XnDotDot>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
XDDN <XnDotDot>

Sets the moon and sun acceleration parameters X''n, Y''n and Z''n.

Parameters:
<XnDotDot> integer

*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC
<Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC:
UNSCaled <Cuc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC
<Cuc>

Sets the cosine difference of latitude.

Parameters:
<Cuc> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS:
UNSCaled <Cus>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS
<Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS:
UNSCaled <Cus>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS
<Cus>

Sets the sine difference of latitude.

Parameters:
<Cus> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC
<Crc>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC
<Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC:
UNSCaled <Crc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC
<Crc>

Sets the cosine difference of orbital radius.

Parameters:
<Crc> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS:
UNSCaled <Crs>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS
<Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS:
UNSCaled <Crs>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS
<Crs>

Sets the sine difference of orbital radius.

Parameters:
<Crs> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC
<Cic>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC
<Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC:
UNSCaled <Cic>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC
<Cic>

Sets the sine difference of orbital radius.

Parameters:
<Cic> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS:
UNSCaled <Cis>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS
<Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS:
UNSCaled <Cis>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS
<Cis>

Sets the sine difference of inclination.

Parameters:
<Cis> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODC
<Iodc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODC
<Iodc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODC
<Iodc>

Sets the issue of data, clock (IODC).

Parameters:
<Iodc> integer

Range: 0  to  1023
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC:
UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC
<Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC:
UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC
<Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC:
UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC
<Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
TOC:UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
TOC <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
TOC:UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
TOC <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
TOC:UNSCaled <Toc>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
TOC <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
TOC:UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
TOC <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC:
UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC
<Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC:
UNSCaled <Toc>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC
<Toc>

Sets the reference time of clock.

Parameters:
<Toc> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
AF<s2us0> <Af>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:
AF<s2us0> <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:
AF<s2us0>:UNSCaled <Af>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:
AF<s2us0> <Af>

Sets the parameter AF 0 to 2.

Suffix: 
AF<s2us0>

.
0 to 2 (GPS, Galileo, BeiDou, QZSS) | 0 to 1 (SBAS)

Parameters:
<Af> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD:
UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD
<Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD:
UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD
<Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD:
UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD
<Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
TGD:UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:
TGD <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
TGD<s2us>:UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:
TGD<s2us> <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD:
UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD
<Tgd>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD:
UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD
<Tgd>

Sets the group delay.

Parameters:
<Tgd> integer

Range: -128  to  127
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L5Q:UNSCaled <IscL5Q5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L5Q <IscL5Q5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L5I:UNSCaled <IscL5I5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L5I <IscL5I5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L2C:UNSCaled <IscL2C>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L2C <IscL2C>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L1CA:UNSCaled <IscL1CA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:
L1CA <IscL1CA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L5Q:UNSCaled <IscL5Q5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L5Q <IscL5Q5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L5I:UNSCaled <IscL5I5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5I
<IscL5I5>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L2C:UNSCaled <IscL2C>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L2C <IscL2C>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L1CA:UNSCaled <IscL1CA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:
L1CA <IscL1CA>

Sets the inter-signal corrections (ISC) parameters of the GPS/QZSS CNAV message.

Parameters:
<IscL1CA> integer

Range: -4096  to  4095
*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
BGDA:UNSCaled <Bgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:
BGDA <Bgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
BGDB:UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
BGDB <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
BGDA:UNSCaled <Bgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:
BGDA <Bgd>

Sets the broadcast group delay.

Parameters:
<Bgd> integer

Range: -512  to  511
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
TAUN:UNScaled <Tau>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
TAUN <Tau>

Sets the parameter Tn (~ -af0)

Parameters:
<Tau> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
GAMN:UNSCaled <GammaN>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
GAMN <GammaN>

Sets the parameter Γn (~af1).

Parameters:
<GammaN> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
DTAU:UNSCaled <Tgd>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:
DTAU <Tgd>

Sets the DELTA Tn (~Tgd).
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Parameters:
<Tgd> integer

Range: -128  to  127
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ALERt
<AlertFlag>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:
ALERt <AlertFlag>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ALERt
<AlertFlag>

Sets the alert flag.

Parameters:
<AlertFlag> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
L5Health <L5Health>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
L2Health <L2Health>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
L1Health <L1Health>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
L5Health <L5Health>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
L2Health <L2Health>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
L1Health <L1Health>

Sets the L1, L2 or L5 health flag in the GPS/QZSS CNAV message.

Parameters:
<L1Health> integer

Range: 0  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED0
<NED0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED1
<NED1>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED2
<NED0>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED0
<NED0>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED1
<NED1>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED2
<NED0>

Sets the NED accuracy index (NED0), accuracy change indexs (NED1) and accuracy
change rate index (NED2).

Parameters:
<NED0> integer

Range: 0  to  7
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:WNOP
<WNOP>

Sets the data predict week number.

Parameters:
<WNOP> integer

Range: 0  to  8191
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP:
UNSCaled <Top>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP
<Top>

Sets the data predict time of week.

Parameters:
<Top> integer

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ISFLag
<IsFlag>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ISFLag
<IsFlag>

Sets the integrity status flag.

Parameters:
<IsFlag> 1 | ON | 0 | OFF

*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:
L2CPhasing <L2CPhasing>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:
L2CPhasing <L2CPhasing>

Sets the L2C phasing.

Parameters:
<L2CPhasing> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:
L5Health <L5Health>

Sets the L5 health flag in the NavIC NAV message.

Parameters:
<L5Health> integer

Range: 0  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SHEalth
<SHealth>

Sets the S health flag in the NavIC NAV message.

Parameters:
<SHealth> integer

Range: 0  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:HEALth
<SvHealt>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
HEALth <SvHealt>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:
HEALth <SvHealt>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:HEALth
<SvHealt>

Sets the SV health.

See also [:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy on page 416.

Parameters:
<SvHealt> integer

Range: 0  to  63
*RST: 0
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:URA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:URA
<URA>

Sets the user range accuracy index.

Parameters:
<URA> integer

Range: 0  to  15
*RST: 5

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ASFLag
<AntiSpoofFlag>

Parameters:
<AntiSpoofFlag> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:
SVConfig <AsFlag>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:
SVConfig <AsFlag>

Sets the SV config.

Parameters:
<AsFlag> integer

Range: 0  to  7
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:
CLTMode <CodeOnL2Mode>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:
CLTMode <CodeOnL2Mode>

Sets the code on L2.
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Parameters:
<CodeOnL2Mode> REServed | PCODe | CACode

*RST: PCODe

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:LTPData
<L2P>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:LTPData
<L2P>

Sets the L2 P data flag.

Parameters:
<L2P> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:FIFLag
<FitInterval>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:FIFLag
<FitInterval>

Sets the fit interval flag.

Parameters:
<FitInterval> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:AODO?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:AODO?
Queries the age of data offset, that is fixed to 31.

Return values: 
<Aodo> integer

Range: 0  to  31
*RST: 31

Usage: Query only

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:
SF1Reserved<s2us>?

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:
SF1Reserved<s2us>?

Sets the subframe 1 (reserved 1 to 4).

Return values: 
<Subfr1Reserved> integer

Range: 0  to  67108864
*RST: 0
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Usage: Query only

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SISA
<URA>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SISA
<URA>

Sets the signal in space accuracy index.

Parameters:
<URA> integer

Range: 0  to  255
*RST: 5

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BDVS
<DvsE1b>

Sets the data validity status - E1BDVS.

Parameters:
<DvsE1b> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BHS <HsE1b>

Sets the signal health status - E1BHS parameter.

Parameters:
<HsE1b> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BDVS
<DvsE5b>

Sets the data validity status - E5bDVS parameter.

Parameters:
<DvsE5b> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BHS <HsE5b>

Sets the signal health status - E5bHS parameter.
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Parameters:
<HsE5b> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:
MODE <SarMode>

Sets the Search-and-Rescue Service (SAR) mode for SAR message generation. SAR
messages are specified by the 22-bit SAR field in the I/NAV navigation message.

For more information, refer to specification Galileo OS SIS ICD.

Parameters:
<SarMode> SPARe | SRLM | LRLM

SPARe
Generates spare SAR data.
The start bit is set to one. SAR receivers interpret the following
21 spare bits as SAR non-relevant data.
SRLM/LRLM
Generates SAR data for nominal mode operation in the Galileo
E1-B component. For the SAR message format, you can select
between short return link message (SRLM) and long return link
message (LRLM).
For the real navigation message, the Short/Long RLM Identifier,
in the SAR data field is set accordingly (0 = Short RLM, 1 = Long
RLM).
*RST: SPARe

Example: See Example"Configuring Galileo Search-and-Rescue (SAR)
data" on page 447.

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:
RLM<s2us> <SarRlmData>

Sets the 20-bit Search-and-Rescue Service (SAR) return link message (RLM) data for
nominal mode operation.

For more information, refer to specification Galileo OS SIS ICD.

Parameters:
<SarRlmData> integer

Range: 0  to  1048575
*RST: 0

Example: See Example"Configuring Galileo Search-and-Rescue (SAR)
data" on page 447.
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:
SPARe <SpareData>

Sets the 21-bit Search-and-Rescue Service (SAR) spare data.

For more information, refer to specification Galileo OS SIS ICD.

Parameters:
<SpareData> integer

Range: 0  to  2097151
*RST: 0

Example: See Example"Configuring Galileo Search-and-Rescue (SAR)
data" on page 447.

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5ADVS
<DvsE5a>

Sets the data validity status - E5aDVS.

Parameters:
<DvsE5a> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5AHS <HsE5a>

Sets the signal health status - E5aHS parameter.

Parameters:
<HsE5a> integer

Range: -1  to  1
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
SEType <SatType>

Sets the satellite ephemeris type - M parameter.

Parameters:
<SatType> GLO | GLOM | GLOK

GLO
GLONASS
GLOM
GLONASS - M
GLOK
GLONASS - K
*RST: GLOM
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:CFM
<FieldM>

Sets CDMA field M parameter.

Parameters:
<FieldM> integer

Range: 1  to  7
*RST: 1

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:P
<P>

Sets the satellite operation mode - P parameter.

Parameters:
<P> integer

Range: 0  to  3
*RST: 0

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
AOEP <AgeOfEphemeris>

Sets the age of ephemeris page - P1 parameter.

Parameters:
<AgeOfEphemeris> A30M | A45M | A60M

*RST: A30M

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:
TALignment <TbAlignment>

Sets the tb alignment - P2.

Parameters:
<TbAlignment> EVEN | ODD

*RST: EVEN

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:EN
<En>

Sets the En parameter.

Parameters:
<En> integer

Range: 0  to  31
*RST: 0
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[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
WNOT <WNot>

Sets the parameter WNot.

Parameters:
<WNot> integer

Range: 0  to  529947
*RST: 0

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT:UNSCaled <Tot>
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[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
TOT <Tot>

Sets the parameter Tot.

Parameters:
<Tot> integer

Range: 0  to  65535

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
ATWO <A2>

Navigation message commands



Remote-control commandsSatellite Navigation

522User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
ATWO <A2>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
ATWO <A2>

Sets the A2 parameter.

Parameters:
<A2> integer

Range: -64  to  63

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>
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[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
AONE <A1>

Sets the parameter A1.

Parameters:
<A1> integer

Range: -4096  to  4095

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:
UTC:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo <A0>
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[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:
AZERo <A0>

Sets the parameter A0.

Parameters:
<A0> integer

Range: -32768  to  32767
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[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
WNOT <WNot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
WNOT <WNot>

Sets the WNot parameter.

Parameters:
<WNot> integer

Range: 0  to  529947
*RST: 0

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
TOT <Tot>

Sets the Tot parameter.

Parameters:
<Tot> integer

Range: 0  to  65535

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:
AZERo <A0>
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[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
AZERo <A0>

Sets the A0 parameter.

Parameters:
<A0> integer

Range: -32768  to  32767

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:
AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:
AONE <A1>

Sets the A1 parameter.

Parameters:
<A1> integer

Range: -4096  to  4095
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[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:
ATWO <A2>

Sets the A2 parameter.

Parameters:
<A2> integer

Range: -64  to  63

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
WNOT <WNot>

Sets the Wnot parameter.

Parameters:
<WNot> integer

Range: 0  to  529947
*RST: 0

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
TOT <Tot>

Sets the Tot parameter.

Parameters:
<Tot> integer

Range: 0  to  65535

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:AZERo <A0>
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[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
AZERo <A0>

Sets the A0 parameter.

Parameters:
<A0> integer

Range: -32768  to  32767

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GALileo:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GALileo:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
AONE <A1>

Sets the A1 parameter.

Parameters:
<A1> integer

Range: -4096  to  4095

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:
ATWO <A2>

Sets the A2 parameter.

Parameters:
<A2> integer

Range: -64  to  63

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:WNOT <WNot>

Sets the WNot parameter.

Parameters:
<WNot> integer

Range: 0  to  529947
*RST: 0
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[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:TOT <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:TOT:UNSCaled <Tot>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:TOT <Tot>

Sets the Tot parameter.

Parameters:
<Tot> integer

Range: 0  to  65535

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:AZERo <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:AZERo:UNSCaled <A0>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:AZERo <A0>

Parameters:
<A0> integer

Range: -32768  to  32767

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:
GLONass:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:
GLONass:AONE <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:AONE:UNSCaled <A1>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:AONE <A1>

Sets the A1 parameter.
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Parameters:
<A1> integer

Range: -4096  to  4095

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:ATWO:UNSCaled <A2>

[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:
GLONass:ATWO <A2>

Sets the A2 parameter.

Parameters:
<A2> integer

Range: -64  to  63

[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:
ALPHa<ch0> <Alpha>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:
ALPHa<ch0>:UNSCaled <AlphaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:
ALPHa<ch0> <Alpha>

Sets the parameters alpha_0 to alpha_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 to 3
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Parameters:
<Alpha> integer

Range: -128  to  127
*RST: 0

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:
AI<ch0>:UNSCaled <AiUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:
AI<ch0> <A_i>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:
AI<ch0>:UNSCaled <AiUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:
AI<ch0> <A_i>

Sets the parameters effective ionization level 1st to 3rd order of the satellite's navigation
message.

Parameters:
<A_i> integer

Range: a_i0 (0 to 2047), a_i1 (-1024 to 1023), a_i2 (-8192
to 8191)

*RST: 0

[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:
BETA<ch0> <Beta>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:
BETA<ch0> <Beta>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:
BETA<ch0> <Beta>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:
BETA<ch0> <Beta>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:
BETA<ch0> <Beta>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:
BETA<ch0> <Beta>
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[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:
BETA<ch0>:UNSCaled <BetaUnscaled>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:
BETA<ch0> <Beta>

Sets the parameters beta_0 to beta_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 to 3

Parameters:
<Beta> integer

Range: -128  to  127
*RST: 0

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:
SF<ch> <SF>

[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:
SF<ch> <SF>

Sets the parameters ionospheric disturbance flag for region 1 to 5 of the satellite's nav-
igation message.

Suffix: 
<ch>

.
1 to 5

Parameters:
<SF> integer

Range: 0  to  1
*RST: 0

21.14  Galileo OSNMA commands

Option: R&S SMBVB-K66

Example: To configure Galileo OSNMA realtime parameters
// *****************************************************************************
// Configure general OSNMA settings.
// *****************************************************************************
:SOURce1:BB:GNSS:GALileo:OSNMa:MACLt 28
// Sets 28 that is the 11100 bit for the MAC look-up table.
:SOURce1:BB:GNSS:GALileo:OSNMa:TS 5
// The tag lengh l_t is 20 bits.
:SOURce1:BB:GNSS:GALileo:OSNMa:KS 0
// The key lengh l_k is 96 bits.
:SOURce1:BB:GNSS:GALileo:OSNMa:HF 0
// The hash function is SHA-256.
:SOURce1:BB:GNSS:GALileo:OSNMa:NPKT 1
// The DSM-PKR is an ECDSA P-256 message.
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:SOURce1:BB:GNSS:GALileo:OSNMa:MF 1
// Sets the MAC Function bit to 1 that corresponds to the hash function CMAC-AES.
:SOURce1:BB:GNSS:GALileo:OSNMa:AESKey:LENGth AES128
// Sets the length of 128 bits of the cipher-based message authentication code
// (CMAC) key.
:SOURce1:BB:GNSS:GALileo:OSNMa:PID 4
// The ID of the public key is 4.
:SOURce1:BB:GNSS:GALileo:OSNMa:ADKD?
// Response: "0"
// The authentication data and key delay (ADKD) for ADKD=4 is disabled.
:SOURce1:BB:GNSS:GALileo:OSNMa:SPReemption?
// Response: "0"
// Status preemption is disabled.
// Optionally, set an additional delay of one subframe of the navigation data.
:SOURce1:BB:GNSS:GALileo:OSNMa:ADDelay 1

// *****************************************************************************
// Configure TESLA chain settings.
// *****************************************************************************
SOURce1:BB:GNSS:GALileo:OSNMa:TMODe TREN
// Sets for TESLA Chain Renewal transition mode.
:SOURce1:BB:GNSS:GALileo:OSNMa:NTDay 4
// Sets four root key transitions per day.
:SOURce1:BB:GNSS:GALileo:OSNMa:RKEY:TOMid 10800
// Sets an offset of 10800 seconds or three hours of the TESLA chain transitions
// per day.
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE 3600
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO 3600
// The durations of step one and step two for TESLA chain transitions are 3600
// seconds or one hour.

// *****************************************************************************
// Configure Public key renewal settings.
// *****************************************************************************
:SOURce1:BB:GNSS:GALileo:OSNMa:TMODe PREN
// Sets for Public Key Renewal transition mode.
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:TOMid 10800
// Sets an offset of 10800 seconds or three hours of the Public key transitions
// per day.
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:NTDay 4
// Sets four Public key transitions per day.
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE 3600
:SOURce1:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO 3600
// The durations of step one and step two for Public key transitions are 3600
// seconds or one hour.

Commands:

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADDelay....................................................... 534
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADKD...........................................................534
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:AESKey:LENGth........................................... 534
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[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:SONE................................ 535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:STWO................................535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:HF............................................................... 535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:KS............................................................... 536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MACLt..........................................................536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MF............................................................... 536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:NPKT........................................................... 536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PID.............................................................. 537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:NTDay................................................ 537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE................................ 537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO................................538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TOMidnight..........................................538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:NTDay................................................ 538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:TOMidnight..........................................538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:SPReemption................................................539
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TMODe........................................................ 539
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TS................................................................540

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADDelay <Delay>

Sets an additional delay in subframes of the navigation data for the tag verification.
The delay can depend on receiver implementation.

You can set a delay of one subframe. A zero subframe delay corresponds to no delay.

Parameters:
<Delay> integer

Range: 0  to  1
*RST: 1

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Additional Data Delay for Tag Verification" on page 186

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADKD <State>

Enable the authentication data and key delay (ADKD) for ADKD=4 for Galileo I/NAV
timing parameters.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Test Phase ADKD4" on page 186

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:AESKey:LENGth <KeyLength>

Sets the length of the cipher-based message authentication code (CMAC) key.
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Setting requires a MAC Function (MF) field value of 1:

:SOURce1:BB:GNSS:GALileo:OSNMa:MF 1
See also [:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MF on page 536.

Parameters:
<KeyLength> AES128 | AES256

AES128
The length of the CMAC key is 128 bits.
AES256
The length of the CMAC key is 256 bits.
*RST: AES128

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "CMAC AES Key Length" on page 185

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:SONE <Duration>

Sets the duration of step 1 for TESLA chain transitions.

Parameters:
<Duration> integer

Range: 1  to  86400
*RST: 3600

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:STWO <Duration>

Sets the duration of step 2 for TESLA chain transitions.

Parameters:
<Duration> integer

Range: 1  to  86400
*RST: 3600

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:HF <Value>

Sets the bits in the 2-bit Hash Function (HF) field.

Parameters:
<Value> 0 | 2

For a description on HF values, see Table 12-6.
*RST: 0
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Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "HF" on page 184

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:KS <Value>

Sets the bits in the 4-bit Key Size (KS) field.

Parameters:
<Value> 0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 | 8

For a description on KS values, see Table 12-5.
*RST: 0

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "KS" on page 184

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MACLt <Value>

Sets the bits in the 8-bit MAC Look-up Table (MACLT) field.

Parameters:
<Value> 27 | 28 | 31 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41

*RST: 28

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "MACLT" on page 183

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MF <MF>

Sets the bits in the 2-bit MAC Function (MF) field.

Parameters:
<MF> integer

For a description on MF values, see Table 12-8.
Range: 0  to  1
*RST: 0

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "MF" on page 185

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:NPKT <Value>

Sets the bits in the 4-bit New Public Key Type (NPKT) field.
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This field represents the signature algorithm associated with the public key provided in
the digital signature message for a public key renewal (DSM-PKR).

Parameters:
<Value> 1 | 3

For a description on NPKT values, see Table 12-7.
*RST: 1

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "NPKT" on page 184

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PID <PidInput2>

Sets the ID of the Public Key (PK) used to verify the signature of the digital signature
message for a root key (DSM-KROOT).

If the transition mode defines the change of the public key, the PKID depends on the
simulation time. This PKID means the public key which is currently in use and the PKID
is increased by each public key transition.

Parameters:
<PidInput2> integer

Range: 0  to  15
*RST: 0

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "PID" on page 185

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:NTDay <TransPerDay>

Sets the number of Public key transitions per day.

Parameters:
<TransPerDay> integer

Range: 1  to  24
*RST: 4

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE <Duration>

Sets the duration of step 1 for Public key transitions.

Parameters:
<Duration> integer

Range: 1  to  86400
*RST: 3600
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Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Chain Key Transition Duration (Step 1)" on page 187
See "Public Key Transition Duration (Step 1)" on page 188

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO <Duration>

Sets the duration of step 2 for Public key transitions.

Parameters:
<Duration> integer

Range: 1  to  86400
*RST: 3600

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Chain Key Transition Duration (Step 2)" on page 187
See "Public Key Transition Duration (Step 2)" on page 188

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TOMidnight <TimeOffset>

Sets a time offset of the Public key transitions per day.

Parameters:
<TimeOffset> integer

Range: 0  to  86400
*RST: 10800

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:NTDay <TransPerDay>

Sets the number of root key transitions per day.

Parameters:
<TransPerDay> integer

Range: 1  to  24
*RST: 4

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Number of Root Key Transitions per Day" on page 187
See "Number of Public Key Transitions per Day" on page 187

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:TOMidnight <TimeOffset>

Sets a time offset of the TESLA chain transitions per day.
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Parameters:
<TimeOffset> integer

Range: 0  to  86400
Increment: 3600
*RST: 10800

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Time Offset of Root Key Transition vs. Midnight"
on page 187
See "Time Offset of Public Key Transition vs. Midnight"
on page 188

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:SPReemption <Status>

Enable the status preemption.

Parameters:
<Status> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Status Preemption" on page 186

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TMODe <TransitionMode>

Sets the OSNMA transition mode.

These modes define the provision for the Public Key, TESLA chain and Alert Message.
Also, the modes determine the OSNMA status transitions.

Parameters:
<TransitionMode> PRENewal | PREVocation | TRENewal | TREVocation |

MRENewal | ALERt
PRENewal
Public key renewal mode
PREVocation
Public key revocation mode
TRENewal
TESLA chain renewal mode
TREVocation
TESLA chain revocation mode
MRENewal
Merkle tree renewal mode
ALERt
Alert message mode
*RST: TRENewal
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Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "Transition Mode" on page 182

[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TS <Value>

Sets the bits in the 4-bit Tag Size (TS) field.

Parameters:
<Value> 5 | 6 | 7 | 8 | 9

*RST: 5

Example: See Example"To configure Galileo OSNMA realtime parameters"
on page 532.

Manual operation: See "TS" on page 183

21.15  SBAS corrections

Option: R&S SMBVB-K106

Suffix SVID<ch>

The value of the SVID<ch> suffix corresponds to PRNs for the SBAS regional system.
The value ranges from SVID120 (PRN 120) to SVID158 (PRN 158). In the following,
the default constellations of all SBAS including assigned PRNs are listed:
● EGNOS: { 120, 123, 124, 126, 131, 136 }
● WAAS: { 122, 133, 134, 135, 138, 0 }
● MSAS: { 129, 137, 0, 0, 0, 0 }
● GAGAN: { 127, 128, 0, 0, 0, 0 }
You can map up to six PRNs with each SBAS, see Example"Mapping SBAS PRN to an
SBAS system" on page 541.

Example: Enabling SBAS and applying SBAS corrections
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:STATe 1
SOURce1:BB:GNSS:ECMode SYNC

SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN1:STATe 1
SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN120:STATe 1
SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN126:STATe 1
SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:STATe 1
SOURce1:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:PERiod 200
SOURce1:BB:GNSS:STATe ON
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Example: Mapping SBAS PRN to an SBAS system
This example shows, how to map individual PRNs to the EGNOS SBAS. Mapping to
other SBAS is analogous.
// ********************************************************************************
// Assign, for example PRM 120 to PRN 125 to EGNOS SBAS.
// ********************************************************************************
SOURce1:BB:GNSS:SVID120:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID121:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID122:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID123:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID124:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID125:SBAS:SYSTem EGNOS
// Assigning the sixth PRN 126 to EGNOS is not possible. The maximum simulation
// capacity of 6 SVs for EGNOS is reached.
SOURce1:BB:GNSS:SVID126:SBAS:SYSTem EGNOS
SOURce1:BB:GNSS:SVID126:SBAS:SYSTem?
// Reponse: "NONE"
// PRN 126 is excluded from all SBAS constellations.

SBAS satellites and their orbit and clock simulated and broadcasted parameters are
defined in the same way as the parameters of all other GNSS systems. The same is
true also for the configuration of pseudorange errors, echos, power and modulation
control and the time conversion settings.

Corresponding remote control commands are thus described together with the com-
mands of the other GNSS systems, see:
● Chapter 21.2, "System and signal commands", on page 333
● Chapter 21.11, "Satellites constellation", on page 409
● Chapter 21.12, "Signals and power configuration per satellite", on page 419
● Chapter 21.8, "Static multipath configuration", on page 386
● Chapter 21.13.1, "Simulated orbit, orbit perturbation and clock commands",

on page 448
● Chapter 21.13.2, "Pseudorange commands", on page 459
● Chapter 21.13.3, "Orbit, clock, system, time conversion and ionospheric errors",

on page 467
● Chapter 21.3, "Time conversion configuration", on page 337
● Chapter 21.16, "Signal dynamics", on page 551

Example: Importing SBAS correction data files
Load user-defined SBAS corrections via import of *.nstb or *.ems files. For a
detailed example of a file import procedure, see Example"Importing grid files"
on page 399.

SOURce1:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:FILE:EMS
"/var/user/gnss/PRN120_y2018_d067_h12.ems"
SOURce1:BB:GNSS:SV:IMPort:SBAS:EGNOS:EXECute
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Commands:

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SYSTem.......................................................544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRN<ch>:STATe........ 544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRN<ch>:STATe...........544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRN<ch>:STATe...........544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN<ch>:STATe........ 544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:STATe.........545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:CECovariance:

STATe.................................................................................................................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:STATe.......... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCDegradation:

STATe.................................................................................................................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCORrection:STATe... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:STATe.............. 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:LTCorrection:STATe....545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:STATe........545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:STATe............. 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:STATe..........545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:STATe?...... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:STATe........... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:STATe.... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:STATe............ 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCDegradation:STATe...545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:STATe...... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:STATe.................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:STATe...... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:STATe.......... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:STATe................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:STATe............ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:STATe?.........546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:STATe........... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:STATe....546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:STATe............ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCDegradation:STATe...546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:STATe......546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:STATe................ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:STATe...... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:STATe.......... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:STATe................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:STATe............546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:STATe?........ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:CECovariance:

STATe.................................................................................................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:STATe..........546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCDegradation:

STATe.................................................................................................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:STATe... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:STATe.............. 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:LTCorrection:STATe....546
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:STATe........546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:STATe............. 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:STATe..........547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:STATe?...... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:STATe.........547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:PERiod.......547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:CECovariance:

PERiod............................................................................................................... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:PERiod........ 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCDegradation:

PERiod............................................................................................................... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCORrection:PERiod..547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:PERiod............ 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:LTCorrection:PERiod.. 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:PERiod...... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:PERiod............547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:PERiod........547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:PERiod...... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:PERiod......... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:PERiod.. 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:PERiod...........547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCDegradation:

PERiod............................................................................................................... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:PERiod.... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:PERiod...............547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:PERiod.....548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:PERiod.........548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:PERiod.............. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:PERiod.......... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:PERiod.........548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:PERiod......... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:PERiod.. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:PERiod.......... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCDegradation:

PERiod............................................................................................................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:PERiod.... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:PERiod...............548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:PERiod.... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:PERiod........ 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:PERiod..............548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:PERiod.......... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:PERiod........ 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:CECovariance:

PERiod............................................................................................................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:PERiod........ 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCDegradation:

PERiod............................................................................................................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:PERiod..548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:PERiod............ 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:LTCorrection:PERiod.. 548
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:PERiod...... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:PERiod............548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:PERiod........548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:PERiod...... 549
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:PERiod.......549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:FILE........................................ 549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:FILE...........................................549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:DIR..........................................549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:DIR............................................549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:LIST?.............................................. 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:LIST?.................................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:EXECute..........................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:EXECute............................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:ALL....................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:ALL...................................... 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:FILE<ch>............................551
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:FILE<ch>..............................551

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SYSTem <SbasSystem>

Maps the SBAS space vehicle, the pseudorandom number (PRN), with the SBAS sys-
tem.

If a PRN is mapped to an SBAS, this PRN is not available in the other SBAS.

Parameters:
<SbasSystem> EGNOS | WAAS | MSAS | GAGAN | NONE

EGNOS|WAAS|MSAS|GAGAN
SBAS available for mapping
NONE
Space vehicle is excluded from all SBAS constellations.

Example: See Example"Mapping SBAS PRN to an SBAS system"
on page 541.

Manual operation: See "SBAS System" on page 243

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRN<ch>:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRN<ch>:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRN<ch>:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN<ch>:
STATe <State>

Enables an SV ID/ SV PRN.
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Suffix: 
PRN<ch>

.
GPS SV ID or SBAS PRN:
GPS: 1 to 37
EGNOS: {120, 124, 126, 131, 136}
WAAS: {122, 133, 134, 135, 138}
MSAS: {129, 137, 0, 0, 0}
GAGAN: {127, 128, 0, 0, 0}

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example"Enabling SBAS and applying SBAS corrections"
on page 540.

Manual operation: See "GNSS PRNs/SBAS PRNs, State" on page 253

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
CECovariance:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
FCDegradation:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
FCORrection:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
LTCorrection:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:
STATe?

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:
FCDegradation:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:
STATe <State>
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:
STATe?

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:
FCDegradation:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:
STATe?

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
CECovariance:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
FCDegradation:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:STATe
<State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
LTCorrection:STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:STATe
<State>
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:
STATe <State>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:
STATe?

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:
STATe <State>

Enables generation of the particular SBAS correction data.

Parameters:
<State> 1 | ON | 0 | OFF

Example: See Example"Enabling SBAS and applying SBAS corrections"
on page 540.

Manual operation: See "Message Schedule" on page 262

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
CECovariance:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
FCDegradation:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
FCORrection:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:
LTCorrection:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:
PERiod <UtcOffsetPeriod>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:
FCDegradation:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:PERiod
<Interval>
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:PERiod
<Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:
PERiod <UtcOffsetPeriod>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:
FCDegradation:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:PERiod
<Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:PERiod
<Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:
PERiod <UtcOffsetPeriod>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
CECovariance:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
FCDegradation:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:
LTCorrection:PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:
PERiod <Interval>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:
PERiod <Interval>
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:
PERiod <UtcOffsetPeriod>

[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:
PERiod <Interval>

Sets the periodicity of the SBAS message.

Parameters:
<Interval> integer

Range: 0  to  999
*RST: 200

Example: See Example"Enabling SBAS and applying SBAS corrections"
on page 540.

Manual operation: See "Message Schedule" on page 262

[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:FILE <Filename>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:FILE <Filename>
Adds

*.ems files for EGNOS correction data

*.nstb files for WAAS correction data

to an import file list.

Setting parameters: 
<Filename> string

The <Filename> string comprises the file directory, filename and
extension. For more information about *.ems and *.nstb files,
see "SBAS correction file download" on page 283.

Example: See Example"Importing SBAS correction data files" on page 541

Usage: Setting only

Manual operation: See "Add File" on page 286

[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:DIR <Directory>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:DIR <Directory>
Adds a set of

*.ems files for EGNOS correction data

*.nstb files for WAAS correction data

to an import file list in one step.

Setting parameters: 
<Directory> string

File path
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Example: See Example"Importing grid files" on page 399 for an analogous
procedure.

Usage: Setting only

Manual operation: See "Add Directory" on page 287

[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:LIST?
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:LIST?
Queries all

*.ems files for EGNOS correction data

*.nstb files for WAAS correction data

of the import file list in a comma separated list.

Example: See Example"Importing grid files" on page 399 for an analogous
procedure.

Usage: Query only

Manual operation: See "Input Files" on page 287

[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:EXECute
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:EXECute
Loads all

*.ems files for EGNOS correction data

*.nstb files for WAAS correction data

from an import file list.

Example: See Example"Importing SBAS correction data files" on page 541

Usage: Event

Manual operation: See "Import, Cancel" on page 287

[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:ALL
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:ALL
Removes all

*.ems files for EGNOS correction data

*.nstb files for WAAS correction data

from the import files list.

Example: SOURce1:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:ALL

Usage: Event

Manual operation: See "Remove File, Remove All" on page 287
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[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:FILE<ch>
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:FILE<ch>
Removes one particular

*.ems file for EGNOS correction data

*.nstb file for WAAS correction data

at the n-th position from the import file list.

Suffix: 
<ch>

.
1 to n

Example: See Example"Importing grid files" on page 399 for an analogous
procedure.

Usage: Event

Manual operation: See "Remove File, Remove All" on page 287

21.16  Signal dynamics

Example: Configuring the signal dynamics
SOURce1:BB:GNSS:TMODe TRAC
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P:STATe 1
SOURce1:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:DATA:NMESsage:STATe 0
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:CA:DATA:PCODe:STATe 1
SOURce1:BB:GNSS:SVID1:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:STATe 0

SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:PROFile HIGH
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:CPHase 3.14
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:PRANge 100
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:TOFFset 10
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:CONFig USER

SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:IVELocity 100
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:CVPeriod 20
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:CAPeriod 40
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:ACCel:MAX 10
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:JERK:MAX 20
SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:RPERiod?
// 240
SOURce1:BB:GNSS:STATe 1
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Commands:

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage[:
STATe]................................................................................................................554

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage[:
STATe]................................................................................................................554

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage[:
STATe]................................................................................................................554

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage[:
STATe]................................................................................................................554

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage[:
STATe]................................................................................................................554

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage[:STATe]..............................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage[:STATe]..............................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage[:STATe]..............................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage[:
STATe]................................................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage[:STATe]..............................................................................................555

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage[:STATe]..555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage[:STATe]... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage[:STATe]..555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage[:STATe]..... 555
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage[:STATe]..555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage[:STATe]..... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage[:STATe]... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PROFile.....................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PROFile.....................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PROFile.....................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PROFile.................................. 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PROFile............................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PROFile..................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PROFile.......................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CPHase..................................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CPHase.....................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CPHase.....................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CPHase.................................. 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CPHase............................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CPHase.................................. 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CPHase.......................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PRANge.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PRANge.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PRANge.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PRANge..................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PRANge...............................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PRANge..................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PRANge...................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:VELocity.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:VELocity.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:VELocity.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:VELocity..................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:VELocity...............................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:VELocity................................. 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:VELocity...................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:TOFFset.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:TOFFset.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:TOFFset.................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:TOFFset..................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:TOFFset...............................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:TOFFset................................. 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:TOFFset...................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:IVELocity................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:IVELocity................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:IVELocity................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:IVELocity.................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:IVELocity..............................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:IVELocity.................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:IVELocity..................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CONFig..................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CONFig..................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CONFig..................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CONFig...................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CONFig................................558
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CONFig.................................. 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CONFig....................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CVPeriod................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CVPeriod................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CVPeriod................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CVPeriod.................................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CVPeriod..............................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CVPeriod................................ 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CVPeriod..................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CAPeriod................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CAPeriod................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CAPeriod................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CAPeriod.................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CAPeriod..............................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CAPeriod................................ 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CAPeriod..................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:ACCel:MAX................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:ACCel:MAX................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:ACCel:MAX................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:ACCel:MAX............................. 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:ACCel:MAX.......................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:ACCel:MAX.............................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:ACCel:MAX..................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:JERK:MAX.................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:JERK:MAX.................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:JERK:MAX.................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:JERK:MAX.............................. 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:JERK:MAX........................... 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:JERK:MAX.............................. 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:JERK:MAX...................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:RPERiod?..................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:RPERiod?..................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:RPERiod?..................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:RPERiod?............................... 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:RPERiod?............................ 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:RPERiod?............................... 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:RPERiod?....................................561

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:
NMESsage[:STATe] <State>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:
NMESsage[:STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage[:
STATe] <State>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage[:
STATe] <State>

In tracking mode, enables configuration of the navigation message parameters.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Nav Msg" on page 91

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PROFile <Profile>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PROFile <Profile>
Selects the dynamics profile type.

Parameters:
<Profile> CONStant | HIGH

CONStant
Constant velocity as set with the command [:SOURce<hw>]:
BB:GNSS:SVID<ch>:GPS:SDYNamics:VELocity.
HIGH
Profiles with higher-order dynamics as set with the command [:
SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:
CONFig.
*RST: CONStant

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Mode" on page 108

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CPHase <CPhase>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CPHase <CPhase>
Sets the initial carrier phase.

Parameters:
<CPhase> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Inital Carrier Phase" on page 108
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PRANge <PRange>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PRANge <PRange>
Sets the initial pseudorange.

Parameters:
<PRange> float

Range: 0  to  119900000
Increment: 0.001
*RST: 0

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Inital Pseudorange" on page 108

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:VELocity <Velocity>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:VELocity <Velocity>
Sets the satellite velocity for constant velocity profile.

The velocity ranges depend on the GNSS and related space vehicles.

Parameters:
<Velocity> float

Range: depends on settings  to  depends on settings
Increment: 1E-4
*RST: 0

Example: :SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:PROFile CONStant
:SOURce1:BB:GNSS:SVID1:GPS:SDYNamics:VELocity 100
// Sets a velocity of 100 m/s.

Manual operation: See "Velocity (Pseudorange Rate)" on page 108

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:TOFFset <TimeOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:TOFFset <TimeOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:TOFFset <TimeOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:TOFFset <TimeOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:TOFFset

<TimeOffset>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:TOFFset <TimeOffset>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:TOFFset <TimeOffset>
Sets a time delay before the profile is applied.

Parameters:
<TimeOffset> float

Range: 0  to  9E4
Increment: 0.1
*RST: 0

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Start Time Offset" on page 108

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:IVELocity
<InitialVelocity>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:IVELocity <InitialVelocity>
Indicates the initial velocity, used at the beginning of the profile.

Parameters:
<InitialVelocity> float

Range: -19042  to  19042
Increment: 1E-4
*RST: 3.62

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Initial Velocity" on page 109

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CONFig
<PredefinedConfi>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CONFig
<PredefinedConfi>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CONFig
<PredefinedConfi>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CONFig
<PredefinedConfi>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CONFig
<PredefinedConfi>
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CONFig
<PredefinedConfi>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CONFig
<PredefinedConfi>

Selects between the predefined velocity profiles or a user-defined one.

Parameters:
<PredefinedConfi> USER | VEL1 | VEL2

USER
User-defined
Profile parametrs are configurable.
VEL1
Low dynamics
Profile parametrs are read-only.
VEL2
High dynamics
Profile parametrs are read-only.
*RST: VEL1

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Velocity Profile" on page 109

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CVPeriod
<ConstVelPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CVPeriod
<ConstVelPeriod>

Sets the time period during that the velocity is kept constant.

Parameters:
<ConstVelPeriod> float

Range: 0.1  to  10800
Increment: 0.1
*RST: 5

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Constant Velocity Period" on page 109
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CAPeriod
<ConstAccPeriod>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CAPeriod
<ConstAccPeriod>

Sets the time duration during that acceleration is applied and thus the velocity varies.

Parameters:
<ConstAccPeriod> float

Range: 0.1  to  10800
Increment: 0.1
*RST: 45

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Constant Acceleration Period" on page 109

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:ACCel:MAX
<MaxAcceleration>

[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:ACCel:MAX
<MaxAcceleration>

Sets the maximum acceleration.

Parameters:
<MaxAcceleration> float

Range: 0.01  to  1000
Increment: 0.0001
*RST: 0.7612

Example: See Example"Configuring the signal dynamics" on page 551.
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Manual operation: See "Maximum Acceleration" on page 109

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:JERK:MAX <MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:JERK:MAX <MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:JERK:MAX <MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:JERK:MAX <MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:JERK:MAX

<MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:JERK:MAX <MaxJerk>
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:JERK:MAX <MaxJerk>
Sets the maximum jerk.

Parameters:
<MaxJerk> float

Range: 0.1  to  7E4
Increment: 0.0001
*RST: 19.0295

Example: See Example"Configuring the signal dynamics" on page 551.

Manual operation: See "Maximum Jerk" on page 110

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:RPERiod?
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:RPERiod?
Queries the duration of the profile.

Return values: 
<RepetitionPer> float

Range: 0  to  9E4
Increment: 0.1
*RST: 0

Example: See Example"Configuring the signal dynamics" on page 551.

Usage: Query only

Manual operation: See "Repetition Period" on page 110

21.17  Assistance data commands

Option: R&S SMBVB-K44/-K94/-K66/-K97/-K107
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Example: Generating of GPS assistance data
SOURce1:BB:GNSS:PRESet
SOURce1:BB:GNSS:TMODe NAV
SOURce1:BB:GNSS:ADGeneration:MODE GPS
SOURce1:BB:GNSS:ADGeneration:GPS:SYNChronize 
SOURce1:BB:GNSS:ADGeneration:GPS:SVID11:STATe?
// Response: 1

SOURce1:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:RFRame WGS84
SOURce1:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS:WSG?
// Response: 11,35,0,EAST,48,9,0,NORT,508
SOURce1:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal:WSG?
// 11.583333,48.150000,508
SOURce1:BB:GNSS:ADGeneration:GPS:LOCation:URADius 3000
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:TBASis UTC
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:DATE?
// Response: 1752,9,14
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:TIME?
// Response: 6,0,0
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:TBASis GPS
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:WNUMber?
// Response: -11860
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:TOWeek?
// Response: -237584
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:DURation 1140.08
SOURce1:BB:GNSS:ADGeneration:GPS:TOAData:RESolution 0.08
SOURce1:BB:GNSS:ADGeneration:NAVigation:DFORmat LNAV

SOURce1:BB:GNSS:ADGeneration:ALManac:CREate "/var/user/ADG/almanac.rs_al"
SOURce1:BB:GNSS:ADGeneration:ALManac:CREate "/var/user/ADG/almanac.rs_yuma"
SOURce1:BB:GNSS:ADGeneration:NAVigation:CREate '/var/user/ADG/navigation'
SOURce1:BB:GNSS:ADGeneration:NAVigation:CREate '/var/user/ADG/RINEX.110n'
SOURce1:BB:GNSS:ADGeneration:ACQ:CREate '/var/user/ADG/acquisition'
MMEM:CAT? '/var/user/ADG'
// Response: 25301,43275001856,".,DIR,0","..,DIR,0","acquisition.rs_acq,BIN,525",
// "almanac.rs_al,BIN,5518","almanac.rs_yuma,BIN,18344","ion.rs_ion,BIN,70",
// "navigation.rs_nav,BIN,245","RINEX.10n,BIN,525","UTC.rs_utc,BIN,74"

Commands:

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SYNChronize......................................... 564
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SYNChronize..........................................564
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SYNChronize........................................564
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SYNChronize.................................... 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SYNChronize....................................... 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SYNChronize............................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:MODE............................................................. 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:DFORmat........................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SVID<ch>:STATe....................................565
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[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SVID<ch>:STATe.....................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SVID<ch>:STATe.................................. 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SVID<ch>:STATe............................... 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SVID<ch>:STATe..................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SVID<ch>:STATe.......................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:RFRame............ 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:RFRame.............566
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:RFRame...........566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:RFRame....... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:RFRame.......... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:RFRame...............566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:COORdinates:FORMat........................... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:COORdinates:FORMat............................ 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:COORdinates:FORMat..........................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:COORdinates:FORMat.......................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:COORdinates:FORMat......................... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:COORdinates:FORMat.............................. 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DECimal:PZ....... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DECimal[:WGS]..566
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DECimal:PZ........ 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DECimal[:WGS]...567
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DECimal[:

WGS]................................................................................................................. 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DECimal:PZ......567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DECimal:PZ...567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DECimal[:

WGS]................................................................................................................. 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DECimal:PZ..... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DECimal[:

WGS]................................................................................................................. 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal:PZ.......... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal[:WGS].....567
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS:PZ.............567
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS[:WGS]....... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS:PZ..............567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS[:WGS]........ 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS:PZ........... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS[:WGS]......568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DMS:PZ........ 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DMS[:WGS]...568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DMS:PZ...........568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DMS[:WGS]......568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS:PZ................568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS[:WGS].......... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:URADius.................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:URADius..................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:URADius............................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:URADius............................ 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:URADius...............................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:URADius....................................569

Assistance data commands



Remote-control commandsSatellite Navigation

564User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TBASis....................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TBASis.................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TBASis.................................. 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TBASis...............................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TBASis..................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TBASis...................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DATE......................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DATE.......................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DATE.................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DATE................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DATE.................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DATE.........................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TIME.......................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TIME....................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TIME..................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TIME.................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TIME.....................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TIME......................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DURation................................ 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DURation................................. 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DURation...............................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DURation............................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DURation.............................. 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DURation................................... 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:RESolution.............................. 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:RESolution...............................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:RESolution.............................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:RESolution..........................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:RESolution............................ 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:RESolution.................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TOWeek..................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TOWeek.................................. 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TOWeek................................ 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TOWeek............................. 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TOWeek................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TOWeek.................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:WNUMber............................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:WNUMber................................ 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:WNUMber..............................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:WNUMber...........................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:WNUMber............................. 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:WNUMber.................................. 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:ACQuisition:CREate..........................................573
[:SOURce<hw>]:BB:GNSS:ADGeneration:ALManac:CREate............................................. 573
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:CREate........................................... 573

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SYNChronize
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SYNChronize
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SYNChronize
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[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SYNChronize
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SYNChronize
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SYNChronize
Synchronizes the affected parameters.

Example: See Example"Generating of GPS assistance data" on page 562.

Usage: Event

Manual operation: See "Synchronize" on page 276

[:SOURce<hw>]:BB:GNSS:ADGeneration:MODE <Mode>

Defines the type of assistance data to be loaded.

Parameters:
<Mode> GPS | GALileo | GLONass | NAVic | QZSS | SBAS | BEIDou

*RST: GPS

Example: See Example"Generating of GPS assistance data" on page 562

Options: R&S SMBVB-K44/K66/K94/K97/K106/K107

Manual operation: See "Assistance Mode" on page 276

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:DFORmat <DataFormat>

Sets format of the generated navigation data file.

Parameters:
<DataFormat> LNAV | CNAV

*RST: LNAV

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Navigation Data Format" on page 276

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SVID<ch>:STATe <State>
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SVID<ch>:STATe <State>
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SVID<ch>:STATe <State>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SVID<ch>:STATe <State>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SVID<ch>:STATe <State>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SVID<ch>:STATe <State>
Activates satellites so that they are included in the generated assistance data.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Space Vehicles" on page 276
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[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:
RFRame <ReferenceFrame>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:
RFRame <ReferenceFrame>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:
RFRame <ReferenceFrame>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:
RFRame <ReferenceFrame>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:
RFRame <ReferenceFrame>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:RFRame
<ReferenceFrame>

Sets the reference frame.

Parameters:
<ReferenceFrame> PZ90 | WGS84

*RST: WGS84

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Reference Frame" on page 278

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:COORdinates:FORMat
<PositionFormat>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:COORdinates:FORMat
<PositionFormat>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:COORdinates:FORMat
<PositionFormat>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:COORdinates:FORMat
<PositionFormat>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:COORdinates:FORMat
<PositionFormat>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:COORdinates:FORMat
<PositionFormat>

Sets the format in which the coordinates of the reference location are set.

Parameters:
<PositionFormat> DMS | DECimal

*RST: DMS

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Reference Location" on page 279

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:
DECimal:PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

Assistance data commands



Remote-control commandsSatellite Navigation

567User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:
DECimal:PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:
DECimal:PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:
DECimal:PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:
DECimal:PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal:
PZ <Longitude>, <Latitude>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:
DECimal[:WGS] <Longitude>, <Latitude>, <Altitude>

Sets the geographic reference location in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-7
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-7
*RST: 0

<Altitude> float
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Generating of GPS assistance data" on page 562.

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS:
PZ <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS:PZ
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>
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[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS:
PZ <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:
DMS:PZ <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:
DMS[:WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>,
<LongitudeDir>, <LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>,
<Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DMS:
PZ <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:
DMS[:WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>,
<LongitudeDir>, <LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>,
<Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS:PZ
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS[:
WGS] <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Sets the geographic reference location in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LongitudeDir> select
*RST: EAST

<LatitudeDeg> integer
Range: 0  to  90
*RST: 0
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<LatitudeMin> integer
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LatitudeDir> select
*RST: NORT

<Altitude> float
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Reference Location" on page 279

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:URADius <Radius>
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:URADius <Radius>
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:URADius <Radius>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:URADius <Radius>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:URADius <Radius>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:URADius <Radius>
Sets the Uncertainty Radius, i.e. sets the maximum radius of the area within which the
two-dimensional location of the UE is bounded.

Parameters:
<Radius> integer

Range: 0  to  1.E6
*RST: 3.E3

Example: See Example"Generating of GPS assistance data" on page 562.

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TBASis <TimeBasis>
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TBASis <TimeBasis>
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TBASis <TimeBasis>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TBASis

<TimeBasis>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TBASis <TimeBasis>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TBASis <TimeBasis>
Determines the timebase used to enter the time of assistance data parameters.

Parameters:
<TimeBasis> UTC | GPS | GST | GLO | BDT | NAV

*RST: UTC
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Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Start Time" on page 277

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DATE <Year>, <Month>,
<Day>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DATE <Year>,
<Month>, <Day>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DATE <Year>, <Month>,
<Day>

Enabled for UTC or GLONASS timebase ([:SOURce<hw>]:BB:GNSS:
ADGeneration:GPS:TOAData:TBASis).

Enters the date for the assistance data in DMS format of the Gregorian calendar.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Date" on page 277

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TIME <Hour>, <Minute>,
<Second>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TIME <Hour>,
<Minute>, <Second>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TIME <Hour>, <Minute>,
<Second>

Enabled for UTC or GLONASS timebase ([:SOURce<hw>]:BB:GNSS:
ADGeneration:GPS:TOAData:TBASis).
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Enters the exact start time for the assistance data in UTC time format.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> float
Range: 0  to  59.999
Increment: 0.001

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Time" on page 277

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DURation <Duration>
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DURation <Duration>
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DURation <Duration>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DURation

<Duration>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DURation <Duration>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DURation <Duration>
Sets the duration of the assistance data.

Parameters:
<Duration> float

Range: 1E-3  to  5E3
Increment: 1E-3
*RST: 1E-3

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Duration" on page 278

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:RESolution
<Resolution>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:RESolution
<Resolution>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:RESolution
<Resolution>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:RESolution
<Resolution>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:RESolution
<Resolution>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:RESolution <Resolution>
Sets the resolution of the assistance data.
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Parameters:
<Resolution> float

Range: 1E-3  to  5
Increment: 1E-3
*RST: 1E-3

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Step" on page 278

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TOWeek <TOW>
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TOWeek <TOW>
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TOWeek <TOW>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TOWeek <TOW>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TOWeek <TOW>
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TOWeek <TOW>
Enabled for GPS timebase ([:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:
TOAData:TBASis).

Determines the Time of Week (TOW) the assistance data is generated for.

Parameters:
<TOW> integer

Range: -604800  to  604800
*RST: 0

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Time of Week" on page 277

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:WNUMber
<WeekNumber>

[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:WNUMber
<WeekNumber>

[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:WNUMber
<WeekNumber>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:WNUMber
<WeekNumber>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:WNUMber
<WeekNumber>

[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:WNUMber
<WeekNumber>

Enabled for GPS timebase ([:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:
TOAData:TBASis).

Sets the week number (WN) the assistance data is generated for.
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Parameters:
<WeekNumber> integer

Range: 0  to  9999.0*53
*RST: 0

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Week Number" on page 277

[:SOURce<hw>]:BB:GNSS:ADGeneration:ACQuisition:CREate <Create>

Saves the current assistance data settings into the selected acquisition file. The file
extension (*.rs_acq) is assigned automatically.

Parameters:
<Create> string

Filename or complete file path

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Generate Acquisition" on page 280

[:SOURce<hw>]:BB:GNSS:ADGeneration:ALManac:CREate <Filename>

Saves the current assistance data settings into the selected almanac file.

Parameters:
<Filename> string

Filename or complete file path
The default extension is *.rs_al. It can be omitted in the file-
name.
To save an almanac file as file with extension *.rs_yuma,
specify it in the filename.

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Generate Almanac" on page 279

[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:CREate <Filename>

Saves the current assistance data settings into the selected navigation file. Assistance
data settings are saved as navigation file with the specific file extensions *.rs_nav or
into RINEX files with extension .10n.

Parameters:
<Filename> string

Filename or complete file path

Example: See Example"Generating of GPS assistance data" on page 562.

Manual operation: See "Generate Navigation" on page 280
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21.18  Monitoring and real-time commands

Example: Configuring GNSS signal, receiver and simulation time
*RST
SOURce1:BB:GNSS:TMODe NAV
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
SOURce1:BB:GNSS:SYSTem:BEIDou:STATe 1
SOURce1:BB:GNSS:RECeiver:V1:POSition MOV
SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:FILE "Melbourne_Car_Motion.xtd"

SOURce1:BB:GNSS:TIME:STARt:GPS:WNUMber?
// Response: 1780
SOURce1:BB:GNSS:TIME:STARt:GPS:TOWeek?
// Response: 280816
SOURce1:BB:GNSS:TIME:STARt:TBASis UTC
SOURce1:BB:GNSS:TIME:STARt:UTC:DATE?
// Response: 2014,2,19
SOURce1:BB:GNSS:TIME:STARt:UTC:TIME?
// Response: 6,0,0

SOURce1:BB:GNSS:RECeiver:V1:ENVironment:MODel MPAT
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHos:COUNt 1
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:ICPHase 100
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:POWer -5
SOURce1:BB:GNSS:SVID1:GPS:MPATh:V1:A1:ECHO1:CPDRift 50
SOURce1:BB:GNSS:STATe 1
SOURce1:BB:GNSS:SIMulation:INFO?
// Response: L1 / GPS,Galileo,BeiDou

Example: Configuring the simulation monitor
SOURce1:BB:GNSS:MONitor1:DISPlay SKY

SOURce1:BB:GNSS:MONitor2:DISPlay POW
SOURce1:BB:GNSS:MONitor2:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:CA 1
SOURce1:BB:GNSS:MONitor2:DISPlay:POWer:SYSTem:GALileo:SIGNal:L1Band:E1OS 1
SOURce1:BB:GNSS:MONitor2:DISPlay:POWer:SYSTem:GLONass:SIGNal:L1Band:CA 1
SOURce1:BB:GNSS:MONitor2:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L1Band:B1I 1

SOURce1:BB:GNSS:MONitor1:DISPlay MAP
SOURce1:BB:GNSS:MONitor1:DISPlay:MAP:AXIS GRID
SOURce1:BB:GNSS:MONitor2:DISPlay TRAC
SOURce1:BB:GNSS:MONitor2:DISPlay:TRACks:SHOW 1

SOURce1:BB:GNSS:MONitor2:DISPlay TRAJ
SOURce1:BB:GNSS:MONitor2:DISPlay:TRAJectory:SYSTem GPS
SOURce1:BB:GNSS:MONitor2:DISPlay:TRAJectory:SVID 1

SOURce1:BB:GNSS:MONitor2:DISPlay CHANnels
SOURce1:BB:GNSS:MONitor2:DISPlay:CHANnels:USED? 
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// Repsonse: 33
SOURce1:BB:GNSS:MONitor2:DISPlay:CHANnels:ALLocated? 
// Response: 48

Example: Retrieving real-time settings
*RST
SOURce1:BB:GNSS:TMODe NAV
SOURce1:BB:GNSS:SYSTem:GPS:STATe 1
SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
SOURce1:BB:GNSS:SYSTem:BEIDou:STATe 1
SOURce1:BB:GNSS:RECeiver:V1:POSition MOV
SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:FILE "Melbourne_Car_Motion.xtd"

SOURce1:BB:GNSS:TIME:STARt:GPS:WNUMber?
// Response: 1780
SOURce1:BB:GNSS:TIME:STARt:GPS:TOWeek?
// Response: 280816
SOURce1:BB:GNSS:TIME:STARt:TBASis UTC
SOURce1:BB:GNSS:TIME:STARt:UTC:DATE?
// Response: 2014,2,19
SOURce1:BB:GNSS:TIME:STARt:UTC:TIME?
// Response: 6,0,0

SOURce1:BB:GNSS:STATe 1
SOURce1:BB:GNSS:SIMulation:INFO?
// Response: "L1 / GPS,Galileo,BeiDou"
SOURce1:BB:GNSS:RT:HWTime?
// Response in s: 8.35
// Elapsed time since simulation start.

// Query space vehicle real-time data.
SOURce1:BB:GNSS:RT:GPS:SVID2:AZIMuth? GST,1780,280818
// Response in degree: 193.484716876694
SOURce1:BB:GNSS:RT:GPS:SVID2:ELEVation? GST,1780,280818
// Response in degree: -17.3132866460052
SOURce1:BB:GNSS:RT:HDOP?
// Response: 0.61
SOURce1:BB:GNSS:RT:PDOP?
// Response: 1.07
SOURce1:BB:GNSS:RT:VDOP?
// Response: 0.89

// Query the receiver real-time data.
SOURce1:BB:GNSS:RT:RECeiver1:RLOCation:COORdinates:DMS? GPS,1780,280850
// Response <LongitudeDeg>,<LongitudeMin>,<LongitudeSec>,<LongitudeDir>,
// <LatitudeDeg>,<LatitudeMin>,<LatitudeSec>,<LatitudeDir>,<Altitude>:
// 144,57,59.1954000000,EAST,37,48,37.6154000000,SOUT,100.037000
SOURce1:BB:GNSS:RT:RECeiver1:RLOCation:COORdinates:DECimal? GPS,1780,280850
// Response <Longitude>,<Latitude>,<Altitude>:
// 144.9664431600000,-37.8104487300000,100.037000
SOURce1:BB:GNSS:RT:RECeiver1:RVELocity? GPS,1780,280850
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// Response in m/s: 987.654321 
SOURce1:BB:GNSS:RT:RPVT? GPS,1780,280850
// Response <Longitude>,<Latitude>,<Altitude>,<Velocity>:
// 144.9664431600000,-37.8104487300000,100.037000,0.000000
SOURce1:BB:GNSS:RT:RATTitude? GPS,1780,280850
// Response <Yaw>,<Pitch>,<Roll>:
// 0.33,0,0

Commands:

● Monitoring commands...........................................................................................576
● Real-time commands............................................................................................ 582

21.18.1  Monitoring commands

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay.............................................................577
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:ANTenna...............................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:MAP:AXIS.............................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRACks:SHOW.....................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SVID...................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SYSTem............................. 579
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:ECHoes.................................... 579
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:

L5Band:EL5S...................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:

L1Band:CA......................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:NAVic:SIGNal:

L5Band:SPS....................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:

L5Band:L5S........................................................................................................ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:

L2Band:L2C........................................................................................................ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:

L1Band:L1C........................................................................................................ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:

L1Band:CA......................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L5Band:B2I......................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L5Band:B2B........................................................................................................580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L5Band:B2A........................................................................................................580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L2Band:B3I......................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L1Band:B1I......................................................................................................... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:

L1Band:B1C........................................................................................................580
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[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:
L5Band:L3CDma................................................................................................. 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:
L2Band:L2CDma................................................................................................. 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:
L2Band:CA......................................................................................................... 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:
L1Band:L1CDma................................................................................................. 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:
L1Band:CA......................................................................................................... 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L5Band:E5B........................................................................................................580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L5Band:E5A........................................................................................................580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L2Band:E6PRs....................................................................................................580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L2Band:E6S........................................................................................................580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L1Band:E1OS..................................................................................................... 580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:
L1Band:E1PRs....................................................................................................580

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L5Band:L5S........................................................................................................ 581

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:CA......................................................................................................... 581

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:L2C........................................................................................................ 581

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:M........................................................................................................... 581

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:P..581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:

L2Band:PY..........................................................................................................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:

L1Band:L1C........................................................................................................ 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:

L1Band:M........................................................................................................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:P..581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:

L1Band:PY..........................................................................................................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:

L1Band:CA......................................................................................................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:ALLocated?...........................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:USED?................................. 581

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay <DisplayType>

Switches between the available views.
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Parameters:
<DisplayType> SKY | MAP | POWer | TRAJectory | ATTitude | TRACks |

CHANnels
*RST: SKY

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "Display" on page 37

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:ANTenna <Antenna>

Sets the antenna for that the information displayed in the "Simulation Monitor" applies.

Parameters:
<Antenna> A1 | A2 | A3 | A4

*RST: A1

Example: See Example"Configuring the simulation monitor" on page 574.

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:MAP:AXIS <AxisType>

Changes the axis type in the "Map View" display.

Parameters:
<AxisType> GRID | CIRCles

*RST: GRID

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "Axis" on page 43

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRACks:SHOW <ShowTracks>

Enables display of the current satellite positions and their orbits.

Parameters:
<ShowTracks> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "Show Tracks" on page 43

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SVID <SvId>

Selects the SV ID which elevation/azimuth variation over 24 hours is displayed.
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Parameters:
<SvId> 1 | 2 | 3 | 5 | 4 | 6 | 7 | 8 | 9 | 10 | 11 | 12 | 13 | 14 | 15 | 16 | 17 |

19 | 18 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27 | 28 | 29 | 30 | 31 |
32 | 33 | 34 | 35 | 36 | 37 | 38 | 39 | 40 | 41 | 42 | 43 | 44 | 45 |
46 | 47 | 48 | 49 | 50 | 51 | 52 | 53 | 54 | 55 | 56 | 57 | 58 | 59 |
60 | 61 | 62 | 63 | 64 | 65 | 66 | 67 | 68 | 69 | 70 | 71 | 72 | 73 |
74 | 75 | 76 | 77 | 78 | 79 | 80 | 81 | 82 | 83 | 84 | 85 | 86 | 87 |
88 | 89 | 90 | 91 | 92 | 93 | 94 | 95 | 96 | 97 | 98 | 99 | 100 | 101 |
102 | 103 | 104 | 105 | 106 | 107 | 108 | 109 | 110 | 111 | 112 |
113 | 114 | 115 | 116 | 117 | 118 | 119 | 120 | 121 | 122 | 123 |
124 | 125 | 126 | 127 | 128 | 129 | 130 | 131 | 132 | 133 | 134 |
135 | 136 | 137 | 138 | 139 | 140 | 141 | 142 | 143 | 144 | 145 |
146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 |
157 | 158 | 159 | 160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 |
168 | 169 | 170 | 171 | 172 | 173 | 174 | 175 | 176 | 177 | 178 |
179 | 180 | 181 | 182 | 183 | 184 | 185 | 186 | 187 | 188 | 189 |
190 | 191 | 192 | 193 | 194 | 195 | 196 | 197 | 198 | 199 | 200 |
ALL

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "SV-ID" on page 44

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SYSTem <System>

Selects the GNSS system which elevation/azimuth variation over 24 hours is dis-
played.

Parameters:
<System> GPS | GALileo | GLONass | BEIDou | QZSS | SBAS

*RST: GPS

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "System" on page 44

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:ECHoes <ShowEchoes>

If enabled, the "Power View" indicates also the echoes per SV.

Parameters:
<ShowEchoes> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "Show Echoes" on page 43
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[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:
L5Band:EL5S <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:
L1Band:CA <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:NAVic:SIGNal:
L5Band:SPS <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:
L5Band:L5S <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:
L2Band:L2C <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:
L1Band:L1C <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:
L1Band:CA <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L5Band:B2I <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L5Band:B2B <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L5Band:B2A <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L2Band:B3I <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L1Band:B1I <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:
SIGNal:L1Band:B1C <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:
SIGNal:L5Band:L3CDma <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:
SIGNal:L2Band:L2CDma <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:
SIGNal:L2Band:CA <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:
SIGNal:L1Band:L1CDma <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:
SIGNal:L1Band:CA <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L5Band:E5B <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L5Band:E5A <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L2Band:E6PRs <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L2Band:E6S <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L1Band:E1OS <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:
SIGNal:L1Band:E1PRs <SignalState>
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[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L5Band:L5S <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:CA <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:L2C <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:M <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:P <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L2Band:PY <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L1Band:L1C <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L1Band:M <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L1Band:P <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L1Band:PY <SignalState>

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:
L1Band:CA <SignalState>

Defines the signals to be visualized on the "Power View" graph.

Parameters:
<SignalState> 1 | ON | 0 | OFF

Example: See Example"Configuring the simulation monitor" on page 574.

Manual operation: See "View Settings" on page 43

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:ALLocated?

Queries the maximum number of allocated channels.

The maximum number of allocated channels depends on the installed options, see
Chapter G, "Channel budget", on page 642.

Return values: 
<AllocatedChans> integer

Range: 0  to  depends on installed options
Increment: 1

Example: See Example"Configuring the simulation monitor" on page 574

Usage: Query only

Manual operation: See "Channels" on page 44

[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:USED?

Queries the number of active channels.
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The maximum number of active channels depends on the installed options, see Chap-
ter G, "Channel budget", on page 642.

Return values: 
<UsedChannels> integer

Range: 0  to  depends on installed options
Increment: 1
*RST: 0
The *RST value depends on the installed GNSS system option,
e.g. for GPS :
*RST: 11

Example: See Example"Configuring the simulation monitor" on page 574

Usage: Query only

Manual operation: See "Channels" on page 44

21.18.2  Real-time commands

[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:ACTive:SYSTems?..................................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:SBAS:ACTive:SIGNals?.............................. 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:QZSS:ACTive:SIGNals?..............................583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:NAVic:ACTive:SIGNals?..............................583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:BEIDou:ACTive:SIGNals?........................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GLONass:ACTive:SIGNals?........................ 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GALileo:ACTive:SIGNals?........................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GPS:ACTive:SIGNals?................................583
[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:AZIMuth?.................................................583
[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:AZIMuth?.................................................583
[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:AZIMuth?................................................ 583
[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:AZIMuth?.............................................. 583
[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:AZIMuth?........................................... 583
[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:AZIMuth?..............................................584
[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:AZIMuth?.................................................. 584
[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:ELEVation?..............................................585
[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:ELEVation?..............................................585
[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:ELEVation?..............................................585
[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:ELEVation?........................................... 585
[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:ELEVation?........................................ 585
[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:ELEVation?...........................................585
[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:ELEVation?................................................585
[:SOURce<hw>]:BB:GNSS:RT:HDOP?.............................................................................586
[:SOURce<hw>]:BB:GNSS:RT:PDOP?.............................................................................586
[:SOURce<hw>]:BB:GNSS:RT:VDOP?.............................................................................587
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:DECimal?......... 587
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:DMS?...............588
[:SOURce<hw>]:BB:GNSS:RT:RATTitude?.......................................................................589
[:SOURce<hw>]:BB:GNSS:RT:RPVT?............................................................................. 591
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RVELocity?............................................. 592
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[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:ACTive:SYSTems?

Queries active GNSS in a comma-separated string.

Return values: 
<ActiveSystems> string

Example: SOURce1:BB:GNSS:RT:ACTive:SYSTems?
// Response: "GPS"

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:SBAS:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:QZSS:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:NAVic:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:BEIDou:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GLONass:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GALileo:ACTive:SIGNals?
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GPS:ACTive:SIGNals?
Queries active signals of a GNSS in a comma-separated list.

Return values: 
<ActiveSignals> string

Example: SOURce1:BB:GNSS:RT:GPS:ACTive:SIGNals?
// Response: 1,CA

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:AZIMuth? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>
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[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:AZIMuth? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

Queries the satellite azimuth in the selected moment of time. The required query
parameters, depend on the selected timebase.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
Required for TimeBasis = UTC
Range: 1980  to  9999

<Month> integer
Required for TimeBasis = UTC
Range: 1  to  12

<Day> integer
Required for TimeBasis = UTC
Range: 1  to  31

<Hour> integer
Required for TimeBasis = UTC
Range: 0  to  23

<Minutes> integer
Required for TimeBasis = UTC
Range: 0  to  59

<Seconds> float
Required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947

<TimeOfWeek> float
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Azimuth> float
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Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:ELEVation? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:ELEVation? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:ELEVation? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:ELEVation? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:ELEVation? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:ELEVation? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:ELEVation? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

Queries the satellite elevation in the selected moment of time. The required query
parameters, depend on the selected timebase.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
Required for TimeBasis = UTC
Range: 1980  to  9999

<Month> integer
Required for TimeBasis = UTC
Range: 1  to  12

<Day> integer
Required for TimeBasis = UTC
Range: 1  to  31

<Hour> integer
Required for TimeBasis = UTC
Range: 0  to  23

Monitoring and real-time commands



Remote-control commandsSatellite Navigation

586User Manual 1178.9403.02 ─ 10

<Minutes> integer
Required for TimeBasis = UTC
Range: 0  to  59

<Seconds> float
Required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947

<TimeOfWeek> float
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Elevation> float

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:HDOP?

Queries the horizontal dilution of precision (HDOP) value of the selected satellite con-
stellation.

Return values: 
<RealtimeHdop> float

Increment: 0.01
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:PDOP?

Queries the position dilution of precision (PDOP) value of the selected satellite constel-
lation.

Return values: 
<RealtimePdop> float

Increment: 0.01
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only
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[:SOURce<hw>]:BB:GNSS:RT:VDOP?

Queries the vertical dilution of precision (VDOP) value of the selected satellite constel-
lation.

Return values: 
<RealtimeVdop> float

Increment: 0.01
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:
DECimal? <TimeBasis>, <Year>, <Month>, <Day>, <Hour>, <Minutes>,
<Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the coordinates of the receiver location in decimal format for the selected
moment of time. The required query parameters depend on the selected timebase.

Query parameters: 
<TimeBasis> select

*RST: UTC

<Year> integer
Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

<Hour> integer
Range: 0  to  23

<Minutes> integer
Range: 0  to  59

<Seconds> float
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Range: 0  to  529947

<TimeOfWeek> float
Range: 0  to  604799.999
Increment: 0.001
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Return values: 
<Longitude> float

Range: -180  to  180
Increment: 1E-7
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-7
*RST: 0

<Altitude> float
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:DMS?
<TimeBasis>, <Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>,
<WeekNumber>, <TimeOfWeek>

Queries the coordinates of the receiver location in DMS format for the selected
moment of time. The required query parameters depend on the selected timebase.

Query parameters: 
<TimeBasis> select

*RST: UTC

<Year> integer
Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

<Hour> integer
Range: 0  to  23

<Minutes> integer
Range: 0  to  59

<Seconds> float
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Range: 0  to  529947
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<TimeOfWeek> float
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LongitudeDir> select
*RST: EAST

<LatitudeDeg> integer
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Range: 0  to  59.999
Increment: 1E-4
*RST: 0

<LatitudeDir> select
*RST: NORT

<Altitude> float
Range: -10E3  to  50E6
Increment: 0.01
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RATTitude? <TimeBasis>, <Year>, <Month>, <Day>,
<Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the receiver attitude parameters yaw, pitch, roll in degrees for the selected
moment of time.
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Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
Required for TimeBasis = UTC
Range: 1980  to  9999

<Month> integer
Required for TimeBasis = UTC
Range: 1  to  12

<Day> integer
Required for TimeBasis = UTC
Range: 1  to  31

<Hour> integer
Required for TimeBasis = UTC
Range: 0  to  23

<Minutes> integer
Required for TimeBasis = UTC
Range: 0  to  59

<Seconds> float
Required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947

<TimeOfWeek> float
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Yaw> float

Range: -3.14  to  3.14
Increment: 0.01
*RST: 0

<Pitch> float
Range: -3.14  to  3.14
Increment: 0.01
*RST: 0
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<Roll> float
Range: -3.14  to  3.14
Increment: 0.01
*RST: 0

Example: See Example"Configuring the simulation monitor" on page 574.

Usage: Query only

[:SOURce<hw>]:BB:GNSS:RT:RPVT? <TimeBasis>, <Year>, <Month>, <Day>,
<Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the velocity and the coordinates of the receiver location in decimal format for
the selected moment of time.

The required query parameters depend on the selected timebase.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
Required for TimeBasis = UTC
Range: 1980  to  9999

<Month> integer
Required for TimeBasis = UTC
Range: 1  to  12

<Day> integer
Required for TimeBasis = UTC
Range: 1  to  31

<Hour> integer
Required for TimeBasis = UTC
Range: 0  to  23

<Minutes> integer
Required for TimeBasis = UTC
Range: 0  to  59

<Seconds> float
Required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
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<TimeOfWeek> float
Required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Longitude> float

Range: -180  to  180
Increment: 1E-13
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-13
*RST: 0

<Altitude> float
Range: -10E3  to  50E6
Increment: 1E-6
*RST: 0

<Velocity> float
Range: 0  to  1000
Increment: 1E-6
*RST: 0
Default unit: m/s

Example: See Example"Configuring the simulation monitor" on page 574.

[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RVELocity? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

Queries the velocity of the receiver location for the selected moment of time.

The required query parameters depend on the selected timebase.

Query parameters: 
<TimeBasis> select

*RST: UTC

<Year> integer
Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

<Hour> integer
Range: 0  to  23
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<Minutes> integer
Range: 0  to  59

<Seconds> float
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
Range: 0  to  529947

<TimeOfWeek> float
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Velocity> float

Range: 0  to  1000
Increment: 1E-6
*RST: 0

Example: See Example"Retrieving real-time settings" on page 575.

Usage: Query only

21.19  Data logging commands

Example: To enable data logging
The following is a simple example on how to use the settings.

:SOURce1:BB:GNSS:TMODe NAV
:SOURce1:BB:GNSS:SYSTem:GALileo:STATe 1
:SOURce1:BB:GNSS:TIME:STARt:TBASis GPS
:SOURce1:BB:GNSS:NAVigation:SIMulation:WNUMber?
// 1780
:SOURce1:BB:GNSS:NAVigation:SIMulation:TOWeek?
// 280816

:SOURce1:BB:GNSS:RECeiver:V1:POSition MOV
:SOURce1:BB:GNSS:RECeiver:V1:LOCation:WAYPoints:FILE "Melbourne_Car_Motion.xtd"
:SOURce1:BB:GNSS:SV:SELection:GPS:MAX 4
:SOURce1:BB:GNSS:SV:SELection:GALileo:MAX 4

:SOURce1:BB:GNSS:LOGGing:MODE OFFL
:SOURce1:BB:GNSS:LOGGing:OFFLine:TOFFset 0
:SOURce1:BB:GNSS:LOGGing:OFFLine:DURation 60
:SOURce1:BB:GNSS:LOGGing:DESTination:FILE:DIRectory "/var/user/my_logs"
:SOURce1:BB:GNSS:LOGGing:DESTination:FILE:TAPPend:STATe 1
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:SOURce1:BB:GNSS:LOGGing:CATegory:UMOTion:STATe 1
:SOURce1:BB:GNSS:LOGGing:CATegory:UMOTion:STEP R10S
:SOURce1:BB:GNSS:LOGGing:CATegory:UMOTion:FORMat?
// CSV
:SOURce1:BB:GNSS:LOGGing:CATegory:UMOTion:CSV:SELect:ALL 
:SOURce1:BB:GNSS:LOGGing:CATegory:SATellite:STATe 1
:SOURce1:BB:GNSS:LOGGing:CATegory:SATellite:STEP R10S
:SOURce1:BB:GNSS:LOGGing:CATegory:SATellite:SELect:ALL 
:SOURce1:BB:GNSS:LOGGing:CATegory:SATellite:FORMat?
// CSV
:SOURce1:BB:GNSS:STATe 1

:SOURce1:BB:GPS:LOGGing:OFFLine:GENerate
:SOURce1:BB:GPS:LOGGing:OFFLine:PROGress?

Commands:

[:SOURce<hw>]:BB:GNSS:LOGGing:MODE.................................................................... 595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:ABORt...................................................... 595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:GENerate.................................................. 595
[:SOURce<hw>]:BB:GNSS:LOGGing:RT:STATe................................................................ 596
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:TOFFset....................................................596
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:DURation...................................................596
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:PROGress?............................................... 596
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:DIRectory.....................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:TAPPend[:STATe]..........................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:FORMat?....................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:FORMat?...................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STATe....................................... 597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STATe.........................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STEP........................................ 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STEP......................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:ALL...................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:NONE.................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:NONE............................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:ALL.................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ACCeleration:ECEF..................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:AZIMuth......................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CBIas......................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CRANge..................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:DSHift.........................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ELEVation...................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:IDELay....................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:POSition:ECEF............................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRANge..................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRRate.......................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBias....................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBRate.................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RANGe.......................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RRATe........................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SLEVel....................................... 598
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[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:TDELay...................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:VELocity:ECEF............................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ACCeleration:ECEF.......... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude.......................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:ACCeleration...... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:JERK................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:RATE................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GDOP..............................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GSPeed...........................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:AOFFset.......................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:HDOP..............................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:JERK:ECEF..................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SVS.................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:PDOP.............................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ECEF.................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ENU...................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:LLA....................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:TDOP.............................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:ECEF.................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:LNED.................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VDOP.............................. 599

[:SOURce<hw>]:BB:GNSS:LOGGing:MODE <Mode>

Sets the logging mode.

Parameters:
<Mode> RT | OFFLine

RT = real-time
OFFLine = offline
*RST: RT

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Mode" on page 268

[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:ABORt
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:GENerate
Logging files are created and saved. Files with the same name are overwritten.

To stop the generation, send [:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:
ABORt.

Example: See Example"To enable data logging" on page 593.

Usage: Event

Manual operation: See "Generate" on page 269
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[:SOURce<hw>]:BB:GNSS:LOGGing:RT:STATe <Status>

Starts real-time data logging.

Parameters:
<Status> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:BB:GPS:LOGGing:RT:STATe 1
Manual operation: See "State" on page 268

[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:TOFFset <TimeOffset>

Delays the logging start.

Parameters:
<TimeOffset> float

Range: 0  to  864000
Increment: 1E-3
*RST: 0
Default unit: s

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Time Offset" on page 269

[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:DURation <Duration>

Sets the logging duration.

Parameters:
<Duration> float

Range: 0  to  2073600
Increment: 0.001
*RST: 0
Default unit: s

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Duration" on page 269

[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:PROGress?

Querries the progress of the offline data logging generation.

Return values: 
<Progress> integer

Range: 0  to  100
*RST: 100

Example: See Example"To enable data logging" on page 593.

Usage: Query only
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[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:DIRectory <Directory>

Sets the storage place.

Parameters:
<Directory> string

File path

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Directory" on page 269
See "Create New Subdirectory for Each Run" on page 269

[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:TAPPend[:STATe]
<Append>

Adds a timestamp to the filename.

Parameters:
<Append> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Create New Subdirectory for Each Run" on page 269

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:FORMat?
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:FORMat?
Sets the file format in that the logged data is saved.

Return values: 
<Format> CSV

*RST: CSV

Example: See Example"To enable data logging" on page 593.

Usage: Query only

Manual operation: See "Format" on page 270

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STATe <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STATe <State>
Enables the logging of the selected category.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: see Example"To enable data logging" on page 593.

Manual operation: See "State" on page 270
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[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STEP <Resolution>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STEP <Resolution>
Sets the logging step.

Parameters:
<Resolution> R1S | R2S | R5S | R10S | R02S | R04S | R08S

*RST: R1S

Example: See Example"To enable data logging" on page 593.

Manual operation: See "Log Step /s" on page 270

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:ALL
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:NONE
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:NONE
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:ALL
Enables or disables all of the available SV IDs.

Example: See Example"To enable data logging" on page 593.

Usage: Event

Manual operation: See "Logged Satellite Parameters" on page 271

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ACCeleration:ECEF
<State>

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:AZIMuth <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CBIas <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CRANge <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:DSHift <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ELEVation <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:IDELay <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:POSition:ECEF <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRANge <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRRate <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBias <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBRate <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RANGe <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RRATe <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SLEVel <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:TDELay <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:VELocity:ECEF <State>
Enables the parameter for logging.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To enable data logging" on page 593.
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[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ACCeleration:
ECEF <State>

[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:

ACCeleration <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:JERK

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:RATE

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GDOP <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GSPeed <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:AOFFset <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:HDOP <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:JERK:ECEF

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SVS <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:PDOP <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ECEF

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ENU

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:LLA

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:TDOP <State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:ECEF

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:LNED

<State>
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VDOP <State>
Enables the parameter for logging.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"To enable data logging" on page 593.

21.20  Trigger commands

Example: Configure and enable triggering
:SOURce1:BB:GNSS:TRIGger:SEQuence SINGle
:SOURce1:BB:GNSS:TRIGger:SLENgth 200

// The first 200 samples of the current waveform are output after 
// the next trigger event.
:SOURce1:BB:GNSS:TRIGger:SEQuence ARETrigger
:SOURce1:BB:GNSS:TRIGger:SOURce EGT1
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// External trigger signal provided at the USER connector.
:SOURce1:BB:GNSS:TRIGger:EXTernal:SYNChronize:OUTPut ON
:SOURce1:BB:GNSS:TRIGger:EXTernal:DELay 200
:SOURce1:BB:GNSS:TRIGger:EXTernal:INHibit 100

:SOURce1:BB:GNSS:TRIGger:SOURce INTB
// The internal trigger signal from the other path is used.
:SOURce1:BB:GNSS:TRIGger:OBASeband:DELay 25
:SOURce1:BB:GNSS:TRIGger:OBASeband:INHibit 10

:SOURce1:BB:GNSS:TRIGger:SEQuence AAUTo
:SOURce1:BB:GNSS:TRIGger:SOURce INTernal
:SOURce1:BB:GNSS:STAT ON
:SOURce1:BB:GNSS:TRIGger:EXEC

Example: Specifying delay and inhibit values in time units
:SOURce1:BB:GNSS:CLOCk 1000000
:SOURce1:BB:GNSS:TRIGger:SEQuence AAUT
:SOURce1:BB:GNSS:TRIGger:SOURce EGT1
:SOURce1:BB:GNSS:TRIGger:DELay:UNIT SAMP
:SOURce1:BB:GNSS:TRIGger:EXTernal:DELay 100
:SOURce1:BB:GNSS:TRIGger:EXTernal:RDELay?
// Response: 100

:SOURce1:BB:GNSS:TRIGger:DELay:UNIT TIME
:SOURce1:BB:GNSS:TRIGger:EXTernal:TDELay 0.00001
:SOURce1:BB:GNSS:TRIGger:EXTernal:RDELay?
// Response: 0.00001

:SOURce1:BB:GNSS:TRIGger:DELay:UNIT SAMP
:SOURce1:BB:GNSS:TRIGger:EXTernal:DELay 10

Commands:

[:SOURce<hw>]:BB:GNSS[:TRIGger]:SEQuence..............................................................601
[:SOURce<hw>]:BB:GNSS:TRIGger:SOURce...................................................................601
[:SOURce<hw>]:BB:GNSS:TRIGger:RMODe?..................................................................601
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:DATE.............................................................. 602
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:TIME...............................................................602
[:SOURce<hw>]:BB:GNSS:TRIGger:TIME[:STATe]............................................................603
[:SOURce<hw>]:BB:GNSS:TRIGger:SLENgth.................................................................. 603
[:SOURce<hw>]:BB:GNSS:TRIGger:EXECute.................................................................. 603
[:SOURce<hw>]:BB:GNSS:TRIGger:ARM:EXECute..........................................................603
[:SOURce<hw>]:BB:GNSS:TRIGger:EXTernal:SYNChronize:OUTPut................................. 604
[:SOURce<hw>]:BB:GNSS:TRIGger:OBASeband:DELay...................................................604
[:SOURce<hw>]:BB:GNSS:TRIGger:OBASeband:INHibit...................................................604
[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:DELay...............................................604
[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:INHibit...............................................605
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[:SOURce<hw>]:BB:GNSS[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode.

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Chapter 21.21, "Marker commands", on page 605.

Manual operation: See "Mode" on page 312

[:SOURce<hw>]:BB:GNSS:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are the following trigger sources:
● INTernal: Internal manual triggering of the instrument
● External trigger signal via one of the global connectors:

EGT1: External global trigger
● For secondary instruments (SCONfiguration:MULTiinstrument:MODE SEC),

triggering via the external baseband synchronization signal of the primary instru-
ment:
SOURce1:BB:ARB:TRIGger:SOURce BBSY

● EXTernal: Setting only
Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators. The R&S SMBV100B accepts this value and maps it automatically as fol-
lows:
EXTernal = EGT1

Parameters:
<Source> INTernal|EGT1|EXTernal|BBSY

Example: See Chapter 21.21, "Marker commands", on page 605.

Manual operation: See "Source" on page 314

[:SOURce<hw>]:BB:GNSS:TRIGger:RMODe?

Queries the status of waveform output.

Return values: 
<RMode> STOP | RUN

*RST: STOP

Example: See Example"Configure and enable triggering" on page 599.

Usage: Query only

Manual operation: See "Running/Stopped" on page 313

Trigger commands



Remote-control commandsSatellite Navigation

602User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMBV100B user manual.

Manual operation: See "Trigger Time" on page 313

[:SOURce<hw>]:BB:GNSS:TRIGger:TIME:TIME <Hour>, <Minute>, <Second>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMBV100B user manual.

Manual operation: See "Trigger Time" on page 313
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[:SOURce<hw>]:BB:GNSS:TRIGger:TIME[:STATe] <State>

Activates time-based triggering with a fixed time reference. If activated, the
R&S SMBV100B triggers signal generation when its operating system time matches a
specified time.

Specify the trigger date and trigger time with the following commands:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:TIME
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<State> 1 | ON | 0 | OFF

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMBV100B user manual.

Manual operation: See "Time Based Trigger" on page 313

[:SOURce<hw>]:BB:GNSS:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence to be output in the SINGle trigger mode.

Parameters:
<SLength> float

Range: 0.001  to  46.648730700
Increment: 1E-9
*RST: 1
Default unit: s

Example: See Example"Configure and enable triggering" on page 599.

Manual operation: See "Signal Duration" on page 313

[:SOURce<hw>]:BB:GNSS:TRIGger:EXECute

Executes an internal trigger event.

Example: See Example"Configure and enable triggering" on page 599.

Usage: Event

Manual operation: See "Execute Trigger" on page 314

[:SOURce<hw>]:BB:GNSS:TRIGger:ARM:EXECute

Stops (arms) waveform output.

Example: See Example"Configure and enable triggering" on page 599.

Usage: Event
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Manual operation: See "Arm" on page 314

[:SOURce<hw>]:BB:GNSS:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

Enables signal output synchronous to the trigger event.

Parameters:
<Output> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configure and enable triggering" on page 599.

Manual operation: See "Sync. Output to External Trigger/Sync. Output to Trigger"
on page 314

[:SOURce<hw>]:BB:GNSS:TRIGger:OBASeband:DELay <Delay>

Specifies the trigger delay for triggering by the signal from the second path.

Parameters:
<Delay> float

Range: 0  to  23.324365344
Increment: 1E-9
*RST: 0

Example: See Chapter 21.20, "Trigger commands", on page 599.

[:SOURce<hw>]:BB:GNSS:TRIGger:OBASeband:INHibit <Inhibit>

For triggering via the other path, specifies the number of samples by which a restart is
inhibited.

Parameters:
<Inhibit> float

Range: 0  to  0.728886406
Increment: 1E-9
*RST: 0

Example: See Chapter 21.20, "Trigger commands", on page 599.

[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:DELay <Delay>

Sets the trigger delay.

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: See Chapter 21.20, "Trigger commands", on page 599.
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Manual operation: See "External Delay/Trigger Delay" on page 315

[:SOURce<hw>]:BB:GNSS:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

Specifies the duration by which a restart is inhibited.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: See Chapter 21.20, "Trigger commands", on page 599.

Manual operation: See "External Inhibit/Trigger Inhibit" on page 315

21.21  Marker commands

Example: Configure and enable marker signals

SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE PPS
SOURce1:BB:GNSS:TRIGger:OUTPut1:PULSe:WIDTh 0.000002
// Delay the marker signal by 10 ns from signal generation start.
SOURce1:BB:GNSS:TRIGger:OUTPut1:DELay 0.000000010
SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE PP2S
SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE PPS10
SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE RAT
SOURce1:BB:GNSS:TRIGger:OUTPut1:ONTime 0.000001
SOURce1:BB:GNSS:TRIGger:OUTPut1:OFFTime 0.000001

SOURce1:BB:GNSS:TRIGger:OUTPut1:HPPS:ADELay 20
SOURce1:BB:GNSS:TRIGger:OUTPut1:HPPS:STATe 1

Example: Generate a marker signal with fixed frequency
// Generate a regular marker signal.
SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE PULS
SOURce1:BB:GNSS:TRIGger:OUTPut1:PULSe:DIVider 2
// Find out the frequency of the marker signal.
SOURce1:BB:GNSS:TRIGger:OUTPut1:PULSe:FREQuency?
// Response in Hz: 511500
// Alternatively define the marker pattern "10".
SOURce1:BB:GNSS:TRIGger:OUTPut1:MODE PATT
SOURce1:BB:GNSS:TRIGger:OUTPut1:PATTern #H2,2
// Route the marker signal to the USER 1 output connector.
SOURce1:INPut:USER1:DIRection OUTP
OUTput1:USER1:SIGNal MARKA1
// The frequency of the marker signal is also 511500 Hz.
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Commands:

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:MODE..................................................606
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:ONTime................................................606
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:OFFTime..............................................606
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:DELay..................................................606
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:ADELay......................................607
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:STATe.........................................607
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PATTern............................................... 607
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:DIVider......................................607
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:FREQuency?.............................608
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:WIDTh...................................... 608

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> PULSe|PATTern|RATio|PPS|PP2S|PPS10

*RST: PPS

Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Mode" on page 318

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:OFFTime <OffTime>
Sets the number of chips during which the marker output is on or off.

Parameters:
<OffTime> float

Range: 0.000000011  to  0.1822215935
Increment: 1E-9
*RST: 1E-6

Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Mode" on page 318

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the sig-
nals.

Parameters:
<Delay> float

Range: 0  to  0.1822215935
Increment: 1E-9
*RST: 0
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Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Delay" on page 319

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:ADELay
<AdditionalDelay>

Sets an additional delay for the high-precision PPS marker signal.

Parameters:
<AdditionalDelay> float

Range: 0  to  10E-6
Increment: 1E-12
*RST: 0

Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Additional Delay" on page 319

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:HPPS:STATe
<HighPrecPpsStat>

Enables generation of a high-precision PPS marker signal.

Parameters:
<HighPrecPpsStat> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Generate High Precision PPS" on page 319

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PATTern <Pattern>

Defines the bit pattern used to generate the marker signal.

Parameters:
<Pattern> 64 bits

Example: See Example"Generate a marker signal with fixed frequency"
on page 605.

Manual operation: See "Mode" on page 318

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for pulse marker mode (PULSe).
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Parameters:
<Divider> integer

Range: 2  to  1024
*RST: 2

Example: See Example"Generate a marker signal with fixed frequency"
on page 605.

Manual operation: See "Mode" on page 318

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal. The pulse frequency is
derived by dividing the symbol rate by the divider.

Return values: 
<Frequency> float

Example: See Example"Generate a marker signal with fixed frequency"
on page 605.

Usage: Query only

Manual operation: See "Mode" on page 318

[:SOURce<hw>]:BB:GNSS:TRIGger:OUTPut<ch>:PULSe:WIDTh <Width>

Sets the pulse width for 1PPS, 1PP2S and PPS10 marker mode. The maximum pulse
width depends on the marker mode.

Marker mode 1PPS 1PP2S PPS10

Max. pulse width 1 s 2 s 0.1 s

Parameters:
<Width> float

Range: 1E-9  to  depends on the marker mode
Increment: 1E-9
*RST: 1E-6

Example: See Example"Configure and enable marker signals"
on page 605.

Manual operation: See "Mode" on page 318
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21.22  Clock commands

Example: Clock settings
:SOURce1:BB:GNSS:CLOCk:SOURce ELCL
:SOURce1:BB:GNSS:CLOCk:MODE SAMP
:CLOCk:INPUt:FREQuency?

[:SOURce<hw>]:BB:GNSS:CLOCk:SOURce.................................................................... 609

[:SOURce<hw>]:BB:GNSS:CLOCk:SOURce <Source>

Selects the clock source:
● INTernal: Internal clock reference

Parameters:
<Source> INTernal

*RST: INTernal

Example: See Chapter 21.22, "Clock commands", on page 609.

Manual operation: See "Clock Source" on page 320
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Annex
A  User environment files

The R&S SMBV100B supports different file formats that describe a moving receiver.
This section focus on:

● Movement or motion files......................................................................................610
● Vehicle description files (used for smoothening)...................................................622
● Antenna pattern and body mask files....................................................................623

A.1  Movement or motion files

A.1.1  Waypoint file format

A waypoint file is a simple text file (*.txt) that describes a trajectory as a sequence of
positions called waypoints. The file contains a resolution (mandatory) in milliseconds
that specifies the time between two consecutive waypoints. Also a list of waypoint
coordinates (optional), one row per waypoint.

Each waypoint is specified with its longitude [° (decimal format)], latitude [° (decimal
format)], altitude [m], see Example"3GPP performance test Scenario#3 "Melbourne"
(WGS84 geodetic coordinates)" on page 610.

If the defined resolution is different than the internally used resolution of 10 ms, the
waypoint file is resampled and the waypoints linearly interpolated. For more informa-
tion, see Chapter A.1.5, "Resampling principle", on page 620.

Example: 3GPP performance test Scenario#3 "Melbourne" (WGS84 geodetic
coordinates)
The resolution command at the beginning of the file specifies the time (in ms) between
two consecutive waypoints. In this example, it is 50 ms. The value is different than 10
ms; the waypoint file is upsampled, see Chapter A.1.5, "Resampling principle",
on page 620.
RESOLUTION: 50
144.966666334601,-37.8166633061788,100.000000009313
144.966662392613,-37.8166632247233,100.000000039116
144.966658453002,-37.8166630889914,100.00000008475
144.966654516955,-37.8166628990241,100.000000149943
144.966650585658,-37.8166626548785,100.000000235625
144.966646660296,-37.8166623566284,100.000000339001
...
etc.

Movement or motion files



User environment filesSatellite Navigation

611User Manual 1178.9403.02 ─ 10

See also Chapter A.1.6, "Calculating the maximum time duration of a movement file",
on page 621.

Example: Polygonal waypoint file with different resolution
The resolution command at the beginning of the file specifies the time (in ms) between
two consecutive waypoints.
In the example below, the resolution is 5 ms. The value is different than 10 ms; the
waypoint file is downsampled. Samples representing the bold lines in the example
below are removed.
RESOLUTION: 5
144.966666334601,-37.8166633061788,100.000000009313
144.966443162832,-37.8090165067983,100.056669838727
144.973563207169,-37.8081942570311,100.098318068311
144.982795444975,-37.8090450499587,100.214069998823
144.981604761683,-37.8166623866118,100.135388446972
144.966673889123,-37.8166633333333,100.000000008382

Monitor the configured movement in "Simulation Monitor > Display > Map View"; the
polygonal shape is lost due to removal of samples.

In the example below, the resolution is 10 ms that is the internally used resolution for
sampling.
RESOLUTION: 10
144.966666334601,-37.8166633061788,100.000000009313
144.966443162832,-37.8090165067983,100.056669838727
144.973563207169,-37.8081942570311,100.098318068311
144.982795444975,-37.8090450499587,100.214069998823
144.981604761683,-37.8166623866118,100.135388446972
144.966673889123,-37.8166633333333,100.000000008382

Monitor the configured movement in "Simulation Monitor > Display > Map View"; the
polygonal movement is simulated.
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In the example below, the resolution is 50 ms. The value is different than 10 ms; the
waypoint file is upsampled, see Chapter A.1.5, "Resampling principle", on page 620.

RESOLUTION: 50
144.966666334601,-37.8166633061788,100.000000009313
144.966443162832,-37.8090165067983,100.056669838727
144.973563207169,-37.8081942570311,100.098318068311
144.982795444975,-37.8090450499587,100.214069998823
144.981604761683,-37.8166623866118,100.135388446972
144.966673889123,-37.8166633333333,100.000000008382

Monitor the configured movement in "Simulation Monitor > Display > Map View"; sam-
ples are added within the polygonal shape of the movement. Four dots between each
of the five corner dots of the polygon indicate the added samples.

Movement or motion files



User environment filesSatellite Navigation

613User Manual 1178.9403.02 ─ 10

A.1.2  Vector trajectory file format

In the vector trajectory file format, motion is defined in an east North plane which is
tangent to earth at the specified reference point. The curvature of the Earth is not con-
sidered in the interpretation of the Up (U) coordinate elements when moving east or
north.

The vector trajectory file format is suitable for description of city motion where the cur-
vature of the earth is negligible. This file format is not intended for long-distance simu-
lations where the curvature of the earth is significant.

This file format uses a script containing the commands defined in the following table:

Command Description

REFERENCE: Lon, Lat, Alt Specifies the reference point of the East, North and Up (ENU) Carte-
sian coordinate system.

The REFERENCE is specified in ECEF coordinates (Longitude / deg,
Latitude / deg, Altitude / m).

START: E ,N, U, Velocity Start location is the initial "current location" in the ENU Cartesian coor-
dinate of center REFERENCE. East, North and Up (ENU) coordinates
are then provided. The last argument is the start velocity (m/s).

ARC: E, N, Angle Specifies a 2-Dimensional ARC (East / m, North / m) with the first two
arguments representing the center of the ARC (m) in the Cartesian
basis.

The last argument specifies the angle in degrees (deg) of the ARC
starting the "current location". Angle sign is significant because it indi-
cates positive direction (counterclockwise) or negative direction (clock-
wise).

The end edge of the arc represents the new "current location". Velocity
does not change when using an ARC command.
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Command Description

LINE: ∆E, ∆N,
Acceleration

Specifies a 2-dimensional line form the current location or first edge
(Current loc E, Current loc N) to the next location or second
edge (Current loc E + ∆E, Current loc N + ∆N) (East / m,
North / m, Up / m).

The argument Acceleration specifies a constant acceleration/decel-
eration, where Acceleration = 0 indicates constant velocity. Unit
for acceleration is (m/s2).

The second edge is used as the current location for the next command.
The speed at this second edge is also used as the start speed for the
next command.

LINE3D: ∆E, ∆N, ∆U,
Acceleration

Describes a 3-dimensional straight line in ENU coordinates, where the
first edge is described as (E, N, U) and the second edge as (E +
∆E, N + ∆N, U + ∆U) (East / m, North / m, Up / m).

The argument Acceleration specifies a constant acceleration/decel-
eration, where Acceleration = 0 indicates constant velocity. Unit
for acceleration is (m/s2).
*********** MOVEMENT FILE ******************
RESOLUTION: 10
REFERENCE: 0,0,0
START: 0, 0, 10000, 20
LINE3D: 0, 0, -10000, 0

STAY: Time Stay at the current location for Time period (ms).

Example: Example of a waypoint file
This example explains a waypoint file in the second format for the case of the 3GPP
performance test Scenario#3 "Melbourne", as described in TS 34.108 and TS 34.171.
The GPS signals simulate the GPS-receiver moving on a rectangular trajectory of
940m by 1440m with rounded corners defined in Table A-1 and Figure A-1.
The initial reference is first defined followed by acceleration to final speed of 100 km/h
in 250 m. The UE then maintains the speed for 400 m. The speed then decreases to
25 km/h in 250 m. The UE then turn 90 degrees with turning radius of 20 m at 25 km/h.
The speed increases to 100 km/h in 250 m.
The sequence is repeated to complete the rectangle.

Table A-1: Trajectory parameters for moving scenario and periodic update performance test case

Parameter Distance (m) Speed (km/h)

l11, l15, l21, l25 20 25

l12, l14, l22, l24 250 25 to 100 and 100 to 25

l13 400 100

l23 900 100

Movement or motion files



User environment filesSatellite Navigation

615User Manual 1178.9403.02 ─ 10

Figure A-1: Moving scenario

The following is the content of the waypoint file.

The start tag MOVEMENT FILE is a mandatory element for each movement descrip-
tion. If this tag is omitted, the instrument interprets the coordinates described in the
waypoint file as static one.

******************************** MOVEMENT FILE ********************************
%%!! All empty lines or statements starting with %% will be ignored. This file format
%% is used to load a continuous movement file into the signal generator.
%% Enter the WGS-84 reference point's coordinates S.
REFERENCE: 144.96667027777777777777777777777777,-7.81666333333333333333333333333,100
%% From here on, we work in an ENU (EAST-NORTH-UPPER) basis centered around the ENU 
%% reference point S. In more detail, the movement description starts from "START":
%% "START", "EAST COORDINATE E0 relative to S", "NORTH COORDINATE N0 relative to S",
%% "UPPER COORDINATE N0 relative to S", "SPEED in (m/s)" 
START: 0, 0, 0, 6.94444444444444444
%% Each movement segment is described in one line command in the file. The segments are
%% to be read sequentially. It can be either a line description or an arc description.  
%% For a line, we start by the syntax "LINE". For an arc, we start with the syntax "ARC".  
%% In the current version, we provide only EAST-NORTH movement segments "ARC",
%% "Center EAST Coordinate", "Center NORTH Coordinate", "ARC in degrees".
&& Positive or negative values are necessary for orientation.
ARC: 0, 20, -90
%% "LINE", "Second Edge EAST Coordinate, first edge is the current point or last point
&& of the previous segment","Second Edge NORTH Coordinate", "Acceleration/Deceleration".
%% Acceleration is to be taken as the projection following the movement segment.
LINE: 0, 250, 1.44675925925925925926
LINE: 0, 400, 0
LINE: 0, 250, -1.44675925925925925926
ARC: 0, 920, -90
LINE: 250, 0, 1.44675925925925925926
LINE: 900, 0, 0
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LINE: 250, 0, -1.44675925925925925926
ARC: 1400, 920, -90
LINE: 0, -250, 1.44675925925925925926
LINE: 0, -400, 0
LINE: 0, -250, -1.44675925925925925926
ARC: 1400, 20, -90
LINE: -250, 0, 1.44675925925925925926
LINE: -900, 0, 0
LINE: -250, 0, -1.44675925925925925926
%% End of Trajectory description.

A.1.3  NMEA files as source for movement information

The NMEA movement information (receiver-fix location) extracted from a standard
NMEA file can be used as a source for the generation of the movement file of interest.

Refer to Chapter C, "NMEA scenarios", on page 627 for detailed description of the
NMEA file format.

A.1.4  Trajectory description files

Option: R&S SMBVB-K108

The trajectory description files use the file extension *.xtd. See Example"<position-
only> waypoint format with automatic linear time stamp" on page 619 for a simple
example of the file format.

The Table A-2 describes the used tags and parameters.
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Table A-2: Format of *.xtd file

Container Tag name Parameter Description

<general>    

 <property> <waypointfor-
mat>

Defines the format of the waypoint data.
The possible values are:
● "positiononly"

Only waypoint data
● "position_attitude"

Waypoint and attitude data
● "position_velocitymagnitude"

Waypoints and velocity magnitude information per point
● "position_velocitymagnitude_attitude"

Waypoints, velocity magnitude and attitude data
● "position_velocityvector"

Waypoints and velocity vector per location
● "position_velocityvector_attitude"

Waypoints, velocity vector and attitude per point

Proper readout of the three formats <property
waypointformat="*_attitude"> requires option R&S SMBVB-K108.
If you load *.xtd files without this option, the simulation discards the atti-
tude values from the file and uses the default values with constant attitude
behavior.

Smoothening is only possible with <property
waypointformat="positiononly"> and NMEA, waypoints and
*.kml.

The description of the waypoints has to follow the selected format.

For example, the vector <waypointvector
data="0.05,144.966662392613,-37.8166632247233,
100.000000039116"/> with <property
waypointformat="positiononly"/> and
<datavectorhastimestamp="yes"> comprises four values.

  <datavectorhas-
timestamp>

Determines the way the time stamp (elapsed time after simulation start) is
defined.
● With <datavectorhastimestamp="yes">, the parameter time

is mandatory. We recommend to set a time stamp of 0.0
(time="0").
The time stamp of a waypoint is retrieved from the
<waypointvector data>, as the first data vector parameter. If
time stamps do not start with 0.0, the simulation takes the first time
stamp as reference time and shift all following timestamps accord-
ingly. That means the simulation assumes that the first time stamps
correspond to time 0.0.

● With <datavectorhastimestamp="no">, setting the parameter
time leads to errors during read-out:
The time stamp is internally calculated based on the following rule:
– The time stamp of first waypoint is T1 = 0

The time stamp of the waypointN is TN = (N–
1)*<timeresolution>

  <coordsystem> Defines the coordinate system used by the definition of the
<waypointvector data>.

Possible values: "enu", "cart ecef", "geod wgs84" or "geod pz90"

  <timeresolution> If <datavectorhastimestamp="no">, applies implicitly time stamps
to waypoints. Otherwise, the time stamp is retrieved automatically, see
<datavectorhastimestamp>.
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Container Tag name Parameter Description

  <enurefpoint> Defines the coordinates of the reference waypoint in ECEF format:

Longitude (deg), latitude (deg), altitude (m).

  <endbehaviour> Determines the behavior of the moving object at the end of the trajectory.

Possible values: "jump", "return", "stop"

  <attitudeunit> Defines the unit ("rad" or "deg") the attitude is expressed in

  <noofway-
points>

Number of the used waypoints vectors.

Use the parameter to minimize the size of the waypoint without actually
deleting the waypoints

  <attitudecontinu-
ous>

If <attitudecontinuous="no">, the attitude angles to be read are
bounded by 2*PI.

The <attitudecontinuous="yes"> means that they are not boun-
ded.

<waypoints>   Description of the trajectory as a list of waypoint vectors.

 <waypointvec-
tor>

<data> Coordinates of the waypoint in the format selected by <coordsystem>
● [time,]longitude,latitude,altitude (geod wgs84)
● [time,]X,Y,Z (cart ecef)
● [time,]EAST,NORTH,UPPER (enu)

If <datavectorhastimestamp>="yes", setting the time is manda-
tory.

If <datavectorhastimestamp>="no", setting the time leads to errors
during read-out.
Depending on the <property waypointformat>, more information
can be provided. The following is a list of the information appended to the
coordinates of the waypoint mentioned above.
● <property waypointformat="positiononly">

No additional information
● <property waypointformat="position_attitude">

yaw/heading,pitch/elevation,roll/bank, e.g.
[time,]longitude,latitude,altitude,yaw,pitch,roll
The vehicle attitude (yaw, pitch and roll) parameters are configured
relative to the local horizon

● <property
waypointformat="position_velocitymagnitude">
vel, e.g. [time,]X,Y,Z,vel

● <property
waypointformat="position_velocitymagnitude_attitude">
vel,yaw/heading,pitch/elevation,roll/bank, e.g.
[time,]EAST,NORTH,UPPER,vel,yaw,pitch,roll

● <property waypointformat="position_velocityvector">
Velocity vector Vx,Vy,Vz, e.g. [time,]X,Y,Z,Vx,Vy,Vz

● <property
waypointformat="position_velocityvector_attitude">
Vx,Vy,Vz,yaw/heading,pitch/elevation,roll/bank, e.g.
[time,]longitude,latitude,altitude,Vx,Vy,Vz,yaw,
pitch,roll.

Note: If the waypoints are in geoid wgs84, the velocity vector is assumed
in Cartesian ECEF coordinate system.

Waypoint data only files

The following examples emphasize on waypoint files defined with <property
waypointformat="positiononly"> format. Also the time stamp principle is illus-
trated in two different configurations.
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The examples can be easily extended to waypoint file formats also specifying attitude
and/or velocity data as in Table A-2.

Example: <positiononly> waypoint format with automatic linear time stamp
The <waypointvector data> vector has three parameters, because of the tag
<property datavectorhastimestamp="no">. If you also define a fourth value,
e.g. time, the waypoint data is read out erroneously.

The time stamps Tx are derived from the tag <property
timeresolution="0.05">. The distribution of the time stamps is linear:

T1 = 0, T2 = (2-1)*0.05 = 0.05, and so on, T12 = (12-1)*0.05 = 0.55

<trajectory>
    <general>
        <property waypointformat="positiononly"/>
        <property datavectorhastimestamp="no"/>
        <property coordsystem="enu"/>
        <property timeresolution="0.05"/>
        <property enurefpoint="54.0,10.0,12"/>
        <property endbehaviour="return"/>
        <property noofwaypoints="12"/>
    </general>
    <waypoints>
        <waypointvector data="0,0,0"/>
        <waypointvector data="0,1,0"/>
        <waypointvector data="0,2,0"/>
        <waypointvector data="0,3,0"/>
        <waypointvector data="0,4,0"/>
        <waypointvector data="0,5,0"/>
        <waypointvector data="0,6,0"/>
        <waypointvector data="0,7,0"/>
        <waypointvector data="0,8,0"/>
        <waypointvector data="0,9,0"/>
        <waypointvector data="0,10,0"/>
        <waypointvector data="0,11,0"/>
</waypoints>
</trajectory>

Example: <positiononly> waypoint format with manual non-linear time stamp
The <waypointvector data> vector has four parameters, because of the tag
<property datavectorhastimestamp="yes">.
The time stamps Tx are retrieved from the first value in the <waypointvector
data> vector. You can set the time stamps individually and define a non-linear distribu-
tion:

T1 = 0, T2 = 0.0081, and so on, T12 = 0.953.

<trajectory>
    <general>

Movement or motion files
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        <property waypointformat="positiononly"/>
        <property datavectorhastimestamp="yes"/>
        <property coordsystem="cart ecef"/>
        <property endbehaviour="jump"/>
        <property attitudeunit="rad"/>
        <property attitudecontinuous="yes"/>
    </general>
    <waypoints>
        <waypointvector data="0.0000, 4178032.9245, 856266.1330, 4727289.0482"/>
        <waypointvector data="0.0081, 4178032.1214, 856270.0516, 4727289.0482"/>
        <waypointvector data="0.0323, 4178031.3183, 856273.9701, 4727289.0482"/>
        <waypointvector data="0.0727, 4178030.5153, 856277.8887, 4727289.0482"/>
        <waypointvector data="0.1290, 4178029.7122, 856281.8072, 4727289.0482"/>
        <waypointvector data="0.2011, 4178028.9091, 856285.7258, 4727289.0482"/>
        <waypointvector data="0.2889, 4178028.1060, 856289.6443, 4727289.0482"/>
        <waypointvector data="0.3921, 4178027.3030, 856293.5629, 4727289.0482"/>
        <waypointvector data="0.5105, 4178026.4999, 856297.4814, 4727289.0482"/>
        <waypointvector data="0.6436, 4178025.6968, 856301.4000, 4727289.0482"/>
        <waypointvector data="0.7913, 4178024.8937, 856305.3186, 4727289.0482"/>
        <waypointvector data="0.9530, 4178024.0906, 856309.2371, 4727289.0482"/>
</waypoints>
</trajectory>

A.1.5  Resampling principle

The resampling principle is common to all movement or motion files. To explain the
principle, we use the simple waypoint file text format described in Chapter A.1.1, "Way-
point file format", on page 610.

The 3GPP performance test Scenario#3 file "Melbourne" uses a resolution of 50 ms.

This resolution is different than the internally used resolution of 10 ms. The waypoint
file is resampled (in this case upsampled) and the waypoints linearly interpolated. Four
samples are inserted between any two consecutive waypoints so that the sampling
rate of 100 Hz (10ms) is achieved.

Figure A-2: Principle of waypoint file upsampling (extract of a waypoint file shown)

1, 2, 3 = Coordinates of the first three waypoints in the file
4 = Resolution
5 = Inserted waypoints

If a resolution of 5 ms is used in the same waypoint file, this file is downsampled. Each
second waypoint is discarded. This case is illustrated on Figure A-3.

Movement or motion files
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Figure A-3: Principle of waypoint file downsampling (extract of a waypoint file shown)

1, 2, 3 = Coordinates of the first three waypoints in the file
2 = Second waypoint removed
4 = Resolution

The described resampling principle applies also for resolutions that are not multiple of
10 ms.

For information on the impact of the used resolution on the number of possible way-
points, see Chapter A.1.6, "Calculating the maximum time duration of a movement
file", on page 621.

A.1.6  Calculating the maximum time duration of a movement file

The R&S SMBV100B loads the movement and the motion files in the RAM memory.
Hence, it is the available RAM memory that limits the duration of a simulated move-
ment.

If a movement is described for example as a waypoint file, its duration is the product of
the used resolution and the number of waypoints. Thus, the maximum number of way-
points in a waypoint file depends on the used resolution.

For a given available RAM memory, the maximum time duration tmax a waypoint file can
have, is calculated as:

tmax [ms] = (RAMSize [bytes]/6*8[bytes])*10[ms], where:
● The RAMSize is the available RAM memory size, e.g. 1 Gbyte;
● 10 ms is the internal resolution
● 6*8 bytes are required to save one resampled waypoint;

Waypoints values are defined in double-precision floating point format (doubles)
and a resampled waypoint requires 6 doubles with 8 bytes each.

A warning message indicates the following situations:
● The time duration of the loaded waypoint file exceeds the maximum allowed value
● The RAM memory is insufficient to process the file

Movement or motion files
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Example: 
If a waypoint file contains 4 waypoints and uses a resolution of 50 ms, then:
● #Waypoints*ResolutionWaypointFile = tWaypointFile, i.e. the waypoint file is 4*50 = 200 ms

long.
● The file is resampled to the internal resolution of 10 ms (i.e. sampling rate of 100

Hz) and the resulting number of samples is:
#Samples = tWaypointFile [ms] / ResolutionInternal[ms] = 200 / 10 = 20

● Storing these 20 samples requires a memory of #Samples * 6*8 [bytes] = 20*48 =
960 bytes.

A.2  Vehicle description files (used for smoothening)

The vehicle description files use the file extension *.xvd. The following is a simple
example of the file format.

<vehicle>
    <info name="Car"/>
    <limits>
        <property maxspeed="100.0"/>
        <property maxacceleration="0.6"/>
        <property maxacceleration_lateral="0.6"/>
        <property maxjerk="15"/>
        <property maxjerk_lateral="15"/>
        <property proximity="0"/>
    </limits>
</vehicle>

The Table A-3 describes the used tags and parameters.
Table A-3: Format of *.xvd file

Container Tag name Parameter Description

<info>    

 <name>  Vehicle name

<limits>    

 <property> <maxspeed> Maximum speed (m/s)

  <maxacceleration> Maximum tangential acceleration (m/s2)

  <maxacceleration_lateral> Maximum radial acceleration (m/s2) due to centrifugal force

  <maxjerk> Maximum tangential Jerk (m/s3)

  <maxjerk_lateral> Maximum radial Jerk (m/s3)

  <proximity> Specifies the maximum allowed deviation from the original
waypoints (m)

Vehicle description files (used for smoothening)
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A.3  Antenna pattern and body mask files

Option: R&S SMBVB-K108

Three files describe an antenna: the body mask file *.body_mask, the antenna pat-
tern *.ant_pat file and the phase response *.phase file.

The *.ant_pat file describes the power response matrix of each antenna. The instru-
ment retrieves the phase response matrix from the *.phase file. If the required
*.phase file does not exist, a zero-phase response is assumed. Antenna pattern and
phase files must have the same filename and must be saved in the same directory.
These files have the same content but different data section <data> (see Table A-4).

The following are two examples of the file format: an extract of the description of an
antenna pattern with three antennas and description of an antenna with four sectors.

Example: Antenna pattern with three antennas
The following is a file content extract from the predefined file
Space_Vehicle_3_antennas.body_mask.

<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr count="3" use_same_pattern="no">
    <antenna id="1" RollAxis_X_offset="0" PitchAxis_Y_offset=" 0.0000" 
                    YawAxis_Z_offset=" 0.2000"  Yaw_offset="0" Pitch_offset="0" 
                    Roll_offset="0" />
    <antenna id="2" RollAxis_X_offset="0" PitchAxis_Y_offset="-0.1414" 
                    YawAxis_Z_offset="-0.1414"  Yaw_offset="0" Pitch_offset="0" 
                    Roll_offset="120"/>
    <antenna id="3" RollAxis_X_offset="0" PitchAxis_Y_offset=" 0.1414" 
                    YawAxis_Z_offset="-0.1414"  Yaw_offset="0" Pitch_offset="0" 
                    Roll_offset="240" />
  </antenna_descr>
  <az_res> 1.00000000e+000 </az_res>
  <elev_res> 1.00000000e+000 </elev_res>
  <data>
     -179.5,-178.5,-177.5,-176.5,-175.5,-174.5,-173.5,-172.5,-171.5,-170.5,-169.5,-168.5,
     -167.5,-166.5,-165.5,-164.5,-163.5,-162.5,-161.5,-160.5,-159.5,-158.5,-157.5,-156.5,
     -155.5,-154.5,-153.5,-152.5,-151.5,-150.5,-149.5,-148.5,-147.5,-146.5,-145.5,-144.5,
     -143.5,-142.5,-141.5,-140.5,-139.5,-138.5,-137.5,-136.5,-135.5,-134.5,-133.5,-132.5,
     ...
  </data>
</antenna_pattern>

Example: Antenna with four sectors
The following is a file describing an antenna with four sectors.

<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
 <antenna_descr count="1" use_same_pattern="no">

Antenna pattern and body mask files
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    <antenna id="1" YawAxis_Z_offset="0" PitchAxis_Y_offset="0"  
                    RollAxis_X_offset="0" Yaw_offset="0" Pitch_offset="90"
                    Roll_offset="0" />
 </antenna_descr>
 <az_res> 90.00000000e+000 </az_res>
 <elev_res> 90.00000000e+000 </elev_res>
  <data>
                -135.0,-45.0,45.0,135,45.0,0.0,3.0,6.0,9.0,-45.0,0.0,3.0,6.0,9.0
  </data>
</antenna_pattern>

The Table A-4 describes the used tags and parameters.
Table A-4: Format of *.body_mask, *.ant_pat and *.phase files

Container Tag name Parameter Description

<antenna_pattern>   Defines antenna pattern file

<antenna_descr>   Contains the descriptions of the antennas

  <count> Number of antenna patterns. Value range = 1 to 4.

  <use_same_pattern> Specify whether the same data section is used for all
the antennas or not.
● "yes": the data section is used for all antennas
● "no": the data section is augmented with the data

of all antennas consecutively

 <antenna>  Descriptions of the individual antenna

  <id> Antenna identification number

  <YawAxis_Z_offset>

<PitchAxis_Y_offset>

<RollAxis_X_offset>

Position shift of the antenna along the X/Y/Z axis rela-
tive to the center of gravity of the body

Value in meters

  <Yaw_offset>

<Pitch_offset>

<Roll_offset>

Angular shift of the antenna along the X/Y/Z axis of the
body

Value in degrees

<az_res>   Resolution of the columns in the data section

Value in degrees integer divider of 360

Antenna pattern and body mask files
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Container Tag name Parameter Description

<elev_res>   Resolution of the rows in the data section

Value in degrees integer divider of 180

<data>   The file has to contain for every pattern:
● [1 + 360/<az_res>] columns
● [1 + 180/<elev_res>] rows

Title column and row are disregarded

If the <use_same_pattern=”yes”> only one pattern
is sufficient, otherwise the other patterns must be
appended after each other inside this section

If the data represents the power response of the
antenna (*.ant_pat file), the power loss values are
in dB (between 0 and 40)

If the data represents the phase response of the
antenna (*.phase file), the phase values are in
degrees

Antenna pattern and body mask files
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B  RINEX files
The RINEX file format consists of three ASCII file types: observation data file, naviga-
tion message file and meteorological data file. The navigation RINEX files provide the
ephemeris information of all visible satellites at a control station or a commercial
receiver.

Each file type consists of a header section and a data section. The header section con-
tains global information for the entire file and is placed at the beginning of the file. The
format of the data records of the RINEX navigation message files can contain naviga-
tion messages of more than one satellite system (GPS, GLONASS, Galileo, etc.).

Navigation files

The GNSS firmware of the R&S SMBV100B can import and generate RINEX naviga-
tion files. For supported file formats and extensions per GNSS system, see Table B-1.
Table B-1: File format and file extension per GNSS

Format GPS Galileo BeiDou GLONASS QZSS NavIC

RINEX 2.x *.<xx>n - - *.<xx>g - -

RINEX 3.x *.rnx *.rnx *.rnx *.rnx *.rnx *.rnx

Where <xx> indicates for the year of the recording. For example, the extensions .12n
indicates a GPS ephemeris file, recorded in 2012.

Specification and download sources

Find latest information on the RINEX file format and download sources for RINEX navi-
gation files, for example, on the following websites:
● RINEX file format specifications all versions:

https://files.igs.org/pub/data/format
● RINEX file format specification version 3.04:

https://files.igs.org/pub/data/format/rinex304.pdf
● RINEX navigation files (registration required):

https://cddis.nasa.gov/archive/gnss/data/daily/

https://files.igs.org/pub/data/format
https://files.igs.org/pub/data/format/rinex304.pdf
https://cddis.nasa.gov/archive/gnss/data/daily/
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C  NMEA scenarios
The National Marine Electronic Association (NMEA) is a broadcasting standard sup-
ported by all navigation receivers. The NMEA files comprise information about com-
mon parameters related to the satellite constellation, navigation parameters, time,
receiver location and dynamics. The Table C-1 defines the starting acronym for a
NMEA command of a specific navigation standard. In the moment this firmware is
released, the Galileo NMEA acronym has not been defined yet.
Table C-1: Overview of the starting acronyms for the NMEA command

ID Meaning

AG Autopilot - General

AP Autopilot - Magnetic

CC Computer - Programmed Calculator (outdated)

CD Communications - Digital Selective Calling (DSC)

CM Computer - Memory Data (outdated)

CS Communications - Satellite

CT Communications - Radio-Telephone (MF/HF)

CV Communications - Radio-Telephone (VHF)

CX Communications - Scanning Receiver

DE DECCA Navigation

DF Direction Finder

EP Emergency Position Indicating Beacon (EPIRB)

ER Engine Room Monitoring Systems

GP Global Positioning System (GPS)

GL GLONASS

HC Heading - Magnetic Compass

HE Heading - North Seeking Gyro

HN Heading - Non North Seeking Gyro

II Integrated Instrumentation

IN Integrated Navigation

LA Loran A

LC Loran C

MP Microwave Positioning System (outdated)

OM OMEGA Navigation System
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Example of NMEA File

$GPVTG,,T,,M,0.000,N,0.000,K,A*23
$GPGGA,215810.00,3540.00066,N,13944.99611,E,1,04,1.61,6.8,M,39.4,M,,*5E
$GPGSA,A,3,06,09,04,10,,,,,,,,,2.47,1.61,1.87*01
$GPGSV,4,1,14,29,48,312,,26,47,312,,06,35,302,47,09,18,238,47*71
$GPGSV,4,2,14,27,47,312,,13,50,118,,04,72,181,47,30,48,312,*76
$GPGSV,4,3,14,14,39,070,,10,12,050,47,31,48,312,,07,64,349,*72
$GPGSV,4,4,14,25,47,312,,28,48,312,*7E
$GPGLL,3540.00066,N,13944.99611,E,215810.00,A,A*69
$GPZDA,215810.00,28,04,2023,00,00*64
$GPRMC,215811.00,A,3540.00066,N,13944.99611,E,0.000,,280423,,,A*7E
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D  QZSS navigation message scheduling
The table on Figure D-1 shows the structure of the QZSS navigation message, as it is
implemented in the R&S SMBV100B.

Figure D-1: QZSS navigation message structure

The QZSS navigation message structure used in R&S SMBV100B deliberately devi-
ates from the QZSS navigation message scheduling published on the Jaxa web page:
http://qz-vision.jaxa.jp/USE/is-qzss/pattern/pattern_L1CA_N_e.html

The reason for this deviation is that the R&S SMBV100B can simulate the signal of up
to three QZSS satellites, while the published information applies for the only one avail-
able QZSS satellite.

http://qz-vision.jaxa.jp/USE/is-qzss/pattern/pattern_L1CA_N_e.html
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E  Predefined GNSS scenarios
If equipped with the GNSS system options, the R&S SMBV100B also supports test
scenarios for assisted GNSS (A-GNSS) protocol and conformance test cases.

How to: "To use predefined scenarios" on page 29

The following chapters provide an overview on the 3GPP technical specifications (TS)
documents and the related A-GNSS scenario. Also it provides a summary of all test
scenarios that are offered on the R&S SMBV100B.

Example: Understanding the name of a R&S SMBV100B test scenario
The filename of the R&S SMBV100B test scenario relates directly to the 3GPP techni-
cal specifications (TS) document, the subclause, the test case and the subtest case.
The table Table E-1 states the different name elements to illustrate the relation
between R&S SMBV100B test scenario and the corresponding 3GPP test case.
Table E-1: R&S SMBV100B test scenario and 3GPP test case

Name element R&S SMBV100B test scenario name 3GPP test case name

- "3GPP TS 37.571-1: S7 Performance 5
ST1"

3GPP TS 37.571-1 subclause 7: A-GPS
Performance scenario 5, Subtest 1

Organization 3GPP 3GPP

Technical specification TS 37.571-1 TS 37.571-1

Subclause S7 Subclause 7

Test case Performance 5 A-GPS Performance scenario 5

Subtest case ST1 Subtest 1

The support of the assisted GNSS with the test scenario is provided by the installation
of the corresponding GNSS system option.

● 3GPP TS and assisted GNSS...............................................................................630
● Assisted GNSS test scenarios.............................................................................. 631
● Assisted GNSS 2020 test scenarios..................................................................... 636
● Real constellations reference scenarios............................................................... 640
● Galileo OSNMA scenarios.................................................................................... 640

E.1  3GPP TS and assisted GNSS

The 3GPP TS documents specify A-GNSS signaling and performance requirements
test cases. These test cases include subtest cases that require specific A-GNSS sup-
port by the user equipment (UE). The content of the assistance data depends on the
subtest case.

For an overview of the 3GPP TS subtest cases, relevant subclause and A-GNSS sup-
port by the UE, see the following tables.

3GPP TS and assisted GNSS
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Table E-2: TS 37.571-2: Subtest cases per subclause and A-GNSS support by UE

Subtest case Subclause UTRA (S6) Subclause E-UTRA (S7)

ST1 A-GLONASS A-GPS

ST2 A-Galileo A-GLONASS

ST3 A-GPS and modernized GPS A-Galileo

ST4 A-GPS and A-GLONASS A-GPS and A-GLONASS

ST8 A-GPS and A-Galileo A-GPS and A-Galileo

ST9 A-BDS A-BDS

ST10 A-GPS and A-BDS A-GPS and A-BDS

Table E-3: TS 37.571-1: Subtest cases per subclause and A-GNSS support by UE

Subtest case Subclause UTRA (S6) Subclause E-UTRA (S7)

ST1 A-GLONASS A-GPS

ST2 A-Galileo A-GLONASS

ST3 A-GPS and modernized GPS A-Galileo

ST4 A-GPS and A-GLONASS A-GPS and modernized GPS

ST5 - A-GPS and A-GLONASS

ST8 A-GPS and A-Galileo A-GPS and A-Galileo

ST9 A-BDS A-BDS

ST10 A-GPS and A-BDS A-GPS and A-BDS

ST11 A-GPS, A-GLONASS and A-BDS A-GPS, A-GLONASS and A-BDS

ST12 A-GPS, A-Galileo and A-GLONASS A-GPS, A-Galileo and A-GLONASS

ST13 A-GPS, A-Galileo and A-BDS A-GPS, A-Galileo and A-BDS

E.2  Assisted GNSS test scenarios

This section lists all predefined scenarios in the folder "Assisted GNSS". The scenarios
are grouped into subfolders of the corresponding cellular standard (GSM, 3GPP FDD,
3GPP2, EUTRA/LTE).

For each subfolder/cellular standard, a table provides an overview on scenario name,
required options, motion type and location.
● For GSM scenarios, see Table E-4.
● For 3GPP FDD scenarios, see Table E-5.
● For 3GPP2 scenarios, see Table E-6.
● For EUTRA/LTE scenarios, see Table E-7.

To understand, which GNSS is used in which scenario, see the GNSS system options
in the required options column of the table.

Assisted GNSS test scenarios
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Table E-4: GSM subfolder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 51.010: 10.9 Signaling R&S SMBVB-K44 Static Tokyo

3GPP TS 51.010: 10.10 Performance 1 R&S SMBVB-K44 Static Tokyo

3GPP TS 51.010: 10.10 Performance 2 R&S SMBVB-K44 Static Sunnyvale

3GPP TS 51.010: 10.10 Performance 3 R&S SMBVB-K44 Dynamic Sunnyvale

Table E-5: 3GPP FDD subfolder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 34.108: 10.7 Signaling R&S SMBVB-K44 Static Tokyo

3GPP TS 34.108: 10.1.2 Performance 1 R&S SMBVB-K44 Static Tokyo

3GPP TS 34.108: 10.1.2 Performance 2 R&S SMBVB-K44 Static Sunnyvale

3GPP TS 34.108: 10.1.2 Performance 3 R&S SMBVB-K44 Dynamic Sunnyvale

3GPP TS 37.571-2: S6 Signaling ST1 R&S SMBVB-K94 Static Tokyo

3GPP TS 37.571-2: S6 Signaling ST2 R&S SMBVB-K66 Static Tokyo

3GPP TS 37.571-2: S6 Signaling ST4 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K136 *)

Static Tokyo

3GPP TS 37.571-2: S6 Signaling ST8 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K136 *)

Static Tokyo

3GPP TS 37.571-2: S6 Signaling ST9 R&S SMBVB-K107 Static Tokyo

3GPP TS 37.571-2: S6 Signaling ST10 R&S SMBVB-K44

R&S SMBVB-K107

R&S SMBVB-K136 *)

Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST1 R&S SMBVB-K94 Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST2 R&S SMBVB-K66 Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST9 R&S SMBVB-K107 Static Tokyo

3GPP TS 37.571-1: S6 Performance 1 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Tokyo

3GPP TS 37.571-1: S6 Performance 2 ST1 R&S SMBVB-K94 Static Sunnyvale

3GPP TS 37.571-1: S6 Performance 2 ST2 R&S SMBVB-K66 Static Sunnyvale

Assisted GNSS test scenarios
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R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 37.571-1: S6 Performance 2 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Static Sunnyvale

3GPP TS 37.571-1: S6 Performance 2 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Sunnyvale

3GPP TS 37.571-1: S6 Performance 2 ST9 R&S SMBVB-K107 Static Sunnyvale

3GPP TS 37.571-1: S6 Performance 2 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST1 R&S SMBVB-K94 Dynamic Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST2 R&S SMBVB-K66 Dynamic Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Dynamic Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST9 R&S SMBVB-K107 Dynamic Sunnyvale

3GPP TS 37.571-1: S6 Performance 5 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Dynamic Sunnyvale

*) TS 37.571-2 S6 signaling scenarios, subtests 4, 8 and 10 require additional channel
options (e.g. R&S SMBVB-K136). These subtests require a larger simulation capacity
for simulating more complex hybrid GNSS satellite constellations.
Table E-6: 3GPP2 subfolder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP2 C.S0036 2.1.1 Stationary R&S SMBVB-K44 Static Sunnyvale

3GPP2 C.S0036 2.1.2 Moving R&S SMBVB-K44

R&S SMBVB-K136 *)

Dynamic Sunnyvale

*) 3GPP2 C.S0036 2.1.2 Moving scenario requires additional channel option (e.g.
R&S SMBVB-K136). These subtests require a larger simulation capacity for simulating
more complex hybrid GNSS satellite constellations.
Table E-7: EUTRA/LTE folder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 37.571-2: S7 Signaling ST1 R&S SMBVB-K44 Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST2 R&S SMBVB-K94 Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST3 R&S SMBVB-K66 Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST4 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K136 *)

Static Tokyo

Assisted GNSS test scenarios
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R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 37.571-2: S7 Signaling ST8 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K136 *)

Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST9 R&S SMBVB-K107 Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST10 R&S SMBVB-K44

R&S SMBVB-K107

R&S SMBVB-K136 *)

Static Tokyo

3GPP TS 37.571-2: S7 Signaling ST15 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

R&S SMBVB-K107

4 x R&S SMBVB-K136
*)

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST1 R&S SMBVB-K44 Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST2 R&S SMBVB-K94 Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST3 R&S SMBVB-K66 Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST9 R&S SMBVB-K107 Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Static Tokyo

3GPP TS 37.571-1: S7 Performance 1 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Static Tokyo

3GPP TS 37.571-1: S7 Performance 2 ST1 R&S SMBVB-K44 Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST2 R&S SMBVB-K94 Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST3 R&S SMBVB-K66 Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Static Sunnyvale
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R&S SMBV100B test scenario Required options Motion type Location

3GPP TS 37.571-1: S7 Performance 2 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST9 R&S SMBVB-K107 Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 2 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Static Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST1 R&S SMBVB-K44 Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST2 R&S SMBVB-K94 Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST3 R&S SMBVB-K66 Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST9 R&S SMBVB-K107 Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP TS 37.571-1: S7 Performance 5 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Dynamic Sunnyvale

*) TS 37.571-2 S7 signaling scenarios, subtests 4, 8, 10 and 15 require additional
channel options (e.g. R&S SMBVB-K136). These subtests require a larger simulation
capacity for simulating more complex hybrid GNSS satellite constellations.

Assisted GNSS test scenarios
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E.3  Assisted GNSS 2020 test scenarios

This section lists all predefined scenarios in the folder "Assisted GNSS 2020". The sce-
narios are grouped into subfolders of the corresponding cellular standard (3GPP FDD
2020, EUTRA/LTE 2020).

For each subfolder/cellular standard, a table provides an overview on scenario name,
required options, motion type and location.
● For 3GPP FDD 2020 scenarios, see Table E-8.
● For EUTRA/LTE 2020 scenarios, see Table E-9.

To understand, which GNSS is used in which scenario, see the GNSS system options
in the required options column of the table.
Table E-8: 3GPP FDD 2020 subfolder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP-2020 TS 37.571-2: S6 Signaling ST1 R&S SMBVB-K94 Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST2 R&S SMBVB-K66 Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST3 R&S SMBVB-K44 Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST4 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K136 *)

Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST8 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K136 *)

Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST9 R&S SMBVB-K107 Static Tokyo

3GPP-2020 TS 37.571-2: S6 Signaling ST10 R&S SMBVB-K44

R&S SMBVB-K107

R&S SMBVB-K136 *)

Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST1 R&S SMBVB-K94 Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST2 R&S SMBVB-K66 Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST3 R&S SMBVB-K44 Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST9 R&S SMBVB-K107 Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 1 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Tokyo

3GPP-2020 TS 37.571-1: S6 Performance 2 ST1 R&S SMBVB-K94 Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 2 ST2 R&S SMBVB-K66 Static Sunnyvale
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R&S SMBV100B test scenario Required options Motion type Location

3GPP-2020 TS 37.571-1: S6 Performance 2 ST3 R&S SMBVB-K44

R&S SMBVB-K136 *)

Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 2 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 2 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 2 ST9 R&S SMBVB-K107 Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 2 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST1 R&S SMBVB-K94 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST2 R&S SMBVB-K66 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST3 R&S SMBVB-K44

R&S SMBVB-K136 *)

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST4 R&S SMBVB-K44

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST9 R&S SMBVB-K107 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S6 Performance 5 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Dynamic Sunnyvale

*) TS 37.571-2 S6 signaling scenarios, subtests 4, 8 and 10 and TS 37.571-1 S6 per-
formance scenarios, subtests 2 and 3 require additional channel options (e.g.
R&S SMBVB-K136). These subtests require a larger simulation capacity for simulating
more complex hybrid GNSS satellite constellations.
Table E-9: EUTRA/LTE 2020 folder: A-GNSS test scenarios

R&S SMBV100B test scenario Required options Motion type Location

3GPP-2020 TS 37.571-2: S7 Signaling ST15 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

R&S SMBVB-K107

4 x R&S SMBVB-K136
*)

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST1 R&S SMBVB-K44

R&S SMBVB-K136 *)

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST2 R&S SMBVB-K94 Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST3 R&S SMBVB-K66 Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST4 R&S SMBVB-K44 Static Tokyo
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R&S SMBV100B test scenario Required options Motion type Location

3GPP-2020 TS 37.571-1: S7 Performance 1 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST9 R&S SMBVB-K107 Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 1 GQ R&S SMBVB-K44

R&S SMBVB-K106

Static Tokyo

3GPP-2020 TS 37.571-1: S7 Performance 2 ST1 R&S SMBVB-K44

R&S SMBVB-K136 *)

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST2 R&S SMBVB-K94 Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST3 R&S SMBVB-K66 Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST4 R&S SMBVB-K44

R&S SMBVB-K136 *)

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST9 R&S SMBVB-K107 Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 2 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Static Sunnyvale
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R&S SMBV100B test scenario Required options Motion type Location

3GPP-2020 TS 37.571-1: S7 Performance 2 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Static Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 3B GN R&S SMBVB-K44

R&S SMBVB-K97

Static Sigar

3GPP-2020 TS 37.571-1: S7 Performance 4B GN R&S SMBVB-K44

R&S SMBVB-K97

Static Maldives

3GPP-2020 TS 37.571-1: S7 Performance 4D GQ R&S SMBVB-K44

R&S SMBVB-K106

Static Kyoto

3GPP-2020 TS 37.571-1: S7 Performance 5 ST1 R&S SMBVB-K44 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST2 R&S SMBVB-K94 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST3 R&S SMBVB-K66 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST4 R&S SMBVB-K44

R&S SMBVB-K136 *)

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST5 R&S SMBVB-K44

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST8 R&S SMBVB-K44

R&S SMBVB-K66

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST9 R&S SMBVB-K107 Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST10 R&S SMBVB-K44

R&S SMBVB-K107

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST11 R&S SMBVB-K44

R&S SMBVB-K94

R&S SMBVB-K107

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST12 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

Dynamic Sunnyvale

3GPP-2020 TS 37.571-1: S7 Performance 5 ST13 R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K107

Dynamic Sunnyvale

*) TS 37.571-2 S7 signaling scenario, subtest 15 and TS 37.571-2 S7 performance
scenarios, subtests 1 and 3 require additional channel options (e.g. R&S SMBVB-
K136). These subtests require a larger simulation capacity for simulating more com-
plex hybrid GNSS satellite constellations.
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E.4  Real constellations reference scenarios

This section lists predefined scenarios in the folder "Real Constellations Reference
Scenarios", see Table E-10. The subfolder provides one scenario with navigation data
and satellite constellations for GPS, Galileo, GLONASS and BeiDou. The data is provi-
ded from the specific GNSS reference stations for a certain date ("2022-07-25").

To simulate the reference scenario, install the basic GNSS system options as in col-
umn "Required options" below.
Table E-10: 2022-07-25 Broadcast Data subfolder: Test scenarios

R&S SMBV100B test scenario Required options

2022-07-25 GPS GAL GLO BDS R&S SMBVB-K44

R&S SMBVB-K66

R&S SMBVB-K94

R&S SMBVB-K107

E.5  Galileo OSNMA scenarios

If equipped with R&S SMBVB-K66, the R&S SMBV100B supports predefined scenar-
ios related to Galileo OSNMA test vectors. For a list of predefined scenarios in the
"Galileo OSNMA" folder, see Table 12-2.

Galileo OSNMA scenarios
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F  Ionospheric grid file format
Customized ionospheric grids can be exported and saved as *.iono_grid files.
Such files can be imported and used for the simulation of the MOPS-D0-229D iono-
spheric model. If imported together with *.ems or *.nstb files, custom ionospheric
grid files can also be mixed with the SBAS files, for example to create an ionospheric
grid covering the entire world map. See Example"Importing grid files" on page 399 for
an example grid configuration.

The *.iono_grid files are XML files in a Rohde & Schwarz proprietary file format .
They contain Vertical Delay, GIVEI value pairs with 5° and 15 minutes resolu-
tion.

Example: Ionospheric grid file content (extract)
<?xml version="1.0" encoding="ISO-8859-1"?>
<REGION sys = "EGNOS">
<IODI init_val="0"/>
<IGP_GRID DateTime="19-02-2014 06:11:47">
<data>
   -180      -175      -170      -165      -160 ... 170       175   
     85    none      none      none      none ... none       none
...
    -85    none      none      none      none ... none       none
 </data>
 </IGP_GRID>
...
<IGP_GRID DateTime="19-02-2014 06:27:57">
<data>
   -180      -175      -170      -165      -160 ... 170       175   
     85    none      none      none      none ... none       none
...
    -85    none      none      none      none ... none       none
 </data>
 </IGP_GRID>
 </REGION>
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G  Channel budget
The number of GNSS channels, that you can simulate, depends on the instrument
hardware and installed options. GNSS system options and "Add x GNSS channels"
options contribute to the number of available channels. Adding more GNSS system
options does increase the number of available channels. Install "Add x GNSS chan-
nels" to increase simulation capacity.

For more information, see data sheet.

G.1  Hardware resources

The field programmable gate array (FPGA) of the R&S SMBV100B consists of three
banks (0 to 2) and several subbanks used for the generation of GNSS signals. Each
bank can simulate only one frequency band L1, L2 or L5 at a time. The frequency band
is assigned automatically, so that a maximum number of hardware resources from the
FPGA banks are used.

A maximum number of 102 GNSS channels can be simulated. A limiting factor is the
limited number of visible satellites within the satellite constellation.

The table below illustrates the FPGA structure, the supported signals by the subbanks
and the FPGA channel capacity.

Bank Subbank Signal Channel capacity

0 0_A C/A, E1 OS, B1I, L5 SPS 12

 0_B C/A, E1 OS, B1I, L5, E5a, E5b, B2I, L5 SPS 12

 0_C C/A, E1 OS, B1I, P, L5, E5a, E5b, B2I, L5 SPS 18

 All subbanks All signals except L2C 42

1 1_A C/A, E1 OS, B1I, L2C, L5, E5a, E5b, B2I, L5 SPS 16

 1_B C/A, E1 OS, B1I, P, L5, E5a, E5b, B2I, L5 SPS 16

 All subbanks All signals 32

2 2_A C/A, E1 OS, B1I, L2C, L5, E5a, E5b, B2I, L5 SPS 28

 All subbanks All signals except P 28

All banks   102

In the following, a few examples illustrate the channel capacity and the used FPGA
resources.
● Example"GPS L1 and L2 band with C/A and P signals" on page 643
● Example"GPS L1, L2, L5 signals and one echo signal per satellite" on page 643
● Example"GPS and Galileo L1 and L5 signals" on page 643

Hardware resources
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● Example"GPS and GLONASS L1 and L2 signals" on page 644

Example: GPS L1 and L2 band with C/A and P signals

Bank Subbank Band and signal Channel capacity

0 0_A L1 C/A 111)

 0_B L1 P 111)

1 1_A L2 C/A 111)

 1_B L2 P 111)

2 - - 0

All banks   44

1) a maximum of 11 GPS satellites are visible. You can increase the number of chan-
nels to depends on installed options by adding non-visible satellites, but they are not
simulated in the composite GNSS signal.

Example: GPS L1, L2, L5 signals and one echo signal per satellite

Bank Subbank Band and signal Channel capacity

0 0_A L1 C/A 121)

 0_B L1 C/A 61)

1 1_A L2 C/A 161)

 1_B L2 C/A 21)

2 2_A L5 GPS L5 181)

All banks   54

1) 9 GPS satellites and one echo signal for each satellite are simulated.

Example: GPS and Galileo L1 and L5 signals

Bank Subbanks Band and signal Channel capacity

0 0_A L1 C/A or L1 E1OS 121)

 0_B L1 C/A or L1 E1OS 71)

1 1_A L1 C/A or L1 E1OS 91)

2 2_A L5 L5, L5 E5a, L5 E5b 181)

All banks   46

1) 9 GPS and 8 Galileo satellites are simulated.

Hardware resources
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Example: GPS and GLONASS L1 and L2 signals

Bank Subbanks Band and signal Channel capacity

0 0_A L1 C/A 121)

 0_B L1 C/A 81)

1 1_A L2 C/A 111)

 1_B L2 C/A 91)

All banks   40

1) 11 GPS and 9 GLONASS satellites are simulated.

G.2  Instrument setups

The following examples show required options and the simulation capacity for different
R&S SMBV100B setups:
● Example"GNSS single-frequency or multi-frequency production tester"

on page 644
● Example"GNSS single-frequency constellation simulator" on page 645
● Example"GNSS multi-frequency constellation simulator" on page 645
● Example"GPS L1 + L5 constellation simulator" on page 646
● Example"GPS L1 + L2 + L5 constellation simulator" on page 646

Example: GNSS single-frequency or multi-frequency production tester
You can set up the R&S SMBV100B for single-frequency or multifrequency production
test. The setup does not require any of the basic or modernized GNSS system options
(R&S SMBVB-K44/-K66/-K94/-K98/-K107/-K132).

Option Description Requirement Max. chan-
nels

Max. SV

R&S SMBVB Base unit Mandatory 4 42)

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-K1331) Single-satellite GNSS

R&S SMBVB-K1343) Upgrade to dual-frequency Optional 8 42)

R&S SMBVB-K1353) Upgrade to triple-frequency Optional 12 42)

1) R&S SMBVB-K133 supports signals of all basic GNSS systems with limited channel
capacity.
2) One space vehicle (SV) for each basic GNSS system.
3) R&S SMBVB-K135 requires R&S SMBVB-K134, which requires R&S SMBVB-K133
or a GNSS system option.

Instrument setups
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Example: GNSS single-frequency constellation simulator

Option Description Requirement Max. chan-
nels

Max. SV

R&S SMBVB Base unit Mandatory 61) 6

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-Kx1) GNSS system option

R&S SMBVB-K136 Add 6 GNSS channels Optional 60 > 62)

R&S SMBVB-K137 Add 12 GNSS channels

1) Kx denotes a GNSS system option: R&S SMBVB-K44/K66/K94/K97/K98/K107/K132
2) The maximum number of channels is limited to six channels. Adding GNSS system
options does not increase the number of channels.
3) The maximum number of space vehicles depends on the visibility state of the satel-
lite.

Example: GNSS multi-frequency constellation simulator

Option Description Requirement Max. chan-
nels

Max. SV

R&S SMBVB Base unit Mandatory 62) 6

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-Kx1) GNSS system option

R&S SMBVB-K1344) Upgrade to dual-frequency Optional 8 > 63)

R&S SMBVB-K1354) Upgrade to triple-frequency Optional 12 > 63)

R&S SMBVB-K136 Add 6 GNSS channels Optional 60 > 63)

R&S SMBVB-K137 Add 12 GNSS channels

1) Kx denotes a GNSS system option: R&S SMBVB-K44/K66/K94/K97/K98/K107/K132
2) The maximum number of channels is limited to six channels. Adding GNSS system
options does not increase the number of channels.
3) The maximum number of space vehicles depends on the visibility state of the satel-
lite.
4) R&S SMBVB-K135 requires R&S SMBVB-K134, which requires R&S SMBVB-K133
or a GNSS system option.

Instrument setups
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Example: GPS L1 + L5 constellation simulator
Simulation of both GPS L1 and L5 signals requires both basic GPS and modernized
GPS options. Signal generation on one RF carrier requires option "Upgrade to dual-fre-
quency". See also the table below for a comprehensive overview.

Option Description Requirement Max. channels Max. SV

R&S SMBVB Base unit Mandatory 61) 62)

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-K44 Basic GPS

R&S SMBVB-K98 Modernized GPS

R&S SMBVB-K134 Upgrade to dual-frequency Mandatory 8 > 62)

R&S SMBVB-K136 Add 6 GNSS channels Optional 60 > 62)

R&S SMBVB-K137 Add 12 GNSS channels

1) The maximum number of channels is limited to six channels. Adding GNSS system
options does not increase the number of channels.
2) The maximum number of space vehicles depends on the visibility state of the satel-
lite.

Example: GPS L1 + L2 + L5 constellation simulator
Simulation of both GPS L1, L2 and L5 signals requires both basic GPS and modern-
ized GPS options. Signal generation on one RF carrier requires options "Upgrade to
dual-frequency" and "Upgrade to triple-frequency". See also the table below for a com-
prehensive overview.

Option Description Requirement Max. channels Max. SV

R&S SMBVB Base unit Mandatory 61) 62)

R&S SMBVB-K520 Baseband real-time extension

R&S SMBVB-K44 Basic GPS

R&S SMBVB-K98 Modernized GPS

R&S SMBVB-K134 Upgrade to dual-frequency Mandatory 8 > 62)

R&S SMBVB-K135 Upgrade to triple-frequency Mandatory 12 > 62)

R&S SMBVB-K136 Add 6 GNSS channels Optional 60 > 62)

R&S SMBVB-K137 Add 12 GNSS channels

1) The maximum number of channels is limited to six channels. Adding GNSS system
options does not increase the number of channels.
2) The maximum number of space vehicles depends on the visibility state of the satel-
lite.

Instrument setups
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H  List of predefined files
If the required options are installed, the firmware provides the following predefined
files:

Application File type File extension Filename

Body mask Body mask files *.body_mask Bus.body_mask
Car_Medium.body_mask
Car_Medium_OpenRoof.body_mask
Car_Small.body_mask
Car_Small_OpenRoof.body_mask
Isotropic.body_mask
Jet.body_mask
Jet_Big.body_mask
Plane.body_mask
Ship_Big.body_mask
Ship_Medium.body_mask
Space_Vehicle_3_antennas.body_mask
SUV.body_mask
Van.body_mask
Yacht_Small.body_mask

Antenna pattern Antenna pattern
files

*.ant_pat Isotropic.ant_pat
PatchAntenna.ant_pat

SBAS corrections Raw data *.nstb
*.ems

PRN120_19_02_14.ems
PRN120_20_08_12.ems
PRN126_19_02_14.ems

Vehicle descrip-
tion

XVD *.xvd Aircraft1.xvd
LandVehicle1.xvd
Pedestrian1.xvd
Ship1.xvd
Small_Jet.xvd
Spacecraft1.xvd
Speed_Boat.xvd
Sports_Car.xvd
Truck.xvd
HiL_Jet_Aircraft.xvd
HiL_Helicopter.xvd
HiL_Big_Aircraft.xvd
HiL_Small_Aircraft.xvd
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Application File type File extension Filename

Motion descrip-
tion

Waypoint files *.txt 3gpp_eutra_per5.txt
3gpp2.txt
CCN_Beijing_standard_trajectory.txt
Melbourne.txt
Melbourne_Movement.txt
Misc_Tokyo_GPS_Moving.txt
Misc_Tokyo_GPS_Moving_2012.txt
Misc_Tokyo_SUPL_AreaEvent.txt
Misc_Tokyo_SUPL_AreaEvent_2012.txt
Scen_Circle_5km.txt
Scen_City_Block.txt
Scen_Parking_10min.txt
Scen_Parking_1h.txt
Scen_Parking_1min.txt
Scen_Urban_Canyon_1.txt

 XTD *.xtd Circle_Motion_VMag.xtd
Barcelona_Ship_Cruise.xtd
Melbourne_Car_Motion.xtd
Munich_Flight.xtd
NewYork_City_Walk.xtd
Nuerburgring_Race_VelComp.xtd
Nuerburgring_Race_VelMag.xtd
Small_Jet_Flight.xtd
Spacecraft_Motion.xtd

 KML *.kml Nuerburgring_Race.kml

 NMEA *.nmea Melbourne_nmea.nmea
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Glossary: Specifications and references
Symbols

[1]: https://www.navipedia.net

1GP102: Rohde & Schwarz application note 1GP102 "Generation of GNSS Signals in
a Hardware in the Loop (HIL) Environment"

B
BeiDou ICD: BeiDou Navigation Satellite System interface control documents availa-
ble at:
https://en.beidou.gov.cn/SYSTEMS/ICD/

D
Di Giovanni and Radicella, 1990: Di Giovanni, G. and Radicella, S. M., 1990. An ana-
lytical model of the electron density pro_le in the ionosphere. Advances in Space
Research

G
Galileo ICD: Galileo European global navigation satellite system interface control
documents.
For copyright information and technical information in Galileo documents, see latest
versions of these documents available at the European GNSS service center (GSC):
https://www.gsc-europa.eu/electronic-library/programme-reference-documents

GFM312: Rohde & Schwarz application note GFM312 "Next generation eCall conform-
ance testing"

GFM341: Rohde & Schwarz application note GFM341 "C-V2X Scenario Simulation
with R&S CMW500 Wideband Radio Communication Tester"

GLONASS ICD: Global navigation satellite system (GLONASS) interface control docu-
ments available at:
https://glonass-iac.ru/en/documents/

GPS ICD: Global positioning system (GPS) interface control documents available at:
https://www.gps.gov/technical/icwg/

J
JAXA: The Japan Aerospace Exploration Agency

N
NavIC ICD: NavIC/Indian regional navigation satellite system (IRNSS) interface control
documents available at:
https://www.isro.gov.in/IRNSSSignal.html

 

https://www.navipedia.net/index.php/Main_Page
https://www.rohde-schwarz.com/appnote/1GP102
https://en.beidou.gov.cn/SYSTEMS/ICD/
https://www.gsc-europa.eu/electronic-library/programme-reference-documents
https://www.rohde-schwarz.com/appnote/GFM312
https://www.rohde-schwarz.com/appnote/GFM341
https://glonass-iac.ru/en/documents/
https://www.gps.gov/technical/icwg/
https://www.isro.gov.in/IRNSSSignal.html
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Q
QZSS ICD: Quasi-zenith satellite system (QZSS) interface control documents available
at:
https://qzss.go.jp/en/technical/ps-is-qzss/ps-is-qzss.html

R
RTCA MOPS DO-229: "Minimum Operational Performance Standards for Global Posi-
tioning System/Wide Area Augmentation System Airborne Equipment", 13 Dec 2006

S
STANAG: NATO Standard Agreement STANAG 4294 Issue 1

T
TLE: NASA/NORAD Two Line Elements (TLE) file format available at:
https://celestrak.org/NORAD/elements/

TS 34.108: 3GPP TS 34.108 "Common test environments for User Equipment (UE);
Conformance testing"

TS 34.171: 3GPP TS 34.171 "Terminal conformance specification; Assisted Global
Positioning System (A-GPS); Frequency Division Duplex (FDD)"

TS 37.571-1: 3GPP TS 37.571-1 "User Equipment (UE) conformance specification for
UE positioning; Part 1: Conformance test specification "

TS 37.571-2: 3GPP TS 37.571-2 "User Equipment (UE) conformance specification for
UE positioning; Part 2: Protocol conformance"

TS 51.010-1: 3GPP TS 51.010-1 "Mobile Station (MS) conformance specification; Part
1: Conformance specification"

https://qzss.go.jp/en/technical/ps-is-qzss/ps-is-qzss.html
https://celestrak.org/NORAD/elements/
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List of commands
[:SOURce<hw>]:BB:GNSS:ADGeneration:ACQuisition:CREate...................................................................573
[:SOURce<hw>]:BB:GNSS:ADGeneration:ALManac:CREate...................................................................... 573
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:COORdinates:FORMat.................................................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DECimal:PZ.......................... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DECimal[:WGS].................... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS:PZ.................................568
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:DMS[:WGS]...........................568
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:COORdinates:RFRame................................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:LOCation:URADius.......................................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SVID<ch>:STATe.......................................................... 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:SYNChronize................................................................564
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DATE............................................................ 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:DURation...................................................... 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:RESolution....................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TBASis..........................................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TIME............................................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:TOWeek........................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:BEIDou:TOAData:WNUMber..................................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:COORdinates:FORMat................................................ 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DECimal:PZ..........................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DECimal[:WGS]....................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DMS:PZ................................ 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:DMS[:WGS].......................... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:COORdinates:RFRame............................... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:LOCation:URADius...................................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SVID<ch>:STATe..........................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:SYNChronize................................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DATE............................................................ 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:DURation......................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:RESolution................................................... 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TBASis......................................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TIME.............................................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:TOWeek....................................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GALileo:TOAData:WNUMber.....................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:COORdinates:FORMat............................................. 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DECimal:PZ.......................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DECimal[:WGS].................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DMS:PZ............................. 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:DMS[:WGS]....................... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:COORdinates:RFRame............................ 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:LOCation:URADius................................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SVID<ch>:STATe.......................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:SYNChronize.............................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DATE......................................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:DURation...................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:RESolution................................................ 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TBASis...................................................... 569
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[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TIME..........................................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:TOWeek.................................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GLONass:TOAData:WNUMber..................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:COORdinates:FORMat......................................................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal:PZ............................... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DECimal[:WGS]......................... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS:PZ..................................... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:DMS[:WGS]............................... 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:COORdinates:RFRame.....................................566
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:LOCation:URADius............................................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SVID<ch>:STATe...............................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:SYNChronize.....................................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DATE................................................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:DURation...........................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:RESolution.........................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TBASis...............................................................569
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TIME.................................................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:TOWeek.............................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:GPS:TOAData:WNUMber..........................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:MODE........................................................................................ 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:COORdinates:FORMat.................................................. 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DECimal:PZ............................ 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DECimal[:WGS]...................... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS:PZ.................................. 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:DMS[:WGS]............................ 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:COORdinates:RFRame................................. 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:LOCation:URADius........................................................ 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SVID<ch>:STATe............................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:SYNChronize..................................................................564
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DATE.............................................................. 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:DURation........................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:RESolution..................................................... 571
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TBASis........................................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TIME...............................................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:TOWeek......................................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVIC:TOAData:WNUMber.......................................................572
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:CREate....................................................................573
[:SOURce<hw>]:BB:GNSS:ADGeneration:NAVigation:DFORmat................................................................ 565
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:COORdinates:FORMat................................................... 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DECimal:PZ.............................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DECimal[:WGS].......................567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS:PZ................................... 567
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:DMS[:WGS]............................. 568
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:COORdinates:RFRame.................................. 566
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:LOCation:URADius......................................................... 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SVID<ch>:STATe.............................................................565
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:SYNChronize...................................................................564
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DATE............................................................... 570
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:DURation.........................................................571
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:RESolution...................................................... 571
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[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TBASis............................................................ 569
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TIME................................................................570
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:TOWeek.......................................................... 572
[:SOURce<hw>]:BB:GNSS:ADGeneration:QZSS:TOAData:WNUMber........................................................572
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:PREDefined?.......................................................................362
[:SOURce<hw>]:BB:GNSS:APATtern:CATalog:USER?.................................................................................363
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:ALPHa<ch0>............... 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:ALPHa<ch0>:

UNSCaled................................................................................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:BETA<ch0>..................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:CNAV:IONospheric:BETA<ch0>:UNSCaled531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:ALPHa<ch0>............... 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:ALPHa<ch0>:

UNSCaled................................................................................................................................................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:BETA<ch0>..................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:BEIDou:NMESsage:DNAV:IONospheric:BETA<ch0>:UNSCaled531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:AI<ch0>....................... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:AI<ch0>:UNSCaled..... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:FNAV:IONospheric:SF<ch>........................ 532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:AI<ch0>.........................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:AI<ch0>:UNSCaled.......531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GALileo:NMESsage:INAV:IONospheric:SF<ch>......................... 532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:ALPHa<ch0>.................... 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:ALPHa<ch0>:UNSCaled.. 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:BETA<ch0>...................... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:CNAV:IONospheric:BETA<ch0>:UNSCaled.... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:ALPHa<ch0>.....................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:ALPHa<ch0>:UNSCaled...530
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:BETA<ch0>....................... 532
[:SOURce<hw>]:BB:GNSS:ATMospheric:GPS:NMESsage:LNAV:IONospheric:BETA<ch0>:UNSCaled..... 532
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:ALPHa<ch0>:UNSCaled..................... 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:KLOBuchar:BETA<ch0>:UNSCaled....................... 405
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MODel.....................................................................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:DISPlay....................................................... 402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:EXPort......................................................... 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:FILE.............................................................402
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:DIR.......................................... 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:EMS................................403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:GRID...............................403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:ADD:FILE:NSTB.............................. 403
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:EXECute.......................................... 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:LIST?............................................... 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:ALL....................................404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:MOPS:IMPort:REMove:FILE<ch>.......................... 404
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SFLux...................................................... 401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:SUNSpot..................................................401
[:SOURce<hw>]:BB:GNSS:ATMospheric:IONospheric:NEQuick:UMSN...................................................... 402
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:ALPHa<ch0>.....................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:ALPHa<ch0>:UNSCaled...530
[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:BETA<ch0>....................... 531
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[:SOURce<hw>]:BB:GNSS:ATMospheric:NAVic:NMESsage:NAV:IONospheric:BETA<ch0>:UNSCaled..... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:ALPHa<ch0>.................. 530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:ALPHa<ch0>:UNSCaled530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:BETA<ch0>.................... 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:CNAV:IONospheric:BETA<ch0>:UNSCaled.. 531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:ALPHa<ch0>.....................530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:ALPHa<ch0>:UNSCaled...530
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:BETA<ch0>.......................531
[:SOURce<hw>]:BB:GNSS:ATMospheric:QZSS:NMESsage:NAV:IONospheric:BETA<ch0>:UNSCaled.....531
[:SOURce<hw>]:BB:GNSS:ATMospheric:TROPospheric:MODel................................................................. 401
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:BWIDth...................................................................................406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CNDRatio...............................................................................406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:CONFig.................................................................................. 406
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CENTer..............................................................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:CW.................................................................... 407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:REFerence?...................................................... 407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:FREQuency:TARGet..............................................................407
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:JSRatio.................................................................................. 408
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:MODE.................................................................................... 408
[:SOURce<hw>]:BB:GNSS:AWGN[:RF<ch>]:STATe.....................................................................................408
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:PREDefined..............................................................................362
[:SOURce<hw>]:BB:GNSS:BODY:CATalog:USER........................................................................................363
[:SOURce<hw>]:BB:GNSS:CFRequency?....................................................................................................334
[:SOURce<hw>]:BB:GNSS:CLOCk:SOURce................................................................................................609
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADDelay................................................................................. 534
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:ADKD..................................................................................... 534
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:AESKey:LENGth.................................................................... 534
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:SONE........................................................535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:CKEY:TDURation:STWO....................................................... 535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:HF...........................................................................................535
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:KS...........................................................................................536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MACLt.................................................................................... 536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:MF.......................................................................................... 536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:NPKT......................................................................................536
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PID......................................................................................... 537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:NTDay..........................................................................537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:SONE........................................................537
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TDURation:STWO....................................................... 538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:PKEY:TOMidnight.................................................................. 538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:NTDay..........................................................................538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:RKEY:TOMidnight.................................................................. 538
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:SPReemption......................................................................... 539
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TMODe...................................................................................539
[:SOURce<hw>]:BB:GNSS:GALileo:OSNMa:TS...........................................................................................540
[:SOURce<hw>]:BB:GNSS:L1Band[:STATe]................................................................................................. 335
[:SOURce<hw>]:BB:GNSS:L2Band[:STATe]................................................................................................. 335
[:SOURce<hw>]:BB:GNSS:L5Band[:STATe]................................................................................................. 335
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ACCeleration:ECEF........................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:AZIMuth..............................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CBIas..................................................................598
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[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:CRANge............................................................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:DSHift................................................................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:ELEVation...........................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:FORMat?............................................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:IDELay................................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:POSition:ECEF...................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRANge............................................................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBias............................................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRBRate............................................................ 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:PRRate...............................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RANGe............................................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:RRATe................................................................ 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:ALL........................................................ 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SELect:NONE.................................................... 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:SLEVel................................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STATe................................................................. 597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:STEP.................................................................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:TDELay.............................................................. 598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:SATellite:VELocity:ECEF...................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:FORMat?.......................................................... 597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STATe................................................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion:STEP.................................................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ACCeleration:ECEF................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:AOFFset................................................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude................................................. 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:ACCeleration...........................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:JERK....................................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:ATTitude:RATE....................................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GDOP.....................................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:GSPeed..................................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:HDOP..................................................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:JERK:ECEF............................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:PDOP..................................................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ECEF.......................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:ENU.........................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:POSition:LLA..........................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:ALL.............................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SELect:NONE.........................................598
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:SVS........................................................ 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:TDOP......................................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VDOP..................................................... 599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:ECEF.......................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:CATegory:UMOTion[:CSV]:VELocity:LNED.......................................599
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:DIRectory............................................................. 597
[:SOURce<hw>]:BB:GNSS:LOGGing:DESTination:FILE:TAPPend[:STATe].................................................597
[:SOURce<hw>]:BB:GNSS:LOGGing:MODE................................................................................................595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:ABORt.................................................................................595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:DURation............................................................................ 596
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:GENerate............................................................................595
[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:PROGress?........................................................................ 596
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[:SOURce<hw>]:BB:GNSS:LOGGing:OFFLine:TOFFset..............................................................................596
[:SOURce<hw>]:BB:GNSS:LOGGing:RT:STATe........................................................................................... 596
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay........................................................................................577
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:ANTenna........................................................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:ALLocated?..................................................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:CHANnels:USED?.........................................................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:MAP:AXIS......................................................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:ECHoes............................................................ 579
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L1Band:B1C............ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L1Band:B1I.............. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L2Band:B3I.............. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L5Band:B2A.............580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L5Band:B2B.............580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:BEIDou:SIGNal:L5Band:B2I.............. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L1Band:E1OS......... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L1Band:E1PRs........580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L2Band:E6PRs........580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L2Band:E6S............ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L5Band:E5A............ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GALileo:SIGNal:L5Band:E5B............ 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:L1Band:CA........... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:L1Band:L1CDma..580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:L2Band:CA........... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:L2Band:L2CDma..580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GLONass:SIGNal:L5Band:L3CDma..580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:CA................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:L1C..................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:M..................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:P......................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L1Band:PY................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:CA................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:L2C..................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:M..................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:P......................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L2Band:PY................... 581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:GPS:SIGNal:L5Band:L5S..................581
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:NAVic:SIGNal:L5Band:SPS...............580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:L1Band:CA................. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:L1Band:L1C............... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:L2Band:L2C............... 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:QZSS:SIGNal:L5Band:L5S................580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:L1Band:CA................. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:POWer:SYSTem:SBAS:SIGNal:L5Band:EL5S............. 580
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRACks:SHOW.............................................................578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SVID.......................................................... 578
[:SOURce<hw>]:BB:GNSS:MONitor<ch>:DISPlay:TRAJectory:SYSTem.....................................................579
[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:PREDefined?........................................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:LMM:CATalog:USER?................................................................. 378
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:PREDefined?.........................................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:RPL:CATalog:USER?.................................................................. 378
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[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:PREDefined?......................................................378
[:SOURce<hw>]:BB:GNSS:OBSCuration:VOBS:CATalog:USER?............................................................... 378
[:SOURce<hw>]:BB:GNSS:PERRors:CATalog..............................................................................................461
[:SOURce<hw>]:BB:GNSS:POWer:REFerence............................................................................................429
[:SOURce<hw>]:BB:GNSS:PRESet.............................................................................................................. 329
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:APATtern:FILE........................................................... 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:BODY:FILE................................................................ 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DBANk.......................................................................363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DELevation................................................................ 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DHEading.................................................................. 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DX..............................................................................364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DY..............................................................................364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:DZ..............................................................................364
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:A<ch>:STATe........................................................................ 363
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:COUNt...................................................................361
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:DISPlay................................................................. 362
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ANTenna:V3D....................................................................... 362
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:PITCh.....................................................................357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:ROLL......................................................................358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:SPIN:RATE............................................................ 358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude:YAW....................................................................... 357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ATTitude[:BEHaviour]............................................................357
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:APPend...................................... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA:COUNt?......................................381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:DELete............................... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:INSert................................. 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:LENGth.............................. 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:AREA<ch>:REFerence......................... 382
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:PREDefined.......................................... 377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow..............................................381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:STATe...................................381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:RWINdow:STRajectory......................... 381
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:FULL:SCALe...................................................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:CONDuctivity......................................... 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:GALTitude.............................................. 385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:MPRoperty............................................. 383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Distance............................................ 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O1Height................................................385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Distance............................................ 384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:O2Height................................................385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:OORientation......................................... 385
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PERMittivity............................................383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:PLOSs....................................................384
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:GSR:STYPe....................................................383
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:LMM:FILE....................................................... 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:EXECute..................................392
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:SVID........................................391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:COPY:SYSTem.................................. 391
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SVID...................................................390
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:MPATh:SYSTem............................................. 390



List of commandsSatellite Navigation

658User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PMODel.......................................................... 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:PREDefined.................................................... 377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:DISPLay..................................................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:FILE........................................................ 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ILENgth...................................................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PMODel.................................................. 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:PREDefined............................................ 377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:ROFFset:HEIGht.................................... 379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow................................................379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:STATe.................................... 379
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:RPL:RWINdow:STRajectory...........................380
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:FILE..................................................... 378
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:MORientation.......................................377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PMODel............................................... 375
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:PREDefined......................................... 377
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:HEIGht................................. 376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:X...........................................376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment:VOBS:ROFFset:Y...........................................376
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:ENVironment[:MODel]...........................................................389
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:ITYPe..............................................................................310
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:PORT..............................................................................310
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:HIL:SLATency........................................................................309
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:CATalog.................................................................353
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal:PZ...................................355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DECimal[:WGS].............................355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS:PZ.........................................355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:DMS[:WGS]...................................355
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:FORMat.........................................354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:COORdinates:RFRame........................................ 354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:SMOVement..........................................................359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:VEHicle:FILE.........................................................360
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:DURation............................................358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:FILE....................................................358
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:LENGth?............................................ 359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation:WAYPoints:ROMode.............................................359
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:LOCation[:SELect]................................................................ 354
[:SOURce<hw>]:BB:GNSS:RECeiver[:V<st>]:POSition................................................................................353
[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:AZIMuth?....................................................................... 583
[:SOURce<hw>]:BB:GNSS:RT:BEIDou:SVID<ch>:ELEVation?.................................................................... 585
[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:AZIMuth?.......................................................................584
[:SOURce<hw>]:BB:GNSS:RT:GALileo:SVID<ch>:ELEVation?....................................................................585
[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:AZIMuth?....................................................................583
[:SOURce<hw>]:BB:GNSS:RT:GLONass:SVID<ch>:ELEVation?.................................................................585
[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:AZIMuth?............................................................................584
[:SOURce<hw>]:BB:GNSS:RT:GPS:SVID<ch>:ELEVation?.........................................................................585
[:SOURce<hw>]:BB:GNSS:RT:HDOP?......................................................................................................... 586
[:SOURce<hw>]:BB:GNSS:RT:HWTime?......................................................................................................310
[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:AZIMuth?..........................................................................583
[:SOURce<hw>]:BB:GNSS:RT:NAVic:SVID<ch>:ELEVation?.......................................................................585
[:SOURce<hw>]:BB:GNSS:RT:PDOP?......................................................................................................... 586
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[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:AZIMuth?..........................................................................583
[:SOURce<hw>]:BB:GNSS:RT:QZSS:SVID<ch>:ELEVation?.......................................................................585
[:SOURce<hw>]:BB:GNSS:RT:RATTitude?...................................................................................................589
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency:STATistics?.................................... 307
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:LATency?......................................................307
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:A....................................................... 305
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:HILPosition:MODE:B....................................................... 306
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:DECimal?.............................. 587
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RLOCation:COORdinates:DMS?.....................................588
[:SOURce<hw>]:BB:GNSS:RT:RECeiver[:V<st>]:RVELocity?...................................................................... 592
[:SOURce<hw>]:BB:GNSS:RT:RPVT?..........................................................................................................591
[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:AZIMuth?..........................................................................583
[:SOURce<hw>]:BB:GNSS:RT:SBAS:SVID<ch>:ELEVation?.......................................................................585
[:SOURce<hw>]:BB:GNSS:RT:VDOP?......................................................................................................... 587
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:ACTive:SYSTems?..............................................................583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:BEIDou:ACTive:SIGNals?...................................................583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GALileo:ACTive:SIGNals?.................................................. 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GLONass:ACTive:SIGNals?............................................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:GPS:ACTive:SIGNals?....................................................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:NAVic:ACTive:SIGNals?..................................................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:QZSS:ACTive:SIGNals?..................................................... 583
[:SOURce<hw>]:BB:GNSS:RT[:STReam<ch>]:SBAS:ACTive:SIGNals?..................................................... 583
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:APATtern:FILE.............................................................. 370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:BODY:FILE................................................................... 370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DBANk..........................................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DELevation................................................................... 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DHEading..................................................................... 371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DX.................................................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DY.................................................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:DZ.................................................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:A<ch>:STATe............................................................................371
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:CATalog....................................................................367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal:PZ......................................368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DECimal[:WGS]................................368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS:PZ............................................ 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:DMS[:WGS]...................................... 369
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:FORMat............................................ 368
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:COORdinates:RFRame........................................... 367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation:SYNC.......................................................................370
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:LOCation[:SELect]................................................................... 367
[:SOURce<hw>]:BB:GNSS:RTK:BASE<st>:MOUNtpoint?........................................................................... 366
[:SOURce<hw>]:BB:GNSS:RTK:BSTation:COUNt........................................................................................366
[:SOURce<hw>]:BB:GNSS:RTK:PASSword?................................................................................................372
[:SOURce<hw>]:BB:GNSS:RTK:PORT.........................................................................................................372
[:SOURce<hw>]:BB:GNSS:RTK:PROTocol...................................................................................................372
[:SOURce<hw>]:BB:GNSS:RTK:STATe.........................................................................................................366
[:SOURce<hw>]:BB:GNSS:RTK:USER?.......................................................................................................372
[:SOURce<hw>]:BB:GNSS:SCENario?.........................................................................................................329
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog:PREDefined?........................................................................332
[:SOURce<hw>]:BB:GNSS:SETTing:CATalog?.............................................................................................331
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[:SOURce<hw>]:BB:GNSS:SETTing:DELete................................................................................................ 332
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD.................................................................................................. 331
[:SOURce<hw>]:BB:GNSS:SETTing:LOAD:PREDefined............................................................................. 332
[:SOURce<hw>]:BB:GNSS:SETTing:STORe................................................................................................ 331
[:SOURce<hw>]:BB:GNSS:SIMulation:INFO?.............................................................................................. 331
[:SOURce<hw>]:BB:GNSS:SSValues........................................................................................................... 450
[:SOURce<hw>]:BB:GNSS:STATe.................................................................................................................329
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE................... 528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE:UNSCaled. 528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:AZERo.................. 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:AZERo:UNSCaled 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT.......................527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT:UNSCaled.....527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:AONE................ 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:AONE:

UNSCaled................................................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:AZERo............... 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:AZERo:

UNSCaled................................................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT....................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT:UNSCaled..529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AONE.........................526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AONE:UNSCaled.......526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AZERo....................... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:AZERo:UNSCaled..... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:TOT............................525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:GPS:TOT:UNSCaled.......... 525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AONE.........................523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AONE:UNSCaled.......523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo....................... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo:UNSCaled..... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:TOT............................521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:UNSCaled.......... 521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT........................ 520
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:AONE................... 528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:AONE:UNSCaled. 528
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:AZERo.................. 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:AZERo:UNSCaled 527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:TOT.......................527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GALileo:TOT:UNSCaled.....527
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:AONE................ 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:AONE:

UNSCaled................................................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:AZERo............... 529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:AZERo:

UNSCaled................................................................................................................................................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:TOT....................529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GLONass:TOT:UNSCaled..529
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AONE.........................526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AONE:UNSCaled.......526



List of commandsSatellite Navigation

661User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AZERo....................... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:AZERo:UNSCaled..... 526
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:TOT............................525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:GPS:TOT:UNSCaled.......... 525
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AONE.........................523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AONE:UNSCaled.......523
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AZERo....................... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:AZERo:UNSCaled..... 524
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:TOT............................521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:TOT:UNSCaled.......... 521
[:SOURce<hw>]:BB:GNSS:SV:BEIDou:NMESsage:DNAV:TIME:CONVersion:UTC:WNOT........................ 520
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AONE.........................526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AONE:UNSCaled.......526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AZERo....................... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:AZERo:UNSCaled..... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:TOT............................525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:TOT:UNSCaled.......... 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:GPS:WNOT........................525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AONE.........................522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AONE:UNSCaled.......522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AZERo....................... 524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:AZERo:UNSCaled..... 524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:TOT............................521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:TOT:UNSCaled.......... 521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:FNAV:TIME:CONVersion:UTC:WNOT........................ 520
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AONE..........................526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AONE:UNSCaled........526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AZERo........................ 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:AZERo:UNSCaled...... 526
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:TOT.............................525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:TOT:UNSCaled........... 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:GPS:WNOT......................... 525
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AONE.......................... 523
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AONE:UNSCaled........ 522
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AZERo.........................524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:AZERo:UNSCaled.......524
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:TOT............................. 521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:TOT:UNSCaled............521
[:SOURce<hw>]:BB:GNSS:SV:GALileo:NMESsage:INAV:TIME:CONVersion:UTC:WNOT......................... 520
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:AZERo...................... 525
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:GPS:AZERo:UNSCaled.... 525
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AONE........................ 523
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AONE:UNSCaled...... 523
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AZERo.......................524
[:SOURce<hw>]:BB:GNSS:SV:GLONass:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:UNSCaled.....524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE........................ 528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AONE:UNSCaled...... 528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:ATWO........................528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:ATWO:UNSCaled......528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AZERo.......................528
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[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:AZERo:UNSCaled.....528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT........................... 527
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:TOT:UNSCaled..........527
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GALileo:WNOT....................... 527
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AONE..................... 529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AONE:UNSCaled... 529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:ATWO.....................530
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:ATWO:UNSCaled...530
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AZERo....................529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:AZERo:UNSCaled..529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT........................ 529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:TOT:UNSCaled.......529
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:GLONass:WNOT.................... 528
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE..............................523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE:UNSCaled............523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO............................. 522
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO:UNSCaled........... 522
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo............................ 524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo:UNSCaled.......... 524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT.................................521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:UNSCaled............... 521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT.............................520
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AONE.............................. 523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AONE:UNSCaled............ 523
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AZERo.............................524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:AZERo:UNSCaled...........524
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:TOT................................. 521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:TOT:UNSCaled................521
[:SOURce<hw>]:BB:GNSS:SV:GPS:NMESsage:LNAV:TIME:CONVersion:UTC:WNOT............................. 520
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:EXECute............................................................................. 419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:CONStellation.............................................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:FILE:NMESsage................................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UALL................................................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:BEIDou:UDSource............................................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:EXECute............................................................................. 419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:CONStellation............................................................ 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:FILE:NMESsage................................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UALL...................................................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GALileo:UDSource........................................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:EXECute.......................................................................... 419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:CONStellation......................................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:FILE:NMESsage.............................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UALL................................................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GLONass:UDSource........................................................................ 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:EXECute.................................................................................. 419
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:CONStellation..................................................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:FILE:NMESsage...................................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UALL........................................................................................ 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:GPS:UDSource................................................................................ 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:EXECute................................................................................ 418
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[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:CONStellation................................................................417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:FILE:NMESsage.................................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UALL......................................................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:NAVic:UDSource.............................................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:EXECute................................................................................ 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:CONStellation............................................................... 417
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:FILE:NMESsage.................................................................... 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UALL......................................................................................418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:QZSS:UDSource.............................................................................. 418
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:DIR.................................................................. 549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:ADD:FILE.................................................................549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:EXECute.................................................................. 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:LIST?....................................................................... 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:ALL............................................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:EGNOS:REMove:FILE<ch>...................................................551
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:DIR.....................................................................549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:ADD:FILE................................................................... 549
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:EXECute.....................................................................550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:LIST?.......................................................................... 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:ALL.............................................................. 550
[:SOURce<hw>]:BB:GNSS:SV:IMPort:SBAS:WAAS:REMove:FILE<ch>..................................................... 551
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AONE.............................. 526
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AONE:UNSCaled............ 526
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:ATWO..............................527
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:ATWO:UNSCaled............527
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AZERo.............................525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:AZERo:UNSCaled...........525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:TOT................................. 525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:TOT:UNSCaled............... 525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:GPS:WNOT............................. 525
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AONE.............................. 522
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AONE:UNSCaled............ 522
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:ATWO..............................521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:ATWO:UNSCaled............521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AZERo.............................523
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:UNSCaled...........523
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:TOT................................. 521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled................521
[:SOURce<hw>]:BB:GNSS:SV:NAVic:NMESsage:NAV:TIME:CONVersion:UTC:WNOT............................. 520
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE........................... 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AONE:UNSCaled......... 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO........................... 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:ATWO:UNSCaled......... 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo.......................... 524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:AZERo:UNSCaled........ 524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT...............................521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:TOT:UNSCaled.............521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:CNAV:TIME:CONVersion:UTC:WNOT...........................520
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AONE.............................. 522
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AONE:UNSCaled............ 522
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[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo.............................524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:UNSCaled...........524
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:TOT................................. 521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled................521
[:SOURce<hw>]:BB:GNSS:SV:QZSS:NMESsage:NAV:TIME:CONVersion:UTC:WNOT............................. 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:AONE................ 522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:AONE:

UNSCaled................................................................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo...............523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:

UNSCaled................................................................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:TOT................... 521
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled..520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:EGNOS:NMESsage:NAV:TIME:CONVersion:UTC:WNOT............... 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:AONE................ 522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:AONE:

UNSCaled................................................................................................................................................522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:AZERo...............523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:

UNSCaled................................................................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:TOT................... 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled..520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:GAGAN:NMESsage:NAV:TIME:CONVersion:UTC:WNOT............... 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:AONE................... 522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:AONE:UNSCaled. 522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo..................523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:UNSCaled523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT...................... 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled.....520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:MSAS:NMESsage:NAV:TIME:CONVersion:UTC:WNOT.................. 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:AONE...................522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:AONE:UNSCaled.522
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo................. 523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:AZERo:

UNSCaled................................................................................................................................................523
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT......................520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:TOT:UNSCaled.... 520
[:SOURce<hw>]:BB:GNSS:SV:SBAS:WAAS:NMESsage:NAV:TIME:CONVersion:UTC:WNOT.................. 520
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:ACTive?.........................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:AVAilable?..................................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MAX...............................................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:BEIDou:MIN................................................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:CHANnels:MAX.......................................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:ANGLe................................................................ 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:EOBScuration:REFerence..........................................................412
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:ACTive?........................................................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:AVAilable?.....................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MAX.............................................................................. 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GALileo:MIN............................................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:ACTive?..................................................................... 414
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[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:AVAilable?..................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MAX........................................................................... 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GLONass:MIN............................................................................ 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:ACTive?..............................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:AVAilable?.......................................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MAX................................................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:GPS:MIN.....................................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:MODE......................................................................................... 412
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:ACTive?............................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:AVAilable?........................................................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MAX................................................................................. 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:NAVic:MIN...................................................................................413
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:ACTive?........................................................................... 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:AVAilable?........................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MAX................................................................................. 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:QZSS:MIN.................................................................................. 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:ACTive?............................................................................414
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:AVAilable?........................................................................ 414
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MAX................................................................................. 413
[:SOURce<hw>]:BB:GNSS:SV:SELection:SBAS:MIN...................................................................................413
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST:ALL?....................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:BEIDou:LIST[:VALid]?.............................................................................. 415
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST:ALL?................................................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:GALileo:LIST[:VALid]?..............................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST:ALL?................................................................................ 415
[:SOURce<hw>]:BB:GNSS:SVID:GLONass:LIST[:VALid]?...........................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST:ALL?........................................................................................ 415
[:SOURce<hw>]:BB:GNSS:SVID:GPS:LIST[:VALid]?...................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST:ALL?...................................................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:NAVic:LIST[:VALid]?.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST:ALL?...................................................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:QZSS:LIST[:VALid]?.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST:ALL?...................................................................................... 415
[:SOURce<hw>]:BB:GNSS:SVID:SBAS:LIST[:VALid]?.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:HEALthy..............................................................................416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:EXECute................................................. 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MCONtrol:COPY:SVID........................................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth.............. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation........... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift................. 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase.................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift....................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer...................395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:ECHos:COUNt............................... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?............................. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.......................... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:CPDRift?................................ 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:CPHase?................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:DSHift?...................................396
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:ENABle...................................392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:ICPHase?...............................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:MPATh[:V<us>:A<gr>]:LOS:POWer?..................................395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:AF<s2us0>......................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:AF<s2us0>:UNSCaled....507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TGD................................ 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TGD:UNSCaled.............. 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TOC................................ 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:CCORrection:TOC:UNSCaled.............. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADELta...............................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADELta:UNSCaled.............498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADOT................................. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ADOT:UNSCaled................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ALERt................................. 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC.....................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIC:UNSCaled...................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS..................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CIS:UNSCaled................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC................................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRC:UNSCaled................. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS....................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CRS:UNSCaled..................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC................................... 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUC:UNSCaled................. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS....................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:CUS:UNSCaled..................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:DNDot................................ 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:DNDot:UNSCaled.............. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ECCentricity....................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ECCentricity:UNSCaled..... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT...................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IDOT:UNSCaled.................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IZERo.................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:IZERo:UNSCaled...............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:MZERo...............................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:MZERo:UNSCaled.............493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:NDELta...............................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:NDELta:UNSCaled.............496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ODOT.................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:ODOT:UNSCaled............... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OMEGa.............................. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OMEGa:UNSCaled............ 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OZERo............................... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:OZERo:UNSCaled............. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:SQRA.................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:SQRA:UNSCaled...............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE....................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:CNAV:EPHemeris:TOE:UNSCaled..................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:AF<s2us0>......................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:AF<s2us0>:UNSCaled....508
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TGD<s2us>.....................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TGD<s2us>:UNSCaled...508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TOC................................ 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:CCORrection:TOC:UNSCaled.............. 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC.....................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIC:UNSCaled...................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS..................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CIS:UNSCaled................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC................................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRC:UNSCaled................. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS....................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CRS:UNSCaled..................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC................................... 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUC:UNSCaled................. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS....................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:CUS:UNSCaled..................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ECCentricity....................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ECCentricity:UNSCaled..... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:HEALth...............................513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT...................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IDOT:UNSCaled.................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODC.................................. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IODE.................................. 487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IZERo.................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:IZERo:UNSCaled...............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:MZERo...............................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:MZERo:UNSCaled.............493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:NDELta...............................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:NDELta:UNSCaled.............496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ODOT.................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:ODOT:UNSCaled............... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OMEGa.............................. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OMEGa:UNSCaled............ 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OZERo............................... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:OZERo:UNSCaled............. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:SQRA.................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:SQRA:UNSCaled...............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE....................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:TOE:UNSCaled..................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:NMESsage:DNAV:EPHemeris:URA....................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:EXECute......................................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:COPY:SVID............................................................ 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:OFFSet...................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:POWer:PLOSs....................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:EXECute................................................. 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:COPY:SVID........................................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:FILE................................................................... 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:MODE................................................................ 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:APPend............................................... 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:COUNt?...............................................464
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile:OFFSet................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:DELete.........................................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:INSert...........................................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:REFerence...................................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:PROFile<gr>:VALue.......................................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRERrors:VALue................................................................ 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:PRESent............................................................................. 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:ACCel:MAX.....................................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CAPeriod........................................................ 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CONFig...........................................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CPHase.......................................................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:CVPeriod........................................................ 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:IVELocity.........................................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:JERK:MAX......................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PRANge..........................................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:PROFile.......................................................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:RPERiod?.......................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:TOFFset..........................................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SDYNamics:VELocity..........................................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:CONTrol...............438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:DSELect...............441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:PATTern............... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage:TYPE................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:NMESsage[:STATe].................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:DATA:PCODe[:STATe]...................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:PCODe[:STATe]....................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:PILot:SCODe[:STATe]....................... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C:POWer:OFFset................................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1C[:STATe]..............................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:CONTrol................ 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:DSELect................ 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:PATTern................. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage:TYPE..................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:NMESsage[:STATe].................. 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:PCODe[:STATe]........................ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:DATA:SCODe[:STATe]........................ 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:PCODe[:STATe].........................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:PILot:SCODe[:STATe].........................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I:POWer:OFFset................................... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L1Band:B1I[:STATe]............................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:CONTrol................ 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:DSELect................ 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:PATTern................. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage:TYPE..................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:NMESsage[:STATe].................. 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:PCODe[:STATe]........................ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:DATA:SCODe[:STATe]........................ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I:POWer:OFFset................................... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L2Band:B3I[:STATe]............................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:CONTrol............... 438
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:DSELect...............441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:PATTern................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage:TYPE....................439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:NMESsage[:STATe].................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:PCODe[:STATe].......................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:DATA:SCODe[:STATe].......................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:PCODe[:STATe]....................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:PILot:SCODe[:STATe]....................... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A:POWer:OFFset..................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2A[:STATe].............................................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:CONTrol............... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:DSELect...............441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:PATTern................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage:TYPE....................439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:NMESsage[:STATe].................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:DATA:PCODe[:STATe].......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B:POWer:OFFset..................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2B[:STATe].............................................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:CONTrol................ 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:DSELect................ 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:PATTern................. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage:TYPE..................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:NMESsage[:STATe].................. 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:PCODe[:STATe]........................ 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:DATA:SCODe[:STATe]........................ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I:POWer:OFFset................................... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIGNal:L5Band:B2I[:STATe]............................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:AF<s2us0>............................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TGD<s2us>...........................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:TOC.......................................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:CLOCk:WNOC...................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIC.......................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CIS.......................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRC.........................................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CRS.........................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUC.........................................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:CUS.........................................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ECCentricity............................................ 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IDOT........................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:IZERo...................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:MZERo.................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:NDELta....................................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:ODOT......................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OMEGa................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:OZERo.................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:SQRA...................................................... 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:TOE......................................................... 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:SIMulated:ORBit:WNOE..................................................... 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:STATe..................................................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:BEIDou:VISibility:STATe?................................................................. 417
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:HEALthy..............................................................................416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:EXECute.................................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MCONtrol:COPY:SVID....................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth.............. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation...........398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift.................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase................ 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift................... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase............... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer.................. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:ECHos:COUNt............................... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?............................. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:AELEVation?..........................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:CPDRift?................................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:CPHase?............................... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:DSHift?.................................. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:ENABle.................................. 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:ICPHase?.............................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:MPATh[:V<us>:A<gr>]:LOS:POWer?................................. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:AF<s2us0>......................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:AF<s2us0>:UNSCaled....507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:BGDA..............................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:BGDA:UNSCaled............510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:TOC................................ 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:CCORrection:TOC:UNSCaled.............. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5ADVS................................................ 518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:E5AHS...................................................518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC.....................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIC:UNSCaled...................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS..................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CIS:UNSCaled................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC................................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRC:UNSCaled................. 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS....................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CRS:UNSCaled..................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC................................... 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUC:UNSCaled................. 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS....................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:CUS:UNSCaled..................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ECCentricity....................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ECCentricity:UNSCaled..... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IDOT...................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IDOT:UNSCaled.................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IODNav.............................. 487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IZERo.................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:IZERo:UNSCaled...............491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:MZERo...............................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:MZERo:UNSCaled.............493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:NDELta...............................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:NDELta:UNSCaled.............496
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ODOT.................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:ODOT:UNSCaled............... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OMEGa.............................. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OMEGa:UNSCaled............ 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OZERo............................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:OZERo:UNSCaled............. 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SISA...................................516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SQRA.................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:SQRA:UNSCaled...............489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE....................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:FNAV:EPHemeris:TOE:UNSCaled..................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:AF<s2us0>.......................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:AF<s2us0>:UNSCaled.....507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDA...............................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDA:UNSCaled.............510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDB...............................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:BGDB:UNSCaled.............510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:TOC..................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:CCORrection:TOC:UNSCaled................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BDVS................................................. 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E1BHS....................................................516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BDVS................................................. 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:E5BHS....................................................516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC...................................... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIC:UNSCaled.................... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS...................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CIS:UNSCaled.................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC.....................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRC:UNSCaled...................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS.....................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CRS:UNSCaled...................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC.....................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUC:UNSCaled...................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS.....................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:CUS:UNSCaled...................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ECCentricity........................ 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ECCentricity:UNSCaled...... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT....................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IDOT:UNSCaled.................. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IODNav................................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IZERo.................................. 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:IZERo:UNSCaled................ 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:MZERo................................ 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:MZERo:UNSCaled.............. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:NDELta................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:NDELta:UNSCaled..............496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ODOT..................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:ODOT:UNSCaled................ 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OMEGa............................... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OMEGa:UNSCaled............. 492
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OZERo................................ 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:OZERo:UNSCaled.............. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:MODE......................... 517
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:RLM<s2us>.................517
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SAR:SPARe........................ 518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SISA.................................... 516
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SQRA.................................. 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:SQRA:UNSCaled................ 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE..................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:NMESsage:INAV:EPHemeris:TOE:UNSCaled................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:EXECute..................................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:COPY:SVID............................................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:OFFSet.................................................................. 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:POWer:PLOSs....................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:EXECute.................................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:COPY:SVID....................................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:FILE...................................................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:MODE................................................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:APPend...............................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:COUNt?.............................................. 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile:OFFSet............................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:DELete.........................................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:INSert.......................................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:REFerence.................................. 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:PROFile<gr>:VALue.......................................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRERrors:VALue................................................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:PRESent.............................................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:ACCel:MAX.................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CAPeriod........................................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CONFig.......................................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CPHase..........................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:CVPeriod........................................................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:IVELocity........................................................ 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:JERK:MAX..................................................... 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PRANge......................................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:PROFile..........................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:RPERiod?.......................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:TOFFset......................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SDYNamics:VELocity......................................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:CONTrol............438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:DSELect............442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:PATTern............ 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage:TYPE................ 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:NMESsage[:STATe]..............555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:OSNMa[:STATe]................... 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:PCODe[:STATe]................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:DATA:SCODe[:STATe]................... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:PCODe[:STATe].................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:PILot:SCODe[:STATe].................... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS:POWer:OFFset.............................. 431
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L1Band:E1OS[:STATe]...........................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:CONTrol...............438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:DSELect.............. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:PATTern............... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage:TYPE................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:NMESsage[:STATe]................ 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:DATA:PCODe[:STATe]...................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:PCODe[:STATe].......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:PILot:SCODe[:STATe].......................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S:POWer:OFFset................................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L2Band:E6S[:STATe]..............................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:CONTrol...............438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:DSELect.............. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:PATTern............... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage:TYPE................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:NMESsage[:STATe]................ 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:PCODe[:STATe]...................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:DATA:SCODe[:STATe]...................... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:PCODe[:STATe].......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:PILot:SCODe[:STATe].......................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A:POWer:OFFset................................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5A[:STATe]..............................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:CONTrol...............438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:DSELect.............. 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:PATTern............... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage:TYPE................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:NMESsage[:STATe]................ 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:PCODe[:STATe]...................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:DATA:SCODe[:STATe]...................... 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:PCODe[:STATe].......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:PILot:SCODe[:STATe].......................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B:POWer:OFFset................................. 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIGNal:L5Band:E5B[:STATe]..............................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:AF<s2us0>........................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TGD...................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:TOC...................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:CLOCk:WNOC.................................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIC..........................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CIS..........................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRC........................................................ 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CRS........................................................ 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUC........................................................ 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:CUS........................................................ 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ECCentricity............................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IDOT....................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:IZERo......................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:MZERo....................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:NDELta................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:ODOT......................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OMEGa...................................................454
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:OZERo....................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:SQRA......................................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:TOE.........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:SIMulated:ORBit:WNOE.....................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:STATe................................................................................. 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GALileo:VISibility:STATe?.................................................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:FNUMber......................................................................... 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:HEALthy...........................................................................416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:EXECute..............................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MCONtrol:COPY:SVID.................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth........... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation........398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift..............394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase............. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift................ 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase............ 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer............... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:ECHos:COUNt............................ 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?.......................... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.......................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:CPDRift?.............................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:CPHase?............................ 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:DSHift?............................... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:ENABle............................... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:ICPHase?........................... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:MPATh[:V<us>:A<gr>]:LOS:POWer?.............................. 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:DTAU..............................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:DTAU:UNSCaled............510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:EN.................................. 519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:GAMN............................ 510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:GAMN:UNSCaled.......... 510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:TAUN..............................510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:CCORrection:TAUN:UNScaled............ 510
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:AOEP................................ 519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:CFM...................................519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:HEALth..............................513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:P........................................519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:SEType..............................518
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TALignment....................... 519
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINDex.............................. 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINDex:UNSCaled............ 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TINTerval?.........................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:TOE?................................. 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:URA...................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDDN................................ 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDDN:UNSCaled.............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDN...................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XDN:UNSCaled.................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN..................................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:XN:UNSCaled................... 499
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDDN................................ 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDDN:UNSCaled.............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDN...................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YDN:UNSCaled.................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN..................................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:YN:UNSCaled................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDDN................................ 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDDN:UNSCaled.............. 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN...................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZDN:UNSCaled.................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN......................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:NMESsage:NAV:EPHemeris:ZN:UNSCaled....................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:EXECute.................................................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:COPY:SVID.........................................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:OFFSet............................................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:POWer:PLOSs.................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:EXECute..............................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:COPY:SVID.................................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:FILE................................................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:MODE.............................................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:APPend............................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:COUNt?........................................... 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile:OFFSet............................................ 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:DELete......................................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:INSert....................................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:REFerence............................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:REFerence............................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:PROFile<gr>:VALue....................................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRERrors:VALue............................................................. 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:PRESent..........................................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:ACCel:MAX................................................. 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CAPeriod.....................................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CONFig....................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CPHase.......................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:CVPeriod.....................................................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:IVELocity..................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:JERK:MAX.................................................. 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PRANge...................................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:PROFile.......................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:RPERiod?....................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:TOFFset...................................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SDYNamics:VELocity...................................................... 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:MEANdering[:STATe]............. 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol............. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:DSELect............. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:PATTern.............. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage:TYPE.................. 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:NMESsage[:STATe]............... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:PCODe[:STATe]..................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:DATA:TSEQuence[:STATe]..............444
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:PILot:PCODe[:STATe]......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:CA:POWer:OFFset................................ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:NMESsage:CONTrol.... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:NMESsage:DSELect.... 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:NMESsage:PATTern.....443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:NMESsage:TYPE.........440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:NMESsage[:STATe]...... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:PCODe[:STATe]............435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:DATA:SCODe[:STATe]............437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:PILot:PCODe[:STATe]............ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma:POWer:OFFset.......................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L1Band:L1CDma[:STATe]................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:MEANdering[:STATe]............. 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:CONTrol............. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:DSELect............. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:PATTern.............. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage:TYPE.................. 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:NMESsage[:STATe]............... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:PCODe[:STATe]..................... 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:DATA:TSEQuence[:STATe]..............444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:PILot:PCODe[:STATe]......................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA:POWer:OFFset................................ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:CA[:STATe]............................................ 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:NMESsage:CONTrol.... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:NMESsage:DSELect.... 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:NMESsage:PATTern.....443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:NMESsage:TYPE.........440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:DATA:NMESsage[:STATe]...... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:PCODe[:STATe]............ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:PILot:SCODe[:STATe]............ 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma:POWer:OFFset.......................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L2Band:L2CDma[:STATe]................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:NMESsage:CONTrol.... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:NMESsage:DSELect.... 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:NMESsage:PATTern.....443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:NMESsage:TYPE.........440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:NMESsage[:STATe]...... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:PCODe[:STATe]............435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:DATA:SCODe[:STATe]............437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:PCODe[:STATe]............ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:PILot:SCODe[:STATe]............ 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma:POWer:OFFset.......................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIGNal:L5Band:L3CDma[:STATe]................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:AF<s2us0>........................................ 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:DATE................................................. 452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TGD................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:CLOCk:TIME.................................................. 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:DATE....................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:TIME.................................................... 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDDN...................................................451
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XDN..................................................... 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:XN........................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDDN...................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YDN..................................................... 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:YN........................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDDN...................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZDN......................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:SIMulated:ORBit:ZN........................................................ 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:STATe.............................................................................. 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GLONass:VISibility:STATe?..............................................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:HEALthy...................................................................................416
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:EXECute...................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MCONtrol:COPY:SVID.............................................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth................... 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift...................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase......................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.........................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase.....................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer....................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:ECHos:COUNt.................................... 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?.................................. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?...............................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?..................................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:CPHase?.....................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:DSHift?........................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ENABle....................................... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?....................................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:MPATh[:V<us>:A<gr>]:LOS:POWer?...................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L1CA..............................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L1CA:UNSCaled............509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L2C................................ 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L2C:UNSCaled.............. 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5I..................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5I:UNSCaled................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5Q................................ 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORection:ISC:L5Q:UNSCaled.............. 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:AF<s2us0>.......................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:AF<s2us0>:UNSCaled........ 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD..................................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TGD:UNSCaled................... 508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC..................................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:CCORrection:TOC:UNSCaled................... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta....................................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADELta:UNSCaled..................498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT......................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ADOT:UNSCaled.................... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ALERt......................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC..........................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIC:UNSCaled........................505
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS..........................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CIS:UNSCaled........................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC........................................ 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRC:UNSCaled...................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS........................................ 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CRS:UNSCaled...................... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC........................................ 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUC:UNSCaled...................... 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS........................................ 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:CUS:UNSCaled...................... 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot..................................... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DNDot:UNSCaled................... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot.....................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:DODot:UNSCaled...................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ECCentricity............................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ECCentricity:UNSCaled..........490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT....................................... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IDOT:UNSCaled......................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ISFLag.................................... 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo......................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:IZERo:UNSCaled....................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L1Health..................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L2CPhasing............................ 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L2Health..................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:L5Health..................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo....................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:MZERo:UNSCaled..................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta................................... 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NDELta:UNSCaled................. 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED0.......................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED1...................................... 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:NED2...................................... 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT......................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:ODOT:UNSCaled....................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa...................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OMEGa:UNSCaled.................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo....................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:OZERo:UNSCaled..................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA......................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:SQRA:UNSCaled....................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE.........................................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOE:UNSCaled.......................488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP.........................................512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:TOP:UNSCaled.......................512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:URA........................................ 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:CNAV:EPHemeris:WNOP.....................................512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:AF<s2us0>...........................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:AF<s2us0>:UNSCaled.........508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD......................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TGD:UNSCaled....................509
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC......................................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:CCORrection:TOC:UNSCaled....................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:AODO?....................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ASFLag....................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC.......................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIC:UNSCaled........................ 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS...........................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CIS:UNSCaled.........................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CLTMode................................. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC.........................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRC:UNSCaled.......................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS.........................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CRS:UNSCaled.......................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC.........................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUC:UNSCaled.......................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS.........................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:CUS:UNSCaled.......................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ECCentricity.............................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ECCentricity:UNSCaled...........490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:FIFLag..................................... 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:HEALth.................................... 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT........................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IDOT:UNSCaled...................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODC........................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IODE........................................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo...................................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:IZERo:UNSCaled.................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:LTPData...................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo.................................... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:MZERo:UNSCaled.................. 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta....................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:NDELta:UNSCaled..................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT...................................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:ODOT:UNSCaled.....................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa....................................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OMEGa:UNSCaled..................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo.....................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:OZERo:UNSCaled...................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SF1Reserved<s2us>?.............515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA...................................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SQRA:UNSCaled.................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:SVConfig................................. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE......................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:TOE:UNSCaled....................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:NMESsage:LNAV:EPHemeris:URA.........................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:EXECute.......................................................... 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:COPY:SVID.................................................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:OFFSet........................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:POWer:PLOSs.........................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:EXECute......................................................463
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:COPY:SVID............................................................ 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:FILE........................................................................ 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:MODE.....................................................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:APPend....................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:COUNt?....................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile:OFFSet.....................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:DELete..............................................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:INSert................................................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:REFerence........................................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:PROFile<gr>:VALue............................................... 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRERrors:VALue..................................................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:PRESent.................................................................................. 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:ACCel:MAX......................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CAPeriod............................................................. 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CONFig................................................................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CPHase............................................................... 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:CVPeriod............................................................. 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:IVELocity............................................................. 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:JERK:MAX...........................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PRANge...............................................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:PROFile...............................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:RPERiod?............................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:TOFFset.............................................................. 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SDYNamics:VELocity.............................................................. 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol......................439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:DSELect..................... 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern...................... 444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE.......................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:NMESsage[:STATe]....................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]............................. 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:PILot:PCODe[:STATe]..............................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA:POWer:OFFset........................................ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:CA[:STATe].....................................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:CONTrol.................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:DSELect....................442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:PATTern.....................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage:TYPE.........................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:NMESsage[:STATe]......................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:DATA:PCODe[:STATe]............................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:PCODe[:STATe]............................ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:PILot:SCODe[:STATe]............................ 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C:POWer:OFFset.......................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:L1C[:STATe]................................................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:CONTrol........................ 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:DSELect........................ 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:PATTern.........................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage:TYPE.............................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:NMESsage[:STATe].......................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:DATA:PCODe[:STATe]................................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:PILot:PCODe[:STATe]................................ 436
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P:POWer:OFFset...........................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L1Band:P[:STATe]....................................................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:CONTrol......................438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:DSELect..................... 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:PATTern...................... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage:TYPE.......................... 440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:NMESsage[:STATe]....................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:DATA:PCODe[:STATe]............................. 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:PILot:PCODe[:STATe]..............................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA:POWer:OFFset........................................ 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:CA[:STATe].....................................................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:CONTrol.................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:DSELect....................442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:PATTern.....................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage:TYPE.........................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:NMESsage[:STATe]......................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:DATA:PCODe[:STATe]............................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:PILot:PCODe[:STATe]............................ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C:POWer:OFFset.......................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:L2C[:STATe]................................................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:CONTrol........................ 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:DSELect........................ 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:PATTern.........................444
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage:TYPE.............................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:NMESsage[:STATe].......................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:DATA:PCODe[:STATe]................................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:PILot:PCODe[:STATe]................................ 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P:POWer:OFFset...........................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L2Band:P[:STATe]....................................................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:CONTrol.................... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:DSELect.................... 442
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:PATTern.....................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage:TYPE.........................440
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:NMESsage[:STATe]...................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:PCODe[:STATe]............................435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:DATA:SCODe[:STATe]............................437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:PCODe[:STATe]............................ 435
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:PILot:SCODe[:STATe]............................ 437
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S:POWer:OFFset.......................................431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIGNal:L5Band:L5S[:STATe]................................................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:AF<s2us0>.................................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TGD........................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:TOC........................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:CLOCk:WNOC........................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIC...............................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CIS............................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRC............................................................. 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CRS..............................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUC............................................................. 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:CUS..............................................................456
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ECCentricity................................................. 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IDOT.............................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:IZERo...........................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:MZERo.........................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:NDELta.........................................................456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:ODOT...........................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OMEGa........................................................ 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:OZERo......................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:SQRA...........................................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:TOE..............................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:SIMulated:ORBit:WNOE..........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:STATe.......................................................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:GPS:VISibility:STATe?......................................................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:HEALthy.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:EXECute.................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MCONtrol:COPY:SVID.......................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth................. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation..............398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift.................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase....................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.......................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase...................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer..................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:ECHos:COUNt.................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?................................ 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.............................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:CPDRift?................................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:CPHase?...................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:DSHift?......................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:ENABle..................................... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:ICPHase?..................................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:MPATh[:V<us>:A<gr>]:LOS:POWer?.................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:AF<s2us0>...........................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:AF<s2us0>:UNSCaled.........507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD......................................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TGD:UNSCaled....................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC......................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:CCORrection:TOC:UNSCaled....................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC.......................................... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIC:UNSCaled........................ 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS.......................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CIS:UNSCaled........................ 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC.........................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRC:UNSCaled.......................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS.........................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CRS:UNSCaled.......................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC.........................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUC:UNSCaled.......................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS.........................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:CUS:UNSCaled.......................501
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ECCentricity............................ 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ECCentricity:UNSCaled.......... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT........................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IDOT:UNSCaled...................... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IODE........................................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo...................................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:IZERo:UNSCaled.................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:L5Health.................................. 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo.................................... 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:MZERo:UNSCaled.................. 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta....................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:NDELta:UNSCaled..................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT...................................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:ODOT:UNSCaled.................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa................................... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OMEGa:UNSCaled................. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo.................................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:OZERo:UNSCaled.................. 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SHEalth................................... 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA...................................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:SQRA:UNSCaled.................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE......................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:TOE:UNSCaled....................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:NMESsage:NAV:EPHemeris:URA.........................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:EXECute........................................................ 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:COPY:SVID...............................................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:OFFSet......................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:POWer:PLOSs.......................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:EXECute....................................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:COPY:SVID.......................................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:FILE...................................................................... 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:MODE...................................................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:APPend..................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:COUNt?................................................. 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile:OFFSet.................................................. 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:DELete............................................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:INSert............................................. 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:REFerence..................................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:PROFile<gr>:VALue............................................. 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRERrors:VALue................................................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:PRESent................................................................................ 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:ACCel:MAX....................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CAPeriod........................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CONFig............................................................. 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CPHase............................................................. 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:CVPeriod........................................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:IVELocity........................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:JERK:MAX........................................................ 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PRANge............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:PROFile.............................................................556
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:RPERiod?..........................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:TOFFset............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SDYNamics:VELocity............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:CONTrol................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:DSELect................. 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:PATTern..................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage:TYPE...................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:NMESsage[:STATe]................... 554
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:DATA:PCODe[:STATe].........................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS:POWer:OFFset....................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIGNal:L5Band:SPS[:STATe]................................................ 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:AF<s2us0>.............................................. 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TGD......................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:TOC......................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:CLOCk:WNOC..................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIC.............................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CIS............................................................. 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRC........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CRS........................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUC........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:CUS........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ECCentricity............................................... 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IDOT.......................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:IZERo.........................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:MZERo.......................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:NDELta...................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:ODOT.........................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OMEGa...................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:OZERo....................................................... 454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:SQRA.........................................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:TOE............................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:SIMulated:ORBit:WNOE........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:STATe.....................................................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:NAVic:VISibility:STATe?....................................................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:HEALthy.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:EXECute....................................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MCONtrol:COPY:SVID.......................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth................. 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation..............398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift....................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase................... 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift...................... 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase.................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer..................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:ECHos:COUNt.................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?................................ 397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.............................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?...................................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:CPHase?.................................. 396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:DSHift?..................................... 397
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:ENABle..................................... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:MPATh[:V<us>:A<gr>]:LOS:POWer?.................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L1CA............................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L1CA:UNSCaled..........509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L2C.............................. 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L2C:UNSCaled............ 509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5I................................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5I:UNSCaled..............509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5Q..............................509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORection:ISC:L5Q:UNSCaled............509
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:AF<s2us0>........................ 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:AF<s2us0>:UNSCaled...... 507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD...................................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TGD:UNSCaled.................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC................................... 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:CCORrection:TOC:UNSCaled................. 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADELta................................. 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADELta:UNSCaled............... 498
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT....................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ADOT:UNSCaled.................. 497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ALERt....................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC........................................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIC:UNSCaled......................504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS........................................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CIS:UNSCaled......................505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC......................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRC:UNSCaled....................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS...................................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CRS:UNSCaled.................... 503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC......................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUC:UNSCaled....................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS...................................... 502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:CUS:UNSCaled.................... 501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot...................................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DNDot:UNSCaled.................497
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot...................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:DODot:UNSCaled.................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ECCentricity..........................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ECCentricity:UNSCaled........490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT..................................... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IDOT:UNSCaled....................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ISFLag.................................. 512
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo....................................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:IZERo:UNSCaled..................490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L1Health................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L2CPhasing.......................... 513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L2Health................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:L5Health................................511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:MZERo..................................493
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:MZERo:UNSCaled................493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NDELta................................. 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NDELta:UNSCaled............... 496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED0.................................... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED1.................................... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:NED2.................................... 511
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT................................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:ODOT:UNSCaled..................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OMEGa.................................492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OMEGa:UNSCaled...............492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OZERo..................................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:OZERo:UNSCaled................491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA....................................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:SQRA:UNSCaled..................489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE...................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:TOE:UNSCaled.................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:CNAV:EPHemeris:URA...................................... 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:AF<s2us0>...........................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:AF<s2us0>:UNSCaled.........507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD......................................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TGD:UNSCaled....................508
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC......................................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:CCORrection:TOC:UNSCaled....................506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:AODO?....................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC.......................................... 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIC:UNSCaled........................ 504
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS.......................................... 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CIS:UNSCaled........................ 505
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CLTMode.................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC.........................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRC:UNSCaled.......................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS.........................................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CRS:UNSCaled.......................503
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC.........................................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUC:UNSCaled.......................501
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS.........................................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:CUS:UNSCaled.......................502
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ECCentricity............................ 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ECCentricity:UNSCaled.......... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:FIFLag.....................................515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:HEALth....................................513
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT........................................494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IDOT:UNSCaled...................... 494
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODC....................................... 506
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IODE........................................487
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo...................................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:IZERo:UNSCaled.................... 490
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:LTPData.................................. 515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo.................................... 493
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:MZERo:UNSCaled.................. 493
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta....................................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:NDELta:UNSCaled..................496
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT......................................495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:ODOT:UNSCaled.................... 495
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa................................... 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OMEGa:UNSCaled................. 492
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo.................................... 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:OZERo:UNSCaled.................. 491
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SF1Reserved<s2us>?.............515
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA...................................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SQRA:UNSCaled.................... 489
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:SVConfig................................. 514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE......................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:TOE:UNSCaled....................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:NMESsage:NAV:EPHemeris:URA.........................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:EXECute........................................................ 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:COPY:SVID...............................................................432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:OFFSet..................................................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:POWer:PLOSs.......................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:EXECute....................................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:COPY:SVID.......................................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:FILE......................................................................461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:MODE...................................................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:APPend..................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:COUNt?................................................. 464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile:OFFSet.................................................. 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:DELete............................................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:INSert............................................. 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:REFerence..................................... 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:PROFile<gr>:VALue............................................. 465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRERrors:VALue...................................................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:PRESent................................................................................429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:ACCel:MAX....................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CAPeriod...........................................................560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CONFig............................................................. 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CPHase.............................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:CVPeriod...........................................................559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:IVELocity........................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:JERK:MAX........................................................ 561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PRANge............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:PROFile.............................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:RPERiod?..........................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:TOFFset............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SDYNamics:VELocity............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol................... 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:DSELect................... 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern.................... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE........................ 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:NMESsage[:STATe]..................... 555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]........................... 434
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:PILot:PCODe[:STATe]............................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA:POWer:OFFset...................................... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:CA[:STATe].................................................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:CONTrol..................438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:DSELect..................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:PATTern.................. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage:TYPE...................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:NMESsage[:STATe]....................555
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:DATA:PCODe[:STATe]......................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:PCODe[:STATe].......................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:PILot:SCODe[:STATe].......................... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C:POWer:OFFset.................................... 431
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L1Band:L1C[:STATe].................................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:CONTrol..................438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:DSELect..................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:PATTern.................. 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage:TYPE...................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:NMESsage[:STATe]....................554
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:DATA:PCODe[:STATe]......................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:PILot:PCODe[:STATe].......................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C:POWer:OFFset.................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L2Band:L2C[:STATe].................................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:CONTrol.................. 438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:DSELect..................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:PATTern...................443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage:TYPE.......................439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:NMESsage[:STATe]....................554
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:PCODe[:STATe]..........................434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:DATA:SCODe[:STATe]..........................436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:PCODe[:STATe].......................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:PILot:SCODe[:STATe].......................... 436
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S:POWer:OFFset.....................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIGNal:L5Band:L5S[:STATe]................................................. 433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:AF<s2us0>.............................................. 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TGD......................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:TOC......................................................... 458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:CLOCk:WNOC..................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIC.............................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CIS.............................................................457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRC........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CRS........................................................... 457
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUC........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:CUS........................................................... 456
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ECCentricity...............................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IDOT.......................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:IZERo.........................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:MZERo.......................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:NDELta...................................................... 455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:ODOT.........................................................455
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OMEGa......................................................454



List of commandsSatellite Navigation

689User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:OZERo.......................................................454
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:SQRA.........................................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:TOE............................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:SIMulated:ORBit:WNOE........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:STATe.................................................................................... 428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:QZSS:VISibility:STATe?....................................................................417
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:HEALthy.................................................................................415
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:EXECute.................................................... 445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MCONtrol:COPY:SVID...........................................................445
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AAZimuth................. 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:AELEVation..............398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPDRift.................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:CPHase....................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:DSHift.......................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:ICPHase...................394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHO<s2us0>:POWer..................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:ECHos:COUNt.................................. 393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:AAZimuth?................................ 398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:AELEVation?.............................398
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:CPDRift?................................... 394
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:CPHase?...................................396
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:DSHift?......................................397
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:ENABle..................................... 392
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:ICPHase?..................................393
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:MPATh[:V<us>:A<gr>]:LOS:POWer?.................................... 395
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:AF<s2us0>...........................507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:CCORrection:AF<s2us0>:UNSCaled.........507
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE......................................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:TOE:UNSCaled....................... 488
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:URA.........................................514
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN...................................... 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDDN:UNSCaled.................... 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN.........................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XDN:UNSCaled.......................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN............................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:XN:UNSCaled..........................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN...................................... 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDDN:UNSCaled.................... 500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN.........................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YDN:UNSCaled.......................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN............................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:YN:UNSCaled..........................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN.......................................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDDN:UNSCaled.....................500
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN......................................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZDN:UNSCaled....................... 499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN............................................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:NMESsage:NAV:EPHemeris:ZN:UNSCaled..........................499
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:EXECute........................................................ 432
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:COPY:SVID...............................................................432
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[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:OFFSet......................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:POWer:PLOSs.......................................................................430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:EXECute....................................................462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:COPY:SVID.......................................................... 462
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:FILE...................................................................... 461
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:MODE...................................................................460
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:APPend..................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:COUNt?..................................................464
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile:OFFSet...................................................463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:DELete............................................467
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:INSert..............................................466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence......................................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:REFerence......................................465
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:PROFile<gr>:VALue............................................. 466
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRERrors:VALue................................................................... 463
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:PRESent................................................................................ 429
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:ACCel:MAX....................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CAPeriod........................................................... 560
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CONFig..............................................................558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CPHase............................................................. 556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:CVPeriod........................................................... 559
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:IVELocity........................................................... 558
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:JERK:MAX.........................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PRANge.............................................................557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:PROFile.............................................................556
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:RPERiod?..........................................................561
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:TOFFset............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SDYNamics:VELocity............................................................ 557
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:CONTrol....................438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:DSELect................... 441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:PATTern.................... 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage:TYPE........................ 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:NMESsage[:STATe]..................... 554
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:DATA:PCODe[:STATe]........................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA:POWer:OFFset...................................... 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L1Band:CA[:STATe]...................................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:CONTrol................438
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:DSELect................441
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:PATTern................ 443
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage:TYPE.................... 439
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:NMESsage[:STATe]..................554
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:DATA:PCODe[:STATe]....................... 434
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S:POWer:OFFset.................................. 430
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIGNal:L5Band:EL5S[:STATe]...............................................433
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:AF<s2us0>...............................................458
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:DATE........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:CLOCk:TIME........................................................ 453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:DATE..........................................................452
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:TIME...........................................................453
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDDN.........................................................451



List of commandsSatellite Navigation

691User Manual 1178.9403.02 ─ 10

[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XDN............................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:XN.............................................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDDN.........................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YDN............................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:YN.............................................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDDN......................................................... 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZDN............................................................451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SIMulated:ORBit:ZN.............................................................. 451
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:STATe.....................................................................................428
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:SYSTem.................................................................................544
[:SOURce<hw>]:BB:GNSS:SVID<ch>:SBAS:VISibility:STATe?....................................................................417
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1C[:STATe]................................................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L1Band:B1I[:STATe]..................................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L2Band:B3I[:STATe]..................................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2A[:STATe]................................................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2B[:STATe]................................................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou:SIGNal:L5Band:B2I[:STATe]..................................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:BEIDou[:STATe].................................................................................. 335
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L1Band:E1OS[:STATe]............................................. 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L2Band:E6S[:STATe]................................................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5A[:STATe]................................................ 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo:SIGNal:L5Band:E5B[:STATe]................................................ 336
[:SOURce<hw>]:BB:GNSS:SYSTem:GALileo[:STATe]..................................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:CA[:STATe]...............................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L1Band:L1CDma[:STATe]......................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:CA[:STATe]...............................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L2Band:L2CDma[:STATe]......................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass:SIGNal:L5Band:L3CDma[:STATe]......................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:GLONass[:STATe]...............................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:CA[:STATe]....................................................... 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:L1C[:STATe]..................................................... 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L1Band:P[:STATe]..........................................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:CA[:STATe]....................................................... 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:L2C[:STATe]..................................................... 337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L2Band:P[:STATe]..........................................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS:SIGNal:L5Band:L5S[:STATe]......................................................337
[:SOURce<hw>]:BB:GNSS:SYSTem:GPS[:STATe]....................................................................................... 335
[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic:SIGNal:L5Band:SPS[:STATe]...................................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:NAVic[:STATe].....................................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:CA[:STATe].....................................................336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L1Band:L1C[:STATe]................................................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L2Band:L2C[:STATe]................................................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS:SIGNal:L5Band:L5S[:STATe]................................................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:QZSS[:STATe].....................................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:PERiod............................549
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:ALManac:STATe..............................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:CECovariance:PERiod....................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:CECovariance:STATe......................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:PERiod............................. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:DFACtor:STATe............................... 546
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCDegradation:PERiod...................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCDegradation:STATe.................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:PERiod......................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:FCORrection:STATe........................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:PERiod..................................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:IGRid:STATe....................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:LTCorrection:PERiod...................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:LTCorrection:STATe........................ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRN<ch>:STATe............................. 544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:PERiod...........................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:PRNMask:STATe.............................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:PERiod.................................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:RINex:STATe...................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:PERiod.............................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:SERVice:STATe...............................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:PERiod...........................549
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS:NMESsage:NAV:UTCoffset:STATe?...........................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:EGNOS[:STATe]....................................................................... 335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:PERiod............................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:ALManac:STATe..............................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:CECovariance:PERiod....................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:CECovariance:STATe......................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:PERiod............................. 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:DFACtor:STATe............................... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCDegradation:PERiod...................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCDegradation:STATe.................... 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCORrection:PERiod......................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:FCORrection:STATe........................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:PERiod..................................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:IGRid:STATe....................................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:LTCorrection:PERiod...................... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:LTCorrection:STATe........................ 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRN<ch>:STATe............................. 544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:PERiod...........................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:PRNMask:STATe.............................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:PERiod.................................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:RINex:STATe...................................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:PERiod.............................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:SERVice:STATe...............................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:PERiod...........................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN:NMESsage:NAV:UTCoffset:STATe?...........................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:GAGAN[:STATe]....................................................................... 335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:PERiod...............................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:ALManac:STATe................................ 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:PERiod.......................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:CECovariance:STATe........................ 545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:PERiod................................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:DFACtor:STATe..................................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCDegradation:PERiod..................... 547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCDegradation:STATe....................... 545
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[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:PERiod.........................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:FCORrection:STATe...........................545
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:PERiod.....................................547
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:IGRid:STATe...................................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:PERiod......................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:LTCorrection:STATe........................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRN<ch>:STATe................................ 544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:PERiod..............................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:PRNMask:STATe............................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:PERiod....................................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:RINex:STATe......................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:PERiod............................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:SERVice:STATe................................. 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:PERiod..............................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS:NMESsage:NAV:UTCoffset:STATe?..............................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:MSAS[:STATe]..........................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L1Band:CA[:STATe]..................................................... 336
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:SIGNal:L5Band:EL5S[:STATe]................................................. 336
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:PERiod.............................. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:ALManac:STATe................................ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:PERiod...................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:CECovariance:STATe........................ 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:PERiod................................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:DFACtor:STATe..................................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCDegradation:PERiod..................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCDegradation:STATe....................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:PERiod........................ 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:FCORrection:STATe.......................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:PERiod.................................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:IGRid:STATe...................................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:PERiod.........................548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:LTCorrection:STATe...........................546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRN<ch>:STATe................................544
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:PERiod............................. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:PRNMask:STATe............................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:PERiod................................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:RINex:STATe..................................... 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:PERiod............................... 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:SERVice:STATe................................. 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:PERiod............................. 548
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS:NMESsage:NAV:UTCoffset:STATe?............................. 546
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS:WAAS[:STATe]..........................................................................335
[:SOURce<hw>]:BB:GNSS:SYSTem:SBAS[:STATe]?................................................................................... 335
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE............................................................ 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AONE:UNSCaled.......................................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo...........................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:AZERo:UNSCaled.........................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:IOFFset?........................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT............................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:TOT:UNSCaled..............................................348
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:BEIDou:UTC:WNOT............................................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE............................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AONE:UNSCaled..........................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo...........................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:AZERo:UNSCaled.........................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:IOFFset?....................................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT............................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:TOT:UNSCaled............................................. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GALileo:UTC:WNOT........................................................... 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE.........................................................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AONE:UNSCaled.......................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo........................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:AZERo:UNSCaled......................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT............................................................ 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:TOT:UNSCaled.......................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTC:WNOT........................................................ 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE.....................................................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AONE:UNSCaled...................................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo................................................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:AZERo:UNSCaled................................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:IOFFset?................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT........................................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:TOT:UNSCaled...................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GLONass:UTCSu:WNOT....................................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE................................................................. 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AONE:UNSCaled............................................... 351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo................................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:AZERo:UNSCaled..............................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:IOFFset?............................................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT.................................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:TOT:UNSCaled...................................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:GPS:UTC:WNOT................................................................ 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:AUTO........................................................................ 343
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:DATE.........................................................................344
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:AFTer........................................................ 344
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:LEAP:SEConds:BEFore......................................................344
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE............................................................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AONE:UNSCaled............................................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo..............................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:AZERo:UNSCaled............................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:IOFFset?.......................................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT.................................................................. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:TOT:UNSCaled.................................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:NAVic:UTC:WNOT.............................................................. 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE...............................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AONE:UNSCaled.............................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo..............................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:AZERo:UNSCaled............................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:IOFFset?.......................................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT.................................................................. 348
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:TOT:UNSCaled................................................ 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:QZSS:UTC:WNOT.............................................................. 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE................................................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AONE:UNSCaled............................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:AZERo:UNSCaled..............................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:IOFFset?............................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT.................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:TOT:UNSCaled...................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:EGNOS:UTC:WNOT................................................ 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE................................................. 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AONE:UNSCaled............................... 350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:AZERo:UNSCaled..............................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:IOFFset?............................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT.................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:TOT:UNSCaled...................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:GAGAN:UTC:WNOT................................................ 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE....................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AONE:UNSCaled..................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo...................................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:AZERo:UNSCaled.................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:IOFFset?............................................... 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT....................................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:TOT:UNSCaled..................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:MSAS:UTC:WNOT................................................... 347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE....................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AONE:UNSCaled..................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo.................................................. 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:AZERo:UNSCaled................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:IOFFset?...............................................349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT.......................................................348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:TOT:UNSCaled..................................... 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:SBAS:WAAS:UTC:WNOT...................................................347
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[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AONE:UNSCaled...........................................351
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo............................................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:AZERo:UNSCaled..........................................350
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:DATE?............................................................347
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:IOFFset?........................................................ 349
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT................................................................ 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:TOT:UNSCaled.............................................. 348
[:SOURce<hw>]:BB:GNSS:TIME:CONVersion:UTCSu:UTC:WNOT............................................................ 347
[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:OFFSet?.......................................................................... 346
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[:SOURce<hw>]:BB:GNSS:TIME:STARt:BEIDou:WNUMber?......................................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:DATE.............................................................................................341
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GALileo:OFFSet?..........................................................................346
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[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:DATE?..........................................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:OFFSet?.......................................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GLONass:TIME?...........................................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:OFFSet?...............................................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:GPS:TOWeek?............................................................................. 346
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[:SOURce<hw>]:BB:GNSS:TIME:STARt:QZSS:WNUMber?........................................................................ 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:OFFSet?...............................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:TOWeek?............................................................. 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:EGNOS:WNUMber?...........................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:OFFSet?...............................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:TOWeek?............................................................. 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:GAGAN:WNUMber?...........................................................345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:OFFSet?..................................................................346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:TOWeek?................................................................ 346
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:MSAS:WNUMber?............................................................. 345
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[:SOURce<hw>]:BB:GNSS:TIME:STARt:SBAS:WAAS:WNUMber?............................................................. 345
[:SOURce<hw>]:BB:GNSS:TIME:STARt:SCTime......................................................................................... 342
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